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Adjustment Guidelines Administration - Overview
 Adjustment guidelines determine an individual's compensation increase as it relates to salary, bonus, or equity compensation.
These guidelines can be created as specific amounts, can implement a recommendation matrix or custom formula, and can be discretionary or non-discretionary. Adjustment guidelines can be created by Organizational Unit (OU). 
The Adjustment Guidelines functionality allows the administrator to define and maintain compensation recommendations and guidelines for both salaried and hourly employees. The administrator can set up adjustment guidelines in order to provide recommended compensation for base, bonus, and equity compensation.
An adjustment guideline can be created for any component including base types (merit increase, market adjustment, COLA, promotion, custom base types), bonus, RSA, ISO, or NQO and each recommendation can be tied to performance metrics in order to drive pay for performance. The administrator can define availability of the guideline to setup different recommendations and guidelines for different areas of the organization. 
If a user is subject to multiple adjustment guidelines, the guideline with the highest payout is applied.
Administrators can create new adjustment guidelines, edit existing guidelines, and activate guidelines. 
There are three compensation types to which you can apply adjustment guidelines:
· Base - Includes merit increase, marked adjustment, cost of living, promotion, and custom base types. See Adjustment Guidelines - Create Base Types on page 7 for additional information.
· Bonus - Includes one-time cash awards or you can create custom bonus types. See Adjustment Guidelines - Create Bonus Types on page 13 for additional information.
· Equity - A grant of company stock which is restricted to an employee until the shares vest. See Adjustment Guidelines - Create Equity Types on page 18 for additional information.
To manage Adjustment Guidelines, go to Admin > Tools > Compensation Management > Adjustment Guidelines.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration


[image: ]
Adjustment Guidelines Workflow
If more than one guideline applies to an employee for a specific component, the following workflow applies:
· If the guideline is a recommendation matrix, then the midpoint of the recommended range will apply for the employee.
· If more than one guideline with recommendation matrices applies, then the guideline with the highest midpoint will apply for the employee.
· If more than one guideline with recommendation matrices applies, and the midpoints are equal between the guidelines, then the guideline with the highest maximum will apply for the employee.
· If one guideline is a specific amount and another guideline is a recommendation matrix, then the system will compare the specific amount against the midpoint of the recommended range of the guideline and apply the highest value for the employee.
Proration and Calculations
Proration can be defined based on an employee's time in an OU or based on their Hire Date. If the proration is based on Last Hire Date, then the most recent guideline that applies to the employee will pull in to display recommendations for the component on the task. If the proration is based on the time the employee was in an OU, and the employee switched managers during the compensation period, then the employee will appear in both the previous manager's and current manager's compensation task as follows: 
· On the previous manager's task, the budget will be adjusted accordingly to support the employee's adjustments.
· The guideline that pulls in for the previous manager will be the guideline that is available to the employee based on the employee's previous OU.
· The adjustment amounts from this guideline will be prorated based on the employee's time in the previous OU during the compensation period.
· The min, max, and median recommendations will be prorated based on this percentage.
· On the current manager's task, the budget will be adjusted accordingly to support the employee's compensation adjustments.
· The guideline that pulls in for the current manager will be the most recent guideline that is available to the employee based on the employee's current OU.
· The adjustment amounts from this guideline will be prorated based on the employee's time in the current OU during the compensation period.
· The min, max, and median recommendations will be prorated based on this percentage.
· For Bonus and Equity components that have targets, the targets will be prorated as well.
If the previous manager does not have a compensation task assigned with the same proration criteria, then the employee will not appear in the previous manager's task as the following applies: 
· The employee will only appear under the current manager's task with the recommendations pro-rated.
· The employee will not receive an adjustment for their time under the previous manager and OU.
If the adjustment guidelines are setup where the same guideline applies to the employee in both the previous and current OU's, then the same adjustment guideline will pull in for the previous and current managers. The summation of the adjustments from both the previous and current managers will appear to the employee on their compensation statement as well as on all compensation reporting and analytics. 
If LTI Awards that contain splits (i.e., RSA, ISO) are used and are prorated, then the full LTI Award Target and recommended award will be prorated in the same workflow that is described above in this section and the following applies:
· For each manager, the splits will be calculated based on the manager's prorated LTI Award recommendation and the guideline that applies to the employee based on the employee's time in OU.
· The prorated split amounts will be aggregated from all managers involved in the compensation of the employee for the task.
· The aggregated split amounts will be captured in the system and converted to their grant/options when the effective date of the equity grant is reached.
Compensation: 
Compensation: Compensation Overview

	 
	csod.com
	


	 
	csod.com
	4


[bookmark: _Ref807061547]Adjustment Guidelines - Create Base Types
Use the Adjustment Guidelines page to create guidelines for Base compensation types. 
Base types include the following components for which you can create adjustment guidelines:
· Merit Increase - An increase to an employee's salary based on a combination of performance metrics and compa-ratio.
· Market Adjustment - An adjustment to an employee's salary to bring the employee's salary up to market levels.
· Cost of Living Adjustment (COLA) - An across the board adjustment to salaries to bring pay in line with cost of living increases.
· Custom Base Types - Organizations can create additional base components. These function like standard base components.
Note: Before creating an adjustment guideline for a base type, administrators must first create the necessary base types in Base Types Administration. See Base Types Administration.
These guidelines can be created as specific amounts, can implement a recommendation matrix or custom formula, and can be discretionary or non-discretionary. Adjustment guidelines can be created by Organizational Unit (OU). 
To create a new adjustment guideline, go to Admin > Tools > Compensation Management > Adjustment Guidelines. Then, click the Create New Adjustment Guideline link. See Adjustment Guideline - Create for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration


Name
In the Name field, enter a name for the adjustment guideline. This name is only visible to administrators with access to this page.
Component
Select the appropriate compensation Type and associated Component. Note: The available options in the Components drop-down are based on the selected Type.
Note: If none of the default components work for you, you can create new components by going to Admin > tools > compensation.
Details 
The details section lets you select the time period to which this adjustment applies and the specific type of bonus. 
· Effective Period - Enter the compensation period for this adjustment. The beginning and end dates must match or extend outside of the Compensation Period to which they apply. 
· Type - Select one of the following bonus types: 
· Specific Amount - This option lets you allocate a specific amount of money to an employee. This can be a percentage of an employee's salary or a specific monetary amount. Use the Adjustment section to enter the appropriate percentage or amount.
· Recommendation Matrix - This option lets administrators configure a merit matrix based on compensation, performance, or succession data that recommends a specific amount based on where the employee is positioned within the matrix. Use the Adjustment section to enter the matrix details.Note: This option is not available for Cost of Living or Market Adjustments.
Enter Recommendation Matrix details in the Adjustment Section
[image: ]
In the matrix rating section, complete the following fields:
· Matrix Rating out of: - Select the appropriate rating range. For example, if you are planning to use performance review scores as your matrix, and your rating scale is 1 to 5, select 5 in this box.
· Add Metric - Click this option to select a matrix on which to base this employee recommendation. Tip: The most commonly used metrics are Last Competency Avg. Score and Last Performance Review Avg. Score. For example, if you select Last Performance Review Avg. Score, the matrix rating will be based on the most recent performance review completed for this employee. The matrix use percentiles to determine where an employee belongs in the matrix row. If the matrix is out of five, and you are using the Last Performance Review Avg. Score metric, employees whose last performance review score is 3.6 out of 5 would correspond to the 72 percentile, which places them in the 5th row. 
· Define Columns - Select the appropriate column. Employees can be placed into columns based on where they fall in their salary range. For example, if you create two columns and the salary range in column one is $50,000.00 to $60,000 and column two is $60,001.00 to $70,000.00, and your employee earns $65,000.00, the appropriate column is column 2. Note: This option is not available for Cost of Living or Marked Adjustment components. 
· Editable Recommendation Matrix - This option lets administrators completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range. Note: This option is not available for Target components or Equity components that are allocated in Shares. 
· Custom Formula - This option is configured in the Adjustment section and can be based on compensation data as well as other performance data. Note: When creating, copying, or editing an adjustment guideline for a base component type that includes a Merit Increase component, base component non-discretionary custom formulas that are set to be dynamically updated in the compensation plan will not update within the task if the formula contains a Merit Increase component and automatic lump sum allocation is enabled. To alert administrators, a warning message appears at the bottom of the Adjustment section when the Custom Formula option is selected in the Details section. 
· Allocation - Select how the adjustment is allocated. Note: This option is only available for Equity adjustment components. 
· Shares/Options - This option allocates the adjustment in stock shares or options. Note: When LTI Award is selected as the component type or when Recommendation Matrix is selected as the Type, this option is not available. 
· Cash Award - This option allocates the adjustment as a cash award. 
· Currency - This option displays the currency for the adjustment guideline.
Availability
The Availability guide section applies recommendations for an employee if that employee falls within the availability of the guideline. Select one of the availability options:
· Default Guideline - This elects the guideline as the default guideline for the organization.
· Select an OU from the drop-down list to apply the guideline for a specific OU within the organization.
Wage Type - This option determines to whom the guideline applies. The available options are:
· Any - The guideline applies to all employees who meet the availability criteria. Note: While "% of Base" and other custom formula recommendations may be applicable to both Annual and Hourly wage types, be aware that fixed dollar amounts may not be appropriate for both wage types.
· Annual - The guideline only applies to annual employees who meet the availability criteria.
· Hourly - The guideline only applies to hourly employees who meet the availability criteria.
Note: If the Default Guideline option is selected in the Availability section, Any is selected as the wage type and cannot be modified until a different Availability option is selected.
If a user's wage type is changed during a compensation task, adjustment guidelines are applied dynamically to new and existing drafts upon edit. Submitted plans are not affected. Simply opening an existing draft does not apply recommendations from new guidelines. However, if an employee has switched from hourly to annual or visa-versa for a Base Type that is included in Base Salary, the recommendation is updated to reflect the appropriate wage type. The employee's Labor Hours value for the task is used to calculate the equivalencies.
Adjustment
Using the radio buttons, select whether the adjustment is Discretionary or Non-Discretionary. If the adjustment is discretionary, then the adjustment amount can be adjusted by the manager. If the adjustment is non-discretionary, then the adjustment amount cannot be modified.
Specific Amount Options
Note: These options are only available when the adjustment Type is set to Specific Amount in the Details section.
Amount:
· Percentage - Select the first option to enter a base increase that is a percentage of the user's most recent base salary. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· Fixed Amount - Select the second option to enter a specific dollar amount. The number of decimal places that is allowed is based on the organization's default currency's (i.e., the adjustment guideline's currency) Default and Hourly Rate Precision settings, depending on the situation.
· If Hourly is selected for the Wage Type, recommendations must be within the Hourly Rate Precision settings. If the number of decimal places for the recommendation amount is less than the Hourly Rate Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Annual is selected for the Wage Type, recommendations must be within the Default Precision settings. If the number of decimal places for the recommendation amount is less than the Default Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Any is selected for the Wage Type, the selected component is a Base Type that is included in the Base Salary, and a Fixed Amount is being recommended, the precision allowed for the fixed amount is the maximum precision between the Default and Hourly Rate Precision settings. In other words, the higher precision value is used for validation. 
· [bookmark: concept4]Fixed amounts are rounded if a lower precision setting needs to be applied during the compensation task.
· If the "Include in Base Salary" option is not selected, the guideline is subjected to the Default Precision settings.
Recommendation Matrix Options
A recommendation matrix enables administrators to determine recommended payouts for the adjustment component based on selected metrics. The administrator can configure the matrix as necessary. 
Complete the following fields:
· Matrix Rating out of: - Select the appropriate rating range. For example, if you are planning to use performance review scores as your matrix, and your rating scale is 1 to 5, select 5 in this box.
· Add Metric - Click this option to select a matrix on which to base this employee recommendation. Tip: The most commonly used metrics are Last Competency Avg. Score and Last Performance Review Avg. Score. For example, if you select Last Performance Review Avg. Score, the matrix rating will be based on the most recent performance review completed for this employee. The matrix use percentiles to determine where an employee belongs in the matrix row. If the matrix is out of five, and you are using the Last Performance Review Avg. Score metric, employees whose last performance review score is 3.6 out of 5 would correspond to the 72 percentile, which places them in the 5th row.
· Define Columns - Select the appropriate column. Employees can be placed into columns based on where they fall in their salary range. For example, if you create two columns and the salary range in column one is $50,000.00 to $60,000 and column two is $60,001.00 to $70,000.00, and your employee earns $65,000.00, the appropriate column is column two.
Note: When creating an Adjustment Guideline, the Recommendation Matrix options are only available when the adjustment Type is set to Recommendation Matrix in the Details section.
See Compensation Recommendation Matrix on page 27 for additional information.
Editable Recommendation Matrix Options
An editable recommendation matrix enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range.
· Compa Ratio column widths are fully configurable with the configurable matrix. The configurable matrix does not have the above range or below range options for compa-ratio. The configurable matrix has the option to start from 0.00 compa-ratio and end with a max compa-ratio (infinity). Everything in between is configurable.
· Performance Score range heights are fully configurable with the configurable matrix. The configurable matrix has the option to start from 0% Performance score to 100%. Everything in between is configurable.
The Editable Recommendation Matrix option is available when creating adjustment guidelines for Base, Bonus, or Equity components. Note: Recommendation matrices cannot be created for Target components or Equity components that are allocated in Shares.
Note: Based on the adjustment Type selected in the Component section, the Editable Recommendation Matrix option appears in the Details section. 
See Compensation Editable Recommendation Matrix Overview on page 23 for additional information.
Custom Formula Options
Note: These options are only available when the adjustment Type is set to Custom Formula in the Details section.
Custom compensation formulas enable administrators to customize the way amounts are calculated in Adjustment Guidelines for any compensation component. Custom formulas can contain conditional statements and perform arithmetic operations using user, compensation, performance, and competency fields. The custom formulas then update compensation fields in real-time during execution of the compensation planning task. 
See Compensation Custom Formulas on page 30 for additional information.
Adjustment Rules
Select this option to activate rules indicating that the manager cannot give a recommendation above the guideline provided by the matrix. If this option is not selected, a manager's adjustment must be on or below the maximum recommendation. Note: This option is not available if the Non-Discretionary option is selected in the Adjustment section. The following options are available:
· On or below maximum recommendation - The manager's adjustment cannot exceed the maximum recommendation.
· May be over maximum recommendation by XX% - The manager's adjustment can exceed the maximum recommendation, but cannot exceed the specified percentage of the maximum recommendation. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Save/Cancel
· Click Save to save the information on this page.
· Click Cancel to close this page without saving changes.
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[bookmark: _Ref-1422206649]Adjustment Guidelines - Create Bonus Types
Use the Adjustment Guidelines page to create guidelines for Bonus compensation types. 
Bonus types include the following components for which you can create adjustment guidelines:
· Bonus - A one time cash award usually due to performance factors, including company performance, division performance, and individual performance for a given period.
· Custom Bonus Types - These allow organizations to create additional bonus components. These function like standard bonus components.
Note: Before creating an adjustment guideline for a base type, administrators must first create the necessary base types in Bonus Types Administration.  See Bonus Types on page 41 for additional information.
To create a new adjustment guideline, go to Admin > Tools > Compensation Management > Adjustment Guidelines. Then, click the Create New Adjustment Guideline link. See Adjustment Guideline - Create for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration


Name
In the Name field, enter a name for the adjustment guideline. This name is only visible to administrators with access to this page.
Component
Select the appropriate compensation Type and associated Component. Note: The available options in the Components drop-down are based on the selected Type.
Note: If none of the default components work for you, you can create new components by going to Admin > tools > compensation.
Details
· Effective Period - Enter the effective compensation period of the guideline. An adjustment guideline can be used for a compensation task as long as the Effective Period matches or extends beyond the Compensation Period of the task (i.e., starts earlier than or ends later than the Compensation Period).
· Type - Select one of the following bonus types: See the Adjustment section below for additional information on configuring the adjustments based on the selected Type.
· Specific Amount
· Recommendation Matrix - This option enables administrators to complete a merit matrix. This is a less configurable version of the Editable Recommendation Matrix. Note: This option is not available for Cost of Living or Market Adjustments.
· Editable Recommendation Matrix - This option enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range. Note: This option is not available for Target components or Equity components that are allocated in Shares.
· Custom Formula - The Custom Formula is configured in the Adjustment section and can be based on compensation data as well as other performance data. Note: When creating, copying, or editing an adjustment guideline for a base component type that includes a Merit Increase component, base component non-discretionary custom formulas that are set to be dynamically updated in the compensation plan will not update within the task if the formula contains a Merit Increase component and automatic lump sum allocation is enabled. To alert administrators, a warning message appears at the bottom of the Adjustment section when the Custom Formula option is selected in the Details section.
· Allocation - Select how the adjustment is allocated. Note: This is only available for Equity adjustment components.
· Shares/Options - Allocate the adjustment in stock shares or options. Note: When LTI Award is selected as the component type or when Recommendation Matrix is selected as the Type, this option is not available.
· Cash Award - Allocate the adjustment as a cash award.
· Currency - This displays the currency for the guideline.
Availability
The Availability guide section applies recommendations for an employee if that employee falls within the availability of the guideline. Select one of the availability options:
· Default Guideline - This elects the guideline as the default guideline for the organization.
· Select an OU from the drop-down list to apply the guideline for a specific OU within the organization.
Wage Type - This option determines to whom the guideline applies. The available options are:
· Any - The guideline applies to all employees who meet the availability criteria. Note: While "% of Base" and other custom formula recommendations may be applicable to both Annual and Hourly wage types, be aware that fixed dollar amounts may not be appropriate for both wage types.
· Annual - The guideline only applies to annual employees who meet the availability criteria.
· Hourly - The guideline only applies to hourly employees who meet the availability criteria.
Note: If the Default Guideline option is selected in the Availability section, Any is selected as the wage type and cannot be modified until a different Availability option is selected.
If a user's wage type is changed during a compensation task, adjustment guidelines are applied dynamically to new and existing drafts upon edit. Submitted plans are not affected. Simply opening an existing draft does not apply recommendations from new guidelines. However, if an employee has switched from hourly to annual or visa-versa for a Base Type that is included in Base Salary, the recommendation is updated to reflect the appropriate wage type. The employee's Labor Hours value for the task is used to calculate the equivalencies.
Adjustment
Target Bonus - This option is only available if the Allocation is set to Cash Award in the Details section. The available options are:
· Percentage - Select the first option to enter a target bonus that is a percentage of the user's most recent base salary.
· Fixed Amount - Select the second option to enter a specific dollar amount. The number of decimal places that is allowed is based on the organization's default currency's (i.e., the adjustment guideline's currency) Default and Hourly Rate Precision settings, depending on the situation.
· If Hourly is selected for the Wage Type, recommendations must be within the Hourly Rate Precision settings. If the number of decimal places for the recommendation amount is less than the Hourly Rate Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Annual is selected for the Wage Type, recommendations must be within the Default Precision settings. If the number of decimal places for the recommendation amount is less than the Default Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Any is selected for the Wage Type, the selected component is a Base Type that is included in the Base Salary, and a Fixed Amount is being recommended, the precision allowed for the fixed amount is the maximum precision between the Default and Hourly Rate Precision settings. In other words, the higher precision value is used for validation. 
· [bookmark: concept5]Fixed amounts are rounded if a lower precision setting needs to be applied during the compensation task.
· If the "Include in Base Salary" option is not selected, the guideline is subjected to the Default Precision settings.
· Individual Targets - Select the third option to use the individual targets set for each user.
Discretionary/Non-Discretionary
For Specific Amount and Custom Formula adjustment types:
· Using the radio buttons, select whether the adjustment is Discretionary or Non-Discretionary. If the adjustment is discretionary, then the adjustment amount can be adjusted by the manager. If the adjustment is non-discretionary, then the adjustment amount cannot be modified.
For Recommendation Matrix adjustment types:
· In the Non-Discretionary field, enter the percentage of the target bonus that is non-discretionary. The remaining percentage of the bonus is discretionary and is based on the results of the recommendation matrix.
Specific Amount Options
Note: These options are only available when the adjustment Type is set to Specific Amount in the Details section.
Amount:
· Percentage - Select the first option to enter a bonus that is a percentage of the user's target bonus. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· Fixed Amount - Select the second option to enter a specific dollar amount.
Recommendation Matrix Options
A recommendation matrix enables administrators to determine recommended payouts for the adjustment component based on selected metrics. The administrator can configure the matrix as necessary. 
Complete the following fields:
· Matrix Rating out of: - Select the appropriate rating range. For example, if you are planning to use performance review scores as your matrix, and your rating scale is 1 to 5, select 5 in this box.
· Add Metric - Click this option to select a matrix on which to base this employee recommendation. Tip: The most commonly used metrics are Last Competency Avg. Score and Last Performance Review Avg. Score. For example, if you select Last Performance Review Avg. Score, the matrix rating will be based on the most recent performance review completed for this employee. The matrix use percentiles to determine where an employee belongs in the matrix row. If the matrix is out of five, and you are using the Last Performance Review Avg. Score metric, employees whose last performance review score is 3.6 out of 5 would correspond to the 72 percentile, which places them in the 5th row.
· Define Columns - Select the appropriate column. Employees can be placed into columns based on where they fall in their salary range. For example, if you create two columns and the salary range in column one is $50,000.00 to $60,000 and column two is $60,001.00 to $70,000.00, and your employee earns $65,000.00, the appropriate column is column two.
Note: When creating an Adjustment Guideline, the Recommendation Matrix options are only available when the adjustment Type is set to Recommendation Matrix in the Details section.
See Compensation Recommendation Matrix on page 27 for additional information.
Editable Recommendation Matrix Options
An editable recommendation matrix enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range.
· Compa Ratio column widths are fully configurable with the configurable matrix. The configurable matrix does not have the above range or below range options for compa-ratio. The configurable matrix has the option to start from 0.00 compa-ratio and end with a max compa-ratio (infinity). Everything in between is configurable.
· Performance Score range heights are fully configurable with the configurable matrix. The configurable matrix has the option to start from 0% Performance score to 100%. Everything in between is configurable.
The Editable Recommendation Matrix option is available when creating adjustment guidelines for Base, Bonus, or Equity components. Note: Recommendation matrices cannot be created for Target components or Equity components that are allocated in Shares.
Note: Based on the adjustment Type selected in the Component section, the Editable Recommendation Matrix option appears in the Details section. 
See Compensation Editable Recommendation Matrix Overview on page 23 for additional information.
Custom Formula Options
Note: These options are only available when the adjustment Type is set to Custom Formula in the Details section.
Custom compensation formulas enable administrators to customize the way amounts are calculated in Adjustment Guidelines for any compensation component. Custom formulas can contain conditional statements and perform arithmetic operations using user, compensation, performance, and competency fields. The custom formulas then update compensation fields in real-time during execution of the compensation planning task.
See Compensation Custom Formulas on page 30 for additional information.
Adjustment Rules
Select this option to activate rules indicating that the manager cannot give a recommendation above the guideline provided by the matrix. If this option is not selected, a manager's adjustment must be on or below the maximum recommendation. Note: This option is not available if the Non-Discretionary option is selected in the Adjustment section. The following options are available:
· On or below maximum recommendation - The manager's adjustment cannot exceed the maximum recommendation.
· May be over maximum recommendation by XX% - The manager's adjustment can exceed the maximum recommendation, but cannot exceed the specified percentage of the maximum recommendation. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Save/Cancel
· Click Save to save the information on this page.
· Click Cancel to close this page without saving changes.
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[bookmark: _Ref-1291030473]Adjustment Guidelines - Create Equity Types
Use the Adjustment Guidelines page to create guidelines for Equity compensation types. 
Equity types include the following components for which you can create adjustment guidelines:
· RSA - A restricted stock award is a grant of company stock which is restricted to an employee until the shares vest.
· ISO - An incentive stock option is only available to company employees and is reportable as income only when the stock is sold.
· NQO - A non-qualified stock option is reportable as income when the option is exercised.
· LTI Award - This is equity that is allocated to employees as a full monetary amount, rather than a grant in shares or options. The full award may be split or distributed between RSA, ISO, or NQO grants. 
To create a new adjustment guideline, go to Admin > Tools > Compensation Management > Adjustment Guidelines. Then, click the Create New Adjustment Guideline link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration


Name
In the Name field, enter a name for the adjustment guideline. This name is only visible to administrators with access to this page.
Component
Select the appropriate compensation Type and associated Component. Note: The available options in the Components drop-down are based on the selected Type.
Note: If none of the default components work for you, you can create new components by going to Admin > tools > compensation.
Details
· Effective Period - Enter the effective compensation period of the guideline. An adjustment guideline can be used for a compensation task as long as the Effective Period matches or extends beyond the Compensation Period of the task (i.e., starts earlier than or ends later than the Compensation Period).
· Type - Select one of the following bonus types: See the Adjustment section below for additional information on configuring the adjustments based on the selected Type.
· Specific Amount
· Recommendation Matrix - This option enables administrators to complete a merit matrix. This is a less configurable version of the Editable Recommendation Matrix. Note: This option is not available for Cost of Living or Market Adjustments.
· Editable Recommendation Matrix - This option enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range. Note: This option is not available for Target components or Equity components that are allocated in Shares.
· Custom Formula - The Custom Formula is configured in the Adjustment section and can be based on compensation data as well as other performance data. Note: When creating, copying, or editing an adjustment guideline for a base component type that includes a Merit Increase component, base component non-discretionary custom formulas that are set to be dynamically updated in the compensation plan will not update within the task if the formula contains a Merit Increase component and automatic lump sum allocation is enabled. To alert administrators, a warning message appears at the bottom of the Adjustment section when the Custom Formula option is selected in the Details section.
· Allocation - Select how the adjustment is allocated. Note: This is only available for Equity adjustment components.
· Shares/Options - Allocate the adjustment in stock shares or options. Note: When LTI Award is selected as the component type or when Recommendation Matrix is selected as the Type, this option is not available.
· Cash Award - Allocate the adjustment as a cash award.
· Currency - This displays the currency for the guideline.
Availability
The Availability guide section applies recommendations for an employee if that employee falls within the availability of the guideline. Select one of the availability options:
· Default Guideline - This elects the guideline as the default guideline for the organization.
· Select an OU from the drop-down list to apply the guideline for a specific OU within the organization.
Wage Type - This option determines to whom the guideline applies. The available options are:
· Any - The guideline applies to all employees who meet the availability criteria. Note: While "% of Base" and other custom formula recommendations may be applicable to both Annual and Hourly wage types, be aware that fixed dollar amounts may not be appropriate for both wage types.
· Annual - The guideline only applies to annual employees who meet the availability criteria.
· Hourly - The guideline only applies to hourly employees who meet the availability criteria.
Note: If the Default Guideline option is selected in the Availability section, Any is selected as the wage type and cannot be modified until a different Availability option is selected.
If a user's wage type is changed during a compensation task, adjustment guidelines are applied dynamically to new and existing drafts upon edit. Submitted plans are not affected. Simply opening an existing draft does not apply recommendations from new guidelines. However, if an employee has switched from hourly to annual or visa-versa for a Base Type that is included in Base Salary, the recommendation is updated to reflect the appropriate wage type. The employee's Labor Hours value for the task is used to calculate the equivalencies.
LTI Split
Note: This section is only available when creating an LTI Award adjustment guideline. This section does not appear for any other equity types.
An LTI Award may be split or distributed between RSA, ISO, or NQO grants. This section enables the administrator to determine the distribution of the LTI Award for the guideline. The split is based on the total monetary amount of the LTI Award that is awarded to the employee. Note: After the effective period of the guideline has passed, the LTI Split cannot be modified.
This is optional. If a split is not defined, then the full amount is allocated under LTI.
1. Click the plus icon to the right of the LTI Split heading, and from the pop-up, select the components between which the award should be divided. 
2. Click the Add button. The selected components are added to the section.
3. In the percentage field to the right of each component, enter the percentage that should be allocated to each component. The total must equal 100%. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Adjustment
Target Award - This option is only available if the Allocation is set to Cash Award in the Details section. The available options are:
· Percentage - Select the first option to enter a target award that is a percentage of the user's most recent base salary.
· Fixed Amount - Select the second option to enter a specific dollar amount. The number of decimal places that is allowed is based on the organization's default currency's (i.e., the adjustment guideline's currency) Default and Hourly Rate Precision settings, depending on the situation.
· If Hourly is selected for the Wage Type, recommendations must be within the Hourly Rate Precision settings. If the number of decimal places for the recommendation amount is less than the Hourly Rate Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Annual is selected for the Wage Type, recommendations must be within the Default Precision settings. If the number of decimal places for the recommendation amount is less than the Default Precision settings, zeroes are added to the end of the value to match the precision settings.
· If Any is selected for the Wage Type, the selected component is a Base Type that is included in the Base Salary, and a Fixed Amount is being recommended, the precision allowed for the fixed amount is the maximum precision between the Default and Hourly Rate Precision settings. In other words, the higher precision value is used for validation. 
· [bookmark: concept6]Fixed amounts are rounded if a lower precision setting needs to be applied during the compensation task.
· If the "Include in Base Salary" option is not selected, the guideline is subjected to the Default Precision settings.
· Individual Targets - Select the third option to use the individual targets set for each user.
Using the radio buttons, select whether the adjustment is Discretionary or Non-Discretionary. If the adjustment is discretionary, then the adjustment amount can be adjusted by the manager. If the adjustment is non-discretionary, then the adjustment amount cannot be modified.
Specific Amount Options
Note: These options are only available when the adjustment Type is set to Specific Amount in the Details section.
Amount - The options that are available are dependent on the Allocation selection that is set in the Details section.
· Shares - If the Allocation is set to Shares, enter the specific amount of shares. 
· Cash Award - If the Allocation is set to Cash Award, the following options are available:
· Percentage - Select the first option to enter an amount that is a percentage of the user's most recent base salary. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· Fixed Amount - Select the second option to enter a specific dollar amount.
Recommendation Matrix Options
A recommendation matrix enables administrators to determine recommended payouts for the adjustment component based on selected metrics. The administrator can configure the matrix as necessary. 
Complete the following fields:
· Matrix Rating out of: - Select the appropriate rating range. For example, if you are planning to use performance review scores as your matrix, and your rating scale is 1 to 5, select 5 in this box.
· Add Metric - Click this option to select a matrix on which to base this employee recommendation. Tip: The most commonly used metrics are Last Competency Avg. Score and Last Performance Review Avg. Score. For example, if you select Last Performance Review Avg. Score, the matrix rating will be based on the most recent performance review completed for this employee. The matrix use percentiles to determine where an employee belongs in the matrix row. If the matrix is out of five, and you are using the Last Performance Review Avg. Score metric, employees whose last performance review score is 3.6 out of 5 would correspond to the 72 percentile, which places them in the 5th row.
· Define Columns - Select the appropriate column. Employees can be placed into columns based on where they fall in their salary range. For example, if you create two columns and the salary range in column one is $50,000.00 to $60,000 and column two is $60,001.00 to $70,000.00, and your employee earns $65,000.00, the appropriate column is column two.
Note: When creating an Adjustment Guideline, the Recommendation Matrix options are only available when the adjustment Type is set to Recommendation Matrix in the Details section.
See Compensation Recommendation Matrix on page 27 for additional information.
Editable Recommendation Matrix Options
An editable recommendation matrix enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range.
· Compa Ratio column widths are fully configurable with the configurable matrix. The configurable matrix does not have the above range or below range options for compa-ratio. The configurable matrix has the option to start from 0.00 compa-ratio and end with a max compa-ratio (infinity). Everything in between is configurable.
· Performance Score range heights are fully configurable with the configurable matrix. The configurable matrix has the option to start from 0% Performance score to 100%. Everything in between is configurable.
The Editable Recommendation Matrix option is available when creating adjustment guidelines for Base, Bonus, or Equity components. Note: Recommendation matrices cannot be created for Target components or Equity components that are allocated in Shares.
Note: Based on the adjustment Type selected in the Component section, the Editable Recommendation Matrix option appears in the Details section. 
See Compensation Editable Recommendation Matrix Overview on page 23 for additional information.
Custom Formula Options
Note: These options are only available when the adjustment Type is set to Custom Formula in the Details section.
Custom compensation formulas enable administrators to customize the way amounts are calculated in Adjustment Guidelines for any compensation component. Custom formulas can contain conditional statements and perform arithmetic operations using user, compensation, performance, and competency fields. The custom formulas then update compensation fields in real-time during execution of the compensation planning task.
See Compensation Custom Formulas on page 30 for additional information.
Adjustment Rules
Select this option to activate rules indicating that the manager cannot give a recommendation above the guideline provided by the matrix. If this option is not selected, a manager's adjustment must be on or below the maximum recommendation. Note: This option is not available if the Non-Discretionary option is selected in the Adjustment section. The following options are available:
· On or below maximum recommendation - The manager's adjustment cannot exceed the maximum recommendation.
· May be over maximum recommendation by XX% - The manager's adjustment can exceed the maximum recommendation, but cannot exceed the specified percentage of the maximum recommendation. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Save/Cancel
· Click Save to save the information on this page.
· Click Cancel to close this page without saving changes.
[bookmark: _Ref1009987072]Compensation Editable Recommendation Matrix Overview
An editable recommendation matrix enables administrators to completely configure a merit matrix that takes into account where an employee stands in their salary range and their performance score and gives compensation managers a recommended increase range.
· Compa Ratio column widths are fully configurable with the configurable matrix. The configurable matrix does not have the above range or below range options for compa-ratio. The configurable matrix has the option to start from 0.00 compa-ratio and end with a max compa-ratio (infinity). Everything in between is configurable.
· Performance Score range heights are fully configurable with the configurable matrix. The configurable matrix has the option to start from 0% Performance score to 100%. Everything in between is configurable.
The Editable Recommendation Matrix option is available when creating adjustment guidelines for Base, Bonus, or Equity components. Note: Recommendation matrices cannot be created for Target components or Equity components that are allocated in Shares.
Note: Based on the adjustment Type selected in the Component section, the Editable Recommendation Matrix option appears in the Details section. 
To create a new adjustment guideline, go to Admin > Tools > Compensation Management > Adjustment Guidelines. Then, click the Create New Adjustment Guideline link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration
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Configure Matrix
Enter the following information to configure the recommendation matrix:
· Matrix Rating out of - Define the number of rating scale levels for the matrix. This drop-down contains values 1-15 to allow the matrix to contain up to 15 rows. Note: Changing these values after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix.
· Total Columns - Define the number of columns to include in the matrix. 
· Base Types - When creating an adjustment guideline for a base component, this drop-down contains values 1-15 to allow the matrix to contain up to 15 columns. Note: Changing these values after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix. Also, the metric that is used for column values is displayed below this field.
· Bonus/Equity Types - When creating an adjustment guideline for a bonus or equity component, the total columns is set to 1, and this cannot be modified. Note: The metric that is used for column values is displayed below this field.
· Add Metric - Click this link to add a performance or succession metric to the recommendation matrix. The selected metrics determine how the recommendation for merit increase is calculated. The available metrics are Last Competency Avg. Score, Last Performance Review Avg. Score, Goal Achievement %, past performance reviews and competency assessments, numeric user custom fields, and any SMP rating scale metric.
· Scale - For numeric user custom fields, enter the top rating scale value. For all other metric types, this value automatically populates with the read-only scale value.
· The value displays as N/A for metrics that are not tied to a specific task (e.g., Last Performance Review Average Score, Last Competency Average Score).
· The value displays as N/A for metrics that are tied to a specific competency assessment task that has the Include all competency models with the selected availability option set, as rating scales vary by competency models and users may have different rating scales defined for the competency task.
· The value displays as 100 for goal metrics.
· Weights - Enter a weight to specify how much each metric impacts the score. The sum of all weights must total 100%.
· See Performance Review Section Score Metrics on page 197 for additional information.
· Metric - This displays the metric that is used for the column values in the matrix. 
· Base Types - This is Compa Ratio, which is the employee's position in their salary range. Note: Changing the below options after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix.
· Include Below Salary Range column - Select this option to include a column for values below the salary range. This is used if employees may be below the salary range for their position. When selected, this column appears in the matrix.
· Include Above Salary Range column - Select this option to include a column for values above the salary range. This is used if employees may be above the salary range for their position. When selected, this column appears in the matrix. 
· Bonus Types - This is % of Target Bonus, which is the percentage of the employee's target bonus.
· Equity Types - This is % of Base, which is the percentage of the employee's base pay.
Create Matrix
Click the Create Matrix link to create the recommendation matrix as configured. Administrators can then set percentages for each row and column combination in the matrix.
In the matrix, enter a recommended minimum and maximum percentage range for each row and column combination on the matrix. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Create Matrix for Base Components
When the Create Matrix link is selected, the Editable Recommendation Matrix is created in the Adjustment section.
· Matrix Rating - As with the Recommendation Matrix, the Matrix Ratings appear along the left side the matrix rows. These values represent percentages of the maximum matrix rating. For example, 100% indicates that the user received the maximum possible rating for the selected metric. The bottom row always begins at 0%, and the top row always ends at 100%. The values within the row headings can be fully customized, and the starting percentages for each row (excluding the bottom row, which automatically begins at 0%) is automatically set based on the ending percentage of the previous row. For example, if the previous row ends at 10.15%, then the row above it will begin at 10.16%. The percentage values use the portal's default decimal precision rate.
· Compa-Ratio - As with the Recommendation Matrix, the Compa-Ratio values appear along the top of the matrix columns. These values represent the how the user's current compensation compares with the industry average. The first column always begins at 0.00, and the last column always ends at Max (infinity). The values within the column headings can be fully customized, and the starting percentages for each column (excluding the first column, which automatically begins at 0.00) is automatically set based on the ending percentage of the previous column. For example, if the previous column ends at 10.15, then the column to the right of it will begin at 10.16. The matrix columns use two decimals of precision.
A value must be entered for all entries in the Editable Recommendation Matrix, as these values will drive recommendations in the compensation plans.
Adjustment - Create Matrix for Bonus or Equity Components
When the Create Matrix link is selected, the Editable Recommendation Matrix is created in the Adjustment section.
· Matrix Rating - As with the Recommendation Matrix, the Matrix Ratings appear along the left side the matrix rows. These values represent percentages of the maximum matrix rating. For example, 100% indicates that the user received the maximum possible rating for the selected metric. The bottom row always begins at 0%, and the top row always ends at 100%. The values within the row headings can be fully customized, and the starting percentages for each row (excluding the bottom row, which automatically begins at 0%) is automatically set based on the ending percentage of the previous row. For example, if the previous row ends at 10.15%, then the row above it will begin at 10.16%. The percentage values use the portal's default decimal precision rate.
· % Attained of Target - When creating an adjustment guideline for a bonus component, only one column is displayed, and that is the % Attained of Target column.
· % of Base - When creating an adjustment guideline for an equity component, only one column is displayed, and that is the % of Base column.
A value must be entered for all entries in the Editable Recommendation Matrix, as these values will drive recommendations in the compensation plans.
[bookmark: _Ref-1028671708]Compensation Recommendation Matrix
A recommendation matrix enables administrators to determine recommended payouts for the adjustment component based on selected metrics. The administrator can configure the matrix as necessary. 
Complete the following fields:
· Matrix Rating out of: - Select the appropriate rating range. For example, if you are planning to use performance review scores as your matrix, and your rating scale is 1 to 5, select 5 in this box.
· Add Metric - Click this option to select a matrix on which to base this employee recommendation. Tip: The most commonly used metrics are Last Competency Avg. Score and Last Performance Review Avg. Score. For example, if you select Last Performance Review Avg. Score, the matrix rating will be based on the most recent performance review completed for this employee. The matrix use percentiles to determine where an employee belongs in the matrix row. If the matrix is out of five, and you are using the Last Performance Review Avg. Score metric, employees whose last performance review score is 3.6 out of 5 would correspond to the 72 percentile, which places them in the 5th row.
· Define Columns - Select the appropriate column. Employees can be placed into columns based on where they fall in their salary range. For example, if you create two columns and the salary range in column one is $50,000.00 to $60,000 and column two is $60,001.00 to $70,000.00, and your employee earns $65,000.00, the appropriate column is column two.
Note: When creating an Adjustment Guideline, the Recommendation Matrix options are only available when the adjustment Type is set to Recommendation Matrix in the Details section.
To create a new adjustment guideline, go to Admin > Tools > Compensation Management > Adjustment Guidelines. Then, click the Create New Adjustment Guideline link. See Adjustment Guideline - Create for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Adjustment Guidelines - Manage
	Grants ability to define and maintain compensation recommendations and guidelines for both salary and hourly employees. This permission can be constrained by User. This is an administrator permission.
	Compensation - Administration


[image: ]
Configure Matrix
Enter the following information to configure the recommendation matrix:
· Matrix Rating out of - Define the number of rating scale levels for the matrix. This can be a value from 1-10. Note: Changing these values after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix.
· Total Columns - Define the number of columns to include in the matrix. 
· Base Types - This can be a value from 1-5. Note: Changing these values after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix. Also, the metric that is used for column values is displayed below this field.
· Bonus/Equity Types - The total number of columns is set at 1 and cannot be changed. Note: The metric that is used for column values is displayed below this field.
· Add Metric - Click this link to add a performance or succession metric to the recommendation matrix. The selected metrics determine how the recommendation for merit increase is calculated. The available metrics are Last Competency Avg. Score, Last Performance Review Avg. Score, Goal Achievement %, past performance reviews and competency assessments, numeric user custom fields, and any SMP rating scale metric.
· Scale - For numeric user custom fields, enter the top rating scale value. For all other metric types, this value automatically populates with the read-only scale value.
· The value displays as N/A for metrics that are not tied to a specific task (e.g., Last Performance Review Average Score, Last Competency Average Score).
· The value displays as N/A for metrics that are tied to a specific competency assessment task that has the Include all competency models with the selected availability option set, as rating scales vary by competency models and users may have different rating scales defined for the competency task.
· The value displays as 100 for goal metrics.
· Weights - Enter a weight to specify how much each metric impacts the score. The sum of all weights must total 100%.
· See Performance Review Section Score Metrics on page 197 for additional information.
· Metric - This displays the metric that is used for the column values in the matrix. 
· Base Types - This is Compa Ratio, which is the employee's position in their salary range. Note: Changing the below options after the matrix is created and re-creating the matrix eliminates any values you may have entered into the matrix.
· Include Below Salary Range column - Select this option to include a column for values below the salary range. This is used if employees may be below the salary range for their position. When selected, this column appears in the matrix.
· Include Above Salary Range column - Select this option to include a column for values above the salary range. This is used if employees may be above the salary range for their position. When selected, this column appears in the matrix. 
· Bonus Types - This is % of Target Bonus, which is the percentage of the employee's target bonus.
· Equity Types - This is % of Base, which is the percentage of the employee's base pay.
Create Matrix
Click the Create Matrix link to create the recommendation matrix as configured. Administrators can then set percentages for each row and column combination in the matrix.
In the matrix, enter a recommended minimum and maximum percentage range for each row and column combination on the matrix. 
· Base Types - Based on the employee's metric rating and compa-ratio, the guideline will provide the recommended base increase for the employee in the compensation plan.
· Bonus Types - Based on the employee's metric rating and % of Base, the guideline will provide the recommended bonus for the employee in the compensation plan.
· Equity Types - Based on the employee's metric rating and % of Base, the guideline will provide the recommended equity increase for the employee in the compensation plan.
One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Compensation: 
Compensation: Compensation Overview
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[bookmark: _Ref746112080]Compensation Custom Formulas
Custom compensation formulas enable administrators to customize the way amounts are calculated in Adjustment Guidelines for any compensation component. Custom formulas can contain conditional statements and perform arithmetic operations using user, compensation, performance, and competency fields. The custom formulas then update compensation fields in real-time during execution of the compensation planning task.
Custom formulas can be created as a single equation or they can be based on an IF/THEN/ELSE statement that can be customized using any available tags. See Conditions for in depth information on creating a IF/THEN/ELSE condition statement.
The tags that are used in the Compensation module are managed in Compensation Tag Management. To view the available compensation tags, click the View Tags link.
Equations
The equation is built in the Equation field. The equation can be created using tags and functions (Min, Max, Avg). To add a tag to the equation, click the Import Field [image: ] icon. All imported fields must be enclosed in curly brackets (e.g., {2009.REVIEW}). See Functions below for additional information on using functions. After setting the equation, click the Save icon to the right of the field to validate and save the equation. All equations must be saved before saving the adjustment guideline. Adjustment values are rounded to two decimal places during the planning task.
Dynamically update value in Compensation Task - Select this option to have the values in the formula dynamically updated as they change within the compensation task.
· Only non-discretionary fields can be dynamically updated in a compensation task.
· Only data that has not been submitted can be updated (i.e., data in draft status). Data that has been submitted is final.
Functions
A function can be added to a formula by clicking the Add Function [image: ] icon. This opens a pop-up where you can select the appropriate function. The following options are available:
· MIN - This selects the lowest value from the list of tags.
· MAX - This selects the highest value from the list of tags.
· AVG - This calculates the average of the list of tags.
When a function is selected, it appears in the text box (e.g., MAX( ; )). In the parenthesis, enter the appropriate tags, separated by a semicolon. For example, to determine the lowest performance review score the user has had over the past three years, you could use the MIN function and then add the previous three performance review tags, separated by a semicolon (MIN({2009.REVIEW};{2010.REVIEW};{2011.REVIEW})). Note: Only numeric fields can be added to these functions.
Imported fields and mathematical operations can be performed inside a function to serve as a parameter value as long as each parameter is separated by a semicolon (MAX({2009.REVIEW}*2; {2010.REVIEW}*2; {2011.REVIEW}).
Conditions
IF/THEN/ELSE statements allow you to set a condition, and if that condition is met, then Result A occurs, otherwise (else), Result B occurs. For example, IF the employee's performance review score is greater than 3/5, THEN their recommended adjustment is $2000. ELSE, their recommended adjustment is $0. 
You can also add additional conditions to the statement using AND or OR logic. Adding an AND condition indicates that both conditions must be met to satisfy the criteria. Adding an OR condition indicates that either of the conditions must be met to satisfy the criteria. For example, IF the employee's performance review score is greater than 3/5 OR the employee's competency assessment score is greater than 3/5, THEN their recommended adjustment is $2000. ELSE, their recommended adjustment is $0. In this example, OR logic is used, so either of the employee's performance review or competency assessment scores must be greater than 3/5 to receive the $2000 adjustment. If AND logic were used, both of the employee's scores must be greater than 3/5 to receive the $2000 adjustment.
Adjustment values are rounded to two decimal places during the planning task.
1. Add Condition - Click this link to select a tag to set a condition for the formula. Note: Tag names are universal for all languages. When a tag is selected, additional options appear, depending on the type of condition tag selected.
· Branched Drop-down - Displays a drop-down list of the options available for the field. An option must be selected.
· Checkbox - Displays the checkbox for the field, which can be selected or deselected.
· Multiple Checkbox - Displays all checkbox options. Multiple options can be selected.
· Date Fields - Create a condition using an operator and a specific date.
· The following operators are available: is on, is not on, is after, is on or after, is before, is on or before.
· After selecting an operator, a date must be entered or selected using the calendar tool.
· Drop-down - Displays a drop-down list of the options available for the field. An option must be selected.
· Numeric Field - Create a condition using an operator and a specific numeric value.
· The following operators are available: equals, not equal to, greater than, greater than or equal to, less than, less than or equal to.
· After selecting an operator, a numeric value must be entered.
· Percentage Field - Create a condition using an operator and a specific percentage. 
· The following operators are available: equals, not equal to, greater than, greater than or equal to, less than, less than or equal to.
· After selecting an operator, a numeric value must be entered. This value should already be in percentage form. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· Radio Button - Displays all radio button options. An option must be selected.
· Short Text Box - Create a condition using an operator and specific text.
· The following operators are available: equals, not equal to, contains.
· After selecting the operator, specific text must be entered. The text is not case sensitive.
2. After completing the IF statement, you may choose to add an additional "AND" or "OR" criteria by clicking the appropriate link after the condition if necessary. This enables you to add an additional criteria to the statement using another tag. Multiple AND or OR criteria can be added, but they all must use the same logic (all AND criteria or all OR criteria).
3. Once all necessary AND or OR criteria are added, you must specify the adjustment value for the IF portion of the statement. Click the Edit icon to the right of the THEN field. This makes the field editable. This value can be calculated using tags and functions (Min, Max, Avg). To add a tag to the equation, click the Import Field [image: ] icon. All imported fields must be enclosed in curly brackets (e.g., {2009.REVIEW}). See Functions below for additional information on using functions. After setting the value, click the Save icon to the right of the field to save the value.
4. An additional IF/THEN condition can be added to the statement, if necessary, by repeating steps 1-4. Adding an additional condition enables you to set another condition before the default result occurs. For example, IF Score A is greater than 4/5, THEN Adjustment equals 5000. Otherwise, IF Score A is greater than 3/5, THEN Adjustment equals 3000. ELSE, Adjustment equals 0. Once an IF/THEN statement is satisfied, the system does not check the remaining IF/THEN statements.
5. After setting all of the necessary IF/THEN conditions, you must set the default result, which is the ELSE portion of the statement. Click the Edit icon to the right of the ELSE field. This makes the field editable. This value can be calculated using tags and functions (Min, Max, Avg). After setting the value, click the Save icon to the right of the field to validate and save the value. All equations must be saved before saving the adjustment guideline.
6. Dynamically update value in Compensation Task - Select this option to have the values in the formula dynamically updated as they change within the compensation task. Note: Only non-discretionary fields can be dynamically updated in a compensation task.
Equation and Condition Statement Rules
The following rules apply to all equations and condition statements:
· Formulas can include numeric operations (addition (+), subtraction (-), division (/), and multiplication (*)). Operators must be separated by a numeric value or tag. 
· Fields cannot be negated (made negative) by a negative sign, but numbers can. For example "{FIELD} * -3" is valid, but "-{FIELD} * 3" is not valid. To negate a field, you can multiply the field by -1.
· Parenthesis can be used in equations, but the system must validate that the equation contains matching open and closing ends.
· Imported fields must be enclosed in curly brackets and they must be defined in the system.
· General compensation, base component, bonus component, and equity component fields used in custom formula equations that are not part of the planning task are treated as zero during the calculation with the exception of CURRENT component fields (e.g., Current Bonus, Current CustomBase).
· If multiple values exist for a field, the formula retrieves the most recent value within the task's compensation period dates.
· If a field's value is updated during the task period, it is reflected in subsequent new drafts of the task. However, all existing drafts are unaffected.
· If a field in a condition is undefined for a user, the clause containing the undefined field as automatically false. However, this does not automatically make the entire IF statement false if there are additional clauses.
· Invalid expressions (e.g., divide by zero) that arise in custom formula equations during a calculation cause the result of the equation to be zero.
· For prorated compensation fields in custom formulas, only one value is retrieved for the field. If a user appears in multiple managers' compensation tasks as a result of proration, the field retrieves a value from their task only. If a user is prorated under the same manager, then the value retrieved for the field is the total prorated amount.
· For conditions involving compensation fields, if a currency conversion is necessary, the conversion occurs before the condition is applied. The conversion rate used is the rate at the task's Start Date.
[bookmark: _Ref1834297900]Performance Review Section Score Metrics
Performance review section scores can be added as a metric for performance reviews that are in a Queued, Not Started, In Progress, Complete, or Expired status. This includes both active and inactive performance reviews.  
[image: ]
On the Search Fields and Metrics pop-up, performance review section scores display as <Performance Review Name> - <Section Name> (e.g., 2011 Annual Performance Review - Work Culture Ratings).
Only current sections included in a performance review task are included in the Search Fields and Metrics pop-up. That is, if a performance review task has been modified to remove a section or add a section, then only the current (at the time the pop-up is opened) sections are included in the task.
Considerations
· Only rated sections within performance reviews are available as a metric in compensation management, which includes Question List, Goal Rating, and Competency section types.
· Calculations for performance review section scores are independent of the weighting of the section in an individual step of a performance review. Calculations take into account the weighting of individual steps within the performance review.
· Performance Review Section Score = ( (<Section Score – Step 1> * <Step 1 Weighting>) + (<Section Score – Step 2> * <Step 2 Weighting>) + … + (<Section Score – Step n> * <Step n Weighting>) ) / (<Step 1 Weighting> + <Step 2 Weighting> + … + <Step n Weighting>)
Note: Not all steps within a performance review contain a specific section. In such cases, the step is not included in the calculation.
· When specific performance review section scores are used as metrics, the score calculation applies to completed tasks at the user level as currently implemented for overall performance review scores.
· Users that do not have a Completed status for the associated performance review have an inapplicable performance review section score.
· For eligibility criteria, the user is not considered eligible if a performance review section score is used and the user does not have a Completed status for the performance review. Eligibility is dynamically re-determined at the time the user receives the Completed performance review.
· For adjustment guideline metrics, the user will not have an applicable score for the performance review section score if the user does not have a Completed status for the associated performance review.
· If an off-cycle performance review task section score is used and there are multiple instances of the task associated to the user, then the last instance associated to the user is used. This will be the last completed task with the latest performance review period within the compensation period of the associated compensation task.
· For performance review sections that do not have the Display Scores to End Users option selected, "No Rating" displays for the performance review section score.
Note: Section scores are populated and available regardless of review status.
Use Cases
Use Case 1: Sections Included in Search Fields and Metrics Pop-Up - Simple
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
Results
1. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
Use Case 2: Sections Included in Search Fields and Metrics Pop-Up - Removed Section
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
3. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
4. Administrator updates 2011 Annual Performance Review and removes 2011 Competencies.
5. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
6. Administrator clicks Add Metric for Recommendation Matrix.
Results
1. 2011 Annual Performance Review has three associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Final Thoughts
Use Case 3: Section Score Calculation
For Use Case 3, assume the following tables show the configuration for 2011 Annual Performance Review:
	Review Step
	Weighting

	Employee Review
	20%

	Manager Review
	50%

	Indirect Manager Review
	30%



	Review Step
	Section 1
	Section 2
	Section 3
	Section 4

	Employee Review
	2011 Goals in Review
	Future Goals
	2011 Competencies
	2011 Final Thoughts

	Manager Review
	2011 Goals in Review
	Future Goals
	2011 Competencies
	2012 Final Thoughts

	Indirect Manager Review
	2011 Final Thoughts
	--
	--
	--


Tammy Andrews receives the following scores for 2011 Annual Performance Review:
	Review Step
	2011 Goals in Review
	2011 Competencies
	2011 Final Thoughts

	Employee Review
	5.0 / 5.0
	4.5 / 5.0
	4.2 / 5.0

	Manager Review
	4.8 / 5.0
	4.6 / 5.0
	4.0 / 5.0

	Indirect Manager Review
	--
	--
	4.2 / 5.0


Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
3. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
Results
1. Tammy Andrews receives the following scores for 2011 Annual Performance Review sections:
	Section
	Score

	2011 Goals in Review
	97.1%

	2011 Competencies
	91.4%

	2011 Final Thoughts
	82.0%


1. Calculations
· 2011 Goals in Review
· (((5.0 / 5.0) * 0.2) + ((4.8 / 5.0) * 0.5)) / (0.2 + 0.5)
· 2011 Competencies
· (((4.5 / 5.0) * 0.2) + ((4.6 / 5.0) * 0.5)) / (0.2 + 0.5)
· 2011 Final Thoughts
· (((4.2 / 5.0) * 0.2) + ((4.0 / 5.0) * 0.5) + ((4.2 / 5.0) * 0.3)) / (0.2 + 0.5 + 0.3)
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[bookmark: _Toc161996442]Compensation Base Types Overview
Similar to bonus types, base types enable administrators to create custom base type components to include as a part of an employee's base compensation package.
Administrators can create, delete, deactivate, and edit base types. Also, administrators can choose whether or not to include a base type as part of base salary calculation.
Adjustment guidelines can be created for custom base type components and can be added to the base section of compensation tasks through Compensation Plan Templates. Components can be added to a template without a budget.
Custom base types are useful when an organization requires components other than Merit Increase, Cost of Living Adjustment, Market Adjustment, and Promotion as part of their base package. Custom base types are also useful when an organization needs to add components to compensation planning without necessarily assigning a budget to the component.
Workflow
The following is the workflow for implementing custom base types:
1. Create a base component.
2. Create adjustment guidelines for the component.
3. Add the component as part of a base compensation plan template.
4. Select the template when creating a compensation task.
5. When performing the compensation planning or modeling task, the manager can enter values for the new base component for employees.
6. The base component may or may not be used in calculation of employee's new salary.
7. Values entered for base types are included and reflected in the ensuing compensation statement.
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Base Types Administration
Base types are the base components used in calculating an employee's new salary. The Base Types administration page enables administrators to create, modify, deactivate, and delete base types. The standard base types are Cost of Living Adjustment, Promotion, Merit Increase, and Market Adjustment. Base types are listed in the order in which they are created. The most recently created base types are at the bottom of the list. 
Up to 60 custom base types can be created. The four default base types are not included in the limit. However, both active and inactive custom base types are included.
To access the Base Types administration screen, go to Admin > Tools > Compensation Management > Base Types.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Base Types
	Grants ability to create, modify, deactivate, and delete compensation base types. This is an administrator permission.
	Compensation - Administration


[image: ]
Add Base Type
To add a new base type, click the Add Base Type link. This adds a blank field at the bottom of the list. In the field, enter the name of the base type. The name should describe the purpose of the base type. Then, click the Save icon in the Options column. Up to 60 custom base types can be added, which does not include the four default base types.
Base Types Table
For each base type in the table, the following information is displayed:
· Base Type - This is the title of the base type. It should also describe the purpose of the base type. This is required.
· Last Updated - This is the date on which the base type was last updated. If the base type has not yet been modified, this column is empty.
· Last Updated By - This is the user by which the base type was last updated. If the base type has not yet been modified, this column is empty.
· Include in Base Salary - Select this option to include the base type in the calculation of a user's new salary during the compensation task and also include the base type as part of the user's base salary in the ensuing compensation statement.
· For open compensation tasks, changes to this value only affect subsequent edits of existing drafts and new drafts of the task. All submitted drafts are not affected.
· Active - This option is selected by default. Deselect this option to make the base type inactive. Deactivating a base type hides it from compensation adjustment guidelines, templates, tasks, and reporting administration screens. After adjusting the active settings for the base type, you must click Done to implement the changes.
· The Promotion and Merit Increase base types are always active and cannot be deleted.
· If a base type is deactivated, tasks that are deployed that contain the base type are unaffected.
· New adjustment guidelines, reports, templates, etc. do not have access to an inactive base type.
· Existing templates that contain the deactivated base type are not affected, so new tasks are still able to use the deactivated base type via the template.
Base Type Options
The following options are available for each base type:
· Edit - Click this option to edit the base type. Only one base type can be edited at a time.
· Translate - If multiple languages are enabled for your portal, click the Translate icon to localize the base type to all available languages.
· Delete - Click this option to delete the base type. This option is only available if the base type has not been used in any adjustment guideline, template, or task.
Done
After adjusting the active settings for the base type, you must click Done to implement the changes.
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[bookmark: _Ref905611595][bookmark: _Toc161996443]Bonus Types
The administrator can create and manage the additional bonus components within the compensation module. Each custom bonus defined will be treated in the exact same manner as the standard bonus component that is currently available within the module. The administrator can define adjustment guidelines and budgets for each custom bonus in the exact same manner as the standard bonus currently in the module. The custom bonus can be included in the compensation task and template as an additional component under the Bonus tab. All functionality and reporting that is available for the standard bonus will be available for each custom bonus component.
Up to 60 custom bonus types can be created. The default bonus type is not included in the limit. However, both active and inactive custom bonus types are included.
To access the Bonus Types administration page, go to Admin > Tools > Compensation Management > Bonus Types.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Bonus Types - Manage
	Grants ability to create and manage additional bonus components within the compensation module. This is an administrator permission.
	Compensation - Administration


[image: ]
Add Bonus Type
To add a new bonus type, click the Add Bonus Type link. This adds a blank field at the bottom of the list. In the field, enter the name of the bonus type. The name should describe the purpose of the bonus type. The character limit is 25. Then, click the Save icon in the Options column. Up to 60 custom bonus types can be added, which does not include the default bonus type.
Bonus Types Table
For each bonus type in the table, the following information is displayed:
· Bonus Type - This is the title of the bonus type. It should also describe the purpose of the bonus type. This is required.
· Last Updated - This is the date on which the bonus type was last updated. If the bonus type has not yet been modified, this column is empty.
· Last Updated By - This is the user by which the bonus type was last updated. If the bonus type has not yet been modified, this column is empty.
· Active - This option is selected by default. Deselect this option to make the bonus type inactive. Deactivating a bonus type hides it from compensation adjustment guidelines, templates, tasks, and reporting administration screens. After adjusting the active settings for the bonus type, you must click Done to implement the changes.
· The Bonus bonus type is always active and cannot be deleted.
· If a bonus type is deactivated, tasks that are deployed that contain the bonus type are unaffected.
· New adjustment guidelines, reports, templates, etc. do not have access to an inactive bonus type.
· Existing templates that contain the deactivated bonus type are not affected, so new tasks are still able to use the deactivated bonus type via the template.
Bonus Type Options
The following options are available for each bonus type:
· Edit - Click this option to edit the bonus type. Only one bonus type can be edited at a time.
· Translate - If multiple languages are enabled for your portal, click the Translate icon to localize the bonus type to all available languages.
· Delete - Click this option to delete the bonus type. This option is only available if the bonus type has not been used in any adjustment guideline, template, or task.
Done
After adjusting the active settings for the base type, you must click Done to implement the changes.
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[bookmark: _Toc161996444]Compensation Currencies Overview
Compensation - Manage Currency Types
The Currency Types page provides administrators with an easy, single point-of-access to manage currency types for your organization. 
You can perform the following tasks on the Currency Types page:
· Enable/disable the status of currency types
· View/edit currency types, decimal precisions, and the Corporate Currency 
· Manage currency conversion rates 
· View Rate History
See Standard Currency Codes for a full list of standard currencies. See Standard Currency Codes on page Error! Bookmark not defined. for additional information.
To access the Currency Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > currencies.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Currencies 2.0 - Edit
	Grants the ability to customize the Decimal Precisions for each Wage Type on each currency, update conversion rates between the currencies and the Corporate Currency, view all currency pages, fly outs , and Rate History. 
	Compensation - Administration



	Compensation Currencies 2.0 - Manage
	Grants the ability to activate/deactivate currencies, change the Corporate Currency, customize Decimal Precisions for each Wage Type on each currency, update conversion rates between the currencies and the Corporate Currency, view all Currency pages, fly outs , and Rate History.
	Compensation - Administration



	Compensation Currencies 2.0 - View
	Grants the ability to view all currency pages, fly outs, and Rate History.
	Compensation - Administration


[image: ]
Currency Types 
The Currency Types table displays the following information for each currency type:
· Corporate Currency - Displays the Currency the Organization uses as the base line for all conversion rates and payments. This be the home currency for the organization or the main static currency. 
· Hide inactive currencies - Check to display active currencies only.
· [bookmark: 1568800314]Status - The current status of the currency type. Options are Enabled or Disabled. To enable or disable a currency type, click its toggle. 
· Currency Type - The name of the currency type.
· ISO Code -The three-letter International Organization for Standardization (ISO) code that represent the specified currency. 
· Symbol - The graphic symbol used to represent a specific currency. For the organization's corporate currency, this displays as N/A because this value cannot be modified.
· Rate - Displays the currency's conversion rate with respect to the organization's Corporate Currency.
· Last Updated - Displays the date and time at which the currency was last updated. This is updated automatically. 
Edit/View
· Click View to view details for the selected currency type.
· Click Edit to change currency details, decimal precisions, and change the Corporate Currency to the selected currency.
Rates
Click Rates for a currency to update the conversion rate between the selected currency and the Corporate Currency to match currency market changes.
Rate History
Click Rate History to display the details of all changes made to the selected conversion rate.
[image: ]
Compensation - View/Edit Currency Types
Administrators can use the Currency Types page to view or edit the currency details, including the decimal precision and the default Corporate Currency. 
To access the Currency Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > Currencies.
See Standard Currency Codes for a full list of standard currencies. See Standard Currency Codes on page Error! Bookmark not defined. for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Currencies 2.0 - Edit
	Grants the ability to customize the Decimal Precisions for each Wage Type on each currency, update conversion rates between the currencies and the Corporate Currency, view all currency pages, fly outs , and Rate History. 
	Compensation - Administration



	Compensation Currencies 2.0 - View
	Grants the ability to view all currency pages, fly outs, and Rate History.
	Compensation - Administration


[image: ]
View Currency Types
Click View to open the flyout that displays the conversion rate, decimal precisions for a specific currency, and the Corporate Currency.
Edit Currency Types
Click Edit for the appropriate currency type. The Edit Currency Type flyout opens and contains the following sections:
· Name - The name of the selected currency type. This field is not editable on the flyout.
· Symbol - Displays the graphic symbol used to represent a specific currency. For the organization's default currency, this displays as N/A because this value cannot be modified. This field is not editable on the flyout.
· ISO Code - Displays the three-letter International Organization for Standardization (ISO) code that represent the specified currency.
· Status - The current status of the currency code. Options are Enabled or Disabled. This field is not editable on the flyout.
· Decimal Precisions - By default, this section displays the default precision for active currency types. Decimal Precision allows Admins to customize the number of decimal places used for each Wage Type, allowing organizations to be more precise. For example, hourly wage types may have more decimal places than an annual wage type. During implementation, a Default Decimal Precision is created and used until a custom Decimal Precision is updated on a Wage Type. Selections made on Wage Types in the Edit flyout take precedence over the default setting. The maximum precision value is 4.
· Corporate Currency - Check Set as Corporate Currency to set the selected currency as the default for your organization. When the corporate currency is changed, all portal currencies are updated to the new default portal currency and the Last Updated information is set to the date and time of the portal currency change. Additionally, when a Corporate Currency is changed, and the new conversion rates between foreign and new Corporate Currencies has more than 15 digits, the rate is rounded per the Real Round Rules (0-4 no rounding, 5-9 round up).
Update 
Click Update to close the flyout, save the changes, and return to the Currency Types page. 
Compensation - Update Conversion Rates
Administrators can make changes to conversion rates as necessary. This allows an organization to stay up-to-date with conversion rates that match market changes. 
To access the Currency Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > Currencies.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Currencies 2.0 - Edit
	Grants the ability to customize the Decimal Precisions for each Wage Type on each currency, update conversion rates between the currencies and the Corporate Currency, view all currency pages, fly outs , and Rate History. 
	Compensation - Administration



	Compensation Currencies 2.0 - Manage
	Grants the ability to activate/deactivate currencies, change the Corporate Currency, customize Decimal Precisions for each Wage Type on each currency, update conversion rates between the currencies and the Corporate Currency, view all Currency pages, fly outs , and Rate History.
	Compensation - Administration


[image: ]
Update the Conversion Rate
1. Click Rate for the appropriate currency type.
2. In the Conversion Rate section, in the New Rate field, enter the new conversion rate . The conversion rate can have 15 numerical digits total spread across the left and right side of the decimal point. Once a compensation task begins, the conversion rates are locked for the life of the task.
3. Click Update to save the changes. 
Conversion Rates with the latest effective date are used for all conversions, which includes all other currencies and the Corporate Currency.
Standard Currency Codes
The table below displays a full list of standard currencies that can be used when managing compensation currencies. 
[image: ]
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[bookmark: _Toc161996445]Compensation Custom Fields
The following custom field types are available for the Compensation module:
· Compensation - See Custom Field Admin - Compensation for additional information.
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[bookmark: _Toc161996446][bookmark: concept14]Custom Statements Overview
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[bookmark: _Ref765683651]Custom Compensation Statements
Custom compensation statements enable administrators to create templates for compensation statements to add to compensation planning tasks. Custom compensation statements use tags to embed User, Compensation, Performance, and Competency fields into the compensation statement. 
The WYSIWYG (what you see is what you get) tool enables administrators to use images, fonts, colors, formatting, tables, etc. There is also a Copy from Word feature, which enables administrators to import from Microsoft Word, preserving the formatting used in the Word document. HTML code can also be used in the editor.
Administrators can create conditional sections within the custom statement, which allows the administrator to include or exclude specific content based on user-specific data.
Once a custom compensation statement is created, administrators can add the custom statement to a compensation planning task. Once the task is complete, all users in the task have their compensation statements based on the selected custom statement template. If a custom compensation statement is not applied to a planning task, then the standard compensation statement is used.
Custom compensation statements support localization and currency conversion, based on the user's settings.
To manage Custom Compensation Statements, go to Admin > Tools > Compensation Management > Custom Statements.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Custom Statements
	Grants ability to create templates for compensation statements to add to compensation planning tasks. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
To create a custom compensation statement, click the Create Custom Compensation Statement link. See Custom Compensation Statement - Create on page 56 for additional information.
To search for an existing custom statement, enter the name of the custom statement in the Name field and click the Search button. 
Select the Display Inactive Statements option to include inactive statements in the display.
The Statements table displays the following information for each custom statement:
· Statement Name - The name associated with the custom statement.
· Last Updated - The date on which the statement was last updated.
· Last Updated By - The user who last updated the statement.
· Active - Select this option to make the statement active. When a statement is inactive, it is not available for future planning tasks unless it is already associated with the task. Tasks that are deployed, started, or completed are not affected.
The following options are available for each custom statement:
· Edit - Click this icon to edit the custom statement.
· Copy - Click this icon to copy the custom statement.
· View Details - Click this icon to open a pop-up, which displays all of the planning tasks (completed, expired, inactive, active, in progress, etc.) that use the custom statement.
· Delete - Click this icon to delete the custom statement. Note: This option is only available for statements that are not associated with any planning tasks. Once the statement is added to a task, this option is not available.
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[bookmark: _Ref2044534542]Custom Compensation Statement - Create
The Custom Compensation Statement page enables administrators to create a custom compensation statement. Each section within the statement can be configured and conditions can be added so that certain sections only appear to users based on specific criteria.
Compensation statements are dynamically generated. Therefore, any changes made to a custom compensation statement affects all past and future compensation statements. Also, custom statements can be edited at any time. However, changes to tag names in compensation tag management does not dynamically update old tag names in existing custom compensation statement templates.
To create a custom compensation statement, go to Admin > Tools > Compensation Management > Custom Compensation Statements. Then, click the Create Custom Compensation Statement link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Custom Statements
	Grants ability to create templates for compensation statements to add to compensation planning tasks. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


To create a custom compensation statement:
1. In the Name field, enter the custom compensation statement name. This name should be descriptive so that the custom statement and it's purpose are easily identifiable. The character limit for this field is 200.
2. In the Content section, click the Add Section link to add a new section to the custom statement. See Custom Compensation Statement - Add Section on page 58 for additional information. Continue this process until all necessary sections are added. New sections are added to the bottom of the template. The Preview section displays the statement as it is currently configured.
3. After adding the necessary sections, the following actions are available for each section:
· Move Section Up [image: ] - Click this icon to move the section up one position in the statement layout. This option is not available for the top section.
· Move Section Down [image: ] - Click this icon to move the section down one position in the statement layout. This option is not available for the bottom section.
· Information [image: ] - Click this icon to view a pop-up that displays the conditions for the section. The conditions determine the users for which the section is included. For example, one section may be only included for users whose base salary is greater than 65,000 (i.e., Base Salary > 65000), while another section may be only included for users whose base salary is less than 65,000 (i.e., Base Salary < 65000). The conditions that are displayed here are set while creating or editing the section. If there are no conditions for the section, then the section is included for all users and this pop-up does not list any conditions.
· Remove - Click this icon to remove the section. 
· Edit [image: ] - Click this icon to edit the section. See Custom Compensation Statement - Add Section on page 58 for additional information.
4. In the Options section, the following options are available:
· Include Standard Statement - Select this option to include the standard compensation statement along with the custom statement. When this option is selected, you can choose to attach the standard statement to the beginning of the custom statement (Attach Before) or at the end of the custom statement (Attach After).
5. Click Save to save the custom compensation statement.
[image: ]
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[bookmark: _Ref972643221]Custom Compensation Statement - Add Section
The Custom Compensation Statement page enables administrators to create and edit the content for a statement section. Administrators can also set the conditions that determine the users to which the section displays.
When creating or editing a custom certificate, a Teleric HTML editor is used. For additional information about the editor, visit http://demos.telerik.com/aspnet-ajax/editor/examples/default/defaultcs.aspx.
To create a custom compensation statement, go to Admin > Tools > Compensation Management > Custom Compensation Statements. Then, click the Create Custom Compensation Statement link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Custom Statements
	Grants ability to create templates for compensation statements to add to compensation planning tasks. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
In the editor, there are two editing modes: Design and HTML. When in Design mode, you can use the standard editing tools to format your text, similar to your word processor application. When in HTML mode, the standard editing tools are disabled and you are able to view and modify the HTML code that is used to design the certificate. To switch between modes, click the appropriate tab in the lower-left corner of the editor. The system only accepts certain customizable HTML elements in the WYSIWYG Editor. Elements that are not acceptable display as text. See Safe Listed Customizable Elements.
When adding an image to a custom statement, the image must be uploaded to the Image Manager in order to appear properly in the statement. However, there are currently no constraints available, so any image that is loaded can be viewed by any user with permission to manage custom compensation statements. To open the Image Manager, click the Image Manager icon [image: ]. This opens the Image Manager. Click the Upload button to select the image to upload. The maximum file size is 1,024KB, and the accepted file types are .gif, .xbm, .xpm, .png, .ief, .jpg, .jpe, .jpeg, .tiff, .tif, .rgb, .g3f, .wxd, .pict, .ppm, .pgm, .pbm, .pnm, .bmp, .ras, .pcd, .cgm, .mil, .cal, .fif, .dsf, .cmx, .wi, .dwg, .dxf, .svf.
To view the available tags for the statement, click the View Tags link in the upper-left corner. This includes all available User, Compensation, Performance, and Competency standard tags and custom field tags that may exist in your portal. To use one of the tags, can copy and paste the tag into the editor. All custom fields must be referenced in all capital letters. The field name must be placed within curly brackets ("{ }").
As previously stated, in Design mode, the standard editing tools are available to format the text. The final option in the bottom right corner of the editing toolbar is the Import Field option [image: ]. Click this option to view and import the available custom fields.
Translation
If multiple languages are available for your portal, administrators can translate the custom compensation statement section into the other available languages. To translate the section, from the Language drop-down list in the upper-right corner of the page, select the appropriate language. Then, in the editor window, enter the translated section content. When a user views the statement in that language, they view the section content in the appropriate language.
[image: ]
Conditions
The conditions for a section determine which users are able to view the section. The custom compensation section is only displayed to the user if the user meets the section's conditions. For example, you can set the condition to: "IF SALARY.CURRENT Greater Than 100,000 AND 2011.PERFORMANCE.REVIEW Greater Than 4.0." This condition indicates that the section is only displayed to users that have a current salary of over $100,000 and their performance review score is over 4.0. You may choose to create a similar section that is displayed to users that do not match this criteria and has the appropriate information for those users.
If no condition is added, then the section is displayed to all users.
To add a condition, click the plus icon [image: ] to the right of the Condition heading and select the appropriate metric to use to set the section condition. The administrator can use User, Compensation, Performance, and Competency metrics. Note: Only one IF condition can be added. If you click the plus icon and add a new condition, the previous condition is removed.
From the drop-down list, select the appropriate operator for the metric (e.g., Greater Than, Less Than, Equals, Is On, Is After, Contains). Then, in the field, enter the appropriate value for each metric. For example, if the employee must have scored higher than 60% on their performance review to be eligible for a compensation adjustment using this template, then select the appropriate performance review as the metric. Select Greater Than as the operator. In the field, enter 60.
You can also add additional conditions to the statement using AND or OR logic. Adding an AND condition indicates that both conditions must be met to satisfy the criteria. Adding an OR condition indicates that either of the conditions must be met to satisfy the criteria. For example, IF the employee's performance review score is greater than 3/5 OR the employee's competency assessment score is greater than 3/5, then they can view the section. In this example, OR logic is used, so either of the employee's performance review or competency assessment scores must be greater than 3/5 to view the section. If AND logic were used, both of the employee's scores must be greater than 3/5 to view the section. Multiple AND or OR criteria can be added, but they all must use the same logic (all AND criteria or all OR criteria).
When creating a condition using percentages, one to three decimals may be entered in the percentage field, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Condition Rules
· Field values are locked for the statement when the task is submitted.
· General compensation, base component, bonus component, and equity component fields used in a condition that are not part of the planning task are treated as zero during the calculation with the exception of CURRENT component fields (e.g., Current Bonus, Current CustomBase).
· If a field is undefined for a user, the clause containing the undefined field is false. However, this does not automatically make the entire IF statement false if there are additional clauses.
· If multiple values exist for a field, the formula retrieves the most recent value within the task's compensation period dates.
Compensation: 
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[bookmark: _Toc161996447][bookmark: concept18]Deferral Guidelines
The compensation deferral functionality enables employers to set deferral programs for their workforce based on criteria determined by the organization. Qualified employees can then view a breakdown of their deferral program on the compensation statement.
To access the Deferral Guidelines page, go to Admin > Tools > Compensation Management > Deferral Guidelines.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Deferral Guidelines
	Grants ability to manage the deferral guidelines that are applied to specific compensation components during compensation planning. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Use Cases
· Organization requires portions of Bonus or Equity to be allocated in different payment methods.
· Organization requires portions of Bonus or Equity to be deferred to dates in the future.
· Organization requires deferral guidelines to apply based on OU and/or a set of conditions based on employee's compensation data, user fields, and/or performance/competency data.
· Organization requires deferral payout schedules to be displayed on compensation statements.
· Organization requires deferring of Bonus or Equity payments based on governmental regulations and laws.
Compensation: 
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Deferral Guidelines Management
[bookmark: concept19]The Deferral Guidelines page enables organizations to manage the deferral guidelines that are applied to specific compensation components during compensation planning. Administrators can create a new guideline, edit, copy or delete an existing guideline, and change the ranking of deferral guidelines. 
A deferral guideline can be defined for any Bonus or Equity compensation components. When creating the guideline, administrators can set deferral payout schedules for a specific effective period. The administrator sets availability for the guideline which determines the user population that is eligible for the guideline. More complex eligibility conditions can also be defined for the guideline.
To access the Deferral Guidelines page, go to Admin > Tools > Compensation Management > Deferral Guidelines.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Deferral Guidelines
	Grants ability to manage the deferral guidelines that are applied to specific compensation components during compensation planning. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
To create a new deferral guideline, click the Create Deferral Guideline link. See Create Deferral Guideline on page 65 for additional information.
To view only the deferral guidelines for a certain component, select the appropriate component from the Select Component drop-down list. This list contains all of the active bonus and equity components, listed in alphabetical order. Selecting a particular component updates the list, displaying only the deferral guidelines for the selected component. You can also include inactive guidelines in the display by selecting the Display Inactive Guidelines option.
The Deferral Guidelines table displays the following information for each guideline:
· Rank - The guideline rank determines the order in which the guidelines are implemented. It is possible that an employee could fall under multiple guidelines for a compensation component. If this occurs, the system applies the deferral guideline with the highest rank. Administrators can change the ranking of existing guidelines by dragging and dropping guidelines into the proper position on the page. A Rank of "1" is the highest priority deferral guideline. The guidelines are displayed in order of priority (i.e., Rank 1 is displayed first followed by the remaining guidelines in ascending rank order). For inactive guidelines, the rank for that guideline is displayed as "--" because the guideline does not have a rank. After adjusting the ranking for the guidelines, you must click Save to implement the changes.
· Guideline Name - This displays the name associated with the guideline.
· Availability - This displays the guideline's availability, which determines to whom the guideline applies.
· Effective Period - This displays the date range for which the guideline is effective. Note: A deferral guideline's effective period must cover the entire compensation period in order to be eligible for a compensation task.
· Active - Select the Active option to make the guideline active. If the guideline is not active, it is not implemented. Guidelines are active by default. After adjusting the active settings for the guidelines, you must click Save to implement the changes. When an inactive guideline is made active, the guideline is added to the bottom of the active list and is the last ranked guideline. When an active guideline is made inactive, the remaining guidelines that are ranked below the deactivated guideline are moved up in rank and the inactive guideline has a rank of "--" to indicate it is inactive.
The following options are available in the Options column:
· Edit
· Copy
· Delete - When an active guideline is deleted, the remaining guidelines that are ranked below the deleted guideline are moved up in rank.
After adjusting the active settings or the ranking for the guidelines, you must click Save to implement the changes.
Compensation: 
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[bookmark: _Ref-1102801202]Create Deferral Guideline
[bookmark: concept20]Deferral guidelines can be defined for any bonus or equity components. When creating a deferral guideline, administrators can set deferral payouts schedules for a specific effective period. Administrators can also use define the availability for the guideline, as well as eligibility conditions. Note: Deferral guidelines are locked at the beginning of the planning task. Any changes made to the deferral guidelines after task completion are not reflected in the ensuing compensation statements.
To create a deferral guideline, go to Admin > Tools > Compensation Management > Deferral Guidelines. Then, click the Create Deferral Guideline link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Deferral Guidelines
	Grants ability to manage the deferral guidelines that are applied to specific compensation components during compensation planning. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
Name
Enter a descriptive name for the guideline. The name should describe the purpose of the guideline. This is required and the character limit for this field is 1000.
Component
From the drop-down list, select the component to which the guideline applies. All active bonus and equity components are available in the list, appearing in alphabetical order. This is required.
Details
· Effective Period - Using the calendar tools, select the date range for which the guideline is effective. The guideline is effective beginning on the From date and is no longer effective after the To date. The From date must be prior to the To date. This is required.
· Currency - This is the currency in which the guideline applies.
Availability
Set the availability for the guideline, which determines who is subject to the deferral guideline. If no availability is set, the guideline applies to all employees for the effective period. 
Condition
Conditions are optional, but they enable administrators to set additional criteria to further limit which users are subject to the guideline. For example, you can set conditions to only include employees from the availability that have a salary greater than $100,000 and a bonus greater than $5,000. In this example, only users that are in the availability criteria that also have the appropriate salary and bonus are subject to the deferral.
To add a condition:
1. Click the plus icon to the right of the Conditions heading. 
2. From the pop-up, select the compensation field you are using to set the condition by searching for the field and click the plus icon to the left of the field name. For example, if selecting users with a bonus higher than $5,000, you should select the Bonus field. If your organization has custom user or compensation fields, a custom field only appear in the pop-up if the administrator has access to the field.
· If a field is used in a condition that is undefined for a user (e.g., if no bonus value is provided for the user), then the condition clause that contains the undefined field is false. 
· If a field is used in a condition that is not in the planning task, then the condition clause that contains the field is false, with the exception of CURRENT component fields (e.g., Current Bonus/Equity Target, Current Custom Base, Current Bonus). CURRENT component fields retrieve the most recent value for the component that is within the task's compensation period dates.
· If a Bonus or Equity is included in the task, its Target and %Attained fields are also included in the task. For example, if Bonus is part of the task, then Target Bonus and Bonus % Attained fields are included in the task by default.
· General compensation fields (New Salary, Total Increase, Compa-Ratio) are only defined if Base Planning is part of the task.
· If multiple values exist for a field, the formula retrieves the most recent value within the task's compensation period dates.
3. The selected field appears in the Condition section. From the drop-down list, select the appropriate operator option. For example, if selecting users with a bonus higher than $5,000, since Bonus is the selected field, you should select "greater than" from the drop-down list. If the selected compensation field is a check box, there is no operator selection.
4. In the value field, enter or select the appropriate value to complete the condition. For example, if selecting users with a bonus higher than $5,000, since Bonus is the selected field and "greater than" is selected from the drop-down list, enter "5000" in the field. This field can have various types of options. For example, if the selected compensation field is a drop-down list, then you must select the appropriate value from the drop-down list. If the field is a check box, you must select the appropriate check box. 
5. Once you have completed the condition, you have the option to add an additional condition. This is done by clicking either the AND or OR link.
· AND - If the two conditions are linked by clicking AND, the users must meed both criteria in order to be included in the guideline. For example, if selecting users with a salary higher than $100,000 and a bonus higher than $5,000, you must click AND to link the two conditions. This ensures that the users meet both conditions.
· OR - If the two conditions are linked by clicking OR, the users must meet either one of the conditions to be included in the guideline. For example, if selecting users with a salary higher than $100,000 or a bonus higher than $5,000, you must click OR to link the two conditions. This ensures that the users meet either one of the conditions.
Payout Schedule
The deferred payment can be separated into multiple deferred payments. The payout schedule section enables you set payment methods as well as the timing of various portions of the component. At least one deferred payout allocation must be added for the guideline. When determining the payout schedule, the various allocations must equal 100% of the total payout.
To add a deferred payout allocation:
1. Click the plus icon to the right of the Payout Schedule heading. A new allocation is added to the section.
2. In the Allocation field, enter the percentage of the total payment that is allocated in this deferred payment. The total amount that is deferred cannot exceed 100% (i.e., you can only defer up to 100% of the payment). As a value is entered, the Remaining Amount percentage is decreased, indicating how much of the total payment is not deferred. If a decimal point is used, the system rounds the value to the nearest decimal point (e.g., 2.49 is rounded to 2.5, 5.02 is rounded to 5.0). The character limit for this field is four, including a decimal point if necessary. Note: When allocating payments, the system ensures that the recipient receives 100% of the payment and that no percentage of payment is lost due to rounding.
3. In the Method field, enter the method of payment that is used for the allocation (e.g., Cash, ISO). The character limit for this field is 25. If multiple languages are available for your organization, click the Translate icon to localize the payment method for all available languages.
4. In the Date section, select when the allocated payment is made. 
· Select the upper option to select a specific date on which the payment is made. 
· Select the lower option to select a relative date for the payment. In the first field, enter the number of days before or after the effective date the payment should be made. From the drop-down list, select whether the payment should be made before or after the date on which the deferral is effective. For example, if the payment should be made 30 days after the effective date, enter 30 in the field, then select After from the drop-down list.
· Note: It is possible to defer payment to the same date as the effective period. Some organizations want to pay part of the awarded amount on the same date, but using different payment methods (e.g., 50% cash, 50% stock). Even if the deferral payment date is set to the effective period, the payment is treated as a deferral and is part of the total deferral calculation.
5. After specifying an allocation, repeat this process until the Remaining Amount is equal to 0%.
Click Save to save the deferral guideline. The new guideline is active default and is the lowest priority guideline. The rank can then be adjusted by dragging and dropping, if necessary.
[bookmark: _Toc161996448]Total Compensation - Employee Compensation Overview
Employee Compensation - View/Create/Edit
Use the Employee Compensation screen to view salary history, associated organizational units (OUs), and easily crate, edit, and delete new salary records. 
Employee Compensation includes added real time calculations for annual equivalency, so administrators can easily adjust custom annual equivalencies for employees with unique pay schedules that sit outside the default set in Wage Types. When creating a new employee compensation record, information that is already known about the employee, such as their Currency, Wage Type, and Annual Equivalency, is retained to save time when creating a new salary amount.
To access the Employee Compensation page, go to Admin > Tools > Compensation Management > Employee salaries. Select the edit icon for a user.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	 Employee Compensation Management - Audit 
	Grants permission to view the Employee Compensation Modification History page. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management - View
	Grants access to the Employee Salary Management page to view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management
	Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	 Compensation Type - View 
	Grants view-only access to the Compensation Types page. This permission is only granted to administrators who also have Employee Salary Management permission. This is an administrator permission.
	Compensation - Administration



	Compensation Type - Edit
	Grants access to the Compensation Types page to create, edit, inactivate, and delete Compensation Types. This permission is only granted to administrators who have Employee Salary Management – Edit permission. This is an administrator permission.
	Compensation - Administration
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Employee Information
Employee information includes the following information for the employee:
· Name
· Position
· Location
· Division
· Manager
· Last Hire Date
View
Select the years for which you want to view compensation.
Create
[image: ]
Click Create to open the flyout to create new salary information for an employee. When you complete the fields, click the Create button. The information appears as a row in the compensation table. The fields on the flyout are the same as the fields in the compensation table. 
Compensation Table
The compensation table contains the following information for an employee:
· Effective Date - Effective date for the salary or rate. Each salary or rate entry in the table must have a unique effective date. Entries in this table are sorted by effective date from newest to oldest.
· Compensation Type - The type of compensation, such as Salary/Rate, Equity, or Health Benefits.
· Wage Type - Type of wage. 
· Amount - Amount of the compensation. 
· Currency - Currency of the compensation. 
· Annual Equivalency - The equivalent annual and hourly rates. For example, if the rate is Annual, then the table displays the annual rate and the hourly rate based on 2080 labor hours per year. If the rate is Hourly, then the table displays the hourly rate and the annual rate based on the number of labor hours that is specified. 
Delete/Edit
· Click Delete for the compensation information you want to remove. When deleted, the compensation record is:
· Removed from Employee Compensation
· Not used for any current or future task
· Not available for custom reports or reporting 2.0
· Click Edit to open the flyout to make changes to an employee's compensation. Click the Update button to save the changes.
Modification History
If visible, click the Modification History link to view the following user compensation changes for a specific employee. See Employee Compensation - View History on page 75 for additional information.
[bookmark: _Ref1145134627]Employee Compensation - View History
Use the Salary Modification link on the Employee Salary Modification History page to view and audit all changes made on the Employee Compensation page. Additionally, administrators can filter history information by Compensation Type.
CESAdmin can see the Modification History link by default.
To access the Employee Compensation page, go to Admin > Tools > Compensation Management > Employee salaries. Select the edit icon for a user, then click the Modification History link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	 Employee Compensation Management - Audit 
	Grants permission to view the Employee Compensation Modification History page. This is an administrator permission.
	Compensation - Administration



	 Compensation Type - View 
	Grants view-only access to the Compensation Types page. This permission is only granted to administrators who also have Employee Salary Management permission. This is an administrator permission.
	Compensation - Administration



	Compensation Type - Edit
	Grants access to the Compensation Types page to create, edit, inactivate, and delete Compensation Types. This permission is only granted to administrators who have Employee Salary Management – Edit permission. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management - View
	Grants access to the Employee Salary Management page to view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management
	Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration
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Compensation Type
Click the Compensation Type drop-down to sort the table by compensation type.
Modification History Table
On the Employee Compensation page, click the Modification History link to view the following user compensation changes for a selected employee: 
· Effective Date - This displays the date on which the modification is effective.
· Change Date - This displays the date and time at which the modification was made.
· Field Changed - This displays which field was modified.
· Changed From - This displays the original value for the field.
· Changed To - This displays the new value for the field.
· Changed By - This displays the name of the user or task that made the modification. For example, if the modification was made via a compensation task, then the name of the task is displayed.
· Update Type - This displays the type of update that was made.
Note: You must have Employee Compensation Management - Audit permission to see the Modification History link. Only Customer System Administrators (CESAdmin), Cornerstone Administrators (CA), and Service Technicians can grant this permission to users. 
Employee Compensation Types - View/Create/Edit
Use the Compensation Types page to view, create, and edit all types of employee compensation. 
To access the Compensation Types page, go to Admin > Tools > Compensation Management > Compensation Types.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Employee Salary Management
	Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management - View
	Grants access to the Employee Salary Management page to view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	 Compensation Type - View 
	Grants view-only access to the Compensation Types page. This permission is only granted to administrators who also have Employee Salary Management permission. This is an administrator permission.
	Compensation - Administration



	Compensation Type - Edit
	Grants access to the Compensation Types page to create, edit, inactivate, and delete Compensation Types. This permission is only granted to administrators who have Employee Salary Management – Edit permission. This is an administrator permission.
	Compensation - Administration


[image: ]
Hide inactive Compensation Types
Select to display only active compensation types in the Compensation Types table.
Create
Click Create to open the Create Compensation Type flyout. Complete the Name (required)and Description (optional)fields, and click Save. 
Compensation Types Table
The Compensation Types table provides the following information:
· Status - Status of the compensation type. Options are active or inactive. To activate a status, move the toggle to the right; to deactivate a status, move the toggle to the left.Note: You cannot change the status of the Standard compensation type. 
· Name - Name of the compensation type. 46 characters maximum, including spaces. Required.
· Code - the system-assigned code for this compensation type. You cannot change this code.
· Description - Description of the compensation type. 
· Last Updated - Last date and time someone made changes to this compensation type.
 Delete/Edit
Click Delete to remove a compensation type. 
Click Edit to open the flyout to make changes to a compensation type. 
Localize
To localize the Name or Description fields, click the Edit button to open the flyout, then click the globe for the appropriate field.
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[bookmark: _Toc161996449][bookmark: concept22]Individual Targets
Individual targets enable organizations to view and set bonus and equity targets for individual users. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This indicates that the adjustment guideline should retrieve the user's individual target value set for each individual, rather than OU-specific values.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Individual Targets - View
	Grants ability to view bonus and equity targets for individual users. The administrator can view the Individual Target history and Modification History for the user. However, the administrator is not able to create, edit, or delete a target. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This permission can be constrained by OU, User's OU, or User. This is an administrator permission.
	Compensation - Administration



	Compensation Individual Targets
	Grants ability to set bonus and equity targets for individual users. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This is an administrator permission.
	Compensation - Administration


Use Cases
Organization requires:
· Common payout recommendations, pay for performance metrics, and discretionary rules among an OU for equity/bonus compensation components, but different target values set per individual.
· Proration of bonus and equity targets based on an individual's target breakdown.
· A breakdown of bonus and equity target history for each individual.
· Setting new bonus and equity targets per individual during compensation tasks for future compensation tasks, without necessarily specifying a budget for these new targets.
· Updating of bonus and equity targets throughout the organization's compensation period. 
Compensation: 
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Set Individual Targets - Search for Users
Administrators are able to set individual targets for employees as well as track its history. This enables target bonus and equity values to be set by individual without having to set up numerous bonus/equity/LTI adjustment guidelines with the only distinguishing factor being the target amount. The ability to manage past target values for employees also enables for proration based on individual targets during compensation tasks.
To set individual targets, go to Admin > Tools > Compensation Management > Individual Targets.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Individual Targets - View
	Grants ability to view bonus and equity targets for individual users. The administrator can view the Individual Target history and Modification History for the user. However, the administrator is not able to create, edit, or delete a target. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This permission can be constrained by OU, User's OU, or User. This is an administrator permission.
	Compensation - Administration



	Compensation Individual Targets
	Grants ability to set bonus and equity targets for individual users. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This is an administrator permission.
	Compensation - Administration


Search for Users
Search for the users for whom your are setting individual targets using the search fields. You can search for users by last name, first name, user ID, manager, or OU.
· Only a single manager can be selected.
· Multiple OU criteria can be selected. If multiple OUs are selected, the search returns users that match at least one of the OU criteria. 
After selecting the appropriate search criteria, click the Search button. The Search Results section displays all users that match the search in alphabetical order by last name. Clicking Search without any criteria displays all visible users.
Search Results
The following information is displayed for each user in the search results:
· User - The user name. Users in the search results are displayed alphabetically by last name. Users who only have permission to view individual targets can select a user's name in the Search Results to view the individual targets for the user. See Set Individual Targets - View and Set Targets on page 83 for additional information.
· User ID
· Identifier - The user's OUs identifiers. These are typically the user's Division and Position.
· Manager - The user's manager.
View User's Individual Targets
Select a user's name in the Search Results to view the individual targets for the user. See Set Individual Targets - View and Set Targets on page 83 for additional information.
Edit User's Individual Targets
Select the Edit icon in the Options column to edit the individual targets for the user. This option is only available to administrator who have permission to set targets for individual users. See Set Individual Targets - View and Set Targets on page 83 for additional information.
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[bookmark: _Ref-166913172]Set Individual Targets - View and Set Targets
On the Individual Targets page, administrators can view and set individual targets for compensation bonus and equity components.
To set individual targets, go to Admin > Tools > Compensation Management > Individual Targets. Search for and select the appropriate user. Then, click the Edit icon in the Options column to edit the individual targets for the user. This option is only available to administrator who have permission to set targets for individual users.
To view individual targets, go to Admin > Tools > Compensation Management > Individual Targets. Search for and select the appropriate user. Then, click the user's name in the Search Results to view the individual targets for the user. This option is only available to administrator who only have permission to view individual targets.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Individual Targets - View
	Grants ability to view bonus and equity targets for individual users. The administrator can view the Individual Target history and Modification History for the user. However, the administrator is not able to create, edit, or delete a target. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This permission can be constrained by OU, User's OU, or User. This is an administrator permission.
	Compensation - Administration



	Compensation Individual Targets
	Grants ability to set bonus and equity targets for individual users. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This is an administrator permission.
	Compensation - Administration


On the left panel, each bonus and equity type that is available in the system is displayed. Bonus types are displayed first in alphabetical order, followed by equity types in alphabetical order. Click the compensation component to set an individual target for that component. When you click a compensation component from the left panel, the right panel updates with past and current individual targets for the component. At the top of the panel, the user's name is displayed along with the component for which you are setting individual targets.
The currency selected in the Currency drop-down list determines the currency that is used in the panel. You can select any of the compensation currencies that are available for the portal. Select User to display currencies in the user's default currency. If the user's default currency has changed over time, the "User" selection displays monetary amounts in the currency in which they were originally set. 
· If the Currency drop-down is changed, fixed amounts that are displayed are converted to the selected currency using the current corporate currency conversion rates.
Add Target
The ability to add a target is only available to administrators who have permission to set targets for individual users.
With the appropriate compensation component selected in the left panel, click the Add Target link in the upper-right corner of the right panel to add a new individual target for the selected component. A new entry appears in the table. Note: The target that you set is set specifically for the selected user and the selected component. The corresponding user and component type is displayed at the top of the panel.
In the Target Date field, click the Calendar icon to select a target date. The target date cannot be the same as any other target within the component. For example, two individual targets for the Performance Bonus component cannot be set to the same target date.
In the Target section, there are two options:
· Select the upper option to enter a target that is a percentage of the user's most recent base salary within the target period's end date. You must then enter the appropriate base salary percentage in the field. The percentage cannot contain more than one decimal place.
· Select the lower option to enter a specific monetary value. The monetary value is saved in the currency that is selected from the Currency drop-down list. The fixed amount cannot contain more than two decimal places. 
· Click the Save icon in the Options column to save the individual target.
View Targets
The target table displays the following information for each individual target:
· Target Date - Targets are displayed by descending target date.
· Target - The percentage of the user's most recent base salary or a fixed target amount. 
· Fixed amounts display two decimal places. Percentages display one to three decimal places, depending on the configured decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· When the Currency drop-down list is set to User, the fixed targets are displayed in the user's default currency at the time the target was created, regardless of whether the user's default currency changes.
· Last Updated - The date on which the target was most recently modified.
· Last Updated By - The name of the user who most recently modified the target.
Target Options
The following options are available in the Options column:
· Edit
· Delete
[image: ]
[bookmark: _Toc161996450]Manage Non-Monetary Types
The Non-Monetary Types page enables administrators to create, edit, and define non-monetary components for compensation. Non-monetary types can be used in custom formulas, custom statements, and custom formula tags. When a non-monetary type is included in a compensation template, compensation managers can select a value for the component.
To manage non-monetary types, go to Admin > Tools > Compensation > Non-Monetary Types.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Non-Monetary Types - Manage
	Grants ability to define non-monetary types for an organization for compensation plans. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Add Non-Monetary Type
To add a non-monetary type, select the Add Non-Monetary Type link. This adds a new entry to the table in which you can enter a name for the new type. You must then select the Define option to configure the type.
When a new type is added, a compensation tag is created, which can be used in custom formulas, custom statements, and custom formula tags. The tag can be modified via Compensation Tag Management. 
Options
The following options are available in the Options column:
· Define [image: ] - Select this option to configure the non-monetary type, including availability and value options. This opens the Define Non-Monetary Component page. See the Define Non-Monetary Component section below for additional information.
· Edit [image: ] - Select this option to edit the type name. After editing the name, select the Save icon to save your changes.
· Translate [image: ] -  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Delete [image: ] - Select this option to delete the type. This option is only available if the component has not been included in a compensation template. To be able to delete a component that is being used, you must either remove the component from the template or delete the template.
Define Non-Monetary Component
The Define Non-Monetary Component page enables you to configure the non-monetary component name, availability, and value options.
[image: ]
Component Name
In the Name field, you have the option to edit the component name, up to 25 characters.
Component Availability
In this section, you can define the availability for the component. This determines which users are eligible for the non-monetary component. If a user is eligible for multiple components, then the highest ranking component is applied to the user.
Component Value Options
The Details section enables you to configure which options are available for the component.
The table displays all existing values for the component. To add a new component, select the Plus icon to the right of the Options heading.
Enter the following options for each component value:
· Numerical Value - Select the numeric value that will be used for the component. This value may be used as a multiplier or in other ways in formulas and conditions.
· Active - Select this option to make the numerical value active. All active values will be available for selection when compensation managers select a value for the component.
· Default - Select this option for the value that should be selected by default when compensation managers select a value for the component.
· Remove - Select this icon to remove the value for the component.
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[bookmark: _Toc161996451]Salary Structures
Salary Structures enable administrators to define the salary ranges for the organization for both annual and non-annual employees. Administrators can define salary ranges by any organizational unit (OU) type, such as grade, position, location, etc. For non-annual rates, administrators can provide annualized ranges, which annualize the non-annual rates prior to placing non-annual employees within the Salary Structure. The salary structure is used in determining salary adjustments and comp-ratio calculations for employee compensation. 
To manage salary structures, go to Admin > Tools > Compensation Management > Salary Structures.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Salary Structure by Currency
	Grants ability to define the salary ranges for the organization by currency. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
The salary structure can be defined by one, two, or three organizational units. For example, the salary structure can be set by position (primary OU), then by location (secondary OU), and then by grade (tertiary OU). Each primary OU appears in the list. The salary structure can then be set just for each primary OU, or administrators have the option to set different salary structures at the secondary OU level within each primary OU. If a tertiary OU type is selected, then administrators can set different salary structures at the tertiary OU level within each secondary OU.
Define Salary Structure
The Define Salary Structure section enables administrators to define the Primary, Secondary, and Tertiary OUs for the salary structure. In addition, administrators can set whether the salary structure includes the ability to set a Market Salary value or edit the midpoint values.
[image: ]
To edit the settings in the Define Salary Structure section, select the Change Settings link in the upper-right corner of the section. The page refreshes, and the following fields become editable:
· Select Primary OU - Select the primary OU by which salary ranges are set. This can be any OU type, including custom OU types.
· Select Secondary OU - Select the secondary OU by which salary ranges are set. This can be any OU type, including custom OU types.
· Select Tertiary OU - Select the tertiary OU by which salary ranges are set. This can be any OU type, including custom OU types.
· The Tertiary OU drop-down is disabled until a Secondary OU is selected. If the Secondary OU drop-down is set to None, then the Tertiary OU drop-down is also set to None. By default, no OU type is selected as the Tertiary OU.
· Include Market Salary - Select this option to also set the market compensation for each salary.
· Edit Midpoint - When this option is selected, the Midpoint column in the Salary Ranges section becomes editable. The administrator can edit or load midpoint values for each salary range. When this option is not selected, the system automatically sets the midpoint for all salary ranges as the mathematical midpoint between the minimum and maximum values of the salary range. The midpoint values cannot be edited or loaded when this option is not selected. Note: If this option is unchecked after the administrator edited midpoint values, a warning pop-up is displayed to confirm the action. This is because when the option is unchecked by the administrator, the system will override any edited midpoint values with the default values.
After defining the salary structure, select the Save button to save any changes. Or, select the Cancel button to discard any unsaved changes. The page is refreshed, and the Define Salary Structure section is read-only again.
Note: Modifying and saving a Salary Structure OU after it has been set and saved will clear any salary range data associated with the OU. For example, if you modify and save the Primary OU, this will clear all salary ranges for the Primary, Secondary, and Tertiary OUs. If you modify and save the Tertiary OU, this will clear any salary ranges for the Tertiary OU.
Note: Modifying and saving a Salary Structure OU after it has been set and saved impacts any Not Started or In Progress tasks that are using Promotion Criteria.
Search Salary Ranges
In the Salary Ranges section, administrators can search for a salary range by Primary, Secondary, or Tertiary OU if the OU types are defined for the Salary Structure. This enables administrators to search for and manage salary ranges for a specific OU or combination of OUs. Select the Search button after defining the search criteria. The Salary Ranges table displays salary ranges that match all specified OU types.
Additionally, administrators can use the Sort Results By drop-down menu to sort the salary ranges by OU Title, Date Created, or Date Modified. Selecting a new sort option automatically refreshes the salary ranges.
The Search functionality searches all wage type salary ranges (e.g., Annual, Hourly), but the results are displayed in their respective tabs.
Edit a Salary Range
To edit a salary range, select the Edit icon [image: ] to the right of the salary range. This opens the Edit flyout for the salary range. At the top of the flyout, the Primary, Secondary, and Tertiary OUs for which the salary range is being edited are displayed if they are defined in the Salary Structure. For example, if Position is selected as the Primary OU, then the Primary field displays the Position OU for which the salary range is being edited.
[image: ]
The flyout is separated into multiple tabs that represent each available wage type, such as Annual, Daily, Hourly, Monthly, and Weekly. When the flyout is opened, the tab that was selected in the Salary Ranges table is automatically selected within the flyout. Each tab displays the salary range for the selected wage type and OU combination. All tabs use the selected Primary, Secondary, and Tertiary OU structure, and the configuration options apply to all tabs. 
· To add a wage type to the flyout for the selected OU combination, select the Add Wage Types drop-down, and then select all appropriate wage types. When editing the salary ranges for a primary OU, all available wage types are automatically added to the flyout.
· All annual salary ranges are displayed and validated based on the precision rate for the Annual Wage Type.
· All other wage type salary ranges are displayed and validated based on the precision rate for the currency and selected wage type.
The following fields may be available:
· Currency - Select the currency for the salary range. The salary range values are stored in the selected currency. The drop-down menu contains all currencies that are available in the portal. For example, if you have a position in the United Kingdom that needs salaries to be paid in British Pounds rather than the corporate currency of US Dollars, this option enables administrators to input the salary range in British Pounds, rather than needing to convert from British Pounds to US Dollars.
· Minimum - Enter the minimum salary for the corresponding wage type and OU combination.
· Midpoint - This field is only available if the Edit Midpoint option is selected in the Define Salary Structure section. Enter the custom midpoint value for the corresponding wage type and OU combination. The Compa-Ratio is calculated using the salary range midpoint values. The midpoint values must be between the minimum and maximum values of the salary range. By default, the midpoint value is set as the mathematical midpoint between the minimum and maximum values of the salary range. This is a required field if a minimum and maximum value is set for the salary range.
· Maximum - Enter the maximum salary for the corresponding wage type and OU combination.
· Market - This option is only available if the Include Market Salary option is selected in the Define Salary Structure section. Enter the market salary for the corresponding wage type and OU combination.
· Annualized Range - This option is not available on the Annual tab. Select this option for a salary range to indicate that the Minimum and Maximum values for the OU are annualized values. Selecting and deselecting this option does not automatically convert the salary ranges to Annual, so the values that are entered should correspond to the Annualized Range selection.
· If the Annualized Range option is selected, the organization is expected to provide annualized values for the salary range. All non-annual employees' rates are annualized by the system prior to being placed in the Salary Structure.
· If the Annualized Range option is not selected, the organization is expected to provide non-annual values for the salary range.
After defining the salary range, select the Save button to save any changes. Or, select the Cancel button to discard any unsaved changes.
View Salary Ranges
The Salary Ranges table is separated into multiple tabs that represent each available wage type, such as Annual, Daily, Hourly, Monthly, and Weekly. Each tab displays the salary ranges for the selected wage type and each OU combination. All tabs use the selected primary, secondary, and tertiary OU structure, and the configuration options apply to all tabs.
After setting the OU types that determine the salary structure, the administrator is able to set salary ranges for each combination of Primary, Secondary, and Tertiary OU. 
· If a user's Tertiary OU does not have a set salary range, then the system uses the salary range for the user's Secondary OU. 
· If a user's Secondary and Tertiary OUs do not have a set salary range, then the system uses the salary range for the user's Primary OU.
[image: ]
The following information is displayed for each OU combination in the Salary Ranges table:
· Primary OU - This displays the primary OU that corresponds with the salary range. For example, if Position is selected as the Primary OU, the column name is "Position," and this column displays each Position OU in the system.
· Secondary OU - This displays the secondary OU that corresponds with the salary range. For example, if Location is selected as the Secondary OU, the column name is "Location," and this column displays each Location OU in the system. This column is only available if a Secondary OU is defined in the Define Salary Structure section.
· See the Secondary and Tertiary OUs section for information on adding additional OUs to the salary structure.
· Tertiary OU - This displays the tertiary OU that corresponds with the salary range. For example, if Division is selected as the Tertiary OU, the column name is "Division," and this column displays each Division OU in the system. This column is only available if a Tertiary OU is defined in the Define Salary Structure section.
· See the Secondary and Tertiary OUs section for information on adding additional OUs to the salary structure.
· OU ID [image: ] - To view the OU ID for an OU, hover the cursor over the ID icon.
· Currency - This displays the currency in which the salary range values are displayed. For example, if USD is displayed, then this indicates that all values for the salary range are displayed in US Dollars.
· Minimum - This displays the minimum salary for the corresponding salary range.
· Midpoint - This displays the midpoint for the salary range. The Compa-Ratio is calculated using the salary range midpoint values. If both a minimum and maximum are not entered, the Midpoint does not display.
· Maximum - This displays the maximum salary for the corresponding salary range.
· Market - This displays the market salary for the corresponding salary range. This column is only displayed if the Include Market Salary option is selected in the Define Salary Structure section.
· Annualized Range - This column does not appear on the Annual tab. This column displays whether the salary range values are annualized values. If the salary range values are not annualized, then the values correspond to the selected wage type tab. For example, if the Hourly tab is selected, then the salary range values are hourly wage values.
Secondary and Tertiary OUs
If a secondary OU type is selected in the Define Salary Structure section, then administrators can add secondary OUs to the salary structure. 
If a tertiary OU type is selected in the Define Salary Structure section, then administrators can add tertiary OUs to the salary structure. 
To add a secondary OU to the salary structure, select the plus icon to the right of a primary OU. Or, to add a tertiary OU, select the plus icon to the right of a secondary OU. The Add Secondary/Tertiary OUs flyout opens. The administrator can search for and select one or more specific OUs, and then select the Save button. The selected OUs are added to the Salary Ranges table. Once the OUs are available in the Salary Ranges table, then the administrator can edit and define the salary range for the OU.
To remove a secondary or tertiary OU's salary range from the salary structure, select the Remove icon [image: ] to the right of the salary range. Removing a secondary OU salary range also removes any tertiary OU salary ranges that are associated with the secondary OU. If the Remove icon is clicked for a Secondary OU that has associated Tertiary OUs, a warning pop-up is displayed to confirm the deletion of the secondary OU and associated tertiary OUs. Note: Primary OUs cannot be removed from the Salary Ranges table.
[image: ]
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[bookmark: _Toc161996452]Share Price
The Share Price allows the administrator to enter the current stock price for purposes of equity compensation. The administrator can enter company share prices (stock price). This data will be used in displaying equity compensation in the employee's total compensation statement.
To manage the Share Price, go to Admin > Tools > Compensation Management > Share Price.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Share Price 
	Grants ability to enter the current stock price for purposes of equity compensation. This is an administrator permission.
	Compensation - Administration


[image: ]
1. Click the Add Price link.
2. Share Price - Enter price and grant date. The administrator can enter a date that is on the current date or in the future. The administrator cannot enter a date that is less than the current date. The administrator can edit the entries in the table that have dates that are in the future. Past entries cannot be edited or removed.
3. Click Save icon.
4. Click Done.
[bookmark: _Toc161996453]Compensation Tags Overview
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Compensation Tag Management
The Compensation Tag Management page enables administrators to manage compensation tag names for fields used in custom compensation formulas and statements. Tag names are initially set to a default value, but administrators can view and manage the compensation tag names if necessary. Note: Field Names and Descriptions can be localized and translated, but tags are universal for all languages.
For User and Compensation custom fields, the fields and tags do not appear in Tag Management if the administrator does not meet the availability criteria for the fields.
To access Compensation Tag Management, go to Admin > Tools > Compensation > Tags.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Tag Management
	Manage Tags for Compensation fields for use in Custom Formulas and Compensation Statements - Manage. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
The tags are organized into sections by tag type. By default, each tag type is collapsed so that administrators can see each available type. To view the tags within the tag type, click the arrow to the right of the tag type name. You can then click the arrow again to collapse the section, if necessary.
[image: ]
Tags - Search
Administrators can search for a tag using the search feature at the top of the page. Search for a tag by name by entering part of the tag name in the Tag Name field and click Search. 
Administrators can also filter the search results by tag type by selecting the appropriate tag type from the Type drop-down list.
By default, inactive tags are hidden on the Compensation Tag Management page. Select the Display Inactive Tags checkbox to display inactive tags on the Compensation Tag Management page. is now available in the search area.page.
Tags - Edit
To edit a tag name, click the Edit icon to the right of the compensation tag. The Tag Name field can then be edited. After editing the tag name, click the Save icon to the right of the tag compensation tag. The tag name is not saved until the Save icon is clicked. To discard the changes, click the Cancel icon. Only one tag in each section can be edited at a time.
· All Tag Names must be unique. If another tag exists with the same tag name, you cannot save the new tag name.
· Tag Names cannot contain any spaces. If the tag name contains multiple words, they should be separated by a period.
· Tag Names cannot contain any special characters other than a period.
Note: Email tags for user custom fields do not correspond with tags for user custom fields in compensation.
[image: ]
Custom Formula Tags
See Compensation Tags - Custom Formula Tags on page 103 for additional information.
OU Tags
See Compensation Tags - OU Tags on page 109 for additional information.
Performance Review Section Score Tags
See Compensation Tags - Performance Review Section Score Tags on page 110 for additional information.
[bookmark: _Ref-1636954970]Compensation Tags - Custom Formula Tags
The Custom Formula Tags section enables administrators to view and create custom formula tags to be used within adjustment guidelines, deferral guidelines, and custom compensation statements.
Custom formula tags utilize values at the time of the task. Tags referenced within in a custom formula tag retain their values for compensation statements regardless of when they are generated. For example, if a custom formula tag has a formula of {SALARY.CURRENT} + {MERIT.INCREASE}, then this tag evaluates the Current Salary and Merit Increase values at the time of the task. However, succession metric tags utilize the most recent succession metric rating values.
Only system-defined numerical tags can be utilized when creating custom formula tags. That is, custom formula tags cannot contain calculations involving other custom formula tags.
Custom formula tags are evaluated as they are defined at the time of the calculation. That is, if the formula is changed in the custom formula tag, it is evaluated using the new formula from that point forward, even when referenced in a previous compensation statement. 
· If an edit is made to a custom formula tag that is used in a compensation statement that is associated with a previously completed task, the compensation statement evaluates the custom formula as it currently exists (i.e., after the edit). If the edited formula contains tags that were not applicable to the previously completed task, then those tags are evaluated as 0 and the calculation proceeds as normal.
Custom formula tags are calculated to four decimals of precision.
The following information is displayed for each existing custom formula tag:
· Field Name
· Formula
· Tag Name
· Decimal Precision
· Rounding Rule
· Active - This checkbox determines whether the custom formula tag is active. 
· Options - Click the Edit icon [image: ] to modify the field name, formula, and tag name.
Note: When a custom tag is used in an adjustment guideline, the precision is always set to 2 and is not configurable.
Custom Formula Tag - Create
To create a custom formula tag, click the Create Custom Formula Tag link in the Custom Formula Tags section. This adds a new entry at the top of the Custom Formula Tags table. Enter the following information for the custom formula tag:
· Field Name - Enter a name for the field, up to 150 characters. This field is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Formula - In this field, define the custom formula for the tag. This can be done using fields and functions. This field is required and has no character limit.
· Fields can be imported into the formula by clicking the Import Fields icon [image: ]. See the Formula - Fields section for additional information.
· Functions can be added to the formula by clicking the Insert Function icon [image: ]. See the Formula - Functions section for additional information.
· Tag Name - Enter the tag name, up to 75 characters. This field is required, and tag names must be unique. Tag names cannot contain any spaces or special characters. The tag name is used when the custom formula tag is added to adjustment guidelines, deferral guidelines, or custom compensation statements.
· Decimal Precision - The Decimal Precision field can be configured for custom formula tags by clicking the Decimal Precision drop-down menu when creating a new tag or when modifying an existing tag. Administrators can select a decimal precision from zero to four, or they can select the User's Currency option. Selecting the User's Currency option causes the formula output to use the number of decimal points required by the user's currency (i.e. two decimal points for the US dollar, or three decimal points for the Algerian dinar). When the tag is used in a Compensation Statement, the output of the formula uses the configured number of decimal points. Note: When a custom tag is used in an adjustment guideline, the precision is always set to 2 and is not configurable.
· Rounding Rule - A rounding rule can be configured for custom formula tags by clicking the Rounding Rule drop-down menu when creating a new tag or when modifying an existing tag. Administrators can choose from the following options:
· Arithmetic - Selecting this option for the Rounding Rule field causes the output of the formula to be rounded up to the next decimal point if the last decimal digit of the output is five or higher, and causes the output of the formula to be rounded down to the next decimal point if the last decimal digit of the output is lower than five (i.e. 1.55 would be rounded to 1.6, and 1.34 would be rounded to 1.3).
· Up - Selecting this option for the Rounding Rule field causes the output of the formula to be rounded up to the next decimal point, if needed (i.e. 3.44 would be rounded to 3.5, and 3.88 would be rounded to 3.9).
· Down - Selecting this option for the Rounding Rule field causes the output of the formula to be rounded down to the next decimal point, if needed (i.e. 8.23 would be rounded to 8.2, and 8.99 would be rounded to 8.9).
Note: When a custom tag is used in an adjustment guideline, the precision is always set to 2 and is not configurable.
· Active - This checkbox determines whether the custom formula tag is active. 
After configuring the custom formula tag, click the Save icon [image: ] to save the tag. Or, click the Cancel icon [image: ] to discard the new tag. When the custom formula tag is saved, the list of custom formula tags is sorted alphabetically by field name.
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Formula - Fields
Fields can be imported into the formula by clicking the Import Fields icon [image: ]. Only active fields appear in the pop-up. However, inactive tags can be manually entered in the formula.
The following tag types can be used in a custom formula:
· User - Numeric
· OU - Numeric
· General Compensation - Numeric
· Base Components - All tags except Breakdown and Percentage tags
· Bonus Components - Numeric amounts
· Equity Components - Numeric amounts
· Performance/Competency - All tags
Formula - Functions
Functions can be added to the formula by clicking the Insert Function icon [image: ]. This opens a pop-up where you can select the appropriate function. The following options are available:
· MIN - This selects the lowest value from the list of tags.
· MAX - This selects the highest value from the list of tags.
· AVG - This calculates the average of the list of tags.
When a function is selected, it appears in the text box (e.g., MAX( ; )). In the parenthesis, enter the appropriate tags, separated by a semicolon. For example, to determine the lowest performance review score the user has had over the past three years, you could use the MIN function and then add the previous three performance review tags, separated by a semicolon (MIN({2009.REVIEW};{2010.REVIEW};{2011.REVIEW})). Note: Only numeric fields can be added to these functions.
Imported fields and mathematical operations can be performed inside a function to serve as a parameter value as long as each parameter is separated by a semicolon (MAX({2009.REVIEW}*2; {2010.REVIEW}*2; {2011.REVIEW}).
Custom Formula Tag - Edit
To edit a custom formula tag, click the Edit [image: ] icon in the Options column. Administrators can edit the field name, formula, and tag name. See the Custom Formula Tag - Create section above for additional information.
Custom Formula Tags Use Cases
The following use cases use the following data:
	Employee
	SALARY.CURRENT
	SALARY.RANGE.MARKET
	SALARY.NEW
	PERFORMANCE.BONUS
	ISO
	COMMISSION

	Annie Thornton
	$50,000
	$55,000
	$55,000
	$3,000
	$1,000
	$0

	Audrey Chen
	$85,000
	$80,000
	$85,000
	$0
	$1,000
	$10,000

	Rich Fromers
	$65,000
	$70,000
	$68,000
	$3,250
	$1,000
	$0


 
	Field Name
	Formula
	Tag Name
	Active

	Market Ratio
	{SALARY.CURRENT}/{SALARY.RANGE.MARKET}
	MARKET.RATIO
	Yes

	Total Compensation
	{SALARY.NEW}+{PERFORMANCE.BONUS}+{ISO}
	TOTAL.COMPENSATION
	Yes

	Total Compensation - Sales
	{SALARY.NEW}+{COMMISSION}+{ISO}
	TOTAL.COMPENSATION.SALES
	Yes


Use Case 1: Custom Formula Tag in Conditional Statement
A default merit increase guideline is set up with the following custom formula:
· IF {MARKET.RATIO} < 1
· THEN 5000
· ELSE 1000
Action
The compensation manager creates a new compensation plan.
Results
Annie Thornton has a merit increase recommendation of $5,000.
· {MARKET.RATIO}={SALARY.CURRENT}/{SALARY.RANGE.MARKET} = 50,000/55,000 = 0.91
Audrey Chen has a merit increase recommendation of $1,000.
· {MARKET.RATIO}={SALARY.CURRENT}/{SALARY.RANGE.MARKET} = 85,000/80,000 = 1.06
Rich Fromers has a merit increase recommendation of $5,000.
· {MARKET.RATIO}={SALARY.CURRENT}/{SALARY.RANGE.MARKET} = 65,000/70,000 = 0.93
Use Case 2: Custom Formula Tag in Custom Compensation Statement
The custom compensation statement for the 2012 Compensation Task contains the total compensation awarded (TOTAL.COMPENSATION).
Action
Annie Thornton opens her 2012 Compensation Task compensation statement.
Results
Annie Thornton shows a total compensation of $59,000.
· {TOTAL.COMPENSATION}={SALARY.NEW}+{PERFORMANCE.BONUS}+{ISO} = 55,000+3,000+1,000 = 59,000
Use Case 3: Custom Formula Tag in Custom Compensation Statement - Edited
An administrator realizes that the Total Compensation custom formula tag is calculating with the new salary planned for the next year. The administrator changes the formula to the following:
· {TOTAL.COMPENSATION}={SALARY.CURRENT}+{PERFORMANCE.BONUS}+{ISO}
Action
Annie Thornton opens her 2012 Compensation Task compensation statement.
Results
Annie Thornton shows a total compensation of $54,000.
· {TOTAL.COMPENSATION}={SALARY.CURRENT}+{PERFORMANCE.BONUS}+{ISO} = 50,000+3,000+1,000 = 54,000
Compensation Tags - Goal Progress Tags
All goal achievement percentages and goal weights used in compensation use the current goal data.
When using any of the Goal Achievement metrics or tags (i.e., Company Goal Achievement %, Division Goal Achievement %, Individual Goal Achievement %) within Adjustment Guidelines, Deferral Guidelines, and Custom Compensation Statements, the Goal Achievement metrics and tags are evaluated using the latest goal progress and goal weights while the compensation task is in progress. Goal achievement and progress is locked once the compensation task is approved or completed.
Once a compensation plan has completed its last editable step, the Goal Achievement metrics and tags are frozen with regards to the task. The frozen value is also used in custom compensation statements and reporting.
For example, a compensation task is configured with one approver step, which has editing privileges. The compensation manager submits the compensation plan where the Individual Goal Achievement % for the employee is 50%. The employee edits their goal progress and all of their individual goals for the year are now 75% complete. When the approver opens the compensation manager's plan to approve or deny it, the Goal Achievement for the user is 75%.
[bookmark: _Ref40910517]Compensation Tags - OU Tags
Each time a new OU is created, the associated OU tags are created: <OU TYPE NAME>, <OU TYPE NAME>.CURRENT, and <OU TYPE NAME>.BREAKDOWN.
· If an OU is renamed, the tag field name and description are updated appropriately, but the tag name remains unchanged.
· Deactivated OUs and their associated tags still appear in Compensation Tag Management and are available for use in the Compensation module.
· OUs that are deleted do not have associated tags for use in the Compensation module.
· <OU TYPE NAME> pulls the user's effective OU on the last day of the compensation period or prorated period.
· <OU TYPE NAME>.CURRENT pulls the user's OU as of today.
· <OU TYPE NAME>.BREAKDOWN can only be used in compensation statements and it shows the user's associated OUs for the compensation period. 
· For example:
[image: ]
If an employee was not prorated, then this tag displays the header line and then a single line that represents their last effective OU during the compensation period.
Each time a new OU custom field is created, the associated OU tags are created: <OU TYPE NAME>.<OU CUSTOM FIELD NAME> and <OU TYPE NAME>.CURRENT.<OU CUSTOM FIELD NAME>.
· If an OU custom field is renamed, the tag field name and description are updated appropriately, but the tag name remains unchanged.
· Deactivated custom fields still appear in Compensation Tag Management and are available for use in the Compensation module.
· Custom fields that are deleted do not have associated tags for use in the Compensation module.
· <OU TYPE NAME>.<OU CUSTOM FIELD NAME> pulls the user's effective OU on the last day of the compensation period or prorated period.
· <OU TYPE NAME>.CURRENT.<OU CUSTOM FIELD NAME> pulls the user's OU as of today and retrieves the current custom field value.
[bookmark: _Ref913121664]Compensation Tags - Performance Review Section Score Tags
Performance review section scores appear as tags once a performance review has been created. Performance reviews must be in a Queued, Not Started, In Progress, Complete, or Expired status in order for their sections to be available as a metric in compensation management. Both active and inactive performance reviews are included in Compensation Tag Management. However, only active performance reviews will be available for use in adjustment guidelines, deferral guidelines, and custom compensation statements.
The tags are available for use in the following areas of compensation management:
· Adjustment Guideline Custom Formula Equations
· Adjustment Guideline Custom Formula Conditions
· Custom Compensation Statements
· Custom Compensation Statement Conditions
· Deferral Guideline Conditions
To access Compensation Tag Management, go to Admin > Configuration Tools > Compensation Management. Then, click the Compensation Tag Management link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Tag Management
	Manage Tags for Compensation fields for use in Custom Formulas and Compensation Statements - Manage. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


The performance review section score tags display as follows in the Performance/Competency Tags panel:
	Column
	Description

	Field Name
	<Performance Review Task> - <Section Name>

	Description
	User's <Performance Review Task> - <Section Name> Average Score

	Tag Name
	<Performance Review Task>.<Section Name>


Considerations
· Performance review section score tags are removed if the associated performance review task is deleted.
· Performance review section score tags are removed if the associated performance review task is modified and the associated section is removed.
· For example, a performance review task ("Annual Review") is created with a Goal Rating section ("Goal Ratings") and a Goal Planning section ("Future Goals"). An Annual Review - Goal Ratings tag is created and appears in Compensation Tag Management. Before the task is started, the administrator updates the task by removing the Goal Ratings section and adding a Question List Section ("Corporate Characteristics"). The Annual Review - Goal Ratings tag is automatically removed from Compensation Tag Management, and the Annual Review - Corporate Characteristics tag is created and appears in Compensation Tag Management.
· Only rated sections within performance reviews are available as a tag, which includes Question List, Goal Rating, and Competency section types.
· Calculations for performance review section scores are independent of the weighting of the section in an individual step in a performance review. Calculations take into account the weighting of individual steps within the performance review.
· Performance Review Section Score = ( (<Section Score – Step 1> * <Step 1 Weighting>) + (<Section Score – Step 2> * <Step 2 Weighting>) + … + (<Section Score – Step n> * <Step n Weighting>) ) / (<Step 1 Weighting> + <Step 2 Weighting> + … + <Step n Weighting>)
Note: Not all steps within a performance review contain a specific section. In such cases, the step is not included in the calculation.
· When specific performance review section scores are used as a tag, the score calculation applies to completed tasks at the user level, as currently implemented for overall performance review scores.
· If an off-cycle performance review task section score is used and there are multiple instances of the task associated to the user, the most recent instance associated with the user is used.
· As currently implemented with overall performance review scores, for performance review sections that do not have the Display Scores to End Users option selected, "No Rating" displays for the performance review section score.
Use Cases
Use Case 1: Sections Included in Tags - Simple
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
Administrator navigates to Compensation Tag Management.
Results
1. 2011 Annual Performance Review has four associated tags in the Performance/Competency category:
· 2011.ANNUAL.PERFORMANCE.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.GOALS.IN.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.COMPETENCIES
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.FINAL.THOUGHTS
Use Case 2: Sections Included in Tags - Removed Section
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
1. Administrator navigates to Compensation Tag Management.
2. 2011 Annual Performance Review has four associated tags in the Performance/Competency category:
· 2011.ANNUAL.PERFORMANCE.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.GOALS.IN.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.COMPETENCIES
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.FINAL.THOUGHTS
3. Admin updates 2011 Annual Performance Review and removes the Competency section.
4. Admin navigates to Compensation Tag Management.
Results
1. 2011 Annual Performance Review has three associated tags:
· 2011.ANNUAL.PERFORMANCE.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.GOALS.IN.REVIEW
· 2011.ANNUAL.PERFORMANCE.REVIEW.2011.FINAL.THOUGHTS
[bookmark: _Toc161996454]Wage Types Administration
With the requirement to pay employees in multiple wage types, and organizations moving into different international marketplaces, the demand to meet the pay requirements of each country is ever increasing.
Administrators can use the Compensation Wage Types pages to view, edit, create, and localize wage types based on the organization's needs. 
To access the Manage Wage Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > WAGE TYPES. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Wage Types 2.0 - View
	Grants ability to view compensation wage types. Administrators with this permission cannot create or edit wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Wage Types 2.0 - Edit
	Grants ability to create and manage compensation wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Create Custom Wage Types
To create custom wage types, select the Create wage type button. See Create/Edit Custom Wage Types on page 118 for additional information.
Edit Wage Types
To edit wage types, select Edit. See Create/Edit Custom Wage Types on page 118 for additional information.
View Wage Types
To view wage types, select View. 
Enable Wage Types
To enable a wage type, click the toggle in the Status column. Note: Wage types cannot be disabled once they are enabled. 
Localize Wage Types
To localize wage types, open the Edit panel, and then click the globe icon next to the appropriate field. 
View Wage Types
Administrators can use the Manage Wage Types page to view the details of an existing wage type. 
To access the Manage Wage Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > WAGE TYPES. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Wage Types 2.0 - View
	Grants ability to view compensation wage types. Administrators with this permission cannot create or edit wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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View Wage Type Details
To view wage type details, click View on the Manage Web Types page. The view flyout opens.
You can view the following fields:
· Status - The current status of this wage type. Options are Enabled or Disabled. 
· General Information
· Name - The name of this wage type.
· Description - The description of this wage type.
· Code - The system-generated unique identifier for this wage type.
· Annual Equivalency
· Name - The amount of units an employee works in a given year for this wage type. If the employee is paid monthly and works 12 months in a year, then the Annual Equivalency name is Months and the Annual Equivalency amount is 12.
· Default Value - The amount of units an employee works in a given year. Note: In previous versions, this field was named Default Annual Equivalency.
 
Edit/Done Buttons
· Click the Done button on the flyout to return to the Manage Wage Types page. 
· Click the Edit button to open the Edit Wage Type flyout panel. Note: The Edit button is only visible for enabled custom wage types. Only the Default Value field is editable. See Create/Edit Custom Wage Types on page 118 for additional information.
[bookmark: _Ref-1641417128]Create/Edit Custom Wage Types
Administrators can use the Manage Wage Types page to create or edit custom wage types to meet the specialized pay cycle needs in their organization. 
To access the Manage Wage Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > WAGE TYPES.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Wage Types 2.0 - View
	Grants ability to view compensation wage types. Administrators with this permission cannot create or edit wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Wage Types 2.0 - Edit
	Grants ability to create and manage compensation wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Create Custom Wage Types
To create a custom wage type: 
1. Click the Create wage type button. The Create Wage Type flyout opens. Note: All fields are required. 
2. In the General Information section, complete the following information:
· In the Name field, enter a name for this wage type.
· In the Description field, enter a description for this wage type.
3. In the Annual Equivalency section, complete the following information:
·  In the Name field, enter the unit that is used to describe the wage type’s annual equivalency or how much the employee works in a given year. For example, if the employee is paid monthly and works 12 months in a year, then the Annual Equivalency unit label is Months and the Annual Equivalency default value is 12. Note: In previous versions, this field was named Annual Equivalency Name.
· In the Default Value field, enter the amount of units an employee works in a given year. Note: In previous versions, this field was named Default Annual Equivalency.
Edit Wage Types
Administrators can edit the Default Value for enabled custom wage types only. 
1. Click Edit for the appropriate wage type. The Edit Wage Type flyout opens. 
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2. Make the appropriate change.
Localize Wage Types
On the Edit Wage Types panel, select the globe icon next to the appropriate field to localize it. Note: Only fields with a globe icon can be localized. 
Save/Cancel Buttons
· Click the Save button to close the flyout, save the changes, and return to the Manage Wage Types page. New custom wage types appear with a Custom icon below the name. 
· Click the Cancel button to cancel the create or edit process. 
Localize Wage Types
Administrators can use the Manage Wage Types page to localize some of the fields for wage types. Note: You can only edit the Default Value field for a custom wage type.
To access the Manage Wage Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > WAGE TYPES.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Wage Types 2.0 - Edit
	Grants ability to create and manage compensation wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Set Up Localization
To set up localization:
1. On the Manage Wage Types page, click Edit for an existing wage type. The Edit Wage Type flyout opens. 
2. Click the globe icon for the field you want to localize. Note: You can only localize fields that display a globe. 
The Translate flyout opens.
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3. Enter the localized text in the appropriate section and then click the OK button to return to the Edit Wage Type flyout.
4. Click the Done button on the Edit Wage Type flyout to save the changes and return to the Manage Wage Types page. 
The selected fields now appear in the localized language.
Enable Wage Types
Administrators can use the Manage Wage Types page to enable wage types. Note: Wage types cannot be disabled once they are enabled.
To access the Manage Wage Types page, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT > WAGE TYPES. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Wage Types 2.0 - Edit
	Grants ability to create and manage compensation wage types. Wage types can only be created or activated by contacting Global Customer Support. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Enable Wage Types 
To enable a wage type, click the appropriate toggle. When enabled, the toggle is blue with a checkmark. 
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[bookmark: _Ref-1546542990][bookmark: _Toc161996456]Compensation Plan Templates
Use Compensation Plan Templates to determine budgets, budget rules, and eligibility rules for base, bonus, and equity compensation. The administrator can create and manage compensation plan templates for base, bonus, and equity compensation. Templates define budgets and budget rules, eligibility rules, and pro-ration rules within a compensation task.
To access Compensation Plan Templates, go to Admin > Tools > Compensation Management > Compensation Templates.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Compensation Plan Template - Create
To create a compensation plan template, go to Admin > Tools > Compensation Management > Compensation Templates. Then, click the Create Compensation Template link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


1. In the Name field, enter a name for the compensation template. This should describe the purpose of the template so that it is easily identified.
2. From the Type drop-down, select the type of template you are creating. The options include:
· Base Types (Merit Increase, Market Adjustment, Cost of Living Adjustment (COLA), Promotion, Custom Base Types)
· Bonus Types (Performance Bonus, Spot Bonus, Custom Bonus Types)
· Equity Types (RSA, ISO, NQO, LTI Award)
3. The Currency value displays the currency for the template.
Base Template - Create Overview
Compensation: 
Compensation: Compensation Overview
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Base Compensation Template - General
When creating a base type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The General page displays template details such as components, budget rules, eligibility rules, proration rules, etc. All layout details appear on the Layout page.
To access Compensation Plan Templates, go to Admin > Tools > Compensation Management > Compensation Templates.
· To create a new compensation template, click Create Compensation Template.
· To edit an existing compensation template, select the edit icon for the appropriate template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration
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Components
The components that are available are based on the option you selected in the Type field. You can add up to 20 components.
To select components:
1. Click the plus icon to the right of the Components heading.
2. Select the components to included in the template. 
3. Click Save. Each selected component is added to the template. 
4. Complete the following for each component:
· Budget Type - Select the appropriate budget type for each component. The available options are:
· % of Base - The budget is a percentage of the employee's most recent base salary within the period end date.
· Cascaded - A cascaded budget is cascaded from the top-level manager down to the lower-level managers. This means that the top-level manager creates their compensation totals from the budget and passes the remaining budget to the next lower manager, and so on
· Fixed Amount - The budget is a fixed monetary amount.
· None - No budget associated with the component
· Amount - In the Amount field, enter the allocated budget amount for each component. Note: If the budget type is None for the component, then the Amount field is not available. Compensation tasks that use a template with None selected as the budget type have the selected components as part of the task, but a budget is not associated with the component. When entering an amount as a percentage, one to three decimals may be entered in the percentage field, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Availability
To set the availability for a component budget, follow these steps:
1. From the Availability drop-down list, select an OU type. A Select icon appears to the right of the drop-down list.
2. After selecting an OU type, click the Select icon and select the appropriate OU. Note: You cannot select the same OU twice for a single budget component.
3. After selecting an OU, a second line item is added for the component budget.
1. The first line item has an Availability set to OU: Default. This component budget serves as the default budget for this component and cannot be deleted unless there are no other budgets for this budget type. Note: For Equity templates, if multiple budgets are available for a budget component, the payout method for all of those budgets matches the payout method for the default component budget.
2. The second line item has the availability set to the selected OU. This OU specific budget can be deleted by clicking the Remove icon to the left of the component budget. If multiple OUs were selected, then each OU is set as a single line item for the budget component.
4. Click the plus icon to the right of the default budget component availability to add another budget for the budget component.
Note: If no availability is selected for a component, then that component serves as the default component budget.
Non-Monetary Components
Enables administrators to select which non-monetary components are included in the template. When a non-monetary component is selected, this automatically includes the component in the Display Columns field on the Layout page.
Promotion Criteria
Note: This option is only available if a Promotion component is added to the template.
Determine the promotion criteria for promotions within the template. The criteria determines to which OUs the employee is being promoted. 
Select the Include Promotion Criteria option to include promotion criteria in the template. When this option is selected, the primary, secondary, and tertiary OUs used in the salary structure are automatically included. The primary, secondary, and tertiary OUs are required in order to pull in the new salary ranges for the promotion based on the salary structure. Note: Secondary and tertiary OUs are only available if they are included in the salary structure.
The administrator can add additional OU types to the promotion criteria by clicking the plus icon to the right of the Promotion Criteria heading. Any additional OU types that are added will appear on the task for selection as part of promoting an employee on the task.
Editing Note: When editing an existing compensation template, if changes are made to the salary structure that impact the promotion criteria for the compensation template, then the impacted criteria are highlighted on the compensation template and the template must be saved to update the promotion criteria to the new salary structure. Until the template is saved, the salary ranges for promotions are not displayed in any task using the template. When the template is saved, the template and any tasks using the template are updated to match the new salary structure.
Budget Rules
Determine the budget rules for the template. The available options are:
· Total must be on or under budget - Select this option if the actual compensation totals from the compensation task must be on or below the set budget.
· Total may be over by - Select this option if the actual compensation totals from the compensation task may exceed the set budget. You must then specify the percentage by which the total may exceed the budget. One to three decimals may be entered in the percentage field, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
· Allow Lump Sum Adjustment for Merit Increase - Select this option to allow a lump sum adjustment to be allocated with the task.
· Automatic Lump Sum allocation for Salary Range overages - This option appears when the Allow Lump Sum Adjustment for Merit Increase option is selected. This option is checked by default. When checked, any amount of salary range overage for a particular employee is automatically taken from the employee's Merit Increase component and shifted to the Lump Sum component. Note: There must be a Merit Increase amount to shift to the Lump Sum. If there is no allocated Merit Increase amount, then the employee remains over the salary range. This option is only applicable if the following are true for the template:
· The template is a Base template.
· The Merit Increase component is added to the template.
· The Allow Lump Sum Adjustment for Merit Increase option is selected.
The Automatic Lump Sum allocation for Salary Range overages option can be deselected when editing the template and can also be configured when copying a template, provided that the template meets the above-mentioned configuration requirements.
Eligibility Rules
Determine the employees that are eligible to be included in the compensation task using this template. If an employee does not meet the eligibility criteria, then that employee can not receive an adjustment for the template type.
When specifying multiple eligibility criteria, the administrator can use either intersecting logic (AND logic) or combining logic (OR logic) to create the eligibility.
To set the eligibility for the template, follow these steps:
1. Click the plus icon to the right of the Eligibility Rules heading.
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2. This adds a Select Criteria drop-down list and hides the plus icon. From the drop-down list, select the appropriate metrics to use to determine the template eligibility. Then, click the Select icon to select a specific criterion. The available drop-down options are OU, Group, or User Fields and Metrics. The User Fields and Metrics option includes performance and succession metrics and hire date.
3. After selecting a criterion, the criterion is displayed in the Eligibility Rules section with AND and OR options. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
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4. To add an additional criterion, click either the AND link to use intersecting logic or click the OR link to use combining logic. Intersecting logic makes the template available to only the employees that match all of the criteria. Combining logic makes the template available to all employees that match at least one of the criteria. When you click the AND or OR link, an additional criterion is added to the Eligibility section. Note: When you add an additional criterion, the logic that is selected must be used for all eligibility criteria. 
5. After selecting another criterion, the new criterion is displayed in the Eligibility Rules section with the option to add another criterion. If you previously clicked the AND link, then another AND link is available, and if you previously clicked the OR link, then another OR link is available. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
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User Fields and Metrics Options
From the drop-down list, select the appropriate operator for each metric (Greater Than, Less Than, Equals, Not Equal To, Greater Than or Equal, Less Than or Equal).
In the field, enter the appropriate value for each metric.
For example, if the employee must have scored higher than 60% on their performance review to be eligible for a compensation adjustment using this template, then select the appropriate performance review as the metric. Select Greater Than as the operator. In the field, enter 60.
See Performance Review Section Score Metrics on page 34 for additional information.
Proration Rules
Proration enables an organization to prorate compensation if the employee has not been with the company or in the position for the entire compensation period. For example, if an employee is hired in April and the compensation period is the calendar year, then the employee has only been in their position for 75% of the compensation period. The organization may choose to prorate the compensation adjustment based on the shortened compensation period. 
Proration may be based off of the employee's Last Hire Date, their time in an OU such as Position or Division, or Last Salary Change Date. Bonus and Equity components can be prorated by Individual Targets. Proration can also be based off an employee's time in a specific group. All adjustment recommendations are prorated on the selected components. Note: Base components cannot be prorated by Individual Targets. See Proration with Individual Targets on page 205 for additional information.
Components - Select the components that are prorated on the compensation plan. Only the components that are selected in the Components section appear in this section.
Criteria - For each selected component, you must then select the appropriate proration criteria for the selected components. Note: The Criteria drop-down list does not appear until the component is selected. The following options may be available:
· Last Hire Date
· Last Salary Change Date - See Proration by Last Salary Change Date on page 203 for additional information.
· Time in OU
· Important: Administrators can only prorate components within a template by one criterion. Multiple criteria cannot be used in the same template.
Retroactive Proration From - This option is only available if Last Hire Date is selected from the Criteria field. This option enables administrators to retroactively prorate the component. See Proration by Last Hire Date - Retroactive Proration on page 201 for additional information.
Next/Cancel
· Click Next to proceed to the Layout tab. See Base Compensation Template - Layout on page 139 for additional information.
· Click Cancel to discard any unsaved changes.
[bookmark: _Ref733454629]Base Compensation Template - Layout
When creating a base type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The Layout page enables administrators to configure the columns and additional information that appears on the compensation template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. See Base Compensation Template - Layout - Column Layout on page 144 for additional information.
Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. See Base Compensation Template - Layout - Expanded View Layout on page 149 for additional information.
Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template. See Base Template - Layout - Budget Layout on page 143 for additional information.
Additional Options
Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. See Base Compensation Template - Layout - Additional Options on page 141 for additional information.
Preview
Click this button to preview how the template will appear to compensation managers. The preview reflects the configuration from the General and Layout pages.
The preview pop-up contains sample data. All hyperlinks and JavaScript are disabled. Only the selected view is displayed; no other tabs of the compensation task are included in the preview.
Modification History
The Modification History section displays a record of each time the template layout is modified. This includes the modification description, administrator username, and date stamp.
Save
Once all fields are completed, click Save.
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Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. 
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Default View
Select the default view for the template within the compensation plan. The following options are available:
· Select the default view for the template:
· Amount - Select this option to view the adjustment amounts as a monetary amount by default.
· % - Select this option to view the adjustment amounts as a percentage of their salary/hourly rate by default.
· Display ineligible employees - Select this option to include ineligible employees in the display by default.
Reference Data
To aggregate company data, select the Aggregate Company Data option and then select the appropriate OUs by which the data should be aggregated.
To include additional recommendation information, select the Additional Recommendations option, which enables a text field. In the field, enter the appropriate information. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. You must then select how the Additional Recommendations information is displayed:
· Display in pop-up - This option displays the additional recommendations in a pop-up. This information is accessed by clicking the Information icon on the corresponding template tab on the compensation plan.
· Display on compensation plan - This option displays the additional recommendations in an expandable section at the top of the corresponding template tab on the compensation plan.
Hourly Employees
Display Annual Equivalents for Hourly Rates - Select this option to display annual equivalents for hourly rates in the corresponding sections of the compensation plan. This option is available for all template types.
Comp Analytics
Select the Comp Analytics option to display the Comp Analytics graphs on the corresponding template tab with a compensation plan.
Depending on the template settings, a compensation task may contain a template that has the Comp Analytics graphs enabled and other templates that have the graphs disabled.
When choosing to display or hide the Comp Analytics graphs, each template is configured individually. However, this option enables the administrator to either display all or hide all of the existing graphs on the template. Administrators cannot choose to only display one or more of the graphs on the template.
[bookmark: _Ref1956880169]Base Template - Layout - Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template. 
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The Available Components field lists all of the components that are added to the compensation template on the General tab. Components are displayed in the Available Components field in alphabetical order. An asterisk appears to the left of each component that cannot be hidden from the template because the component has a defined budget.
The Component Visibility field displays the areas in which the component may be able to be hidden. The visibility options are only editable if the budget for the component is set to "None" on the General tab. If the component's budget is configured by OU on the General tab, then the visibility options are only editable if the budget is set to "None" for all OUs, including the default budget. Further, if a component budget is changed from "None" to a different budget type, then the visibility options are automatically selected for the component, regardless of the previous setting of the options. The following areas are available:
· Budget Summary - This option determines whether the component is visible in the Budget Summary graph on the template tab of the compensation plan. By default, this option is selected for all components. Note: If this option is updated and the template is not reversioned, then all affected Budget Summary graphs are updated with the changes.
When editing a compensation template, modifying the visibility options does not create a new version of the template.
[bookmark: _Ref2071688400]Base Compensation Template - Layout - Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. 
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Available Columns
The Available Columns field lists all of the available fields that can be added as a column to the compensation template. Fields are displayed in the Available Columns field in alphabetical order. 
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. See the Columns - Add to Display section below for additional information.
Components that appear in the Available Columns field for a template do not appear in the corresponding compensation plan tab, the Budget Summary graph on the plan, the Roll-up and Plan Summary tabs of the compensation task, or on the profile dashboard of the compensation task.
Display columns
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. See the Columns - Remove from Display section below for additional information.
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field.  See the Columns - Change Display Order section below for additional information.
Administrators are able to customize the column names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all columns appear in the Display Columns field when a compensation template is created. The following fields are available for base type compensation templates:
· Name - This column cannot be removed from the Display Columns field. Also, this column must appear first.
· Performance
· Current Salary/Rate
· Wage Type
· Currency
· Current Compa-Ratio
· <Base components that are included in the Base Salary that are added to the template>
· These components are added in the Components section of the General page.
· Components with a budget defined automatically appear in the Display Columns field and cannot be removed. Only components with a Budget Type of "None" can be removed.
· Total Increase
· New Salary/Rate
· New Compa-Ratio
· Lump Sum
· This column appears only if the Allow Lump Sum Adjustment for Merit Increase checkbox is selected on the General page.
· This column can only be removed from the Display Columns field if there is no budget defined for the Merit Increase component.
· Non-Monetary Components - "These fields have an asterisk next to it, and it cannot be renamed or removed from the Display Columns field. To remove it, you must remove it from the Non-Monetary Components section on the General page. All non-monetary components are grouped together at the bottom of the Display Columns list."
· <Base components that are not included in the Base Salary that are added to the template>
· These components are added in the Components section of the General page.
· Components with a budget defined automatically appear in the Display Columns field and cannot be removed. Only components with a Budget Type of "None" can be removed.
Add Fields
Administrators can add performance metrics, succession metrics, and user custom fields to the compensation plan template.
To add fields, click the Add Fields link at the top of the Display Columns field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the Display Columns field.
Once fields are added, they remain visible in either the Available Columns or Display Columns field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Selected field and Display name
When a single field is selected in the Available Columns or Display Columns field, the Selected Field field displays the default name of the selected field. If more than one field is selected or if no field is selected, then this field is blank.
While the Selected Field field displays the default name for the selected field, administrators are able to customize the column name that is displayed to compensation managers on the compensation task. To customize the column name, enter a new column name in the Display Name field, up to 100 characters. This is the column name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field appears.
· By default, the display name is the same as the default field name. 
· A display name is required for each column, regardless of whether it is included in the Available Columns or Display Columns field.
If the display name is changed for the Current Salary/Rate or New Salary/Rate columns, then this display name is displayed regardless of the employee wage type. However, if the display name is unchanged, then the individual cell headers reflect whether the user has a wage type of Annual or Hourly.
Note: The Display Name field is inactive if more than one field is selected, no field is selected, or the selected field is a component that is included in the template.
Columns - Add to Display
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. To add a column to the display, select the field from the Available Columns field and click the Move Right button [image: ], which is to the right of the Available Columns field. The selected item is added to the bottom of the Display Columns field. The display order of the column can then be modified, if necessary. See the Columns - Change Display Order section below for additional information.
Administrators can move multiple fields to the Display Columns field by selecting multiple fields prior to clicking the Move Right button.
Columns - Remove from Display
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. To remove a column from the display, select the field from the Display Columns field and click the Move Left button [image: ], which is to the left of the Display Columns field. The selected item is added to the Available Columns field in alphabetical order.
Administrators can move multiple fields to the Available Columns field by selecting multiple fields prior to clicking the Move Left button.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display Columns field.
Components with a budget defined automatically appear in the Display Columns field and cannot be removed. Only components with a Budget Type of "None" can be removed.
Columns - Change Display Order
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the column that appears at the top of the Display Columns field will appear as the first column on the compensation task, and the column that appears at the bottom of the Display Columns field will appear as the last column on the compensation task.
Note: The Name column must always appear as the first column on the compensation task. Because of this, the display order cannot be changed for the Name column. In addition, no column can be moved above the Name column.  
To change the display order for a column, select the field from the Display Columns field and click the appropriate button to the right of the Display Columns field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected column to the top of the list, below the Name column.
· Move to Bottom [image: ] - Click this button to move the selected column to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected column up one position. No column can be moved above the Name column.
· Move Down [image: ] - Click this button to move the selected column down one position. 
Administrators can move multiple columns by selecting multiple fields prior to clicking the appropriate Move button.
Use Cases
Use Case 1: Default Layout
The administrator creates a Base template and includes the following components on the General page:
· Merit Increase
· Budget Type = Fixed Amount, $10,000
· Promotion
· Budget Type = None
Results
On the Layout page, the following occurs:
· The Available Columns field does not contain any columns.
· The Display Columns field contains the following columns in the specified order.
	Column
	Default Display Name

	*Name
	Name

	Performance
	Performance

	Current Salary/Rate
	Current Salary/Rate

	Currency
	Currency

	Current Compa-Ratio
	Current Compa-Ratio

	*Merit Increase
	Merit Increase

	Promotion
	Promotion

	Total Increase
	Total Increase

	New Salary/Rate
	New Salary/Rate

	New Compa-Ratio
	New Compa-Ratio


[bookmark: _Ref226264452]Base Compensation Template - Layout - Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. 
[image: ]
Available fields
The Available fields field lists all of the available fields that can be added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are moved to the Display fields field, then the Graphs category does not appear in the Available fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. The following categories may be available:
· Graphs - This category includes Performance History and Salary History graphs.
· Salary Data - This category includes salary data fields.
· Organizational Data - This category includes organizational data fields such as default organizational unit (OU) associations.
· Performance Data - This category includes Competency, Performance, and Succession fields.
· Additional Information - This category includes User and custom OU fields.
Data fields in the Available fields field are displayed in alphabetical order within each category. 
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. See the Fields - Add to Display section below for additional information.
Components that appear in the Available fields field for a template do not appear in the corresponding expanded employee view.
Display fields
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. See the Fields - Remove from Display section below for additional information.
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. See the Fields - Change Display Order section below for additional information.
Administrators are able to customize the category and field names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all default fields appear in the Display fields field when a compensation template is created. The following categories and fields are available for base type compensation templates:
· Graphs - This category must appear at the top of the Display fields field because any graphs that are displayed in the expanded employee view must be displayed first (on the left side of the expanded view).
· Salary/Rate History
· Performance History
· Organizational Data
· Hire Date
· Division
· Grade
· Location
· Cost Center
· Salary Data
· Wage Type
· Salary/Rate Range
· Labor Hours
· Market Rate - This field appears only if Market Rate is enabled in the salary structure.
· Performance Data - This category includes Competency, Performance, and Succession fields that were manually added. See the Add Fields section below for additional information.
· Additional Information - This category includes User and OU fields that were manually added. See the Add Fields section below for additional information.
Add Fields
Administrators can add user, OU, competency, performance review, and succession fields to the expanded employee view.
To add fields, click the Add Fields link at the top of the Display fields field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the appropriate category in the Display fields field.
Once fields are added, they remain visible in either the Available fields or Display fields field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Performance review section scores can be added as a metric for performance reviews that are in a Queued, Not Started, In Progress, Complete, or Expired status. This includes both active and inactive performance reviews. See Performance Review Section Score Metrics on page 34 for additional information.
Selected field and Display name
When a single field or category is selected in the Available fields or Display fields field, the Selected field field displays the default name of the selected field or category. If more than one field or category is selected or if no field or category is selected, then this field is blank.
While the Selected field field displays the default name for the selected field or category, administrators are able to customize the name that is displayed to compensation managers on the compensation task. To customize the field or category name, enter a new name in the Display name field, up to 100 characters. This is the field or category name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field or category appears.
· By default, the display name is the same as the default field or category name. 
· A display name is required for each field and category, regardless of whether it is included in the Available fields or Display fields field.
· You cannot edit the following fields:
· Graphs
· Salary/Rate History
· Performance History
· Division
· Grade
· Location
· Cost Center
· Employee's Annual Equivalency
· Bi-Weekly: en-US
· Days: en-US
· Labor Hours: en-US
· Monthly Custom Wage: en-US
· Annual Equivalency
· OU display fields
· Any Display fields whose parent is Annual Equivalency, such as Labor Hours or Display fields with type Amount.
If the display name is changed for the Salary/Rate field, then this display name is displayed regardless of the employee wage type. However, if the display name is unchanged, then the field reflects whether the user has a wage type of Annual or Hourly (Salary Range/Rate Range).
Note: The Display name field is inactive if more than one field is selected, no field is selected, or the selected field's display name cannot be modified. 
Fields - Add to Display
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. To add a field to the display, select the field from the Available fields field and click the Move Right button [image: ], which is to the right of the Available fields field. The selected item is added to the bottom of the appropriate category in the Display fields field. The display order of the field can then be modified, if necessary. See the Fields - Change Display Order section below for additional information.
An entire category can be moved to the Display fields field by selecting the category and clicking the Move Right button. The selected category is added to the bottom of the Display fields field.
Administrators can move multiple fields to the Display fields field by selecting multiple fields prior to clicking the Move Right button.
Fields - Remove from Display
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. 
To remove a field from the display, select the field from the Display fields field and click the Move Left button [image: ], which is to the left of the Display fields field. The selected item is added to the appropriate category in the Available fields field in alphabetical order.
Administrators can move multiple fields to the Available fields field by selecting multiple fields prior to clicking the Move Left button.
An entire category can be removed from the Display fields field by selecting the category and clicking the Move Left button. The selected category is removed from the Display fields field.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display fields field.
Fields - Change Display Order
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the field that appears at the top of the Display fields field will appear as the first field on the left in the expanded employee view on the compensation task, and the field that appears at the bottom of the Display fields field will appear as the last field on the right in the expanded employee view on the compensation task.
Note: If the Graph category is displayed, it must be the first category in the expanded employee view on the compensation task. Because of this, the display order cannot be changed for the Graph category. In addition, no category can be moved above the Graph column. However, the display order of the fields within the Graph category can be modified.
To change the display order for a field, select the field from the Display fields field and click the appropriate button to the right of the Display fields field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected field to the top of the list.
· Move to Bottom [image: ] - Click this button to move the selected field to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected field up one position.
· Move Down [image: ] - Click this button to move the selected field down one position. 
Administrators can move multiple fields by selecting multiple fields prior to clicking the appropriate Move button. In addition, administrators can move an entire category by selecting the category prior to clicking the appropriate Move button.
Bonus Template - Create Overview
Compensation: 
Compensation: Compensation Overview

	 
	csod.com
	


	 
	csod.com
	133


Bonus Compensation Template - General
When creating a bonus type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The General page displays template details such as components, budget rules, eligibility rules, proration rules, etc. All layout details appear on the Layout page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Components
Click the plus icon to the right of the Components heading and select the components that are included in the template. Then click Save. Each selected component is added to the template.
Budget Type
From the Select Budget Type drop-down list, select the appropriate budget type for each component. The available options are:
· % of Base - The budget is a percentage of the employee's most recent base salary within the period end date.
· Fixed Amount - The budget is a fixed monetary amount.
· Cascaded - A cascaded budget is cascaded from the top-level manager down to the lower-level managers. This means that the top-level manager creates their compensation totals from the budget and passes the remaining budget to the next lower manager, and so on.
· Sum of Targets - This indicates that the budget is dynamically set to be a sum of the employee's target values for the manager's task. Note: This option is not available for Target components.
· None - No budget associated with the component.
Amount
In the Amount field, enter the allocated budget amount for each component. Note: If the budget type is None for the component, then the Amount field is not available. Compensation tasks that use a template with None selected as the budget type have the selected components as part of the task, but a budget is not associated with the component.
Save As
For Target components, you must select how the target is saved for a user's individual target. The options are to save it as a fixed amount or as a percentage.
Availability
To set the availability for a component budget, follow these steps:
1. From the Availability drop-down list, select an OU type. A Select icon appears to the right of the drop-down list.
2. After selecting an OU type, click the Select icon and select the appropriate OU. Note: You cannot select the same OU twice for a single budget component.
3. After selecting an OU, a second line item is added for the component budget.
1. The first line item has an Availability set to OU: Default. This component budget serves as the default budget for this component and cannot be deleted unless there are no other budgets for this budget type. Note: For Equity templates, if multiple budgets are available for a budget component, the payout method for all of those budgets matches the payout method for the default component budget.
2. The second line item has the availability set to the selected OU. This OU specific budget can be deleted by clicking the Remove icon to the left of the component budget. If multiple OUs were selected, then each OU is set as a single line item for the budget component.
4. Click the plus icon to the right of the default budget component availability to add another budget for the budget component.
Note: If no availability is selected for a component, then that component serves as the default component budget.
Non-Monetary Components
This section enables administrators to select which non-monetary components are included in the template. When a non-monetary component is selected, this automatically includes the component in the Display Columns field on the Layout page.
Budget Rules
Determine the budget rules for the template. The available options are:
· Total must be on or under budget - Select this option if the actual compensation totals from the compensation task must be on or below the set budget.
· Total may be over by - Select this option if the actual compensation totals from the compensation task may exceed the set budget. You must then specify the percentage by which the total may exceed the budget. One to three decimals may be entered in the percentage field, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Allocation Rules
The Allocation Rules section allows the administrator to specify how compensation managers will enter Bonus allocations for their employees. Select one of the following options:
· Fixed amount or percentage of Base Salary - When this option is selected, the compensation manager allocates the employee's bonus as a fixed amount or a percentage of the employee's Base Salary for each Bonus component included in the template.
· When this option is selected for a Bonus type template that is included in a compensation task, the Bonus component column is editable, allowing compensation managers to allocate by a fixed amount or a percentage of the employee's Base Salary. The % Attained column is read-only and the value in this column is dynamically updated based on the Bonus component allocation.
· Percentage of Bonus Targets - When this option is selected, the compensation manager allocates the employee's bonus as a percentage of the employee's Target Bonus for each Bonus component included in the template.
· When this option is selected for a Bonus type template that is included in a compensation task, the % Attained column is editable, allowing compensation managers to allocate by a percentage of the employee's Target Bonus. The Bonus component column is read-only, and the value in this column is dynamically updated based on the % Attained allocation.
· When this option is selected for a Bonus Type template, an Adjustment Guideline must be associated with the Individual Target component.
Eligibility Rules
Determine the employees that are eligible to be included in the compensation task using this template. If an employee does not meet the eligibility criteria, then that employee can not receive an adjustment for the template type.
When specifying multiple eligibility criteria, the administrator can use either intersecting logic (AND logic) or combining logic (OR logic) to create the eligibility.
To set the eligibility for the template, follow these steps:
1. Click the plus icon to the right of the Eligibility Rules heading.
[image: ]
2. This adds a Select Criteria drop-down list and hides the plus icon. From the drop-down list, select the appropriate metrics to use to determine the template eligibility. Then, click the Select icon to select a specific criterion. The available drop-down options are OU, Group, or User Fields and Metrics. The User Fields and Metrics option includes performance and succession metrics and hire date.
3. After selecting a criterion, the criterion is displayed in the Eligibility Rules section with AND and OR options. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
[image: ]
4. To add an additional criterion, click either the AND link to use intersecting logic or click the OR link to use combining logic. Intersecting logic makes the template available to only the employees that match all of the criteria. Combining logic makes the template available to all employees that match at least one of the criteria. When you click the AND or OR link, an additional criterion is added to the Eligibility section. Note: When you add an additional criterion, the logic that is selected must be used for all eligibility criteria. 
5. After selecting another criterion, the new criterion is displayed in the Eligibility Rules section with the option to add another criterion. If you previously clicked the AND link, then another AND link is available, and if you previously clicked the OR link, then another OR link is available. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
[image: ]
User Fields and Metrics Options
From the drop-down list, select the appropriate operator for each metric (Greater Than, Less Than, Equals, Not Equal To, Greater Than or Equal, Less Than or Equal).
In the field, enter the appropriate value for each metric.
For example, if the employee must have scored higher than 60% on their performance review to be eligible for a compensation adjustment using this template, then select the appropriate performance review as the metric. Select Greater Than as the operator. In the field, enter 60.
See Performance Review Section Score Metrics on page 34 for additional information.
Proration Rules
Proration enables an organization to prorate compensation if the employee has not been with the company or in the position for the entire compensation period. For example, if an employee is hired in April and the compensation period is the calendar year, then the employee has only been in their position for 75% of the compensation period. The organization may choose to prorate the compensation adjustment based on the shortened compensation period. 
Proration may be based off of the employee's Last Hire Date, their time in an OU such as Position or Division, or Last Salary Change Date. Bonus and Equity components can be prorated by Individual Targets. Proration can also be based off an employee's time in a specific group. All adjustment recommendations are prorated on the selected components. Note: Base components cannot be prorated by Individual Targets. See Proration with Individual Targets on page 205 for additional information.
Components - Select the components that are prorated on the compensation plan. Only the components that are selected in the Components section appear in this section.
Criteria - For each selected component, you must then select the appropriate proration criteria for the selected components. Note: The Criteria drop-down list does not appear until the component is selected. The following options may be available:
· Last Hire Date
· Last Salary Change Date - See Proration by Last Salary Change Date on page 203 for additional information.
· Time in OU
· Important: Administrators can only prorate components within a template by one criterion. Multiple criteria cannot be used in the same template.
Retroactive Proration From - This option is only available if Last Hire Date is selected from the Criteria field. This option enables administrators to retroactively prorate the component. See Proration by Last Hire Date - Retroactive Proration on page 201 for additional information.
Next or Cancel
Once all fields are completed, click Next to proceed to the Layout tab. See Bonus Compensation Template - Layout on page 160 for additional information.
Otherwise, click Cancel to discard any unsaved changes.
[image: ]
[bookmark: _Ref-1145909935]Bonus Compensation Template - Layout
When creating a bonus type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The Layout page enables administrators to configure the columns and additional information that appears on the compensation template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. See Bonus Compensation Template - Layout - Column Layout on page 165 for additional information.
Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. See Bonus Compensation Template - Layout - Expanded View Layout on page 171 for additional information.
Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template. See Bonus Template - Layout - Budget Layout on page 164 for additional information.
Additional Options
Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. See Bonus Compensation Template - Layout - Additional Options on page 162 for additional information.
Preview
Click this button to preview how the template will appear to compensation managers. The preview reflects the configuration from the General and Layout pages.
The preview pop-up contains sample data. All hyperlinks and JavaScript are disabled. Only the selected view is displayed; no other tabs of the compensation task are included in the preview.
Modification History
The Modification History section displays a record of each time the template layout is modified. This includes the modification description, administrator username, and date stamp.
Save or Cancel
Once all fields are completed, click Save to save the template.
Otherwise, click Cancel to discard any unsaved changes.
[image: ]
[bookmark: _Ref-859251381]Bonus Compensation Template - Layout - Additional Options
Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. 
[image: ]
Default View
Select the default view for the template within the compensation plan. The following options are available:
· Select the default view for the template:
· Amount - Select this option to view the adjustment amounts as a monetary amount by default.
· % - Select this option to view the adjustment amounts as a percentage of their salary/hourly rate by default.
· Display ineligible employees - Select this option to include ineligible employees in the display by default.
Reference Data
To aggregate company data, select the Aggregate Company Data option and then select the appropriate OUs by which the data should be aggregated.
To include additional recommendation information, select the Additional Recommendations option, which enables a text field. In the field, enter the appropriate information. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. You must then select how the Additional Recommendations information is displayed:
· Display in pop-up - This option displays the additional recommendations in a pop-up. This information is accessed by clicking the Information icon on the corresponding template tab on the compensation plan.
· Display on compensation plan - This option displays the additional recommendations in an expandable section at the top of the corresponding template tab on the compensation plan.
Hourly Employees
Display Annual Equivalents for Hourly Rates - Select this option to display annual equivalents for hourly rates in the corresponding sections of the compensation plan. This option is available for all template types.
Comp Analytics
Select the Comp Analytics option to display the Comp Analytics graphs on the corresponding template tab with a compensation plan.
Depending on the template settings, a compensation task may contain a template that has the Comp Analytics graphs enabled and other templates that have the graphs disabled.
When choosing to display or hide the Comp Analytics graphs, each template is configured individually. However, this option enables the administrator to either display all or hide all of the existing graphs on the template. Administrators cannot choose to only display one or more of the graphs on the template.
[bookmark: _Ref476501545]Bonus Template - Layout - Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template. 
[image: ]
The Available Components field lists all of the components that are added to the compensation template on the General tab. Components are displayed in the Available Components field in alphabetical order. An asterisk appears to the left of each component that cannot be hidden from the template because the component has a defined budget.
The Component Visibility field displays the areas in which the component may be able to be hidden. The visibility options are only editable if the budget for the component is set to "None" on the General tab. If the component's budget is configured by OU on the General tab, then the visibility options are only editable if the budget is set to "None" for all OUs, including the default budget. Further, if a component budget is changed from "None" to a different budget type, then the visibility options are automatically selected for the component, regardless of the previous setting of the options. The following areas are available:
· Budget Summary - This option determines whether the component is visible in the Budget Summary graph on the template tab of the compensation plan. By default, this option is selected for all components. Note: If this option is updated and the template is not reversioned, then all affected Budget Summary graphs are updated with the changes.
When editing a compensation template, modifying the visibility options does not create a new version of the template.
[bookmark: _Ref-1844746976]Bonus Compensation Template - Layout - Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. 
[image: ]
Available Columns
The Available Columns field lists all of the available fields that can be added as a column to the compensation template. Fields are displayed in the Available Columns field in alphabetical order. 
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. See the Columns - Add to Display section below for additional information.
Components that appear in the Available Columns field for a template do not appear in the corresponding compensation plan tab, the Budget Summary graph on the plan, the Roll-up and Plan Summary tabs of the compensation task, or on the profile dashboard of the compensation task.
For non-target bonus components, a bonus component is not considered completely removed unless all associated Bonus fields have been removed (e.g., <Bonus component>, <Bonus component> - Target, <Bonus component> - % Attained).
Display columns
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. See the Columns - Remove from Display section below for additional information.
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field.  See the Columns - Change Display Order section below for additional information.
Administrators are able to customize the column names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all columns appear in the Display columns field when a compensation template is created. The following fields are available for bonus type compensation templates:
· Name - This column cannot be removed from the Display columns field. Also, this column must appear first.
· Performance
· Current Salary/Rate
· Wage Type
· Currency
· Non-Monetary Components - "These fields have an asterisk next to it, and it cannot be renamed or removed from the Display Columns field. To remove it, you must remove it from the Non-Monetary Components section on the General page. All non-monetary components are grouped together at the bottom of the Display Columns list."
· <Non-target bonus components that are added to the template>
· These components are added in the Components section of the General page.
· For each non-target bonus component, the following components are available:
· <Bonus component> - Target - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Percentage of Bonus Targets" on the General page.
· <Bonus component> - % Attained - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Percentage of Bonus Targets" on the General page.
· <Bonus component> - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Fixed amount of percentage of Base Salary" on the General page.
· <Target bonus components that are added to the template>
· These components are added in the Components section of the General page.
· Target bonus components with a budget defined automatically appear in the Display columns field and cannot be removed. Only target bonus components with a Budget Type of "None" can be removed.
Add Fields
Administrators can add performance metrics, succession metrics, and user custom fields to the compensation plan template.
To add fields, click the Add Fields link at the top of the Display Columns field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the Display Columns field.
Once fields are added, they remain visible in either the Available Columns or Display Columns field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Selected field and Display name
When a single field is selected in the Available Columns or Display Columns field, the Selected Field field displays the default name of the selected field. If more than one field is selected or if no field is selected, then this field is blank.
While the Selected Field field displays the default name for the selected field, administrators are able to customize the column name that is displayed to compensation managers on the compensation task. To customize the column name, enter a new column name in the Display Name field, up to 100 characters. This is the column name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field appears.
· By default, the display name is the same as the default field name. 
· A display name is required for each column, regardless of whether it is included in the Available Columns or Display Columns field.
Important: If the % Attained columns that are associated with a Bonus component have not had their display names edited nor been ordered appropriately, then these columns are not easily distinguishable as they all appear as "% Attained" on the compensation plan. This may cause confusion for compensation managers. 
If the display name is changed for the Current Salary/Rate column, then this display name is displayed regardless of the employee wage type. However, if the display name is unchanged, then the individual cell headers reflect whether the user has a wage type of Annual or Hourly.
Note: The Display name field is inactive if more than one field is selected, no field is selected, or the selected field is a component that is included in the template.
Columns - Add to Display
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. To add a column to the display, select the field from the Available Columns field and click the Move Right button [image: ], which is to the right of the Available Columns field. The selected item is added to the bottom of the Display Columns field. The display order of the column can then be modified, if necessary. See the Columns - Change Display Order section below for additional information.
Administrators can move multiple fields to the Display Columns field by selecting multiple fields prior to clicking the Move Right button.
Columns - Remove from Display
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. To remove a column from the display, select the field from the Display Columns field and click the Move Left button [image: ], which is to the left of the Display Columns field. The selected item is added to the Available Columns field in alphabetical order.
Administrators can move multiple fields to the Available Columns field by selecting multiple fields prior to clicking the Move Left button.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display Columns field.
Target bonus components with a budget defined automatically appear in the Display columns field and cannot be removed. Only target bonus components with a Budget Type of "None" can be removed.
For non-target bonus components, the following rules apply:
· <Bonus component> - Target - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Percentage of Bonus Targets" on the General page.
· <Bonus component> - % Attained - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Percentage of Bonus Targets" on the General page.
· <Bonus component> - This component cannot be removed from the Display columns field if a budget is defined for the component and the Allocation Rules field is set to "Fixed amount of percentage of Base Salary" on the General page.
Columns - Change Display Order
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the column that appears at the top of the Display Columns field will appear as the first column on the compensation task, and the column that appears at the bottom of the Display Columns field will appear as the last column on the compensation task.
Note: The Name column must always appear as the first column on the compensation task. Because of this, the display order cannot be changed for the Name column. In addition, no column can be moved above the Name column.  
To change the display order for a column, select the field from the Display Columns field and click the appropriate button to the right of the Display Columns field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected column to the top of the list, below the Name column.
· Move to Bottom [image: ] - Click this button to move the selected column to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected column up one position. No column can be moved above the Name column.
· Move Down [image: ] - Click this button to move the selected column down one position. 
Administrators can move multiple columns by selecting multiple fields prior to clicking the appropriate Move button.
Important: If the % Attained columns that are associated with a Bonus component have not had their display names edited nor been ordered appropriately, then these columns are not easily distinguishable as they all appear as "% Attained" on the compensation plan. This may cause confusion for compensation managers. 
Use Cases
Use Case 1: Default Layout - No Budget Defined
The administrator creates a Bonus template and includes the following components on the General page:
· Performance Bonus
· Budget Type = None
· Target Team Bonus
· Budget Type = Fixed Amount, $100,000
Results
On the Layout page, the following occurs:
· The Available columns field does not contain any columns.
· The Display columns field contains the following columns in the specified order.
	Column
	Selected Field
	Default Display Name

	*Name
	 
	Name

	Performance
	 
	Performance

	Current Salary/Rate
	 
	Current Salary/Rate

	Currency
	 
	Currency

	Performance Bonus - Target
	 
	Target Performance Bonus

	Performance Bonus - % Attained
	% Attained {Performance Bonus}
	% Attained

	Performance Bonus
	 
	Performance Bonus

	New Target Team Bonus
	 
	New Target Team Bonus


Use Case 2: Default Layout - Fixed Amount/% of Base Allocation Rules
The administrator creates a Bonus template and includes the following components on the General page:
· Performance Bonus
· Budget Type = Fixed Amount, $100,000
The administrator sets the Allocation Rules for the Bonus template to "Fixed amount or percentage of Base Salary" on the General page.
Results
On the Layout page, the following occurs:
· The Available columns field does not contain any columns.
· The Display columns field contains the following columns in the specified order.
	Column
	 Selected Field
	Default Display Name

	*Name
	 
	Name

	Performance
	 
	Performance

	Current Salary/Rate
	 
	Current Salary/Rate

	Currency
	 
	Currency

	Performance Bonus - Target
	 
	Target Performance Bonus

	Performance Bonus - % Attained
	% Attained {Performance Bonus}
	% Attained

	*Performance Bonus
	 
	Performance Bonus


Use Case 3: Default Layout - % of Target
The administrator creates a Bonus template and includes the following components on the General page:
· Performance Bonus
· Budget Type = Fixed Amount, $100,000
The administrator sets the Allocation Rules for the Bonus template to "Percentage of Bonus Targets" on the General page.
Results
On the Layout page, the following occurs:
· The Available columns field does not contain any columns.
· The Display columns field contains the following columns in the specified order.
	Column
	Selected Field
	Default Display Name

	*Name
	 
	Name

	Performance
	 
	Performance

	Current Salary/Rate
	 
	Current Salary/Rate

	Currency
	 
	Currency

	*Performance Bonus - Target
	 
	Target Performance Bonus

	*Performance Bonus - % Attained
	% Attained {Performance Bonus}
	% Attained

	Performance Bonus
	 
	Performance Bonus


[bookmark: _Ref1689057220]Bonus Compensation Template - Layout - Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. 
[image: ]
Available fields
The Available fields field lists all of the available fields that can be added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are moved to the Display fields field, then the Graphs category does not appear in the Available fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. The following categories may be available:
· Graphs - This category includes Performance History and Bonus History graphs.
· Organizational Data - This category includes organizational data fields such as default organizational unit (OU) associations.
· Performance Data - This category includes Competency, Performance, and Succession fields.
· Additional Information - This category includes User and custom OU fields.
Data fields in the Available fields field are displayed in alphabetical order within each category. 
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. See the Fields - Add to Display section below for additional information.
Components that appear in the Available fields field for a template do not appear in the corresponding expanded employee view.
Display fields
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. See the Fields - Remove from Display section below for additional information.
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. See the Fields - Change Display Order section below for additional information.
Administrators are able to customize the category and field names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all default fields appear in the Display fields field when a compensation template is created. The following categories and fields are available for bonus type compensation templates:
· Graphs - This category must appear at the top of the Display fields field because any graphs that are displayed in the expanded employee view must be displayed first (on the left side of the expanded view).
· Bonus History
· Performance History
· Organizational Data
· Hire Date
· Division
· Grade
· Location
· Cost Center
· Bonus Data
· Previous <Bonus components that are added to the template>
· Performance Data - This category includes Competency, Performance, and Succession fields that were manually added. See the Add Fields section below for additional information.
· Additional Information - This category includes User and OU fields that were manually added. See the Add Fields section below for additional information.
Add Fields
Administrators can add user, OU, competency, performance review, and succession fields to the expanded employee view.
To add fields, click the Add Fields link at the top of the Display fields field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the appropriate category in the Display fields field.
Once fields are added, they remain visible in either the Available fields or Display fields field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Performance review section scores can be added as a metric for performance reviews that are in a Queued, Not Started, In Progress, Complete, or Expired status. This includes both active and inactive performance reviews. See Performance Review Section Score Metrics on page 34 for additional information.
Selected field and Display name
When a single field or category is selected in the Available fields or Display fields field, the Selected field field displays the default name of the selected field or category. If more than one field or category is selected or if no field or category is selected, then this field is blank.
While the Selected field field displays the default name for the selected field or category, administrators are able to customize the name that is displayed to compensation managers on the compensation task. To customize the field or category name, enter a new name in the Display name field, up to 100 characters. This is the field or category name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field or category appears.
· By default, the display name is the same as the default field or category name. 
· A display name is required for each field and category, regardless of whether it is included in the Available fields or Display fields field.
· You cannot edit the following fields:
· Graphs
· Salary/Rate History
· Performance History
· Division
· Grade
· Location
· Cost Center
· Employee's Annual Equivalency
· Bi-Weekly: en-US
· Days: en-US
· Labor Hours: en-US
· Monthly Custom Wage: en-US
· Annual Equivalency
· OU display fields
· Any Display fields whose parent is Annual Equivalency, such as Labor Hours or Display fields with type Amount.
· The Graphs category name cannot be modified. Also, the name of any bonus components that are included in the template cannot be modified.
Note: The Display name field is inactive if more than one field is selected, no field is selected, or the selected field's display name cannot be modified.  
Fields - Add to Display
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. To add a field to the display, select the field from the Available fields field and click the Move Right button [image: ], which is to the right of the Available fields field. The selected item is added to the bottom of the appropriate category in the Display fields field. The display order of the field can then be modified, if necessary. See the Fields - Change Display Order section below for additional information.
An entire category can be moved to the Display fields field by selecting the category and clicking the Move Right button. The selected category is added to the bottom of the Display fields field.
Administrators can move multiple fields to the Display fields field by selecting multiple fields prior to clicking the Move Right button.
Fields - Remove from Display
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. 
To remove a field from the display, select the field from the Display fields field and click the Move Left button [image: ], which is to the left of the Display fields field. The selected item is added to the appropriate category in the Available fields field in alphabetical order.
Administrators can move multiple fields to the Available fields field by selecting multiple fields prior to clicking the Move Left button.
An entire category can be removed from the Display fields field by selecting the category and clicking the Move Left button. The selected category is removed from the Display fields field.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display fields field.
Fields - Change Display Order
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the field that appears at the top of the Display fields field will appear as the first field on the left in the expanded employee view on the compensation task, and the field that appears at the bottom of the Display fields field will appear as the last field on the right in the expanded employee view on the compensation task.
Note: If the Graph category is displayed, it must be the first category in the expanded employee view on the compensation task. Because of this, the display order cannot be changed for the Graph category. In addition, no category can be moved above the Graph column. However, the display order of the fields within the Graph category can be modified.
To change the display order for a field, select the field from the Display fields field and click the appropriate button to the right of the Display fields field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected field to the top of the list.
· Move to Bottom [image: ] - Click this button to move the selected field to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected field up one position.
· Move Down [image: ] - Click this button to move the selected field down one position. 
Administrators can move multiple fields by selecting multiple fields prior to clicking the appropriate Move button. In addition, administrators can move an entire category by selecting the category prior to clicking the appropriate Move button.
Equity Template - Create Overview
Compensation: 
Compensation: Compensation Overview

	 
	csod.com
	


	 
	csod.com
	155


Equity Compensation Template - General
When creating an equity type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The General page displays template details such as components, budget rules, eligibility rules, proration rules, etc. All layout details appear on the Layout page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Components
Click the plus icon to the right of the Components heading and select the components that are included in the template. Then click Save. Each selected component is added to the template. Note: If LTI Award is selected, RSA, ISO, and NQO options cannot be selected. If RSA, ISO, or NQO is selected, the LTI Award cannot be selected. This prevents duplicate compensation because LTI Awards can contain RSA, ISO, and NQO components.
Shares/Cash Award
For Equity type components, you must specify whether the component is allocated in Shares or in a Cash Award. LTI Awards and Target components are set as Cash Award and cannot be changed. Note: This option is only available for Equity type templates.
Budget Type
From the Select Budget Type drop-down list, select the appropriate budget type for each component. The available options are:
· % of Base - The budget is a percentage of the employee's most recent base salary within the period end date. Note: This option is not available if Shares is selected as the component allocation.
· Fixed Amount - The budget is a fixed monetary amount.
· Cascaded - A cascaded budget is cascaded from the top-level manager down to the lower-level managers. This means that the top-level manager creates their compensation totals from the budget and passes the remaining budget to the next lower manager, and so on.
· Sum of Targets - This indicates that the budget is dynamically set to be a sum of the individual targets that comprise the component. Note: This option is not available if Shares is selected as the component allocation. Also, this option is not available for Target components.
· None - No budget associated with the component.
Amount
In the Amount field, enter the allocated budget amount for each component. Note: If the budget type is None for the component, then the Amount field is not available. Compensation tasks that use a template with None selected as the budget type have the selected components as part of the task, but a budget is not associated with the component.
Save As
For Target components, you must select how the target is saved for a user's individual target. The options are to save it as a fixed amount or as a percentage.
Availability
To set the availability for a component budget, follow these steps:
1. From the Availability drop-down list, select an OU type. A Select icon appears to the right of the drop-down list.
2. After selecting an OU type, click the Select icon and select the appropriate OU. Note: You cannot select the same OU twice for a single budget component.
3. After selecting an OU, a second line item is added for the component budget.
1. The first line item has an Availability set to OU: Default. This component budget serves as the default budget for this component and cannot be deleted unless there are no other budgets for this budget type. Note: For Equity templates, if multiple budgets are available for a budget component, the payout method for all of those budgets matches the payout method for the default component budget.
2. The second line item has the availability set to the selected OU. This OU specific budget can be deleted by clicking the Remove icon to the left of the component budget. If multiple OUs were selected, then each OU is set as a single line item for the budget component.
4. Click the plus icon to the right of the default budget component availability to add another budget for the budget component.
Note: If no availability is selected for a component, then that component serves as the default component budget.
Non-Monetary Components
This section enables administrators to select which non-monetary components are included in the template. When a non-monetary component is selected, this automatically includes the component in the Display Columns field on the Layout page.
Budget Rules
Determine the budget rules for the template. The available options are:
· Total must be on or under budget - Select this option if the actual compensation totals from the compensation task must be on or below the set budget.
· Total may be over by - Select this option if the actual compensation totals from the compensation task may exceed the set budget. You must then specify the percentage by which the total may exceed the budget. One to three decimals may be entered in the percentage field, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Eligibility Rules
Determine the employees that are eligible to be included in the compensation task using this template. If an employee does not meet the eligibility criteria, then that employee can not receive an adjustment for the template type.
When specifying multiple eligibility criteria, the administrator can use either intersecting logic (AND logic) or combining logic (OR logic) to create the eligibility.
To set the eligibility for the template, follow these steps:
1. Click the plus icon to the right of the Eligibility Rules heading.
[image: ]
2. This adds a Select Criteria drop-down list and hides the plus icon. From the drop-down list, select the appropriate metrics to use to determine the template eligibility. Then, click the Select icon to select a specific criterion. The available drop-down options are OU, Group, or User Fields and Metrics. The User Fields and Metrics option includes performance and succession metrics and hire date.
3. After selecting a criterion, the criterion is displayed in the Eligibility Rules section with AND and OR options. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
[image: ]
4. To add an additional criterion, click either the AND link to use intersecting logic or click the OR link to use combining logic. Intersecting logic makes the template available to only the employees that match all of the criteria. Combining logic makes the template available to all employees that match at least one of the criteria. When you click the AND or OR link, an additional criterion is added to the Eligibility section. Note: When you add an additional criterion, the logic that is selected must be used for all eligibility criteria. 
5. After selecting another criterion, the new criterion is displayed in the Eligibility Rules section with the option to add another criterion. If you previously clicked the AND link, then another AND link is available, and if you previously clicked the OR link, then another OR link is available. If a User Fields and Metrics option was selected, you must set the operator values for the field. See User Fields and Metrics Options below for additional information.
[image: ]
User Fields and Metrics Options
From the drop-down list, select the appropriate operator for each metric (Greater Than, Less Than, Equals, Not Equal To, Greater Than or Equal, Less Than or Equal).
In the field, enter the appropriate value for each metric.
For example, if the employee must have scored higher than 60% on their performance review to be eligible for a compensation adjustment using this template, then select the appropriate performance review as the metric. Select Greater Than as the operator. In the field, enter 60.
See Performance Review Section Score Metrics on page 34 for additional information.
Proration Rules
Proration enables an organization to prorate compensation if the employee has not been with the company or in the position for the entire compensation period. For example, if an employee is hired in April and the compensation period is the calendar year, then the employee has only been in their position for 75% of the compensation period. The organization may choose to prorate the compensation adjustment based on the shortened compensation period. 
Proration may be based off of the employee's Last Hire Date, their time in an OU such as Position or Division, or Last Salary Change Date. Bonus and Equity components can be prorated by Individual Targets. Proration can also be based off an employee's time in a specific group. All adjustment recommendations are prorated on the selected components. Note: Base components cannot be prorated by Individual Targets. See Proration with Individual Targets on page 205 for additional information.
Components - Select the components that are prorated on the compensation plan. Only the components that are selected in the Components section appear in this section.
Criteria - For each selected component, you must then select the appropriate proration criteria for the selected components. Note: The Criteria drop-down list does not appear until the component is selected. The following options may be available:
· Last Hire Date
· Last Salary Change Date - See Proration by Last Salary Change Date on page 203 for additional information.
· Time in OU
· Important: Administrators can only prorate components within a template by one criterion. Multiple criteria cannot be used in the same template.
Retroactive Proration From - This option is only available if Last Hire Date is selected from the Criteria field. This option enables administrators to retroactively prorate the component. See Proration by Last Hire Date - Retroactive Proration on page 201 for additional information.
Next or Cancel
Once all fields are completed, click Next to proceed to the Layout tab. See Equity Compensation Template - Layout on page 182 for additional information.
Otherwise, click Cancel to discard any unsaved changes.
[image: ]
[bookmark: _Ref-687708999]Equity Compensation Template - Layout
When creating an equity type compensation template, the Compensation Template administration page is separated into two pages, the General page and the Layout page. The Layout page enables administrators to configure the columns and additional information that appears on the compensation template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan Templates
	Grants ability to create and manage compensation plan templates for base, bonus, and equity compensation. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. See Equity Compensation Template - Layout - Column Layout on page 187 for additional information.
Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. See Equity Compensation Template - Layout - Expanded View Layout on page 192 for additional information.
Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template.  See Equity Template - Layout - Budget Layout on page 186 for additional information.
Additional Options
Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. See Equity Compensation Template - Layout - Additional Options on page 184 for additional information.
Preview
Click this button to preview how the template will appear to compensation managers. The preview reflects the configuration from the General and Layout pages.
The preview pop-up contains sample data. All hyperlinks and JavaScript are disabled. Only the selected view is displayed; no other tabs of the compensation task are included in the preview.
Modification History
The Modification History section displays a record of each time the template layout is modified. This includes the modification description, administrator username, and date stamp.
Save or Cancel
Once all fields are completed, click Save to save the template.
Otherwise, click Cancel to discard any unsaved changes.
[image: ]
[bookmark: _Ref-1202061205]Equity Compensation Template - Layout - Additional Options
Additional display options are available to determine what information is displayed to the manager in order to help guide them in making specific compensation recommendations. 
[image: ]
Default View
Select the default view for the template within the compensation plan. The following options are available:
· Select the default view for the template:
· Amount - Select this option to view the adjustment amounts as a monetary amount by default.
· % - Select this option to view the adjustment amounts as a percentage of their salary/hourly rate by default.
· Display ineligible employees - Select this option to include ineligible employees in the display by default.
Reference Data
To aggregate company data, select the Aggregate Company Data option and then select the appropriate OUs by which the data should be aggregated.
To include additional recommendation information, select the Additional Recommendations option, which enables a text field. In the field, enter the appropriate information. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. You must then select how the Additional Recommendations information is displayed:
· Display in pop-up - This option displays the additional recommendations in a pop-up. This information is accessed by clicking the Information icon on the corresponding template tab on the compensation plan.
· Display on compensation plan - This option displays the additional recommendations in an expandable section at the top of the corresponding template tab on the compensation plan.
Hourly Employees
Display Annual Equivalents for Hourly Rates - Select this option to display annual equivalents for hourly rates in the corresponding sections of the compensation plan. This option is available for all template types.
Comp Analytics
Select the Comp Analytics option to display the Comp Analytics graphs on the corresponding template tab with a compensation plan.
Depending on the template settings, a compensation task may contain a template that has the Comp Analytics graphs enabled and other templates that have the graphs disabled.
When choosing to display or hide the Comp Analytics graphs, each template is configured individually. However, this option enables the administrator to either display all or hide all of the existing graphs on the template. Administrators cannot choose to only display one or more of the graphs on the template.
[bookmark: _Ref1216404957]Equity Template - Layout - Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the template. 
[image: ]
The Available Components field lists all of the components that are added to the compensation template on the General tab. Components are displayed in the Available Components field in alphabetical order. An asterisk appears to the left of each component that cannot be hidden from the template because the component has a defined budget.
The Component Visibility field displays the areas in which the component may be able to be hidden. The visibility options are only editable if the budget for the component is set to "None" on the General tab. If the component's budget is configured by OU on the General tab, then the visibility options are only editable if the budget is set to "None" for all OUs, including the default budget. Further, if a component budget is changed from "None" to a different budget type, then the visibility options are automatically selected for the component, regardless of the previous setting of the options. The following areas are available:
· Budget Summary - This option determines whether the component is visible in the Budget Summary graph on the template tab of the compensation plan. By default, this option is selected for all components. Note: If this option is updated and the template is not reversioned, then all affected Budget Summary graphs are updated with the changes.
When editing a compensation template, modifying the visibility options does not create a new version of the template.
[bookmark: _Ref1942947362]Equity Compensation Template - Layout - Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. 
[image: ]
Available Columns
The Available Columns field lists all of the available fields that can be added as a column to the compensation template. Fields are displayed in the Available Columns field in alphabetical order. 
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. See the Columns - Add to Display section below for additional information.
Components that appear in the Available Columns field for a template do not appear in the corresponding compensation plan tab, the Budget Summary graph on the plan, the Roll-up and Plan Summary tabs of the compensation task, or on the profile dashboard of the compensation task.
Display columns
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. See the Columns - Remove from Display section below for additional information.
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field.  See the Columns - Change Display Order section below for additional information.
Administrators are able to customize the column names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all columns appear in the Display Columns field when a compensation template is created. The following fields are available for equity type compensation templates:
· Name - This column cannot be removed from the Display Columns field. Also, this column must appear first.
· Performance
· Current Salary/Rate
· Wage Type
· Currency
· Non-Monetary Components - "These fields have an asterisk next to it, and it cannot be renamed or removed from the Display Columns field. To remove it, you must remove it from the Non-Monetary Components section on the General page. All non-monetary components are grouped together at the bottom of the Display Columns list."
· <Non-target equity components that are added to the template>
· These components are added in the Components section of the General page.
· For Award Equity components, the following components are available:
· <Equity component> - Target - This component can always be removed from the Display Columns field, regardless of whether it has a budget defined.
· <Equity component> Award - This component cannot be removed from the Display Columns field if a budget is defined for the component.
· For Shares Equity components, the following component is available:
· <Equity component> Grant - This component cannot be removed from the Display Columns field if a budget is defined for the component.
· <Target equity components that are added to the template>
· These components are added in the Components section of the General page.
· Target equity components with a budget defined automatically appear in the Display Columns field and cannot be removed. Only target equity components with a Budget Type of "None" can be removed.
Add Fields
Administrators can add performance metrics, succession metrics, and user custom fields to the compensation plan template.
To add fields, click the Add Fields link at the top of the Display Columns field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the Display Columns field.
Once fields are added, they remain visible in either the Available Columns or Display Columns field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Selected field and Display name
When a single field is selected in the Available Columns or Display Columns field, the Selected Field field displays the default name of the selected field. If more than one field is selected or if no field is selected, then this field is blank.
While the Selected Field field displays the default name for the selected field, administrators are able to customize the column name that is displayed to compensation managers on the compensation task. To customize the column name, enter a new column name in the Display Name field, up to 100 characters. This is the column name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field appears.
· By default, the display name is the same as the default field name. 
· A display name is required for each column, regardless of whether it is included in the Available Columns or Display Columns field.
If the display name is changed for the Current Salary/Rate column, then this display name is displayed regardless of the employee wage type. However, if the display name is unchanged, then the individual cell headers reflect whether the user has a wage type of Annual or Hourly.
Note: The Display name field is inactive if more than one field is selected, no field is selected, or the selected field is a component that is included in the template.
Columns - Add to Display
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. To add a column to the display, select the field from the Available Columns field and click the Move Right button [image: ], which is to the right of the Available Columns field. The selected item is added to the bottom of the Display Columns field. The display order of the column can then be modified, if necessary. See the Columns - Change Display Order section below for additional information.
Administrators can move multiple fields to the Display Columns field by selecting multiple fields prior to clicking the Move Right button.
Columns - Remove from Display
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. To remove a column from the display, select the field from the Display Columns field and click the Move Left button [image: ], which is to the left of the Display Columns field. The selected item is added to the Available Columns field in alphabetical order.
Administrators can move multiple fields to the Available Columns field by selecting multiple fields prior to clicking the Move Left button.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display Columns field.
Target equity components with a budget defined automatically appear in the Display Columns field and cannot be removed. Only target equity components with a Budget Type of "None" can be removed.
For non-target Award equity components, the following rules apply:
· <Equity component> - Target - This component can always be removed from the Display Columns field, regardless of whether it has a budget defined.
· <Equity component> Award - This component cannot be removed from the Display Columns field if a budget is defined for the component.
For non-target Shares equity components, the following rule applies:
· <Equity component> Grant - This component cannot be removed from the Display Columns field if a budget is defined for the component.
Columns - Change Display Order
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the column that appears at the top of the Display Columns field will appear as the first column on the compensation task, and the column that appears at the bottom of the Display Columns field will appear as the last column on the compensation task.
Note: The Name column must always appear as the first column on the compensation task. Because of this, the display order cannot be changed for the Name column. In addition, no column can be moved above the Name column.  
To change the display order for a column, select the field from the Display Columns field and click the appropriate button to the right of the Display Columns field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected column to the top of the list, below the Name column.
· Move to Bottom [image: ] - Click this button to move the selected column to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected column up one position. No column can be moved above the Name column.
· Move Down [image: ] - Click this button to move the selected column down one position. 
Administrators can move multiple columns by selecting multiple fields prior to clicking the appropriate Move button.
Use Cases
Use Case 1: Default Layout - Shares
The administrator creates an Equity template and includes the following components on the General page:
· ISO
· Shares
· Budget Type = None
· RSA
· Shares
· Budget Type = Fixed Amount, $100,000
· Target NQO
· Budget Type = Fixed Amount, $100,000
Results
On the Layout page, the following occurs:
· The Available columns field does not contain any columns.
· The Display columns field contains the following columns in the specified order.
	Column
	Default Display Name

	Name
	Name

	Performance
	Performance

	Current Salary/Rate
	Current Salary/Rate

	Currency
	Currency

	ISO Grant
	ISO Grant

	*RSA Grant
	RSA Grant

	*New Target NQO
	New Target NQO


Use Case 2: Default Layout - Cash Awards
The administrator creates an Equity template and includes the following components on the General page:
· ISO
· Cash Award
· Budget Type = None
· RSA
· Cash Award
· Budget Type = Fixed Amount, $100,000
Results
On the Layout page, the following occurs:
· The Available columns field does not contain any columns.
· The Display columns field contains the following columns in the specified order.
	Column
	Default Display Name

	*Name
	Name

	Performance
	Performance

	Current Salary/Rate
	Current Salary/Rate

	Currency
	Currency

	ISO Award
	ISO Award

	RSA - Target
	Target RSA

	*RSA Award
	RSA Award


[bookmark: _Ref-223065250]Equity Compensation Template - Layout - Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view in the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. 
[image: ]
Available fields
The Available fields field lists all of the available fields that can be added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are moved to the Display fields field, then the Graphs category does not appear in the Available fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. The following categories may be available:
· Graphs - This category includes Performance History and Grant History graphs.
· Equity Data - This category includes equity data fields, such as Aggregate Company Data.
· Organizational Data - This category includes organizational data fields such as default organizational unit (OU) associations.
· Performance Data - This category includes Competency, Performance, and Succession fields.
· Additional Information - This category includes User and custom OU fields.
Data fields in the Available fields field are displayed in alphabetical order within each category. 
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. See the Fields - Add to Display section below for additional information.
Components that appear in the Available fields field for a template do not appear in the corresponding expanded employee view.
Display fields
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. See the Fields - Remove from Display section below for additional information.
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. See the Fields - Change Display Order section below for additional information.
Administrators are able to customize the category and field names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, all default fields appear in the Display fields field when a compensation template is created. The following categories and fields are available for equity type compensation templates:
· Graphs - This category must appear at the top of the Display fields field because any graphs that are displayed in the expanded employee view must be displayed first (on the left side of the expanded view).
· Grant History
· Performance History
· Organizational Data
· Hire Date
· Division
· Grade
· Location
· Cost Center
· Equity Data
· Previous <Equity components that are added to the template>
· Performance Data - This category includes Competency, Performance, and Succession fields that were manually added. See the Add Fields section below for additional information.
· Additional Information - This category includes User and OU fields that were manually added. See the Add Fields section below for additional information.
Add Fields
Administrators can add user, OU, competency, performance review, and succession fields to the expanded employee view.
To add fields, click the Add Fields link at the top of the Display fields field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the appropriate category in the Display fields field.
Once fields are added, they remain visible in either the Available fields or Display fields field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Performance review section scores can be added as a metric for performance reviews that are in a Queued, Not Started, In Progress, Complete, or Expired status. This includes both active and inactive performance reviews. See Performance Review Section Score Metrics on page 34 for additional information.
Selected field and Display name
When a single field or category is selected in the Available fields or Display fields field, the Selected field field displays the default name of the selected field or category. If more than one field or category is selected or if no field or category is selected, then this field is blank.
While the Selected field field displays the default name for the selected field or category, administrators are able to customize the name that is displayed to compensation managers on the compensation task. To customize the field or category name, enter a new name in the Display name field, up to 100 characters. This is the field or category name that will appear on the compensation plan. This field does not accept HTML. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation template. The change does not affect any other compensation templates in which the corresponding field or category appears.
· By default, the display name is the same as the default field or category name. 
· A display name is required for each field and category, regardless of whether it is included in the Available fields or Display fields field.
· You cannot edit the following fields:
· Graphs
· Salary/Rate History
· Performance History
· Division
· Grade
· Location
· Cost Center
· Employee's Annual Equivalency
· Bi-Weekly: en-US
· Days: en-US
· Labor Hours: en-US
· Monthly Custom Wage: en-US
· Annual Equivalency
· OU display fields
· Any Display fields whose parent is Annual Equivalency, such as Labor Hours or Display fields with type Amount.
· The Graphs category name cannot be modified. Also, the name of any equity components that are included in the template cannot be modified.
Note: The Display name field is inactive if more than one field is selected, no field is selected, or the selected field's display name cannot be modified.  
Fields - Add to Display
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. To add a field to the display, select the field from the Available fields field and click the Move Right button [image: ], which is to the right of the Available fields field. The selected item is added to the bottom of the appropriate category in the Display fields field. The display order of the field can then be modified, if necessary. See the Fields - Change Display Order section below for additional information.
An entire category can be moved to the Display fields field by selecting the category and clicking the Move Right button. The selected category is added to the bottom of the Display fields field.
Administrators can move multiple fields to the Display fields field by selecting multiple fields prior to clicking the Move Right button.
Fields - Remove from Display
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the graphs are removed from the Display fields field, then the Graphs category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. 
To remove a field from the display, select the field from the Display fields field and click the Move Left button [image: ], which is to the left of the Display fields field. The selected item is added to the appropriate category in the Available fields field in alphabetical order.
Administrators can move multiple fields to the Available fields field by selecting multiple fields prior to clicking the Move Left button.
An entire category can be removed from the Display fields field by selecting the category and clicking the Move Left button. The selected category is removed from the Display fields field.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display fields field.
Fields - Change Display Order
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the field that appears at the top of the Display fields field will appear as the first field on the left in the expanded employee view on the compensation task, and the field that appears at the bottom of the Display fields field will appear as the last field on the right in the expanded employee view on the compensation task.
Note: If the Graph category is displayed, it must be the first category in the expanded employee view on the compensation task. Because of this, the display order cannot be changed for the Graph category. In addition, no category can be moved above the Graph column. However, the display order of the fields within the Graph category can be modified.
To change the display order for a field, select the field from the Display fields field and click the appropriate button to the right of the Display fields field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected field to the top of the list.
· Move to Bottom [image: ] - Click this button to move the selected field to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected field up one position.
· Move Down [image: ] - Click this button to move the selected field down one position. 
Administrators can move multiple fields by selecting multiple fields prior to clicking the appropriate Move button. In addition, administrators can move an entire category by selecting the category prior to clicking the appropriate Move button.
[bookmark: _Ref712739577]Performance Review Section Score Metrics
Performance review section scores can be added as a metric for performance reviews that are in a Queued, Not Started, In Progress, Complete, or Expired status. This includes both active and inactive performance reviews.  
[image: ]
On the Search Fields and Metrics pop-up, performance review section scores display as <Performance Review Name> - <Section Name> (e.g., 2011 Annual Performance Review - Work Culture Ratings).
Only current sections included in a performance review task are included in the Search Fields and Metrics pop-up. That is, if a performance review task has been modified to remove a section or add a section, then only the current (at the time the pop-up is opened) sections are included in the task.
Considerations
· Only rated sections within performance reviews are available as a metric in compensation management, which includes Question List, Goal Rating, and Competency section types.
· Calculations for performance review section scores are independent of the weighting of the section in an individual step of a performance review. Calculations take into account the weighting of individual steps within the performance review.
· Performance Review Section Score = ( (<Section Score – Step 1> * <Step 1 Weighting>) + (<Section Score – Step 2> * <Step 2 Weighting>) + … + (<Section Score – Step n> * <Step n Weighting>) ) / (<Step 1 Weighting> + <Step 2 Weighting> + … + <Step n Weighting>)
Note: Not all steps within a performance review contain a specific section. In such cases, the step is not included in the calculation.
· When specific performance review section scores are used as metrics, the score calculation applies to completed tasks at the user level as currently implemented for overall performance review scores.
· Users that do not have a Completed status for the associated performance review have an inapplicable performance review section score.
· For eligibility criteria, the user is not considered eligible if a performance review section score is used and the user does not have a Completed status for the performance review. Eligibility is dynamically re-determined at the time the user receives the Completed performance review.
· For adjustment guideline metrics, the user will not have an applicable score for the performance review section score if the user does not have a Completed status for the associated performance review.
· If an off-cycle performance review task section score is used and there are multiple instances of the task associated to the user, then the last instance associated to the user is used. This will be the last completed task with the latest performance review period within the compensation period of the associated compensation task.
· For performance review sections that do not have the Display Scores to End Users option selected, "No Rating" displays for the performance review section score.
Note: Section scores are populated and available regardless of review status.
Use Cases
Use Case 1: Sections Included in Search Fields and Metrics Pop-Up - Simple
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
Results
1. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
Use Case 2: Sections Included in Search Fields and Metrics Pop-Up - Removed Section
1. 2011 Annual Performance Review is configured to contain the following sections:
· Goal Rating: 2011 Goals in Review
· Competency: 2011 Competencies
· Goal Planning: Future Goals
· Question List: 2011 Final Thoughts
Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
3. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
4. Administrator updates 2011 Annual Performance Review and removes 2011 Competencies.
5. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
6. Administrator clicks Add Metric for Recommendation Matrix.
Results
1. 2011 Annual Performance Review has three associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Final Thoughts
Use Case 3: Section Score Calculation
For Use Case 3, assume the following tables show the configuration for 2011 Annual Performance Review:
	Review Step
	Weighting

	Employee Review
	20%

	Manager Review
	50%

	Indirect Manager Review
	30%



	Review Step
	Section 1
	Section 2
	Section 3
	Section 4

	Employee Review
	2011 Goals in Review
	Future Goals
	2011 Competencies
	2011 Final Thoughts

	Manager Review
	2011 Goals in Review
	Future Goals
	2011 Competencies
	2012 Final Thoughts

	Indirect Manager Review
	2011 Final Thoughts
	--
	--
	--


Tammy Andrews receives the following scores for 2011 Annual Performance Review:
	Review Step
	2011 Goals in Review
	2011 Competencies
	2011 Final Thoughts

	Employee Review
	5.0 / 5.0
	4.5 / 5.0
	4.2 / 5.0

	Manager Review
	4.8 / 5.0
	4.6 / 5.0
	4.0 / 5.0

	Indirect Manager Review
	--
	--
	4.2 / 5.0


Action
1. Administrator creates new Compensation Recommendation Matrix Adjustment Guideline.
2. Administrator clicks Add Metric for Recommendation Matrix.
3. 2011 Annual Performance Review has four associated metrics in the pop-up:
· 2011 Annual Performance Review
· 2011 Annual Performance Review - 2011 Goals in Review
· 2011 Annual Performance Review - 2011 Competencies
· 2011 Annual Performance Review - 2011 Final Thoughts
Results
1. Tammy Andrews receives the following scores for 2011 Annual Performance Review sections:
	Section
	Score

	2011 Goals in Review
	97.1%

	2011 Competencies
	91.4%

	2011 Final Thoughts
	82.0%


1. Calculations
· 2011 Goals in Review
· (((5.0 / 5.0) * 0.2) + ((4.8 / 5.0) * 0.5)) / (0.2 + 0.5)
· 2011 Competencies
· (((4.5 / 5.0) * 0.2) + ((4.6 / 5.0) * 0.5)) / (0.2 + 0.5)
· 2011 Final Thoughts
· (((4.2 / 5.0) * 0.2) + ((4.0 / 5.0) * 0.5) + ((4.2 / 5.0) * 0.3)) / (0.2 + 0.5 + 0.3)
[bookmark: _Ref-367566503]Proration by Last Hire Date - Retroactive Proration
When creating a template and prorating a component by Last Hire Date, administrators can enable retroactive proration by selecting the Retroactive Proration From option. This option is only available if Last Hire Date is selected from the Criteria field in the Proration Rules section. 
When the Retroactive Proration From option is selected, a retroactive proration date must be specified. The selected date should occur before the start of the compensation task's compensation period. If the selected date is not before the start of the compensation period, then retroactive proration is disabled for the component. When retroactive proration is enabled, employees with a Last Hire Date between the selected retroactive proration date and the start of the compensation task's compensation period will receive guidelines with a prorated amount for that period in addition to the compensation period. Note: The retroactive proration date is a fixed date. When reusing templates for a different compensation period (e.g., the following year's annual compensation task), the retroactive proration date must be adjusted for the new compensation period.
· Employees with a Last Hire Date that occurs before the Retroactive Proration From date will receive guidelines and contribute budget based upon a 100% proration percentage. That is, the employees will not be prorated.
· Adjustment guideline defines the recommended amounts in the compensation plan.
· Full budget definition applies to the employees.
· Employees with a Last Hire Date that occurs within the compensation period for the compensation task will receive guidelines and contribute budget based upon the number of days between the Last Hire Date and the end of the compensation period. That is, the employees will have a proration percentage that is less than or equal to 100%.
· Proration Percentage = <Number of days between Last Hire Date and end of compensation period including Last Hire Date and last day of compensation period> / <Number of days in compensation period>
· Proration percentage is calculated and rounded to the nearest fourth decimal place before being applied to other calculations.
· Adjustment Guideline = <Adjustment guideline recommendation> * <Proration percentage>
· Budget = <Full budget calculation> * <Proration percentage>
· Employees with a Last Hire Date that occurs between the Retroactive Proration From date and the start of the compensation period for the compensation task will receive guidelines and contribute budget based upon the entire compensation period and the number of days between the Retroactive Proration From date and the start of the compensation period. That is, the employees will have a proration percentage that is greater than 100%.
· Proration Percentage = (1 + <Number of days between Last Hire Date and start of compensation period including Last Hire Date> / <Number of days in compensation period>
· Proration percentage is calculated and rounded to the nearest fourth decimal place before being applied to other calculations.
· Adjustment Guideline = <Adjustment guideline recommendation> * <Proration percentage>
· Budget = <Full budget calculation> * <Proration percentage>
Use Cases
The following information is used for these use cases:
	Employee
	Last Hire Date
	Current Salary

	Melissa
	November 10, 2012
	$65,000

	Kevin
	March 3, 2008
	$100,000

	Paul
	July 30, 2013
	$50,000


· Compensation Task: 2013 Compensation Cycle
· Compensation Period: January 1, 2013 - December 31, 2013
· Bonus Budget: 10% of Base
· Bonus Proration: Prorate by Last Hire Date with Retroactive Proration
· Retroactive Proration Date: November 1, 2012
Use Case 1: Adjustment Guideline Calculation with Retroactive Proration
1. Default Bonus Adjustment Guideline is set to 5% of Base.
2. Compensation Manager launches 2013 Compensation Cycle.
3. Compensation Plan recommends the following Bonus allocations:
1. Melissa:
1. Proration Percentage = (1 + (52 / 365)) = 1.1425 = 114.25%
2. Recommendation = (0.05 * $65,000) * 1.1425 = $3,713.13
2. Kevin:
1. Proration Percentage = No proration percentage
2. Recommendation = (0.05 * $100,000) = $5,000
3. Paul
1. Proration Percentage = 155 / 365 = 0.4247 = 42.47%
2. Recommendation = (0.05 * $50,000) * 0.4247 = $1,061.75
Use Case 2: Budget Calculation with Retroactive Proration
1. The compensation task is configured as described above.
2. Compensation Manager launches 2013 Compensation Cycle.
3. Compensation Plan displays Bonus Budget of $19,549.75.
4. The Bonus Budget is calculated as follows:
1. Melissa:
1. Proration Percentage = (1 + (52 / 365)) = 1.1425 = 114.25%
2. Recommendation = (0.1 * $65,000) * 1.1425 = $7,426.25
2. Kevin:
1. Proration Percentage = No proration percentage
2. Recommendation = (0.1 * $100,000) = $10,000
3. Paul
1. Proration Percentage = 155 / 365 = 0.4247 = 42.47%
2. Recommendation = (0.1 * $50,000) * 0.4247 = $2,123.50
[bookmark: _Ref1289187732]Proration by Last Salary Change Date
When creating a template, in the Proration Rules section, a component can be prorated by Last Salary Change Date.
When a component is prorated by Last Salary Change Date, the component proration is calculated if the employee had a change in salary within the compensation task's compensation period.
· If the employee has not had a salary change within the compensation period, then the employee will receive guidelines and contribute budget based upon a 100% proration percentage. That is, the employee will not be prorated.
· Adjustment guideline defines the recommended amounts in the compensation plan.
· Full budget definition applies to the employees.
· If the employee has had a salary change within the compensation period, then the employee will receive guidelines and contribute budget based upon the number of days between the Last Salary Change Date and the end of the compensation period. That is, the employees will have a proration percentage that is less than or equal to 100%. If there have been more than one salary changes within the compensation period, then the proration is calculated from the most recent salary change within the compensation period.
· Proration Percentage = <Number of days between Last Salary Change Date and end of compensation period including Last Salary Change Date and last day of compensation period> / <Number of days in compensation period>
· Proration percentage is calculated and rounded to the nearest fourth decimal place before being applied to other calculations.
· Adjustment Guideline = <Adjustment guideline recommendation> * <Proration percentage>
· Budget = <Full budget calculation> * <Proration percentage>
Use Cases
The following information is used for these use cases:
	Employee
	Effective Date
	Current Salary

	Melissa
	November 10, 2012
	$65,000

	Kevin
	March 3, 2013
	$85,000

	Kevin
	October 12, 2013
	$100,000

	Paul
	July 15, 2013
	$50,000


· Compensation Task: 2013 Compensation Cycle
· Compensation Period: January 1, 2013 - December 31, 2013
· Bonus Budget: 10% of Base
· Bonus Proration: Prorate by Last Salary Change Date
Use Case 1: Adjustment Guideline Calculation with Last Salary Change Date Proration
1. Default Bonus Adjustment Guideline is set to 5% of Base.
2. Compensation Manager launches 2013 Compensation Cycle.
3. Compensation Plan recommends the following Bonus allocations:
1. Melissa:
1. Proration Percentage = No proration percentage
2. Recommendation = (0.05 * $65,000) = $3,250
2. Kevin:
1. Proration Percentage = 81 / 365 = 0.2219 = 22.19%
2. Recommendation = (0.05 * $100,000) * 0.2219 = $1,109.50
3. Paul
1. Proration Percentage = 170 / 365 = 0.4658 = 46.58%
2. Recommendation = (0.05 * $50,000) * 0.4658 = $1,164.50
Use Case 2: Budget Calculation with Retroactive Proration
1. The compensation task is configured as described above.
2. Compensation Manager launches 2013 Compensation Cycle.
3. Compensation Plan displays Bonus Budget of $11,048.00.
4. The Bonus Budget is calculated as follows:
1. Melissa:
1. Proration Percentage = No proration percentage
2. Recommendation = (0.1 * $65,000) = $6,500
2. Kevin:
1. Proration Percentage = 81 / 365 = 0.2219 = 22.19%
2. Recommendation = (0.1 * $100,000) * 0.2219 = $2,219
3. Paul
1. Proration Percentage = 170 / 365 = 0.4658 = 46.58%
2. Recommendation = (0.1 * $50,000) * 0.4658 = $2,329
Compensation: 
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[bookmark: _Ref105383857]Proration with Individual Targets
Bonus components can be prorated based on Last Hire Date, Time in an OU, and Individual Targets.
If the proration criteria for a component is set to Last Hire Date or Time in OU, and the corresponding adjustment guidelines are set to Individual Targets:
· The guidelines retrieve the user's most recent target value set for the guideline's compensation component that is within the user's proration criteria period.
· If no individual target entry is available for the user for the compensation component type during the proration criteria period, the user's target value is zero for the proration segment.
· The target values retrieved by the adjustment guidelines according to the proration criteria are prorated as normal.
If the proration criteria for a component is set to Individual Targets:
· Only adjustment guidelines with the Target set to Individual Targets are applicable and are used for the component. 
· For example, if Bonus proration criteria is set to Individual Targets only, Bonus adjustment guidelines are filtered so that only guidelines with the Target to Individual Targets are used in the task.
· The adjustment guideline with the highest payout recommendation is implemented.
· Proration of the target value is calculated on Individual Target values set for the user for the duration of the compensation period.
· For dates in the compensation period that the user does not have a target set, the user's target for that period is zero when calculating the prorated target value.
· If no target values are set for the user during the entire compensation period, their target is zero.
· Unlike proration by OU or Last Hire Date, proration by Individual Targets is represented in the compensation task by a single line item.
· Although the target is a prorated value, proration by Individual Targets does not split the user's entry for this component based on Individual Target entries.
· The manager that is solely responsible for setting the bonus amount for the user is the most recent manager of the user during the compensation period.
Example
The following diagram depicts a compensation period from 01/01/2011 to 12/31/2011:
[image: ]
Proration by Division:
· Adjustment Guidelines: Development, Management
· Time in Development Division:
· Target for 01/01/2011 - 06/30/2011: $5,000
· Time in Management Division:
· Target for 07/01/2011 - 12/31/2011: $6,000
Proration by Individual Targets:
· Adjustment Guidelines: Management (Assume it recommends higher payout than Development adjustment guideline)
· Target for 01/01/2011 - 03/31/2011: $2,000
· Prorated Target Value: $493.15
· Target for 04/01/2011 - 05/31/2011: $4,000
· Prorated Target Value: $668.49
· Target for 06/01/2011 - 08/31/2011: $5,000
· Prorated Target Value: $1,260.27
· Target for 09/01/2011 - 09/31/2011: $5,500
· Prorated Target Value: $452.05
· Target for 10/01/2011 - 12/31/2011: $6,000
· Prorated Target Value: $1,512.33
· Total Prorated Target for Compensation Period: $4,386.29
Proration by Last Hire Date (Last Hire Date = 06/01/2010):
· Adjustment Guidelines: Management
· Target for 06/01/2011 - 12/31/2011 (214 days): $6,000
· Prorated Target Value: $3,517.81
[bookmark: _Ref-480902842][bookmark: _Toc161996457]Compensation Task Administration
The Compensation Task Administration screen enables administrators to configure and assign compensation planning and modeling tasks to managers in the organization. Only managers can be assigned a compensation task. While configuring a compensation task, administrators can select which compensation templates are used in the compensation plan, as well as the planning dates, the dates on which the compensation is based, the availability of the task, and also the approval and manager workflow.
To access Compensation Task Administration, go to Admin > Tools > Compensation Management > Tasks.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
Compensation Task - Create
To create a compensation task, click the Create Compensation Task link. See Compensation Task - Create - General on page 211 for additional information.
Compensation Tasks - Search
To search for an existing compensation task, enter the task name in the Name search field and click Search. You can also filter the results by type (Planning and Modeling) using the Type drop-down list. To include completed or expired tasks in the search results, select the Show completed/expired option. To include off-cycle tasks in the search results, select the Display Off Cycle Tasks option. 
Compensation Tasks
The compensation task table displays a list of all available and active compensation tasks, including both planning and modeling tasks. 
The following information is displayed for each task:
· Name
· Description
· Created By
· Task Period - This displays the duration of the compensation task for standard tasks. The task period is the time frame that managers have to complete the task. For off-cycle tasks, this is a relative date, so Off Cycle is displayed here.
· Status
· Active - When this option is selected, the task is active. When a task is deactivated, managers do not have access to the task. 
· If an off-cycle task is made inactive, the system does not check the date settings in the Assignment Criteria, so the off-cycle task is not assigned to any users. If the task is reactivated, the system does not retroactively auto-assign the task for days in the past.
· Dynamically Assigned - When this option is selected, the task is dynamically assigned to the managers that match the specified availability of the task. If a manager no longer matches the availability, they are removed from the task. If a manager changes positions and now matches the availability, they are assigned the task.
Options
The following options are available in the Options column:
· Copy - This option is only available to administrators with the Compensation Task Administration permission.
· Edit - This option allows administrators to modify the task. This option is only available while the task is Queued. Once the task is In Progress, the task cannot be edited. Instead, the View Settings option is available. This option is only available to administrators with the Compensation Task Administration permission.
· View Settings - This option displays a read-only view of the task settings. No changes can be made. This option is only available once the task is In Progress. The View Details option is only available for Off-Cycle, In Progress, Expired, and Completed tasks.
· For administrators with the Compensation Task Administration permission, this option is available for all In Progress tasks.
· For administrators with the Compensation Task Administration - Manage permission, this option is only available if the administrator is within the visibility settings for the task.
· Add User - This option allows you to manually add users to the task by OU, group, or individual users. This option is only available once the task is In Progress. If the task is Queued, users can be added to the task by modifying the availability in the Availability section. This option is only available to administrators with the Compensation Task Administration permission.
· View Details [image: ] - This option opens the task details, which displays an overview of the task progress and details. Administrators can also view the status of individual users, extend the task, adjust budgets, reset compensation plans, track compensation plans, etc. This option is only available once the task is In Progress. This option is only available to administrators See Compensation Task Details on page 363 for additional information.
· For administrators with the Compensation Task Administration permission, this option is available for all In Progress tasks.
· For administrators with the Compensation Task Administration - Manage permission, this option is only available if the administrator is within the visibility settings for the task.
· Delete - Only tasks with a status of Not Started can be deleted. This option is only available to administrators with the Compensation Task Administration permission.
Save
After making changes to the Active or Dynamically Assigned options, click Save to save the changes.
[bookmark: _Toc161996458]Create Task Overview
Compensation: 
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[bookmark: _Ref529292233][bookmark: _Ref-61660287]Compensation Task - Create - General
To create a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the Create Compensation Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Enter the following information for the compensation task:
· Task Name - This task name is displayed at the beginning of the task.
· Description - This description is displayed to administrators and managers when searching for tasks.
· Instructions - These instructions are displayed to managers when completing the task.
If multiple languages are available for your organization, you can click the globe icon to the right of the field to translate the field information to the available languages. 
[image: ]
Task Details
Select the appropriate settings for the compensation task:
· Task - Select whether the task is a Planning task or a Modeling task. A Planning task allows organizations to directly plan and adjust compensation, while a Modeling task allows organizations to set budgets and project financials for upcoming compensation planning.
· Task Type - Select whether the task is a Standard task or Off Cycle task. A Standard compensation task type is a task that is completed on a regular schedule in line with the organization's compensation adjustment schedule. An off-cycle compensation task is a task that can be initiated by a manager or administrator at any time on an ad hoc or off-cycle basis. Employees can be compensated through an off-cycle task more than once.
· Task Period (Standard task type) - Select the duration of the compensation task. This determines the amount of time managers have to complete the task. For Planning tasks, this period must occur after the end of the Compensation Period, but for Modeling tasks, this period may occur before or after the Compensation Period. Note: This option is only available when creating a standard compensation task.
· Task Due Date (Off Cycle task type) - In the field, enter the number of days the managers or administrators have to complete the compensation task. This due date is relative to the date on which the task is assigned. Note: This option is only available when creating an off-cycle compensation task.
· Compensation Period - Select the time period on which the employee is being compensated. For example, if a compensation period is set as the previous calendar year, then the compensation task determines any compensation adjustments based on the previous calendar year. All information referenced in the guidelines (e.g., review ratings, SMP ratings, goal ratings, assessment ratings) for the task that occurred during the previous calendar year is utilized in the compensation task. 
· Planning Tasks - For Planning tasks, this period must occur prior to the start of the Task Period.
· For Standard task types, select specific dates from the From and To calendar boxes.
· For Off Cycle task types, the Compensation Period is relative to the date on which the task is assigned. In the Starts field, determine when the period starts by entering the number of months before the task is assigned that the compensation period starts. Then, in the Duration field, enter the number of months that the period lasts. For example, if the period starts 12 months before the task is assigned and lasts 12 months, then the compensation is the entire 12 months prior to the date on which the task is assigned.
· Modeling Tasks - For Modeling tasks, the Compensation Period may occur in the future. Whether the compensation period occurs before or after the task period, the user's most recent Salary value is used for the task. For example, if the compensation period begins 1/1/2011 and a user's most recent salary of $60,000 was set on 5/1/2011, $60,000 is used for the modeling task.
· For Standard task types, select specific dates from the From and To calendar boxes. Because it is a modeling task, the Compensation Period may occur before or after the Task Period.
· For Off Cycle task types, the Compensation Period is relative to the date on which the task is assigned and can also occur before or after the task is assigned. In the Starts field, determine when the period starts by entering the number of months before or after the task is assigned that the compensation period starts. Then, from the drop-down list, specify whether the compensation period starts before or after the task is assigned. Lastly, in the Duration field, enter the number of months that the period lasts. For example, if the period starts 12 months before the task is assigned and lasts 12 months, then the compensation is the entire 12 months prior to the date on which the task is assigned.
· Compensation Manager (Standard task type) - Select the role that acts as the manager for the compensation task. The selected role is assigned the compensation task. Options include Manager, Administrator, and other custom employee relationships. Note: This option is only available when creating a standard compensation task.
· When Manager is selected, the task is assigned to all direct managers in the task availability. 
· When Administrator is selected, then the administrator can select a specific administrator to be assigned the compensation plan for a group of employees. 
· When a custom employee relationship is selected, all users who are within the task availability who are assigned as the selected custom relationship on one or more employee user records are be assigned the task. For each user assigned, all employees will appear in the task where the user is assigned as the selected custom relationship. For example, if User1 is assigned to 10 employees in the HR Generalist relationship, and HR Generalist is selected as the Compensation Manager, if User1 is in the task availability, then User1 is assigned the task and can see all 10 employees on the compensation plan. When a custom employee relationship is selected the following option appears:
· Display Roll-up and Plan Summary views by Compensation Manager hierarchy - This option is selected by default. 
· When selected, the Roll-up and Plan Summary views are displayed by compensation manager hierarchy. A warning message appears below the checkbox when selected warning the administrator that the compensation manager hierarchy must not contain any circular references. Circular references in the compensation manager hierarchy may cause the Roll-up and Plan Summary views to display incorrectly.
· When deselected, the Roll-up and Plan Summary views are displayed by manager-subordinate hierarchy.
· Co-Planner - Select this option to allow the compensation manager to add a co-planner for the compensation task. The compensation manager selects a co-planner, if enabled, at the beginning of the compensation task. The co-planner for the task is able to complete the task as though they were the manager assigned the review task. This can be useful for managers to delegate tasks.
· Admin Contact - Select an email contact for the task who serves as the support contact for users that are assigned the task. This is optional. If an admin contact is selected, a "Contact Administrator" link appears on the compensation task.
· Executive Roll-up - Select this option to enable compensation managers to access a subordinate's compensation plan. This option is deselected by default. If the Executive Roll-up option is not selected, the Compensation Plans tab for subordinate managers is not visible for compensation managers in the compensation task. When this option is selected, the administrator must determine the compensation manager's level of access:
· Read-Only access - This option is selected by default. With this access level, compensation mangers can only view a subordinate's compensation plan.
· Edit access - Selecting this option grants a compensation manager edit access to a subordinate's compensation plan. Edit access allows compensation managers to perform all actions that their subordinate manager is able to perform, which include the following:
· Create new draft compensation plans
· Edit or delete existing draft compensation plans that have not yet been submitted
· Copy draft compensation plans
· View draft compensation plans
· Submit draft compensation plans if a draft has not been submitted
· Considerations:
· This option is available for both planning and modeling tasks, but is not available for off-cycle tasks.
· As Executive Roll-up is a task-level setting, if Executive Roll-up is selected in the task configuration, the setting applies to all compensation managers associated with the task.
· Executive Roll-up functionality makes a subordinate manager's plan available based on the hierarchy as set for the Roll-up and Plan Summary views. If the compensation manager is set to be based upon the manager-subordinate hierarchy, this is automatically used for the Roll-up and Plan Summary views. Therefore, if there are circular references in the hierarchy, the Executive Roll-up functionality will not function as designed.
· The compensation manager hierarchy view cannot contain any circular references.
· Co-planners for compensation managers have the same view as the compensation manager, which includes the settings for Executive Roll-up.
· Lock User Status - Select this option to select the date on which a user's Active status is locked. When the user's status is locked, changes to their Active status on or after the defined date within the task period do not trigger the compensation task to be reset. This option is unchecked by default. When it is selected, an explanation of the field appears below the checkbox. Note: The lock takes effect at 12:00 am GMT on the start date specified.
· In the calendar field, define the start date on which to lock the user's Active status. The start date must fall within the task period.
· The field can be edited while the task is in a Queued or Not Started status and can be turned on or off when copying a task. The option is available for both Compensation Modeling and Planning tasks. The option is not available for off-cycle task types.
· When this option is selected, changes to a user's Active status are still updated on the user record.
· Regardless of the configuration of this option, Eligibility Flags set in Compensation Templates and changes made in the OU structure still apply and trigger resetting of the compensation task as appropriate.
· When this option is checked, changes to a user's Active status do not affect the budgets in a compensation plan - when using a fixed amount budget. The user is treated as Active for the task and is not removed from budget calculations. Note: When using a budget type of "% of base" the budget will be reduced with deactivation of users, even when this option is selected.
[image: ]
Click here to view automatic reset scenarios
The scenarios below provide information about when a compensation task may be reset, deactivated, or activated automatically for some users. 
 
	Scenario
	Details

	User is deactivated
	·  If Lock User Status = No, or Lock User Status = Yes and deactivation happens before the lock date: 
· If the task is in the Completed or Pending Approval status, the task of the user’s manager or user’s custom relationship is reset. 
· If the user is a manager or custom relationship for other users, the user’s task is deactivated. 
· If Lock User Status = Yes and deactivation happens after the lock date and the user is a manager or custom relationship for other users, user’s task is deactivated.

	User is activated, for example, a few days after deactivation
	· If Lock User Status = No, or Lock User Status = Yes and deactivation happens before the lock date: 
· If the task is in the Completed or Pending Approval status, the task of the user’s manager or user’s custom relationship is reset.
· If the user is a manager or custom relationship for other users, the user’s existing deactivated task is activated. 
· If Lock User Status = Yes and activation happens after the lock date and user is a manager or custom relationship for other users, the user’s existing deactivated task is activated

	User is assigned a manager or custom relationship, for example, upon user creation
	 If the task is in the Completed or Pending Approval status, the task of the user’s assigned manager or custom relationship is reset.

	User’s manager or custom relationship is changed
	 If the tasks are in the Completed or Pending Approval status, the tasks of the user’s old manager / custom relationship and new manager / custom relationship, is reset.


Assignment Criteria
Note: The Assignment Criteria section is only available when the Task Type is set to Off-Cycle.
This section enables administrators to determine how the off-cycle compensation task is assigned. Administrators can choose to allow managers to assign the task via My Team, as previously implemented, or to automatically assign the task based on an employee's unique date field (hire date, last hire date, last performance review completion date, or any other date type User custom field. Off-cycle compensation tasks can continue to be launched by administrators through the Task Details Page, regardless of Assignment Criteria options.
These options apply to both planning and modeling off-cycle compensation tasks.
In the Assignment Criteria section, the following options are available:
· All tasks will be launched by managers and/or administrators - Select this option to enable managers or administrators to launch the off-cycle compensation task. This option is selected by default.
· Tasks will be assigned based on Employee's XXX - Select this option to have the off-cycle compensation task assigned to users based on the defined date criteria. From the drop-down list, select the date field on which the assignment is based. The options include Hire Date, Last Hire Date, Last Performance Review Completion Date, and other Date-type User custom fields. If this option is selected, managers cannot launch the task via My Team.
· In the field, enter the number of days before or after the selected date the off-cycle task should be assigned. The accepted values are 0-364.
· From the drop-down list, select whether the off-cycle task should be assigned before or after the selected date. For example, to assign the off-cycle task 30 days after the completed performance review, enter "30" in the field and select "After" from the drop-down list. 
· The off-cycle compensation task can be assigned to a compensation manager multiple times for the same user if the selected date occurs multiple times. For example, if the selected date occurs annually, then the off-cycle task is assigned annually as well. However, only one instance of the same off-cycle compensation task can be assigned for the same user. If an employee has an off-cycle task already in progress for them, another instance of the same task cannot be automatically assigned.
· From the Compensation Manager drop-down list, select the relationship that is assigned as the compensation manager for the off-cycle task. The options include Manager, Administrator, and all custom relationships. The Compensation Manager must match the Availability criteria for the off-cycle task to be assigned to them.
Note: An employee who meets the settings defined in the Assignment Criteria section and has a compensation manager who meets the availability criteria must also meet the eligibility criteria for at least one of the templates included in the task. Otherwise, the task is not launched for the user.
[image: ]
Currency
From the drop-down list, select the default currency preference of the task. The available options are:
· Corporate Currency - The manager can only make adjustments on the compensation plan in the default corporate compensation currency for the portal. If multiple currencies are in use, this option should be selected as the currency preference for the task. All amounts are converted based on the most recent conversion rates pulled into the task when the task start date is reached. Once the conversion rates are pulled in, they are locked for the entire life of the task and cannot be modified.
· Compensation Manager's Currency - The manager can only make adjustments on the compensation plan in the manager's own compensation currency. 
· Employee's Local Currency - The manager can only make adjustments on the compensation plan in each employee's local currency.
[image: ]
Base, Bonus, and Equity Templates
Click the Add Template icon (plus sign) to the right of the Base, Bonus, or Equity Template heading to select one of the existing active templates to include. You also have the option to create a new template by clicking the Create Template icon. See Compensation Plan Templates on page 130 for additional information.
Only one template can be added for each section (Base, Bonus, Equity). At least one template must be selected for the task, but a template is not required for each section, providing greater flexibility on what is comprised within the compensation plan.
Once a template is added to the task, it appears in the corresponding Template section with the Component and Budget pre-populated. Note: For modeling tasks, the Budget value is not displayed, as budgets are not used in modeling tasks.
Effective Date - For off-cycle planning tasks, you are able to set the Effective Date of the compensation adjustment.
· XX Day(s) after task is completed and approved - Select this option to set an effective date that is relative to the date on which the task is completed and approved. When this field is selected, enter the number of days after the task is completed and approved that the compensation changes should be effective. This option is selected by default.
· Allow assigner to define the effective date at the launch of the task - Select this option to allow the task assigner to define a fixed effective date for the associated template at the time the task is launched. This option is only available if the All tasks will be launched by managers and/or administrators option is selected in the Assignment Criteria section
Note: Effective date options are not available for modeling tasks because modeling tasks are compensation projections and do not update a user's compensation values.
Tab Title - You can also customize the Tab Title. The character limit for the field is 15.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
[image: ]
Template Details
Note: The Template Details section only appears if a template with a fixed amount, % of base, or cascaded component budget type is added to the task. If a new template is created in the Base Template, Bonus Template, or Equity Template section and the template includes a cascaded component budget type, then the Cascaded Budget Lock field appears. If a new template is created in the Base Template, Bonus Template, or Equity Template section and the template includes a fixed amount or % of base budget type, then the Budget Adjustment option appears.
Template Details - Budget Adjustment
Budget Adjustment - Select this option to allow compensation managers to adjust the budgets of their subordinate employees and the subordinate employee's direct reports within a specified threshold.
Individual component budget adjustments - This option is only available once the Budget Adjustment option is selected. In the field, define the threshold within which the budget can be adjusted. One to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting. If a value is not entered, compensation managers do not have a threshold when adjusting the budgets of their subordinate employees or the subordinate employee's direct reports.
· The Budget Adjustment option is only available for standard compensation tasks.
· The Budget Adjustment setting applies to the overall task. All compensation managers assigned to a task for which the setting is turned on have the ability to adjust all component budgets included in the task for their subordinates.
· Budget adjustments only apply to components with fixed amounts and % of Base budget types. Cascaded budget types are not adjustable.
· Compensation managers can only adjust budgets for subordinates when the task is in a Not Started or In Progress status. Or, if the option is selected to include tasks that are in a Pending Approval status, then the budgets for those tasks can also be adjusted. Approved plans are not affected by the budget adjustment.
· The compensation manager view hierarchy cannot contain any circular references.
Availability - This option determines which compensation managers within the compensation task are able to adjust budgets for subordinate compensation managers. Availability can be set by OU, group, or user. If no availability is defined, then all compensation managers in the task are able to adjust budgets for subordinate compensation managers. Note: This option is only available once the Budget Adjustment option is selected.
· Include Subordinates - Select this option to also allow subordinate OUs, groups, or users to adjust budgets.
· Once a compensation task has been started (i.e., at least one compensation manager has saved or submitted a compensation plan), administrators can no longer modify the Availability criteria.
Template Details - Cascaded Budget Lock
Define when cascaded component budget types lock their budgets by selecting from the following options. Compensation tasks check this setting such that cascaded budgets type components lock their budgets at the appropriate time.
Submission - Select this option to lock budgets at the time of submission. The Budget is locked for all components with cascaded budget types after the plan is submitted or approved/denied. This option is selected by default. Note: During the approval process, if the approver edits the plan before approving or denying it and the edits result in changes to the allocations of any of the components with a cascaded budget type, the locked budgets will reflect the approver's allocations.
Days after submission or upon next level approval - Select this option to lock budgets a set number of days after submission or upon next level approval, whichever occurs first. Enter the number of days in the numeric text field. The number must be a whole number. The number of days from submission is calculated based on the date of the last submission.
· If a Task is reset before the budgets are locked, the number of days' calculation is canceled until the next time the task is submitted. The number of days then restarts based on this last submission date of the plan.
· Days are counted as full days after the submission. The lock occurs at midnight of the day specified. For example, if a compensation manager submits a plan midday Monday and the task is set to lock budgets after three days, the lock occurs on Friday at midnight, with Tuesday through Thursday counting as three full days.
· Note: During the approval process, if the approver edits the plan before approving it and the edits result in changes to the allocations of any of the components with a cascaded budget type, the locked budgets reflect the approver's allocations. That is, the locked budget reflects the final approved values. During the approval process, if the approver edits the plan before denying it and the edits result in changes to the allocations of any of the components with a cascaded budget type, the locked budgets reflect the last approved budgets. But, the plan reflects the approver's allocations.
· The cascading budget lock feature applies to both standard and off-cycle compensation tasks and is available for Compensation Planning tasks.
· For tasks with multiple approvers/approval steps in the approval workflow, cascaded budget types lock their budgets at each level of approval.
· If Days after submission or upon next level approval option is selected and the next level of approval contains an approval condition that results in skipping the level, the components with cascaded budget types will not have their budgets locked until the number of days specified has passed or the next applicable approver in the approval workflow approves the task.
· If the Days after submission or upon next level approval option is selected and the next level of approver denies the plan before the number of days has expired (for example, before the budgets are locked by the time trigger), the locked budgets will reflect the last approved budgets and the time trigger will not apply until the compensation manager submits the plan. Upon submission of the plan, the number of days is automatically reset and based upon the date of the plan's submission.
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Compensation Statement
In this section, using the calendar tool, select the date on which the compensation statement for the task is available to the employee. The earliest date that the statement can be made available is the end of the task period.
Click the Add Custom Fields link to select appropriate custom compensation fields to appear on the compensation statement.
You can also click the Add Custom Statement icon (plus icon [image: ]) to the right of the Compensation Statement heading to select one of the existing active templates to include. You also have the option to create a new custom statement by clicking the Create Custom Statement icon. See Custom Compensation Statements on page 54 for additional information.
The Allow Compensation Managers to generate Compensation Statements for their subordinates field enables compensation mangers to download their employees' and employees' teams compensation statements on or after the date specified in the Employee Compensation Statement Available field. The field is unchecked by default. When checked, an explanation of the field appears below the checkbox. This option is not available for off-cycle task types.
· If the option is enabled, then on the compensation task User Profile Dashboard, Download Statement and Download Team Statements links appear. Clicking the links allows compensation managers to download a compensation statement for one employee or for the employee's direct reports.
· Compensation managers can also download compensation statements for subordinate compensation managers when viewing the subordinate's compensation task.
· Since bulk compensation statements settings apply at the task level, every compensation manager included in the compensation task has the same setting for the associated task.
· The compensation manager hierarchy used in the Roll-up and Plan Summary views cannot contain any circular references.
· Compensation managers that do not have subordinate compensation managers are only able to download compensation statements for their teams. They are not able to individually download compensation statements for each of their employees.
· The compensation statements generated via the Download Team Statements link by the compensation manager hierarchy used in the Roll-up and Plan Summary views cannot contain any circular references.
Note: The Compensation Statement section is not available when Modeling is selected as Task option within the Task Details section.
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Back, Cancel, or Next
Click Cancel to discard any unsaved changes that have been made to the compensation task and return to the Compensation Task Administration page. See Compensation Task Administration on page 207 for additional information.
Click Next to proceed to the Availability step. See Compensation Task - Create - Availability on page 223 for additional information.
Compensation: 
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[bookmark: _Ref-1924043415][bookmark: _Ref-1586261031]Compensation Task - Create - Availability
The Availability step is the same for Planning and Modeling tasks.
On the Availability step, select the managers that are assigned the compensation task. Any manager that falls within the selected availability is assigned the compensation task.
To create a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the Create Compensation Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
Availability
To set the availability, from the drop-down list, select the OU type you are using to select managers. For example, if you are selecting the managers by position, select the Position OU from the drop-down list. Then click the pop-up icon to select the appropriate OUs.
To include subordinate OUs in the availability selection, select the Include Subordinates option.
Visibility
This section enables the administrator to define which administrators are able to view the compensation task in the Compensation Task Administration page. This also determines which administrators can view the View Details option for the task on the Compensation Task Administration page. Administrators must also have the Compensation Task Administration - Manage permission in order to view and manage the compensation task. When an administrator has access to a compensation task, the administrator can view the task details, extend the task, adjust budgets, reset compensation plans, track compensation plans, etc.
Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks, regardless of the Admin Visibility settings. Also, they do not require the Compensation Task Administration - Manage permission.  
Visibility can be set by OU, Group, or specific users. Select the Include Subordinates option to include subordinate OUs or users.
Back, Cancel, or Next
Click Back to navigate to the General step. See Compensation Task - Create - General on page 211 for additional information.
Click Cancel to discard any unsaved changes that have been made to the compensation task and return to the Compensation Task Administration page. See Compensation Task Administration on page 207 for additional information.
Click Next to proceed to the Layout step. See Compensation Task - Create - Layout on page 225 for additional information.
[bookmark: _Ref544953951][bookmark: _Ref1824171075]Compensation Task - Create - Layout
The Layout step enables administrators to configure the layout and contents of the Summary, Read-Only, and Approval views of the compensation task. The layout and contents of the Base, Bonus, and Equity pages is configured within the corresponding plan templates.
To create a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the Create Compensation Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the Summary, Read-Only, and Approval views of the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. 
Note: This configuration affects the layout and contents of the Summary, Read-Only, and Approval views of the compensation task. The layout and contents of the Base, Bonus, and Equity pages is configured within the corresponding plan templates. 
See Compensation Task - Create - Layout - Column Layout on page 230 for additional information.
Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view on the Summary, Read-Only, and Approval views of the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. 
See Compensation Task - Create - Layout - Expanded View Layout on page 234 for additional information.
Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the compensation task. This section is not available for compensation modeling tasks. 
See Compensation Task - Create - Layout - Budget Layout on page 228 for additional information.
Preview
Click this button to preview how the Summary, Read-Only, and Approval views of the compensation task will appear to compensation managers. 
The preview pop-up contains sample data. All hyperlinks and JavaScript are disabled. Only the selected view is displayed; no other tabs of the compensation task are included in the preview.
Back, Cancel, or Next
Click Back to navigate to the Availability step. See Compensation Task - Create - Availability on page 223 for additional information.
Click Cancel to discard any unsaved changes that have been made to the compensation task and return to the Compensation Task Administration page. See Compensation Task Administration on page 207 for additional information.
Click Next to navigate to the Workflow step. See Compensation Task - Create - Workflow on page 238 for additional information.
[image: ]
[bookmark: _Ref1264704428]Compensation Task - Create - Layout - Budget Layout
The Budget Layout section enables administrators to configure the visibility of components within the compensation task. This section is not available for compensation modeling tasks. 
[image: ]
The Available Components field lists all of the components that are added to the compensation task's templates. Components are displayed in the Available Components field in alphabetical order. An asterisk appears to the left of each component that cannot be hidden from the task because the component has a defined budget.
The Component Visibility field displays the areas in which the component may be able to be hidden. The visibility options are only editable if the budget for the component is set to "None." If the component's budget is configured by OU, then the visibility options are only editable if the budget is set to "None" for all OUs, including the default budget. Further, if a component budget is changed from "None" to a different budget type, then the visibility options are automatically selected for the component, regardless of the previous setting of the options. Which areas are available is dependent on the task type.
The following areas are available for standard compensation tasks:
· Compensation Dashboard - This option determines whether the component is visible in the User Profile Dashboard within the compensation task. By default, this option is selected for all components.
· Roll-up Summary - This option determines whether the component is displayed as a column in the Roll-up Summary tab of the compensation task. By default, this option is selected for all components. Note: This option is not available if "Administrator" is selected in the Compensation Manager field on the General tab.
· Plan Summary - This option determines whether the component is displayed as a column in the Plan Summary tab of the compensation task. By default, this option is selected for all components. Note: This option is not available if "Administrator" is selected in the Compensation Manager field on the General tab.
· Pending Approvals - This option determines whether the component is displayed as a column in the Pending Approvals tab of the compensation task. By default, this option is selected for all components. Note: This option is not available if "Administrator" is selected in the Compensation Manager field on the General tab.
· Summary Tab/Approved Compensation Plans - This option determines whether the component is visible in the Budget Summary graph on the Summary/Approve tab of the compensation plan. This does not hide the component as a column on the Summary Tab/Approved Compensation Plans page. By default, this option is selected for all components.
The following areas are available for off-cycle compensation tasks:
· Compensation Dashboard - This option determines whether the component is visible in the User Profile Dashboard within the compensation task. By default, this option is selected for all components.
· Summary Tab/Approved Compensation Plans - This option determines whether the component is visible in the Budget Summary graph on the Summary/Approve tab of the compensation plan. This does not hide the component as a column on the Summary Tab/Approved Compensation Plans page. By default, this option is selected for all components.
[bookmark: _Ref1838038821]Compensation Task - Create - Layout - Column Layout
The Column Layout section enables administrators to select which compensation columns appear on the Summary, Read-Only, and Approval views of the compensation task. Administrators are also able to customize the column name that is displayed on the compensation task. 
Note: This configuration affects the layout and contents of the Summary, Read-Only, and Approval views of the compensation task. The layout and contents of the Base, Bonus, and Equity pages is configured within the corresponding plan templates. 
[image: ]
Available columns
The Available columns field lists all of the available fields that can be added as a column to the Summary, Read-Only, and Approval views of the compensation task. Fields are displayed in the Available columns field in alphabetical order. 
The Available columns field only displays fields that have not yet been added to the view. In order for a field to be displayed as a column, it must be moved to the Display columns field. See the Columns - Add to Display section below for additional information.
Components that appear in the Available columns field do not appear in the Summary, Read-Only, and Approval views of the compensation task.
By default, the following fields appear in the Available columns field when a compensation task is created:
· Current Compa-Ratio
· New Compa-Ratio (if a base template is included in the task)
· Total Increase (if a base template is included in the task)
· <Base components that are included in the Base Salary that are hidden on the base template> (if a base template is included in the task)
· <Bonus components that are hidden on the bonus template> (if a bonus template is included in the task)
· For each bonus component, the following components are available:
· <Bonus component> - Target
· <Bonus component> - % Attained
· <Bonus component>
· <Equity components that are hidden on the equity template> (if an equity template is included in the task)
· For each equity component, the following components are available: 
· <Equity component> - Target
· <Equity component> Award/Grant
Display columns
The Display columns field lists all of the fields that have been added as a column to the Summary, Read-Only, and Approval views of the compensation task. In order to hide a column from the display, it must be moved to the Available columns field. See the Columns - Remove from Display section below for additional information.
Columns are displayed in the Display columns field in the order in which they will appear on the Summary, Read-Only, and Approval views of the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. See the Columns - Change Display Order section below for additional information.
Administrators are able to customize the column names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
By default, the following fields appear in the Display columns field when a compensation task is created:
· Name - This column cannot be removed from the Display columns field. Also, this column must appear first.
· Performance
· Hire Date
· Length of Service
· Currency
· Current Salary/Rate
· <Base components that are included in the Base Salary that are included on the base template> (if a base template is included in the task)
· New Salary/Rate (if a base template is included in the task)
· Lump Sum (if a base template is included in the task)
· Non-Monetary Components - "These fields have an asterisk next to it, and it cannot be renamed or removed from the Display Columns field. To remove it, you must remove it from the Non-Monetary Components section on the General page. All non-monetary components are grouped together at the bottom of the Display Columns list."
· <Base components that are not included in the Base Salary that are added to the base template> (if a base template is included in the task)
· <Bonus components that are included on the bonus template> (if a bonus template is included in the task)
· For each bonus component, the following components are available:
· <Bonus component> - Target
· <Bonus component> - % Attained
· <Bonus component>
· <Equity components that are included on the equity template> (if an equity template is included in the task)
· For each equity component, the following components are available: 
· <Equity component> - Target
· <Equity component> Award/Grant
Add Fields
Administrators can add user fields and performance, succession, and competency metrics to the Summary, Read-Only, and Approval views of the compensation task.
To add fields, click the Add Fields link at the top of the Display columns field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the Display columns field.
Once fields are added, they remain visible in either the Available columns or Display columns field after the task is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the task.
Selected field and Display name
When a single field is selected in the Available columns or Display columns field, the Selected field field displays the default name of the selected field. If more than one field is selected or if no field is selected, then this field is blank.
While the Selected field field displays the default name for the selected field, administrators are able to customize the column name that is displayed to compensation managers on the compensation task. To customize the column name, enter a new column name in the Display name field, up to 100 characters. This is the column name that will appear on the compensation task. This field does not accept HTML.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation task. The change does not affect any other compensation tasks or templates in which the corresponding field appears.
· By default, the Display name field contains the field's display name from the last template (base, bonus, equity) in which the field has been configured to be displayed.
· A display name is required for each column, regardless of whether it is included in the Available columns or Display columns field.
Note: The Display name field appears gray and is inactive if more than one field is selected, no field is selected, the selected field is in the Available columns field, or the selected field is a component that is included in the task.  
If a component field in the Display name field is selected, an Include as percentage of base option is available the right of the Selected field field. When this option is selected, the component allocations appear as the fixed amount and as a percentage of the employee's Base Salary on the Summary, Read-Only, and Approval views of the compensation task. When this option is not selected, the component allocations appear as the fixed amount only on the Summary, Read-Only, and Approval views; the allocations as a percentage of the employee's Base Salary appear in the expanded employee view.
Columns - Add to Display
The Available Columns field only displays fields that have not yet been added to the display. In order for a field to be displayed as a column, it must be moved to the Display Columns field. To add a column to the display, select the field from the Available Columns field and click the Move Right button [image: ], which is to the right of the Available Columns field. The selected item is added to the bottom of the Display Columns field. The display order of the column can then be modified, if necessary. See the Columns - Change Display Order section below for additional information.
Administrators can move multiple fields to the Display Columns field by selecting multiple fields prior to clicking the Move Right button.
Columns - Remove from Display
The Display Columns field lists all of the fields that have been added as a column to the display. In order to hide a column from the display, it must be moved to the Available Columns field. To remove a column from the display, select the field from the Display Columns field and click the Move Left button [image: ], which is to the left of the Display Columns field. The selected item is added to the Available Columns field in alphabetical order.
Administrators can move multiple fields to the Available Columns field by selecting multiple fields prior to clicking the Move Left button.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display Columns field.
Columns - Change Display Order
Columns are displayed in the Display Columns field in the order in which they will appear on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the column that appears at the top of the Display Columns field will appear as the first column on the compensation task, and the column that appears at the bottom of the Display Columns field will appear as the last column on the compensation task.
Note: The Name column must always appear as the first column on the compensation task. Because of this, the display order cannot be changed for the Name column. In addition, no column can be moved above the Name column.  
To change the display order for a column, select the field from the Display Columns field and click the appropriate button to the right of the Display Columns field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected column to the top of the list, below the Name column.
· Move to Bottom [image: ] - Click this button to move the selected column to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected column up one position. No column can be moved above the Name column.
· Move Down [image: ] - Click this button to move the selected column down one position. 
Administrators can move multiple columns by selecting multiple fields prior to clicking the appropriate Move button.
[bookmark: _Ref-1727788445]Compensation Task - Create - Layout - Expanded View Layout
The Expanded View Layout section enables administrators to select which compensation fields appear in the expanded employee view on the Summary, Read-Only, and Approval views of the compensation task. Administrators are also able to customize the field name that is displayed on the compensation task. 
[image: ]
Available fields
The Available fields field lists all of the available fields that can be added to the expanded employee view on the Summary, Read-Only, and Approval views of the compensation task. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the performance data is moved to the Display fields field, then the Performance Data category does not appear in the Available fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. The following categories may be available:
· Salary Data - This category includes salary data fields, such as Aggregate Company Data and Labor Hours.
· Performance Data - This category includes Competency, Performance, and Succession fields.
· Additional Information - This category includes User and OU fields.
Data fields in the Available fields field are displayed in alphabetical order within each category. 
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. See the Fields - Add to Display section below for additional information.
Components that appear in the Available fields field for a template do not appear in the corresponding expanded employee view.
Display fields
The Display fields field lists all of the fields that have been added to the expanded employee view on the Summary, Read-Only, and Approval views of the compensation task. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the performance data is removed from the Display fields field, then the Performance Data category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. See the Fields - Remove from Display section below for additional information.
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the Summary, Read-Only, and Approval views of the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. See the Fields - Change Display Order section below for additional information.
Administrators are able to customize the category and field names that are displayed to compensation managers on the compensation plan. See the Selected field and Display name section below for additional information.
The following categories and fields are available by default:
· Salary Data
· Wage Type
· Salary Range
· Market Rate - This field is available if Market Rate is enabled in the Salary Structure.
· Base - This category is available if a base template is included in the task.
· Current Salary
· Current Compa-Ratio
· Merit Increase - This field is available if it is included in the base template.
· <Bonus components that are included in the Base Salary>
· New Salary
· New Compa-Ratio
· Lump Sum - This field is available if it is included in the base template.
· <Bonus components that are not included in the Base Salary>
· <Bonus components> - This category is available if a bonus template is included in the task.
· <Bonus> - Target
· <Bonus> - Recommended
· <Bonus>
· <Bonus> - % Attained
· <Equity components> - This category is available if an equity template is included in the task.
· For Awards:
· <Equity> - Target
· <Equity> - Recommended
· <Equity>
· For Shares:
· <Equity>
· Performance Data - This category includes Competency, Performance, and Succession fields that were manually added. See the Add Fields section below for additional information.
· Additional Information - This category includes User and OU fields that were manually added. See the Add Fields section below for additional information.
Add Fields
Administrators can add user, OU, competency, performance review, and succession fields to the expanded employee view on the Summary, Read-Only, and Approval views of the compensation task.
To add fields, click the Add Fields link at the top of the Display fields field. This opens the Search Fields and Metrics pop-up. Select the appropriate fields and click the Add button. The selected fields are added in alphabetical order at the bottom of the appropriate category in the Display fields field.
Once fields are added, they remain visible in either the Available fields or Display fields field after the template is saved. However, if the administrator cancels the changes after the fields are added, then the added fields are removed from the template.
Selected field and Display name
When a single field or category is selected in the Available fields or Display fields field, the Selected field field displays the default name of the selected field or category. If more than one field or category is selected or if no field or category is selected, then this field is blank.
While the Selected field field displays the default name for the selected field or category, administrators are able to customize the name that is displayed to compensation managers on the Summary, Read-Only, and Approval views of the compensation task. To customize the field or category name, enter a new name in the Display name field, up to 100 characters. This is the field or category name that will appear on the compensation plan. This field does not accept HTML.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· When a display name is modified, the change only applies to the current compensation task. The change does not affect any other compensation templates or tasks in which the corresponding field or category appears.
· By default, the display name is the same as the default field or category name. 
· A display name is required for each field and category, regardless of whether it is included in the Available fields or Display fields field.
· For fields that are used in multiple templates, the display name for the Summary, Read-Only, and Approval views of the compensation task is taken from the template that was last added to the task.
If the Aggregate Company Data field in the Display name field is selected, a Grade, Position, and Division option is available the right of the Selected field field. Select the appropriate OUs by which the data should be aggregated on the Summary, Read-Only, and Approval views of the compensation task.
The Available fields field only displays fields that have not yet been added to the employee expanded view. In order for a field to be displayed in the expanded view, it must be moved to the Display fields field. To add a field to the display, select the field from the Available fields field and click the Move Right button [image: ], which is to the right of the Available fields field. The selected item is added to the bottom of the appropriate category in the Display fields field. The display order of the field can then be modified, if necessary. See the Fields - Change Display Order section below for additional information.
An entire category can be moved to the Display fields field by selecting the category and clicking the Move Right button. The selected category is added to the bottom of the Display fields field.
Administrators can move multiple fields to the Display fields field by selecting multiple fields prior to clicking the Move Right button.
Fields - Remove from Display
The Display fields field lists all of the fields that have been added to the expanded employee view on the compensation template. Fields are grouped into categories, and the categories are only displayed if there are available fields within the category. For example, if all of the performance data is removed from the Display fields field, then the Performance Data category does not appear in the Display fields field. The category titles are based upon the system default title headers for the section in the expanded employee view. In order to hide a field from the display, it must be moved to the Available fields field. 
To remove a field from the display, select the field from the Display fields field and click the Move Left button [image: ], which is to the left of the Display fields field. The selected item is added to the appropriate category in the Available fields field in alphabetical order.
Administrators can move multiple fields to the Available fields field by selecting multiple fields prior to clicking the Move Left button.
An entire category can be removed from the Display fields field by selecting the category and clicking the Move Left button. The selected category is removed from the Display fields field.
Fields that cannot be removed from the display are denoted with an asterisk (*) next to the column name in the Display fields field.
Fields - Change Display Order
Categories and fields are displayed in the Display fields field in the order in which they will appear in the expanded view on the compensation task. The display order can be modified by the administrator by changing the order in which they appear in this field. For example, the field that appears at the top of the Display fields field will appear as the first field on the left in the expanded employee view on the compensation task, and the field that appears at the bottom of the Display fields field will appear as the last field on the right in the expanded employee view on the compensation task.
To change the display order for a field, select the field from the Display fields field and click the appropriate button to the right of the Display fields field. The following options are available:
· Move to Top [image: ] - Click this button to move the selected field to the top of the list.
· Move to Bottom [image: ] - Click this button to move the selected field to the bottom of the list.
· Move Up [image: ] - Click this button to move the selected field up one position.
· Move Down [image: ] - Click this button to move the selected field down one position. 
Administrators can move multiple field by selecting multiple fields prior to clicking the appropriate Move button. In addition, administrators can move an entire category by selecting the category prior to clicking the appropriate Move button.
Compensation: 
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[bookmark: _Ref-1566113267]Compensation Task - Create - Workflow
The Workflow step is the same for Planning and Modeling tasks.
On the Workflow step, administrators first determine the approval workflow for the task by adding approval steps for the task and then ordering them and add any necessary approval conditions.
After setting the approvals, administrators can determine the workflow in the event than a compensation manager falls out of the availability of the task. Note: The Manager Workflow section is not available for off-cycle tasks.
To create a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the Create Compensation Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
Approvals
In the Approvals section, you set the approval workflow for the task. The approval workflow outlines the sequence of approvals that are in necessary once the compensation task is completed by the manager. Multiple levels of approval can be added to the task.
To add an approval level, click the plus icon to the right of the Approvals heading. This opens the Select Approvers pop-up where you can select the necessary approvers. The options include Manager, indirect managers, cost center approvers, User, as well as custom employee relationships. If User is added as an approver, you must then select the appropriate users.
To add an approval condition to an approval step, click the Add Approval Condition icon to the left of the approval step. See Approval Conditions below for additional information.
The number field to the left of the approval step determines the order in which the approval steps occur (i.e., the step with an order value of 1 occurs first if the approval condition is met, the step with an order value of 2 occurs second if the approval condition is met, and so on). If the approval condition for a step is not met, the approval step is skipped. To reorder the approval steps, set the order values to the appropriate values. The values must be integers greater than zero.
To allow an approvers within the approval workflow to edit the plan during the approval process, select the Allow edit during approval option to the right of the appropriate approver. The option is unchecked by default. Checking this option grants the approver edit rights, allowing them to edit submitted compensation plans, log additional comments related to individual user adjustments, and approve/deny plans. Note: This option is only available for standard compensation tasks. 
· Approvers that are not granted edit rights can still view plans and approve/deny them.
· If a co-planner is designated as an approver and the original approver is given rights to edit plans during the approval workflow, the co-planner has the same edit rights as the approver.
· Co-planners have the same approval rights as the approver.
Select the Allow Line Item Approval or Allow indirect managers to override approval options if necessary. 
Approval Conditions
After the necessary approvals are added to the task, you can set an approval condition for each approval. Approval conditions are used to determine if the approval step is included in the approval process. If the condition is not met, then the approval step is not included. If no approval condition is set for an approval, the approval is always included in the process. The criteria for defining a condition encompasses all compensation components used in the compensation task, including Merit Increase, Market Adjustment, COLA, Promotion, all Bonus types, and all Equity types. 
Approval Conditions can be used to create additional levels of approval if a certain adjustment is above or below a certain threshold. To set an approval condition for an approval, click the Add Approval Condition icon [image: ] to the left of the approval step. The Define Approval Condition pop-up opens. 
[image: ]
The available approval condition options are:
· No Approval Condition
· Merit Increase
· Market Adjustment
· COLA (Cost-of-Living Allowance)
· All bonus types (Standard and custom bonus types)
· All equity types
Note: Compensation components that are not included in the compensation task do not appear in the drop-down list.  
Only one component can be included in the approval condition. If No Approval Condition is selected, then the approval step does not contain an approval condition and is included in the approval process as a standard approval step.
When an approval condition option is selected from the drop-down list, an operator field appears with the following selections:
· Greater Than
· Greater Than or Equal
· Less Than
· Less Than or Equal
[image: ]
After selecting an operator (e.g., Greater Than, Less Than), you can either enter a percentage value in the percentage field or enter a monetary amount in the monetary field. One of these options is required. When entering percentage values, one to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
After entering all of the appropriate details, click Save. The approval condition details appear in parenthesis to the right of the approval step. Once an approval condition is saved, you can modify the condition by clicking the Add Approval Condition icon again. Within the pop-up, you can either edit the details and then click Save or click the Remove button to remove the condition.
Manager Workflow
In the Manager Workflow section, determine the workflow in the event than a compensation manager falls out of the availability of the task. Note: The Manager Workflow section is not available for off-cycle tasks.
If the option in the Manager Workflow section is selected, when a compensation manager no longer matches the availability of the compensation task, the compensation task is no longer assigned to that compensation manager. That compensation manager is no longer responsible for that particular compensation task.
If the option is not selected, the compensation task remains assigned to the compensation manager even if they no longer match the availability of the compensation task.
Back, Cancel, or Next
Click Back to navigate to the Layout step. See Compensation Task - Create - Layout on page 225 for additional information.
Click Cancel to discard any unsaved changes that have been made to the compensation task and return to the Compensation Task Administration page. See Compensation Task Administration on page 207 for additional information.
Click Next to proceed to the Summary step. See Compensation Task - Create - Summary on page 242 for additional information.
Compensation: 
Compensation: Compensation Overview
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[bookmark: _Ref-426731425]Compensation Task - Create - Summary
The Summary step is nearly the same for Planning and Modeling tasks. With modeling tasks, the effective dates are not implemented, so they are not displayed.
On the Summary step, a summary of the compensation task is displayed. Review the details of the task, and then click Save to save the task.
If you need to make changes to the task prior to saving the task, you can click Back to go to the previous step, or you can click the appropriate link in the left navigation to go to the appropriate step to make the necessary changes.
Important Note: A compensation task CANNOT be edited once it has been started by any compensation manager.
To create a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the Create Compensation Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
[bookmark: _Toc161996459]Complete a Compensation Task
To access a compensation task, go to Home > Scheduled Tasks. Then click the compensation task title.
Note: When referring to the compensation manager and their subordinates, this assumes that the compensation manager and their subordinates have been assigned the same compensation task.
[image: ]
Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation manager who is completing the compensation task. If the co-planner is completing the compensation task, then the name of the compensation manager for whom the co-planner is planning is displayed.
When the compensation manager navigates to view the User Profile Dashboard of a subordinate, then the subordinate's name is also displayed in the breadcrumbs.
[image: ]
User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components.  
See Compensation Task - User Profile Dashboard on page 246 for additional information.
See Compensation Task - Options Drop-down on page 263 for additional information.
Compensation Task Tabs
Below the User Profile Dashboard, the following tabs may be available:
· Compensation Plans - See Compensation Task - Compensation Plans Tab on page 248 for additional information.
· Roll-up Summary - See Compensation Task - Roll-up Summary Tab on page 252 for additional information.
· Plan Summary - See Compensation Task - Plan Summary Tab on page 256 for additional information.
· Pending Approvals - See Compensation Task - Pending Approvals Tab on page 260 for additional information.
[bookmark: _Ref-1468186520][bookmark: _Ref1102576240]Compensation Task - User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components. 
[image: ]
Compensation Task Title
Below the breadcrumbs, the compensation task title is displayed.
Options
Depending on the configuration of the compensation task, options may be available from the Options drop-down menu. See Compensation Task - Options Drop-down on page 263 for additional information.
Compensation Manager Overview
On the left side of the User Profile Dashboard, the following information is displayed for the compensation manager:
· Photograph, Name, and Title - The compensation manager's photograph, name, and position title are displayed. Click the user's name or photograph to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Compensation Task Status - Below the compensation manager's position, the status of the compensation manager's compensation task is displayed.
View Controls
On the right side of the User Profile Dashboard, the following view controls may be available:
· View - From the drop-down, select whether components are displayed as an amount or as a percentage:
· Amount - Select this option to display components as fixed currency amounts. This option is selected by default.
· Percentage - Select this option to display components as percentages of the budget (i.e., <ALLOCATION> divided by <BUDGET>). If no budget applies or has been set, "--%" is displayed.
· Currency - From the drop-down, select the currency in which currency amounts are displayed throughout the compensation task. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Corporate Currency - This option is selected by default unless the compensation task is configured to display in the compensation manager's currency.
· Compensation Manager's Currency
Compensation Task Components
Below the view controls, a summary of each of the component allocations is displayed. The values that are displayed correspond with the compensation plan of the user whose User Profile Dashboard is being viewed. For example, if a compensation manager is viewing a subordinate's User Profile Dashboard, then the values correspond with the subordinate's compensation plan.
· If the plan has been submitted, then values from the submitted plan are displayed.
· If the plan has not been submitted, then values from the last active draft are displayed.
· If the plan has not been started, the component values appear blank.
The following information is displayed for each component that is configured to be displayed in the compensation plan:
· Component name
· Amount allocated for the component
· Budget for the component
Individual component allocations and budgets appear in either Amount or Percent view, depending on the View setting.
Up to three components are displayed by default. If additional components are available, click the more link to display all components. Click the show less link to hide the additional components.
[bookmark: _Ref-1284404429][bookmark: _Ref1878887358]Compensation Task - Compensation Plans Tab
The Compensation Plans tab of a compensation task enables the compensation manager to create a compensation plan. Also, this tab displays all of the compensation manager's compensation plan drafts for the compensation task. If Executive Roll-up is enabled for the compensation task, then the compensation manager can view a subordinate's compensation plan drafts when viewing the subordinate's User Profile Dashboard.
The Compensation Plans tab only displays if one of the following is true:
· The user that is displayed in the User Profile Dashboard is the compensation manager.
· The user that is displayed in the User Profile Dashboard is the compensation manager's co-planner.
· Executive Roll-up is enabled for the task.
To access the Compensation Plans tab of a compensation task, go to Home > Scheduled Tasks. Click the compensation task title. Then, click the Compensation Plans tab.
The Compensation Plans tab is the default tab for the compensation task if the compensation manager or their co-planner does not have subordinate compensation managers (i.e., the Roll-up Summary tab does not appear).
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation


[image: ]
Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation manager who is completing the compensation task. If the co-planner is completing the compensation task, then the name of the compensation manager for whom the co-planner is planning is displayed.
When the compensation manager navigates to view the User Profile Dashboard of a subordinate, then the subordinate's name is also displayed in the breadcrumbs.
[image: ]
User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components.  
See Compensation Task - User Profile Dashboard on page 246 for additional information.
See Compensation Task - Options Drop-down on page 263 for additional information.
Instructions
The instructions for the Compensation Plans tab are displayed below the User Profile Dashboard. The instructions are configured by the administrator when the compensation task is created.
Create Plan
Click the Create Plan button to create a compensation plan for the compensation task. Note: Users must have permission to manage compensation plans to create a compensation plan. See Compensation Plan - Create/View/Edit on page 279 for additional information.
This button is available when the compensation manager or a co-planner is viewing the compensation manager's User Profile Dashboard and the task is not expired or completed. The button is also available when the compensation manager or a co-planner is viewing the User Profile Dashboard for one of the compensation manager's subordinates and Executive Roll-up is enabled with Edit access for the compensation task.
Compensation Plan Drafts Table
The Compensation Plan Drafts table displays the following information for each of the selected user's compensation plan drafts:
· Version - This displays the version number for the draft. Version updates are increased by 1.0 for each draft version.
· Last Saved Date - This displays the date on which the draft was last saved. For a submitted compensation plan, this includes any time the plan is saved during the approval workflow. Note: During the approval workflow, an approver with edit rights can save a compensation plan by editing the compensation plan and then either saving, approving, or denying the plan.
· Status - This displays the status of the draft. The following statuses are available:
· Draft
· Draft (Copy of Submitted <Version #>)
· Submitted
· Approved
· Denied
Draft Options
When a compensation manager or their co-planners are viewing the compensation manager's User Profile Dashboard, the following options may be available by clicking the drop-down arrow [image: ] in the Options column:
· Edit - This option is available for the following draft statuses:
· Draft
· Draft (Copy of Submitted <Version #>)
· If edits are made to a copy and the copy is saved, the status of the copy changes to Draft.
· If edits are made to the copy and the copy is submitted, the status of the copy changes to Submitted.
· Denied
· View - This option is available for the following draft statuses:
· Submitted - If edits are made to a submitted compensation plan during the approval workflow, then these changes are reflected when the compensation plan is viewed.
· Approved
· Copy - This option is available for all draft statuses.
· Delete - This option is available for the following draft statuses:
· Draft
· Draft (Copy of Submitted <Version #>)
· Denied
When viewing a subordinate's User Profile Dashboard and Executive Roll-up is enabled for the compensation task, the following options may be available by clicking the drop-down arrow [image: ] in the Options column:
· Edit - This option is only available when Executive Roll-up is enabled with Edit access for the compensation task. Also, this option is available for the following draft statuses:
· Draft
· Draft (Copy of Submitted <Version #>)
· Denied
· View - This option is available when Executive Roll-up is enabled with Read access for the compensation task for all draft statuses. This option is available when Executive Roll-up is enabled with Edit access for the compensation task if the task is in Submitted or Approved status.
· Copy - This option is available for all draft statuses.
· Delete - This option is only available when Executive Roll-up is enabled with Edit access for the compensation task. Also, this option is available for the following draft statuses:
· Draft
· Draft (Copy of Submitted <Version #>)
· Denied
[bookmark: _Ref-1623990302]Compensation Task - Roll-up Summary Tab
The Roll-up Summary tab of a compensation task displays the roll-up of allocations and budgets of all subordinate compensation manager plans. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. The Roll-up hierarchy is dependent upon the settings at the task level, which can be set to use the compensation manager hierarchy or the manager-subordinate hierarchy.
The Roll-up Summary tab displays budgets at the overall component level. For component budgets that have OU specific component budgets, the component budget represents the sum of all OU specific component budgets for the compensation manager. The OU specific component budgets are only included if there are eligible employees that apply to the budget. This is calculated at the time the compensation plan is created, so budgets may be updated once the plan is In Progress. Initially, budget calculations assume that there is at least one eligible employee for fixed amount budget types, which may be updated once a draft plan is created.
This tab reflects only components that are included in the compensation plan templates. If a component is hidden from a compensation plan template, then the component does not appear in this tab.
· A bonus component is not considered hidden unless all three bonus component columns have been hidden (% Attained, Target, and Bonus).
· An equity component with a target is not considered hidden unless the component and the target are both hidden.
The Roll-up Summary tab only displays if the following is true:
· The task is a standard compensation tasks.
· The compensation manager has subordinate compensation managers based on the hierarchy view set for the task.
· The hierarchy view set for the task does not contain a circular reference.
To access the Roll-up Summary tab of a compensation task, go to Home > Scheduled Tasks. Click the compensation task title.
The Roll-up Summary tab is the default tab for the compensation task if it is available.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation


[image: ]
Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation manager who is completing the compensation task. If the co-planner is completing the compensation task, then the name of the compensation manager for whom the co-planner is planning is displayed.
When the compensation manager navigates to view the User Profile Dashboard of a subordinate, then the subordinate's name is also displayed in the breadcrumbs.
[image: ]
User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components.  
See Compensation Task - User Profile Dashboard on page 246 for additional information.
See Compensation Task - Options Drop-down on page 263 for additional information.
Roll-up Summary Table
The Roll-up Summary information can be viewed for any compensation manager within the Roll-up hierarchy for the compensation manager. The compensation manager can click a user's photograph to view the corresponding user's Roll-up Summary information. When a new user is selected, the User Profile Dashboard is also updated to display the selected user's information.
The table displays the following information:
· Name - This column displays the following information for each direct subordinate compensation manager of the user who is displayed in the User Profile Dashboard:
· Name and Photograph - By default, compensation managers are displayed in alphabetical order by last name. If the user has subordinate compensation managers, clicking the name or photograph opens the Roll-up Summary information for the corresponding compensation manager. Otherwise, clicking the photograph opens the Compensation Plans tab for the corresponding compensation manager.
· Position
· Hierarchy Icon [image: ] - This icon is displayed if the user has subordinate compensation managers. Click the icon to view the Roll-up Summary information for the corresponding compensation manager.
· Components - Each of the components that are configured to be displayed in the compensation task are displayed. The component allocation appears above the component budget. The manner in which the allocations are displayed (e.g., amount, percentage, currency) can be modified using the view controls in the User Profile Dashboard. Components can be sorted by allocation in Amount view by clicking the column header. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. The components are displayed in the following order:
· Base components included in Base salary
· Base components not included in Base salary
· Bonus components
· Equity components
The Total row is displayed at the top of the Roll-up Summary table, and this row displays the total rolled-up allocations and budgets for the compensation manager. Note: For subordinate compensation managers that have a plan status of Not Started, their contributed allocations are zero, but their applicable component budgets are still applied. The color of the allocation reflects whether the allocation is more than or less than the budget. Note: When values are displayed as percentages, due to rounding, a percentage may appear as 100%, but may actually be over the budget. The color is based on the actual allocation and budget values.
· Green - Less than or equal to the budget
· Gray - Zero
· Red - More than the budget
If a subordinate compensation manager becomes inactive during the task, "(Inactive)" appears next to their name. Inactive managers appear in the Roll-up Summary view, but their allocations and budgets are not applied to the roll-up totals unless a co-planner has been added to the task.
[bookmark: _Ref-2121361982]Compensation Task - Plan Summary Tab
The Plan Summary tab of a compensation task displays the allocations and budgets for each subordinate compensation managers' compensation plan. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. 
This tab reflects only components that are included in the compensation plan templates. If a component is hidden from a compensation plan template, then the component does not appear in this tab.
· A bonus component is not considered hidden unless all three bonus component columns have been hidden (% Attained, Target, and Bonus).
· An equity component with a target is not considered hidden unless the component and the target are both hidden.
The Plan Summary tab only displays if the following is true:
· The task is a standard compensation tasks.
· The compensation manager has subordinate compensation managers based on the hierarchy view set for the task.
· The hierarchy view set for the task does not contain a circular reference.
To access the Plan Summary tab of a compensation task, go to Home > Scheduled Tasks. Click the compensation task title. Then, click the Plan Summary tab.
[image: ]
Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation manager who is completing the compensation task. If the co-planner is completing the compensation task, then the name of the compensation manager for whom the co-planner is planning is displayed.
When the compensation manager navigates to view the User Profile Dashboard of a subordinate, then the subordinate's name is also displayed in the breadcrumbs.
[image: ]
User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components.  
See Compensation Task - User Profile Dashboard on page 246 for additional information.
See Compensation Task - Options Drop-down on page 263 for additional information.
Plan Summary Table
The Plan Summary information can be viewed for any subordinate compensation manager. The compensation manager can click a user's photograph to view the corresponding user's Plan Summary information. When a new user is selected, the User Profile Dashboard is also updated to display the selected user's information.
The table displays the following information:
· Name - This column displays the following information for each direct subordinate compensation manager of the user who is displayed in the User Profile Dashboard:
· Name and Photograph - By default, compensation managers are displayed in alphabetical order by last name. If the user has subordinate compensation managers, clicking the name or photograph opens the Plan Summary information for the corresponding compensation manager. Otherwise, clicking the photograph opens the Compensation Plans tab for the corresponding compensation manager.
· Position
· Hierarchy Icon [image: ] - This icon is displayed if the user has subordinate compensation managers. Click the icon to view the Plan Summary information for the corresponding compensation manager.
· Components - Each of the components that are configured to be displayed in the compensation task are displayed. The component allocation appears above the component budget. The manner in which the allocations are displayed (e.g., amount, percentage, currency) can be modified using the view controls in the User Profile Dashboard. Components can be sorted by allocation in Amount view by clicking the column header. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. The components are displayed in the following order:
· Base components included in Base salary
· Base components not included in Base salary
· Bonus components
· Equity components
· Status - This column displays the status for the compensation manager's compensation plan. The status is linked to the appropriate page of the user's compensation plan:
· Not Started - This opens the Compensation Plan History pop-up. See Compensation Task - View Plan History on page 277 for additional information.
· In Progress - This opens the Compensation Plan History pop-up.See Compensation Task - View Plan History on page 277 for additional information.
· Pending Approval - This opens the Compensation Plan History pop-up. See Compensation Task - View Plan History on page 277 for additional information.
· Approve Plan - This opens the compensation plan for approval. This status only appears if the user that is viewing the Plan Summary tab is the next approver in the approval workflow (or the co-planner for the approver).See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
· Approved - This opens the Compensation Plan History pop-up. See Compensation Task - View Plan History on page 277 for additional information.
· Denied - This opens the Compensation Plan History pop-up. See Compensation Task - View Plan History on page 277 for additional information.
If a subordinate compensation manager becomes inactive during the task, "(Inactive)" appears next to their name. If the compensation task is inactive due to the compensation manager becoming inactive, the plan cannot be acted upon unless a co-planner is assigned the task.
[bookmark: _Ref2137536470]Compensation Task - Pending Approvals Tab
The Pending Approvals tab of a compensation task displays all compensation plans within the compensation task that are pending approval from the compensation manager who is viewing the task. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. 
This tab reflects only components that are included in the compensation plan templates. If a component is hidden from a compensation plan template, then the component does not appear in this tab.
· A bonus component is not considered hidden unless all three bonus component columns have been hidden (% Attained, Target, and Bonus).
· An equity component with a target is not considered hidden unless the component and the target are both hidden.
The Pending Approvals tab only displays if the following is true:
· The user that is displayed in the User Profile Dashboard is the compensation manager or the compensation manager's co-planner.
· The compensation manager has compensation plans that are pending approval within the compensation task.
To access the Pending Approvals tab of a compensation task, go to Home > Scheduled Tasks. Click the compensation task title. Then, click the Pending Approvals tab.
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Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation manager who is completing the compensation task. If the co-planner is completing the compensation task, then the name of the compensation manager for whom the co-planner is planning is displayed.
When the compensation manager navigates to view the User Profile Dashboard of a subordinate, then the subordinate's name is also displayed in the breadcrumbs.
[image: ]
User Profile Dashboard
At the top of the compensation task, the User Profile Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, view controls, and a summary of the compensation manager and the compensation task components.  
See Compensation Task - User Profile Dashboard on page 246 for additional information.
See Compensation Task - Options Drop-down on page 263 for additional information.
Pending Approvals Table
The Pending Approvals information can be viewed for any user for which the compensation manager is the next level approver.
The table displays the following information:
· Name - This column displays the following information for each direct subordinate compensation manager who has a compensation plan that is pending approval from the user who is displayed in the User Profile Dashboard:
· Name and Photograph - By default, compensation managers are displayed in alphabetical order by last name.
· Position
· Hierarchy Icon [image: ] - This icon is displayed if the user has subordinate compensation managers. Click the icon to view the Pending Approvals information for the corresponding compensation manager.
· Components - Each of the components that are configured to be displayed in the compensation task are displayed. The component allocation appears above the component budget. The manner in which the allocations are displayed (e.g., amount, percentage, currency) can be modified using the view controls in the User Profile Dashboard. Components can be sorted by allocation in Amount view by clicking the column header. Allocation and budget values are taken from the last submitted or last active draft of each compensation plan. The components are displayed in the following order:
· Base components included in Base salary
· Base components not included in Base salary
· Bonus components
· Equity components
· Status - This column indicates that the compensation plan is in Approve Plan status. Click the Approve Plan link to open the compensation plan for approval. See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
If a subordinate compensation manager becomes inactive during the task, "(Inactive)" appears next to their name. If the compensation task is inactive due to the compensation manager becoming inactive, the plan cannot be acted upon unless a co-planner is assigned the task.
[bookmark: _Ref416626056]Compensation Task - Options Drop-down
When completing a compensation task, the following options may be available from the Options drop-down menu:
· Adjust Budgets - All Reports - Select this option to adjust the budget for all of the selected compensation manager's subordinates (the entire compensation manager hierarchy). This option is only available if the compensation manager is within the Budget Adjustment Availability criteria that is defined for the compensation task and if the user displayed in the User Profile Dashboard has subordinate compensation managers. For example, if a subordinate who does not have subordinate compensation managers is displayed in the User Profile Dashboard, then this option is not available. See Compensation Task - Adjust Budget - All Reports on page 265 for additional information.
· Adjust Budgets - Individual - Select this option to make adjustments to the compensation budget for an individual subordinate. This option is only available if the compensation manager is within the Budget Adjustment Availability criteria that is defined for the compensation task and when viewing the User Profile Dashboard of a subordinate compensation manager. See Compensation Task - Adjust Budget - Individual on page 268 for additional information.
· Approve Plan - Select this option to open the selected compensation manager's compensation plan for approval or denial. This option is only available if the compensation manager who is viewing the compensation task is next in the approval workflow for the corresponding subordinate's compensation plan. This opens the subordinate's compensation plan for approval or denial. See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
· Cascade Budget - Select this option to cascade the budget to subordinate compensation managers. This option is only available when the compensation manager is viewing their own User Profile Dashboard, the compensation task contains Cascaded Budget type components, and the compensation manager must cascade component budgets to their team. See Compensation Task - Cascade Budget on page 270 for additional information.
· Co-Planner - Select this option to view, add, and edit co-planners for the compensation manager's compensation task. This ability to view existing co-planners is always available. The ability to add and edit co-planners is only available when enabled for the compensation task. See Compensation Task - Co-Planner - Add/View on page 273 for additional information.
· Contact Administrator - Select this option to send a message to the administrator for the compensation task. This option is only available if an administrator contact is defined for the compensation task. See Compensation Task - Contact Administrator on page 272 for additional information.
· Download Individual Adjustments - Select this option to open the Compensation Adjustment Report for the users within the compensation task. The most recently saved current draft of the compensation plan is reflected in the report. A deleted draft cannot be exported. This option is only available if Executive Roll-up is enabled for the compensation task.
· Download Statement - Select this option to download the compensation statement of the selected subordinate. This opens a PDF of the subordinate's compensation statement for the compensation task. This option is only available when viewing the User Profile Dashboard of a subordinate and if the compensation task is configured to allow compensation managers to download subordinates' compensation statements.
· Download Team Statements - Select this option to generate and download compensation statements for the direct subordinates of the selected compensation manager. This option is only available when viewing the User Profile Dashboard of a subordinate and if the compensation task is configured to allow compensation managers to download subordinates' compensation statements. See Compensation Task - Download Team Statements on page 275 for additional information.
· View History - Select this option to view the submission, approval/denial, and edit history of the compensation plan during the approval workflow. This option is only available if there is any history to display for the user's compensation plan. See Compensation Task - View Plan History on page 277 for additional information.
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[bookmark: _Ref-255872007]Compensation Task - Adjust Budget - All Reports
The Adjust Budget - All Reports pop-up enables compensation managers to adjust the budget for all of the selected compensation manager's subordinates (the entire compensation manager hierarchy). The compensation manager can adjust the budget for all components in the compensation task that have a Fixed Amount or % of Base budget type.
Budget adjustments are only applied to compensation tasks that have a status of Not Started or In Progress.
Note: Co-planners can also adjust budgets. Budget adjustments apply to the compensation manager hierarchy that is set for the task.
To adjust budgets for all of a compensation manager's subordinates (the entire compensation manager hierarchy), select Adjust Budget - All Reports from the Options drop-down in the User Profile Dashboard.
This option is only available if the compensation manager is within the Budget Adjustment Availability criteria that is defined for the compensation task and if the user displayed in the User Profile Dashboard has subordinate compensation managers. For example, if a subordinate who does not have subordinate compensation managers is displayed in the User Profile Dashboard, then this option is not available. 
[image: ]
Pop-up Title
The pop-up title indicates the name of the compensation manager whose subordinates' budgets are being adjusted. For example, if budgets are being adjusted for John Doe's subordinates (the entire compensation manager hierarchy), then John Doe's name appears in the pop-up title.
Adjust budgets for "Pending Approval" tasks
This option is unchecked by default.
Select this option to apply the budget adjustments to tasks that are in a Not Started, In Progress, or Pending Approval status. When unchecked, budget adjustments only apply to the tasks that are in a Not Started or In Progress status.
Include compensation manager
This option is only available if the compensation manager is adjusting budgets for their subordinates' teams. 
This option is unchecked by default.
Select this option to apply the budget adjustments to the compensation manager's budget and all of the compensation manager's subordinates' budgets. If this option is unchecked, only the budgets for the selected compensation manager's subordinates are affected.
Currency
This displays the system's default currency.
Component Budget Table
The Component Budget Table displays the following information:
· Component - This column displays each component included in the compensation task, regardless of budget type.
· Current Task Budget - This column displays the component's current budget for the compensation task. This reflects the budget that was set at the compensation template or task level. This value does not change unless the administrator changes the budgets for the entire compensation task.
· New Budget - This column enables the compensation manager to set a new budget for the component. 
· A new budget can only be set for components that have a Fixed Amount or % of Base budget type.
· This column is blank for components that have a Sum of Targets or None budget type.
· This column displays Cascaded for components that have a Cascaded budget type.
Adjust Budgets
To adjust a component budget, enter a new value in the appropriate field and save the changes. New budgets must be within the threshold set for task budget adjustments.
All adjustments that are saved apply to the selected compensation manager's subordinates (the entire compensation manager hierarchy).
Save or Cancel
After entering the appropriate budget adjustments, click Save to save all adjustments, or click Cancel to discard all adjustments. Any changes that are saved are reflected in the Adjust Budget - Individual pop-up. See Compensation Task - Adjust Budget - Individual on page 268 for additional information.
[bookmark: _Ref1331589636]Compensation Task - Adjust Budget - Individual
The Adjust Budget - Individual pop-up enables compensation managers to make adjustments to the compensation budget for an individual subordinate. The compensation manager can adjust the budget for all components in the compensation task that have a Fixed Amount or % of Base budget type.
Budget adjustments are only applied to compensation tasks that have a status of Not Started or In Progress.
Note: Co-planners can also adjust budgets.
To adjust budgets for an individual subordinate, select Adjust Budget - Individual from the Options drop-down in the User Profile Dashboard.
This option is only available if the compensation manager is within the Budget Adjustment Availability criteria that is defined for the compensation task and when viewing the User Profile Dashboard of a subordinate compensation manager. 
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Pop-up Title
The pop-up title indicates the name of the compensation manager whose budgets are being adjusted. For example, if budgets are being adjusted for John Doe, then John Doe's name appears in the pop-up title.
Currency
This displays the system's default currency.
Component Budget Table
The Component Budget Table displays the following information:
· Component - This column displays each component included in the compensation task, regardless of budget type.
· Current Budget - This column displays the component's current calculated budget value for the compensation manager. For example, if the template specified a budget of 3.0% of base, then the Current Budget column displays the actual calculated amount instead of the percentage.
· New Budget - This column enables the compensation manager to set a new budget for the component.
· A new budget can only be set for components that have a Fixed Amount or % of Base budget type.
· This column is blank for components that have a Sum of Targets or None budget type.
· This column displays Cascaded for components that have a Cascaded budget type.
Adjust Budgets
To adjust a component budget, enter a new value in the appropriate field and save the changes. New budgets must be defined as a fixed amount, regardless of how the budget was initially calculated.
· New budgets cannot be lower than current budgets.
· New budgets must be within the threshold set for task budget adjustments.
Modification History
This section displays all modifications that have been made to the compensation manager's budget. The most recent modification appears at the top. The modification includes the component, the name of the person who made the modification, and the modification date.
Save or Cancel
After entering the appropriate budget adjustments, click Save to save all adjustments, or click Cancel to discard all adjustments.
[bookmark: _Ref-1822175197]Compensation Task - Cascade Budget
The Cascade Budget pop-up enables compensation managers to set their own compensation budget and cascade or distribute the remaining budget to direct report compensation managers. The compensation manager hierarchy that is set for the compensation task determines which compensation managers are available in the pop-up.
To cascade the budget to subordinate compensation managers, select Cascade Budget from the Options drop-down in the User Profile Dashboard.
This option is only available when the compensation manager is viewing their own User Profile Dashboard, the compensation task contains Cascaded Budget type components, and the compensation manager must cascade component budgets to their team. 
Note:Lower level managers in the task must submit their plan before the higher level managers in the task, soupper hierarchy managers cannot submit the plan until the subordinate managers submits their plan.
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Currency
This displays the system's default currency.
Cascade Budget Table
The Cascade Budget Table displays the following information:
· Team - This column displays the name of the compensation manager and any of the compensation manager's direct subordinates who also have subordinates. Note: If a direct report does not also have subordinates, then they do not appear in this table because the cascaded budgets are intended to be distributed by the corresponding compensation managers.
· Components - Each of the components that are included in the compensation task and also have a Cascaded budget type are displayed. Compensation managers can allocate budgets by a fixed amount or a percentage of the budget pool. The components are displayed in the following order:
· Base components with a Cascaded budget type
· Bonus components with a Cascaded budget type
· Equity components with a Cascaded budget type
Set Budgets
To set a budget for a compensation manager, enter a value in the appropriate field and save the changes. 
For each component, the compensation manager can allocate budgets by a fixed amount or a percentage of the budget pool. Enter a value on the left to set the budget at a specific amount, or enter a value on the right to set the budget as a percentage of the Budget Pool.
· Once a compensation plan is submitted for approval, the budget for that compensation plan may not be modified.
· The total amount that is distributed for a component cannot be more than the total Budget Pool for the component.
· If no funds are allocated to a compensation manager for a component, then the amount field for that component cannot be edited.
If a compensation manager does not distribute all of their budgeted funds, then those undistributed funds are available to the indirect manager.
Total Table
Below the Cascade Budget Table, the Total table displays the following information:
· Budget Pool - This row displays the total budget pool for each Cascaded budget type component.
· Remainder - This row displays the currency amount that is left to be distributed for each associated Cascaded budget type component. These values are dynamically updated as budget values are distributed.
Save or Cancel
After entering the appropriate budget distribution, click Save to save all cascaded values, or click Cancel to discard all cascaded values.
[bookmark: _Ref-266501177][bookmark: _Ref805731580]Compensation Task - Contact Administrator
The Contact Administrator pop-up enables compensation managers to send a message to the administrator for the compensation task. 
To send a message to the administrator for the compensation task, select Contact Administrator from the Options drop-down in the User Profile Dashboard.
This option is only available if an administrator contact is defined for the compensation task. 
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Message Content
· To - This displays the name of the administrator for the compensation task who will receive the message.
· Subject - Enter a descriptive subject for the message.
· Message - Enter the message text. Be sure to provide all of the details regarding your question, concern, or statement.
Note: When the option to contact the administrator is selected, the email is sent from the corporate account email address, and the Reply-To is set to the actual administrator.
Send or Cancel
After entering the subject and message, click Send to send the message to the administrator, or click Cancel to discard the message.
[bookmark: _Ref834640862]Compensation Task - Co-Planner - Add/View
The Co-Planner pop-up enables users to view, add, and edit co-planners for the compensation manager's compensation task. This functionality applies to the compensation manager who is displayed in the User Profile Dashboard. For example, when viewing another compensation manager's User Profile Dashboard, the pop-up enables you to view, add, and edit co-planners for that compensation manager. 
To add or edit co-planners for the compensation manager's compensation task, select Add Co-Planner from the Options drop-down in the User Profile Dashboard.
To view co-planners for the compensation manager's compensation task, select View Co-Planner from the Options drop-down in the User Profile Dashboard. Note: This option is only available when the compensation manager cannot add or edit co-planners.
This ability to view existing co-planners is always available. The ability to add and edit co-planners is only available when enabled for the compensation task. 
Add Co-Planner
[image: ]
The Add-Co-Planner pop-up enables compensation managers to add or edit co-planners to the compensation manager's compensation task. This functionality applies to the compensation manager who is displayed in the User Profile Dashboard. For example, when viewing another compensation manager's User Profile Dashboard, the pop-up enables you to view, add, and edit co-planners for that compensation manager. 
Only one co-planner can be added to a compensation task.
To add a co-planner, click the Select icon [image: ]. This opens the Select User pop-up. Note: A compensation manager cannot be selected as a co-planner for their own compensation task. See Select User Pop-up for additional information.
To edit a co-planner, you must first remove the existing co-planner by clicking the Remove icon [image: ] to the right of the co-planner. Then, add a new co-planner.
After adding or editing the compensation task co-planner, click Save to save the co-planner changes, or click Cancel to discard any co-planner changes.
View Co-Planner
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The View Co-Planner pop-up enables compensation managers to view the compensation task's co-planner. If a co-planner exists for the compensation task, the co-planner's photograph and name are displayed. In this pop-up, the co-planner cannot be edited.
To close the pop-up, click Close.
[bookmark: _Ref1704624319]Compensation Task - Download Team Statements
The Download Team Statements pop-up enables compensation managers to generate and download compensation statements for the direct subordinates of the selected compensation manager.
To download team statements, select Download Team Statements from the Options drop-down in the User Profile Dashboard.
This option is only available when viewing the User Profile Dashboard of a subordinate and if the compensation task is configured to allow compensation managers to download subordinates' compensation statements. 
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Refresh Compensation Statement File
To generate a new compensation statement file based on the latest compensation data, select the Refresh option from the Options drop-down menu. After refreshing the data, it may take a few minutes for the new compensation statements file to be generated.
When the compensation statement data is refreshed, the Last Run date and time are updated to reflect the most recent refresh.
Download Compensation Statement File
The Last Run date and time indicate when the compensation statement file was last refreshed. If more current data is necessary, you must refresh the compensation data prior to downloading.
To download the compensation statement file, select the Download option from the Options drop-down menu. This option is only available if a compensation statement file is available. If a file is not available, you must first refresh the compensation statement file.
Note: Compensation statements appear in the display language of the user who created the statement.
Refresh or Cancel
Click Refresh to refresh the pop-up. If the compensation manager is generating new statements, this button refreshes the pop-up to indicate whether the updated statements have been generated.
Click Cancel to close the pop-up.
Considerations
· Team hierarchies are based on the view hierarchy set for the compensation task. That is, teams are based upon the hierarchy view set for the Roll-up and Plan Summary tabs for the task. When team statements are downloaded, this functionality utilizes this team hierarchy.
· The compensation statement file is associated with the selected team and the compensation manager. That is, compensation managers will only see the compensation statements that they refresh and download, regardless of whether or not other compensation managers with access to the employee's User Profile Dashboard have downloaded the team statement.
· Co-planners can download team compensation statements.
[bookmark: _Ref1122290186][bookmark: _Ref-63477379]Compensation Task - View Plan History
The Plan History pop-up displays the following history information for the compensation plan:
· Submission
· Approval/Denial
· Edit During Approval Workflow
The Plan History pop-up can be accessed in the following ways:
· From the Options drop-down in the User Profile Dashboard, Select View History. This option is only available if there is any history to display for the user's compensation plan. 
· From the Plan Summary tab of the compensation task, click the Status link.
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Compensation Plan History
Entries are displayed in chronological order with the earliest event displayed first. If an approver edits and then approves or denies the plan, then the edit entry is always logged before the approval or denial.
The following information is displayed for each entry:
· Action
· Compensation manager who performed the action - If an indirect compensation manager or a co-planner performed the action on behalf of a compensation manager, then the original compensation manager is displayed in parentheses.
· Date on which the action occurred
Close or Deny
Click Close to close the pop-up.
Click Deny to override approval for the compensation plan. This option is only available if the following is true:
· The compensation task is configured to allow indirect managers to override approval.
· An indirect manager is viewing the Plan History pop-up for an approved compensation plan.
[bookmark: _Ref-1296164855]Compensation Plan - Create/View/Edit 
To create a compensation plan for a compensation task, go to Home > Scheduled Tasks. Click the compensation task title. Click the Compensation Plans tab. Then, click the Create Plan button.
An off-cycle compensation task can be launched via Universal Profile and My Team. See Compensation - Award Off-cycle on page 361 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation
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Breadcrumbs
At the top of the page, the breadcrumbs for the page are displayed. Users can click the links within the breadcrumbs to navigate to those pages. Note: The page to which the Home icon is linked is configured by the administrator in Navigation Tabs and Links.
The breadcrumbs include the compensation task name and the name of the compensation managers who is creating the compensation plan. If the compensation manager is editing a subordinate compensation manager's plan, then the breadcrumbs also display the compensation plan owner's name.
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User Dashboard
At the top of the compensation plan, the User Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, and a summary of the compensation plan owner. 
See Compensation Plan - User Dashboard on page 282 for additional information.
See Compensation Plan - Options Drop-down Overview on page 312 for additional information.
Additional Recommendations
When viewing a Base, Bonus, or Equity tab within a compensation plan, additional recommendation information may appear above the compensation plan tabs. This information pertains to the selected tab. If a different tab is selected, the information may disappear or change. Additional recommendation information is displayed when the compensation template that corresponds with the selected tab is configured to display additional recommendation information on the compensation plan. For example, when viewing the Base tab, additional recommendation information is displayed on the compensation plan if the corresponding base compensation template is configured to display additional recommendation information.
[image: ]
Compensation Task Tabs
Below the User Dashboard, the following tabs may be available:
· Base - See Compensation Plan - Base Tab on page 284 for additional information.
· Bonus - See Compensation Plan - Bonus Tab on page 291 for additional information.
· Equity - See Compensation Plan - Equity Tab on page 299 for additional information.
· Summary - See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
· Approve Compensation Plan (no editing rights) - See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
· Compensation Plan Details (read-only) - See Compensation Plan - Summary/Read-only/Approval Tab on page 306 for additional information.
The Base, Bonus, and Equity tabs are only available if they are included in the compensation task. Note: The tab names can be configured by the compensation administrator, so the tab names that appear in the compensation plan may vary.
When the compensation plan is in Read-only mode, only the Compensation Plan Details tab is available.
When the compensation plan is in Approval mode and the compensation manager is not able to edit the compensation plan during the approval workflow, only the Approve Compensation Plan tab is available.
[bookmark: _Ref348249745]Compensation Plan - User Dashboard
At the top of the compensation plan, the User Dashboard is displayed. This section displays the compensation task title, the Options drop-down menu, and a summary of the compensation plan owner. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation
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Compensation Task Title
Below the breadcrumbs, the compensation task title is displayed.
Options
Depending on the configuration of the compensation task, options may be available from the Options drop-down menu. See Compensation Plan - Options Drop-down Overview on page 312 for additional information.
Compensation Plan Owner Overview
On the left side of the User Dashboard, the following information is displayed for the compensation plan owner:
· Photograph, Name, and Title - The compensation plan owner's photograph, name, and position title are displayed. Click the user's name or photograph to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Compensation Task Status - Below the compensation plan owner's position, the status of the compensation plan owner's compensation plan is displayed. The status is only displayed if the compensation plan is in one of the following statuses:
· Denied
· Pending Approval
· Approved
· Compensation Period - To the right of the user information, the compensation period that is defined for the compensation task is displayed.
[bookmark: _Ref644981972]Compensation Plan - Base Tab
The Base tab enables compensation managers to allocate base compensation to their employees and even promote employees. Only employees that match the criteria set in the compensation task appear.
To access the Base tab when creating a compensation plan, click the Base tab.
The Base, Bonus, and Equity tabs are only available if they are included in the compensation task. Note: The tab names can be configured by the compensation administrator, so the tab names that appear in the compensation plan may vary.
When the compensation plan is in Read-only mode, only the Compensation Plan Details tab is available.
When the compensation plan is in Approval mode and the compensation manager is not able to edit the compensation plan during the approval workflow, only the Approve Compensation Plan tab is available.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation
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Additional Recommendations
When viewing a Base, Bonus, or Equity tab within a compensation plan, additional recommendation information may appear above the compensation plan tabs. This information pertains to the selected tab. If a different tab is selected, the information may disappear or change. Additional recommendation information is displayed when the compensation template that corresponds with the selected tab is configured to display additional recommendation information on the compensation plan. For example, when viewing the Base tab, additional recommendation information is displayed on the compensation plan if the corresponding base compensation template is configured to display additional recommendation information.
Search and Filter Users
Compensation managers and approvers can search for users within a compensation plan by name, position, and eligibility status.
· Search by Name - This field enables managers to search for specific users within the compensation plan by name. When a search is conducted, the search query is retained as the compensation manager navigates between tabs. 
· The Budget Summary and Compensation Analytics are not impacted or limited when a search is conducted. 
· Compensation managers can search by <First Name>, by <Last Name>, or by <First Name> <Last Name>. Compensation managers cannot search by <Last Name> <First Name>.
· Compensation managers can search for multiple names by separating them by a semicolon.
· Position - This field enables managers to filter the compensation plan by position. When one or more position organizational unit (OU) is selected, the compensation plan only displays users who are within the selected positions. This enables compensation managers to easily compare employees within the same position or similar positions. The filter only contains the positions that are associated with users within the compensation plan. If there are no users within the compensation plan, then this filter is not available.
· Show Ineligible Employees - Select this option to include ineligible employees in the search. No component data is displayed and no options are available for ineligible employees.
Effective Date
This displays the date on which the compensation adjustments on the selected tab will be implemented. For example, if the effective date for the Base tab is March 15, 2015, then any compensation adjustments that are made on the Base tab will be reflected in the user's compensation on March 15, 2015.
View Options
The following options enable the compensation manager to customize how information is displayed in the Plan Details table:
· View - From the drop-down, select whether components are displayed as an amount or as a percentage. Administrators can configure the default selection for this option when configuring the compensation template.
· Amount - Select this option to display components as fixed currency amounts. This option is selected by default.
· Percentage - Select this option to display components as percentages of the budget (i.e., <ALLOCATION> divided by <BUDGET>). If no budget applies or has been set, "--%" is displayed.
· Currency - From the drop-down, select the currency in which currency amounts are displayed throughout the compensation plan tab. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Compensation Task Currency
· Compensation Manager's Currency
· Employee's Currency
· Show Ineligible Employees - Select this option to include ineligible employees in the Plan Details table for the current tab. No component data is displayed and no options are available for ineligible employees. Administrators can configure the default selection for this option when configuring the compensation template.
· Show All Comments - Select whether all comments for each user are displayed directly in the Plan Details table. When this option is selected, all comments for the current compensation plan tab are displayed in the Plan Details table. The user photo and name of the compensation manager who wrote the comment and the date and time at which the comment was made are displayed for each comment. The newest comments are displayed first. This option is unchecked by default.
· Show - From the drop-down, select the maximum number of users who can be displayed in the Plan Details table. If more than the selected number is available, then the additional users appear on a separate page, and the compensation manager must navigate to each page to view all users. This option is only available if at least 16 users are available to be displayed in the Plan Details table. This includes ineligible employees.
Plan Details Table
The plan details table can be sorted by any of the data or component columns in the plan. Only one column can be sorted at a time. Monetary values are sorted based on string values, so all hourly rates appear above salary rates when sorted from low to high. In addition, $500 appears before 1000 Yen when sorted from low to high regardless of the currency conversion. 
· The sorting applies to the entire compensation plan tab, regardless of the number of pages. If the compensation manager is not on the first page when they sort the plan, they are taken to the first page of the plan. 
· To sort the compensation plan based on a certain column, click the column heading. To reverse the sort order, click the column heading again. When navigating to a different tab, the sort order is not saved.
The following information is displayed for each user in the Plan Details table:
· User Photograph
· Name - Click the user's name to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Position
· Promoted - A Promoted link will appear below the user's Position OU title if the user is promoted during a compensation task. Click the link to open the Promotion pop-up. Note: If the user is given a promotion, and then the promotion is removed, the Promoted link is removed.
· Options - To view which options are available for a user, click the Options drop-down [image: ] to the right of the user's name. See the User Options section below for additional information. Note: The Options drop-down is not available for ineligible employees. 
· Components - For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. See the Components section below for additional information.
At the bottom of the Plan Details table, the horizontal scroll bar is always visible when viewing any part of the Plan Details table when not all data in the table can be displayed on the screen. The horizontal scroll bar enables the user to scroll left and right on the Plan Details table. As the user scrolls vertically on the page while the Plan Details table is displayed, the horizontal scroll bar for the Plan Details table floats at the bottom of the screen.
User Options
The following options may be available by selecting the Options drop-down [image: ] to the right of the eligible user's name:
· More Info - Select this option to open the expanded view of the employee. This option is only available if the expanded view is enabled for the component tab (i.e., Base, Bonus, Equity). This option is also available on the Base tab if the user has been promoted. See Compensation Plan - Employee Expanded View on page 328 for additional information.
· Comment - Select this option to view a history of all of the comments made regarding the user for the component tab (i.e., Base, Bonus, Equity). This option also enables the compensation manager to add a new comment. See Compensation Plan - Comments on page 324 for additional information.
· Promote - Select this option to promote the user. This option is only available on the Base component tab if a promotion component is available in the compensation plan. See Compensation Plan - Promotion on page 343 for additional information.
· Show Warning - Select this option to view the components within the compensation plan that are outside the component guidelines. This option is only available when there is at least one component that is outside its guidelines. See Compensation Plan - Outside Guidelines on page 338 for additional information.
Note: The Options drop-down is not available for ineligible employees. 
Components
For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. Note: No data is displayed for ineligible employees.
In the corresponding field for each component, the compensation manager can enter the appropriate compensation adjustment for each component for each employee. When a component allocation field is selected, a fixed amount field and a percentage of base field are displayed. Enter the allocation amount or percentage in the appropriate field.
If any adjustment guidelines are defined for the employee, the adjustment fields are automatically populated with the recommended adjustments. The recommended adjustment values can be modified, but must remain within the adjustment guidelines. If a component allocation is outside the component guidelines, an error icon appears to the right of the allocation. Compensation managers can click the icon to open the Over Guideline pop-up, which enables the compensation manager to adjust the allocation. See Compensation Plan - Over Guideline on page 340 for additional information.
· If a component allocation is outside the component guidelines but within the threshold, a yellow Error icon [image: ] appears to the right of the component allocation.
· If a component allocation is outside the component guidelines and also exceeds the threshold, a red Error icon [image: ] appears to the right of the component allocation.
Adjustment Guideline Recommendations
If a discretionary adjustment guideline applies to a component, then the Adjustment Guidelines icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the original recommended allocations for the component. The pop-up displays the currency and the original recommended allocation for the component. The currency that is displayed is the currency that is set for the compensation plan.
The Adjustment Guidelines icon is not available if there is no associated adjustment guideline or if the guideline is non-discretionary.
When automatic lump sum allocation for salary range overages is enabled for the template, the salary range overage appears in the pop-up.
Component Proration
If a component has been prorated for the user, then the Prorated Recommendations icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the prorated recommendations for the component. The pop-up displays the currency and the prorated recommendations for the component. The currency that is displayed is the currency that is set for the compensation plan.
· If the component has not yet been prorated into multiple periods, then the component allocation field is editable.
· If the component has multiple prorated periods, then the component allocation field is read-only and an Edit icon [image: ] appears to the right of the Prorated Recommendations icon. Click the Edit icon to open the Proration pop-up and allocate prorated amounts for each of the prorated periods of the component for the user.
See Compensation Plan - Proration - Base on page 347 for additional information.
Lump Sum Allocation
If lump sum adjustments are enabled for the Base tab, a Lump Sum component appears on the Base tab in the compensation plan. The location and the name of the Lump Sum column is configured by the administrator when the base template is created. A lump sum is a one-time payment that does not affect the employee's salary/rate. However, it does count towards the budget for base adjustments.
See Compensation Plan - Lump Sum Allocation on page 330 for additional information.
Employee Expanded View
Each employee row is collapsed by default. To view detailed information for the employee, select the More Info option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
See Compensation Plan - Employee Expanded View on page 328 for additional information.
Budget Summary Graph
The Budget Summary graph appears below the Plan Details table on Compensation Plan template and summary pages. This graph displays allocations, budgets, and remaining available allocations for each component that is configured to display. The graph is updated dynamically as the compensation plan is edited. See Compensation Plan - Budget Summary Graph Overview on page 317 for additional information.
Comp Analytics
The Comp Analytics section appears below the Budget Summary graph on Compensation Plan template pages. Each report displays a snapshot of the corresponding information. These reports are updated in real-time. If a component is not included in the compensation plan, then the component does not appear in any compensation analytics graphs. See Compensation Plan - Comp Analytics on page 327 for additional information.
Action Buttons
At the bottom of the page, the following buttons may be available:
· Save Draft - Click this button to save the compensation plan without submitting it.
· Previous - Click this button to return to the previous page. This button is not available on the first tab of the compensation plan.
· Next - Click this button to proceed to the next tab within the compensation plan.
· Deny - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and deny the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
· Approve - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and approve the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
[bookmark: _Ref-758696002]Compensation Plan - Bonus Tab
The Bonus tab enables compensation managers to allocate bonus compensation to their employees. Only employees that match the criteria set in the compensation task appear.
To access the Bonus tab when creating a compensation plan, click the Bonus tab.
The Base, Bonus, and Equity tabs are only available if they are included in the compensation task. Note: The tab names can be configured by the compensation administrator, so the tab names that appear in the compensation plan may vary.
When the compensation plan is in Read-only mode, only the Compensation Plan Details tab is available.
When the compensation plan is in Approval mode and the compensation manager is not able to edit the compensation plan during the approval workflow, only the Approve Compensation Plan tab is available.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation


[image: ]
Additional Recommendations
When viewing a Base, Bonus, or Equity tab within a compensation plan, additional recommendation information may appear above the compensation plan tabs. This information pertains to the selected tab. If a different tab is selected, the information may disappear or change. Additional recommendation information is displayed when the compensation template that corresponds with the selected tab is configured to display additional recommendation information on the compensation plan. For example, when viewing the Base tab, additional recommendation information is displayed on the compensation plan if the corresponding base compensation template is configured to display additional recommendation information.
Search and Filter Users
Compensation managers and approvers can search for users within a compensation plan by name, position, and eligibility status.
· Search by Name - This field enables managers to search for specific users within the compensation plan by name. When a search is conducted, the search query is retained as the compensation manager navigates between tabs. 
· The Budget Summary and Compensation Analytics are not impacted or limited when a search is conducted. 
· Compensation managers can search by <First Name>, by <Last Name>, or by <First Name> <Last Name>. Compensation managers cannot search by <Last Name> <First Name>.
· Compensation managers can search for multiple names by separating them by a semicolon.
· Position - This field enables managers to filter the compensation plan by position. When one or more position organizational unit (OU) is selected, the compensation plan only displays users who are within the selected positions. This enables compensation managers to easily compare employees within the same position or similar positions. The filter only contains the positions that are associated with users within the compensation plan. If there are no users within the compensation plan, then this filter is not available.
· Show Ineligible Employees - Select this option to include ineligible employees in the search. No component data is displayed and no options are available for ineligible employees.
Effective Date
This displays the date on which the compensation adjustments on the selected tab will be implemented. For example, if the effective date for the Base tab is March 15, 2015, then any compensation adjustments that are made on the Base tab will be reflected in the user's compensation on March 15, 2015.
View Options
The following options enable the compensation manager to customize how information is displayed in the Plan Details table:
· View - From the drop-down, select whether components are displayed as an amount or as a percentage. Administrators can configure the default selection for this option when configuring the compensation template.
· Amount - Select this option to display components as fixed currency amounts. This option is selected by default.
· Percentage - Select this option to display components as percentages of the budget (i.e., <ALLOCATION> divided by <BUDGET>). If no budget applies or has been set, "--%" is displayed.
· Currency - From the drop-down, select the currency in which currency amounts are displayed throughout the compensation plan tab. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Compensation Task Currency
· Compensation Manager's Currency
· Employee's Currency
· Show Ineligible Employees - Select this option to include ineligible employees in the Plan Details table for the current tab. No component data is displayed and no options are available for ineligible employees. Administrators can configure the default selection for this option when configuring the compensation template.
· Show All Comments - Select whether all comments for each user are displayed directly in the Plan Details table. When this option is selected, all comments for the current compensation plan tab are displayed in the Plan Details table. The user photo and name of the compensation manager who wrote the comment and the date and time at which the comment was made are displayed for each comment. The newest comments are displayed first. This option is unchecked by default.
· Show - From the drop-down, select the maximum number of users who can be displayed in the Plan Details table. If more than the selected number is available, then the additional users appear on a separate page, and the compensation manager must navigate to each page to view all users. This option is only available if at least 16 users are available to be displayed in the Plan Details table. This includes ineligible employees.
Plan Details Table
The plan details table can be sorted by any of the data or component columns in the plan. Only one column can be sorted at a time. Monetary values are sorted based on string values, so all hourly rates appear above salary rates when sorted from low to high. In addition, $500 appears before 1000 Yen when sorted from low to high regardless of the currency conversion. 
· The sorting applies to the entire compensation plan tab, regardless of the number of pages. If the compensation manager is not on the first page when they sort the plan, they are taken to the first page of the plan. 
· To sort the compensation plan based on a certain column, click the column heading. To reverse the sort order, click the column heading again. When navigating to a different tab, the sort order is not saved.
The following information is displayed for each user in the Plan Details table:
· User Photograph
· Name - Click the user's name to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Position
· Promoted - A Promoted link will appear below the user's Position OU title if the user is promoted during a compensation task. Click the link to open the Promotion pop-up. Note: If the user is given a promotion, and then the promotion is removed, the Promoted link is removed.
· Options - To view which options are available for a user, click the Options drop-down [image: ] to the right of the user's name. See the User Options section below for additional information. Note: The Options drop-down is not available for ineligible employees. 
· Components - For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. See the Components section below for additional information.
At the bottom of the Plan Details table, the horizontal scroll bar is always visible when viewing any part of the Plan Details table when not all data in the table can be displayed on the screen. The horizontal scroll bar enables the user to scroll left and right on the Plan Details table. As the user scrolls vertically on the page while the Plan Details table is displayed, the horizontal scroll bar for the Plan Details table floats at the bottom of the screen.
User Options
The following options may be available by selecting the Options drop-down [image: ] to the right of the eligible user's name:
· More Info - Select this option to open the expanded view of the employee. This option is only available if the expanded view is enabled for the component tab (i.e., Base, Bonus, Equity). See Compensation Plan - Employee Expanded View on page 328 for additional information.
· Comment - Select this option to view a history of all of the comments made regarding the user for the component tab (i.e., Base, Bonus, Equity). This option also enables the compensation manager to add a new comment. See Compensation Plan - Comments on page 324 for additional information.
· Show Warning - Select this option to view the components within the compensation plan that are outside the component guidelines. This option is only available when there is at least one component that is outside its guidelines. See Compensation Plan - Outside Guidelines on page 338 for additional information.
Note: The Options drop-down is not available for ineligible employees. 
Components
For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. Note: No data is displayed for ineligible employees.
In the corresponding field for each component, the compensation manager can enter the appropriate compensation adjustment for each component for each employee. Depending upon how the Bonus component is configured, the compensation manager may be able to define the bonus in different ways:
· If the Bonus component is configured to be set as a fixed amount or as a percentage of the Base Salary, then the compensation manager can set an employee's bonus in the Bonus component column. Enter the allocation amount or percentage in the appropriate field. The % Attained column is read-only, and the value in this column is dynamically updated based on the Bonus component allocation.
· If the Bonus component is configured to be set as a percentage of the Bonus Target, then the compensation manager can set an employee's bonus in the % Attained column. The Bonus component column is read-only, and the value in this column is dynamically updated based on the % Attained allocation. The % Attained value must be greater than or equal to 0% and must be less than 1000%.
See the Use Cases section below for additional information.
Target bonuses can be set for an employee. If a target bonus is set, the target amount is displayed. 
If any adjustment guidelines are defined for the employee, the adjustment fields are automatically populated with the recommended adjustments. The recommended adjustment values can be modified, but must remain within the adjustment guidelines. If a component allocation is outside the component guidelines, an error icon appears to the right of the allocation. Compensation managers can click the icon to open the Over Guideline pop-up, which enables the compensation manager to adjust the allocation. See Compensation Plan - Over Guideline on page 340 for additional information.
· If a component allocation is outside the component guidelines but within the threshold, a yellow Error icon [image: ] appears to the right of the component allocation.
· If a component allocation is outside the component guidelines and also exceeds the threshold, a red Error icon [image: ] appears to the right of the component allocation.
Adjustment Guideline Recommendations
If a discretionary adjustment guideline applies to a component, then the Adjustment Guidelines icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the original recommended allocations for the component. The pop-up displays the currency and the original recommended allocation for the component. The currency that is displayed is the currency that is set for the compensation plan.
The Adjustment Guidelines icon is not available if there is no associated adjustment guideline or if the guideline is non-discretionary.
When the allocation rule for the bonus template is set to a percentage of Bonus Targets, then the pop-up does not display a currency setting, as it does not apply.
Component Proration
If a component has been prorated for the user, then the Prorated Recommendations icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the prorated recommendations for the component. The pop-up displays the currency and the prorated recommendations for the component. The currency that is displayed is the currency that is set for the compensation plan.
· If the component has not yet been prorated into multiple periods, then the component allocation field is editable.
· If the component has multiple prorated periods, then the component allocation field is read-only and an Edit icon [image: ] appears to the right of the Prorated Recommendations icon. Click the Edit icon to open the Proration pop-up and allocate prorated amounts for each of the prorated periods of the component for the user.
See Compensation Plan - Proration - Bonus on page 349 for additional information.
Employee Expanded View
Each employee row is collapsed by default. To view detailed information for the employee, select the More Info option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
See Compensation Plan - Employee Expanded View on page 328 for additional information.
Budget Summary Graph
The Budget Summary graph appears below the Plan Details table on Compensation Plan template and summary pages. This graph displays allocations, budgets, and remaining available allocations for each component that is configured to display. The graph is updated dynamically as the compensation plan is edited. See Compensation Plan - Budget Summary Graph Overview on page 317 for additional information.
Comp Analytics
The Comp Analytics section appears below the Budget Summary graph on Compensation Plan template pages. Each report displays a snapshot of the corresponding information. These reports are updated in real-time. If a component is not included in the compensation plan, then the component does not appear in any compensation analytics graphs. See Compensation Plan - Comp Analytics on page 327 for additional information.
Action Buttons
At the bottom of the page, the following buttons may be available:
· Save Draft - Click this button to save the compensation plan without submitting it.
· Previous - Click this button to return to the previous page. This button is not available on the first tab of the compensation plan.
· Next - Click this button to proceed to the next tab within the compensation plan.
· Deny - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and deny the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
· Approve - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and approve the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
Use Cases
The following use cases use the following data:
Bonus Template 2012 has the following settings and is included in the 2012 Compensation Task.
· The template includes a Bonus component.
· In the Allocation Rules section, Percentage of Bonus Targets is selected.
	Employee
	Current Salary
	Target Bonus

	Allison Briggs
	$55,000
	$10,000


Use Case 1: Allocate as Percentage of Bonus Target - Simple
Action
On the Bonus tab of the 2012 Compensation Task, the compensation manager allocates 50.7% in the % Attained field for the Bonus component for Allison.
Results
The compensation task shows the following for Allison Briggs:
· % Attained: 50.7%
· Bonus (read-only):
· Amount View: 5070.00
· Percent View: 9.2%
Use Case 2: Allocate as Percentage of Bonus Target - Fixed Amount Adjustment Guideline
Default Adjustment Guideline for Bonus component is set to $4500.25 USD.
Action
The compensation manager views the Bonus tab of the 2012 Compensation Task for Allison.
Results
The compensation task shows the following for Allison Briggs:
· % Attained: 45.0%
· Bonus (read-only):
· Amount View: 4500.25
· Percent View: 8.2%
[bookmark: _Ref-1369482290]Compensation Plan - Equity Tab
The Equity tab enables compensation managers to allocate equity compensation to their employees. Only employees that match the criteria set in the compensation task appear.
To access the Equity tab when creating a compensation plan, click the Equity tab.
The Base, Bonus, and Equity tabs are only available if they are included in the compensation task. Note: The tab names can be configured by the compensation administrator, so the tab names that appear in the compensation plan may vary.
When the compensation plan is in Read-only mode, only the Compensation Plan Details tab is available.
When the compensation plan is in Approval mode and the compensation manager is not able to edit the compensation plan during the approval workflow, only the Approve Compensation Plan tab is available.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation


[image: ]
Additional Recommendations
When viewing a Base, Bonus, or Equity tab within a compensation plan, additional recommendation information may appear above the compensation plan tabs. This information pertains to the selected tab. If a different tab is selected, the information may disappear or change. Additional recommendation information is displayed when the compensation template that corresponds with the selected tab is configured to display additional recommendation information on the compensation plan. For example, when viewing the Base tab, additional recommendation information is displayed on the compensation plan if the corresponding base compensation template is configured to display additional recommendation information.
Search and Filter Users
Compensation managers and approvers can search for users within a compensation plan by name, position, and eligibility status.
· Search by Name - This field enables managers to search for specific users within the compensation plan by name. When a search is conducted, the search query is retained as the compensation manager navigates between tabs. 
· The Budget Summary and Compensation Analytics are not impacted or limited when a search is conducted. 
· Compensation managers can search by <First Name>, by <Last Name>, or by <First Name> <Last Name>. Compensation managers cannot search by <Last Name> <First Name>.
· Compensation managers can search for multiple names by separating them by a semicolon.
· Position - This field enables managers to filter the compensation plan by position. When one or more position organizational unit (OU) is selected, the compensation plan only displays users who are within the selected positions. This enables compensation managers to easily compare employees within the same position or similar positions. The filter only contains the positions that are associated with users within the compensation plan. If there are no users within the compensation plan, then this filter is not available.
· Show Ineligible Employees - Select this option to include ineligible employees in the search. No component data is displayed and no options are available for ineligible employees.
Effective Date
This displays the date on which the compensation adjustments on the selected tab will be implemented. For example, if the effective date for the Base tab is March 15, 2015, then any compensation adjustments that are made on the Base tab will be reflected in the user's compensation on March 15, 2015.
View Options
The following options enable the compensation manager to customize how information is displayed in the Plan Details table:
· View - From the drop-down, select whether components are displayed as an amount or as a percentage. Administrators can configure the default selection for this option when configuring the compensation template.
· Amount - Select this option to display components as fixed currency amounts. This option is selected by default.
· Percentage - Select this option to display components as percentages of the budget (i.e., <ALLOCATION> divided by <BUDGET>). If no budget applies or has been set, "--%" is displayed.
· Currency - From the drop-down, select the currency in which currency amounts are displayed throughout the compensation plan tab. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Compensation Task Currency
· Compensation Manager's Currency
· Employee's Currency
· Show Ineligible Employees - Select this option to include ineligible employees in the Plan Details table for the current tab. No component data is displayed and no options are available for ineligible employees. Administrators can configure the default selection for this option when configuring the compensation template.
· Show All Comments - Select whether all comments for each user are displayed directly in the Plan Details table. When this option is selected, all comments for the current compensation plan tab are displayed in the Plan Details table. The user photo and name of the compensation manager who wrote the comment and the date and time at which the comment was made are displayed for each comment. The newest comments are displayed first. This option is unchecked by default.
· Show - From the drop-down, select the maximum number of users who can be displayed in the Plan Details table. If more than the selected number is available, then the additional users appear on a separate page, and the compensation manager must navigate to each page to view all users. This option is only available if at least 16 users are available to be displayed in the Plan Details table. This includes ineligible employees.
Plan Details Table
The plan details table can be sorted by any of the data or component columns in the plan. Only one column can be sorted at a time. Monetary values are sorted based on string values, so all hourly rates appear above salary rates when sorted from low to high. In addition, $500 appears before 1000 Yen when sorted from low to high regardless of the currency conversion. 
· The sorting applies to the entire compensation plan tab, regardless of the number of pages. If the compensation manager is not on the first page when they sort the plan, they are taken to the first page of the plan. 
· To sort the compensation plan based on a certain column, click the column heading. To reverse the sort order, click the column heading again. When navigating to a different tab, the sort order is not saved.
The following information is displayed for each user in the Plan Details table:
· User Photograph
· Name - Click the user's name to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Position
· Promoted - A Promoted link will appear below the user's Position OU title if the user is promoted during a compensation task. Click the link to open the Promotion pop-up. Note: If the user is given a promotion, and then the promotion is removed, the Promoted link is removed.
· Options - To view which options are available for a user, click the Options drop-down [image: ] to the right of the user's name. See the User Options section below for additional information. Note: The Options drop-down is not available for ineligible employees. 
· Components - For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. See the Components section below for additional information.
At the bottom of the Plan Details table, the horizontal scroll bar is always visible when viewing any part of the Plan Details table when not all data in the table can be displayed on the screen. The horizontal scroll bar enables the user to scroll left and right on the Plan Details table. As the user scrolls vertically on the page while the Plan Details table is displayed, the horizontal scroll bar for the Plan Details table floats at the bottom of the screen.
User Options
The following options may be available by selecting the Options drop-down [image: ] to the right of the eligible user's name:
· More Info - Select this option to open the expanded view of the employee. This option is only available if the expanded view is enabled for the component tab (i.e., Base, Bonus, Equity). See Compensation Plan - Employee Expanded View on page 328 for additional information.
· Comment - Select this option to view a history of all of the comments made regarding the user for the component tab (i.e., Base, Bonus, Equity). This option also enables the compensation manager to add a new comment. See Compensation Plan - Comments on page 324 for additional information.
· Show Warning - Select this option to view the components within the compensation plan that are outside the component guidelines. This option is only available when there is at least one component that is outside its guidelines. See Compensation Plan - Outside Guidelines on page 338 for additional information.
Note: The Options drop-down is not available for ineligible employees. 
Components
For each component included in the compensation component template, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation template is created. Note: No data is displayed for ineligible employees.
In the corresponding field for each component, the compensation manager can enter the appropriate compensation adjustment for each component for each employee. When a component allocation field is selected, a fixed amount field and a percentage of base field are displayed. Enter the allocation amount or percentage in the appropriate field. Note: If an equity component is allocated in shares, the percentage of base field is not available. 
Target equity grants can be set for an employee. If a target equity grant is set, the target amount is displayed. 
If any adjustment guidelines are defined for the employee, the adjustment fields are automatically populated with the recommended adjustments. The recommended adjustment values can be modified, but must remain within the adjustment guidelines. If a component allocation is outside the component guidelines, an error icon appears to the right of the allocation. Compensation managers can click the icon to open the Over Guideline pop-up, which enables the compensation manager to adjust the allocation. See Compensation Plan - Over Guideline on page 340 for additional information.
· If a component allocation is outside the component guidelines but within the threshold, a yellow Error icon [image: ] appears to the right of the component allocation.
· If a component allocation is outside the component guidelines and also exceeds the threshold, a red Error icon [image: ] appears to the right of the component allocation.
Adjustment Guideline Recommendations
If a discretionary adjustment guideline applies to a component, then the Adjustment Guidelines icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the original recommended allocations for the component. The pop-up displays the currency and the original recommended allocation for the component. The currency that is displayed is the currency that is set for the compensation plan.
The Adjustment Guidelines icon is not available if there is no associated adjustment guideline or if the guideline is non-discretionary.
For equity components being allocated as a cash award, the currency that is displayed is the currency that is set for the compensation plan. For equity components being allocated as shares, the currency is displayed as "Shares."
Component Proration
If a component has been prorated for the user, then the Prorated Recommendations icon [image: ] appears to the right of the component field. Hover the computer cursor over the icon to view the prorated recommendations for the component. The pop-up displays the currency and the prorated recommendations for the component. The currency that is displayed is the currency that is set for the compensation plan.
· If the component has not yet been prorated into multiple periods, then the component allocation field is editable.
· If the component has multiple prorated periods, then the component allocation field is read-only and an Edit icon [image: ] appears to the right of the Prorated Recommendations icon. Click the Edit icon to open the Proration pop-up and allocate prorated amounts for each of the prorated periods of the component for the user.
See Compensation Plan - Proration - Equity on page 354 for additional information.
Employee Expanded View
Each employee row is collapsed by default. To view detailed information for the employee, select the More Info option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
See Compensation Plan - Employee Expanded View on page 328 for additional information.
Budget Summary Graph
The Budget Summary graph appears below the Plan Details table on Compensation Plan template and summary pages. This graph displays allocations, budgets, and remaining available allocations for each component that is configured to display. The graph is updated dynamically as the compensation plan is edited. See Compensation Plan - Budget Summary Graph Overview on page 317 for additional information.
Comp Analytics
The Comp Analytics section appears below the Budget Summary graph on Compensation Plan template pages. Each report displays a snapshot of the corresponding information. These reports are updated in real-time. If a component is not included in the compensation plan, then the component does not appear in any compensation analytics graphs. See Compensation Plan - Comp Analytics on page 327 for additional information.
Action Buttons
At the bottom of the page, the following buttons may be available:
· Save Draft - Click this button to save the compensation plan without submitting it.
· Previous - Click this button to return to the previous page. This button is not available on the first tab of the compensation plan.
· Next - Click this button to proceed to the next tab within the compensation plan.
· Deny - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and deny the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
· Approve - This option is only available when a compensation manager views a compensation plan that requires their approval. Click this button to validate the compensation allocations for the tab and approve the compensation plan. If all allocation validations are passed, then the Summary tab is opened, and the Approve/Deny Confirmation pop-up is opened.
[bookmark: _Ref-265080357]Compensation Plan - Summary/Read-only/Approval Tab
The Summary/Read-only/Approval view enables compensation managers to view all components and their allocations from the compensation plan for each employee. Allocations cannot be edited in this view.
To access the Summary tab when creating a compensation plan, click the Summary tab. This is always the last tab in the compensation plan.
To access the Read-only view of a compensation plan when viewing the compensation task, from the Compensation Plans tab, select the View option for a specific draft.
To access the Approval view of a compensation plan, view a compensation plan for which you are an approver. The Approval view is only available when the compensation manager is an approver for the compensation plan but does not have editing rights.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation


[image: ]
Search and Filter Users
Compensation managers and approvers can search for users within a compensation plan by name, position, and eligibility status.
· Search by Name - This field enables managers to search for specific users within the compensation plan by name. When a search is conducted, the search query is retained as the compensation manager navigates between tabs. 
· The Budget Summary and Compensation Analytics are not impacted or limited when a search is conducted. 
· Compensation managers can search by <First Name>, by <Last Name>, or by <First Name> <Last Name>. Compensation managers cannot search by <Last Name> <First Name>.
· Compensation managers can search for multiple names by separating them by a semicolon.
· Position - This field enables managers to filter the compensation plan by position. When one or more position organizational unit (OU) is selected, the compensation plan only displays users who are within the selected positions. This enables compensation managers to easily compare employees within the same position or similar positions. The filter only contains the positions that are associated with users within the compensation plan. If there are no users within the compensation plan, then this filter is not available.
· Show Ineligible Employees - Select this option to include ineligible employees in the search. No component data is displayed and no options are available for ineligible employees.
Effective Dates
The Effective Date is displayed for each component in the compensation plan. This indicates when the changes for each component will be effective if the compensation plan is approved.
The Effective Date for each component is set when the component template is added to the compensation task.
For standard off-cycle compensation tasks, this functionality is only available if the Effective Date setting for the task is configured so that the assigner can define the effective date at the launch of the task.
For modeling compensation tasks, this functionality is not available. 
View Options
The following options enable the compensation manager to customize how information is displayed in the Plan Details table:
· View - From the drop-down, select whether components are displayed as an amount or as a percentage. Administrators can configure the default selection for this option when configuring the compensation template.
· Amount - Select this option to display components as fixed currency amounts. This option is selected by default.
· Percentage - Select this option to display components as percentages of the budget (i.e., <ALLOCATION> divided by <BUDGET>). If no budget applies or has been set, "--%" is displayed.
· Currency - From the drop-down, select the currency in which currency amounts are displayed throughout the compensation plan tab. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Compensation Task Currency
· Compensation Manager's Currency
· Employee's Currency
· Show Ineligible Employees - Select this option to include ineligible employees in the Plan Details table for the current tab. No component data is displayed and no options are available for ineligible employees. This option is unchecked by default.
· Show All Comments - Select whether all comments for each user are displayed directly in the Plan Details table. When this option is selected, all comments for the current compensation plan tab are displayed in the Plan Details table. The user photo and name of the compensation manager who wrote the comment and the date and time at which the comment was made are displayed for each comment. The newest comments are displayed first. This option is unchecked by default.
· Show - From the drop-down, select the maximum number of users who can be displayed in the Plan Details table. If more than the selected number is available, then the additional users appear on a separate page, and the compensation manager must navigate to each page to view all users. This option is only available if at least 16 users are available to be displayed in the Plan Details table. 
Plan Details Table
The plan details table can be sorted by any of the data or component columns in the plan. Only one column can be sorted at a time. Monetary values are sorted based on string values, so all hourly rates appear above salary rates when sorted from low to high. In addition, $500 appears before 1000 Yen when sorted from low to high regardless of the currency conversion. 
· The sorting applies to the entire compensation plan tab, regardless of the number of pages. If the compensation manager is not on the first page when they sort the plan, they are taken to the first page of the plan. 
· To sort the compensation plan based on a certain column, click the column heading. To reverse the sort order, click the column heading again. When navigating to a different tab, the sort order is not saved.
The following information is displayed for each user in the Plan Details table:
· User Photograph
· Name - Click the user's name to open their Universal Profile - Snapshot in a separate window. See Snapshot Overview for additional information. If Universal Profile - Snapshot is not enabled, then this opens their Universal Profile - Bio in a separate window. See Universal Profile - Bio Overview for additional information.
· Position
· Options - To view which options are available for a user, click the Options drop-down [image: ] to the right of the user's name. See the User Options section below for additional information.
· Components - For each component included in the compensation plan, a column appears to the right of the Name column. The layout of the columns and the column names are configured by the compensation administrator when the compensation task is created. See the Components section below for additional information.
At the bottom of the Plan Details table, the horizontal scroll bar is always visible when viewing any part of the Plan Details table when not all data in the table can be displayed on the screen. The horizontal scroll bar enables the user to scroll left and right on the Plan Details table. As the user scrolls vertically on the page while the Plan Details table is displayed, the horizontal scroll bar for the Plan Details table floats at the bottom of the screen.
User Options
The following options may be available by selecting the Options drop-down [image: ] to the right of the user's name:
· More Info - Select this option to open the expanded view of the employee. This option is only available if the expanded view is enabled for at least one component tab (i.e., Base, Bonus, Equity). This option is also available if the user has been promoted. See Compensation Plan - Employee Expanded View on page 328 for additional information.
· Comment - Select this option to view a history of all of the comments made regarding the user for all component tabs (i.e., Base, Bonus, Equity). This option also enables the compensation manager to add a new comment. See Compensation Plan - Comments on page 324 for additional information.
Components
For each component included in the compensation plan, a column appears to the right of the Current Salary column. The layout of the columns and the column names are configured by the compensation administrator when the compensation task is created. Components can be hidden from this page when creating the compensation task. Hiding a component from the Summary page hides the component from the Budget Summary graph, but it does not hide the component as a column in the table.
If a component allocation is outside the component guidelines, a yellow Error icon [image: ] appears to the right of the component allocation. See Compensation Plan - Outside Guidelines on page 338 for additional information.
Line Item Approval
If a compensation plan has been denied with line item approval and the original compensation manager is viewing the compensation plan, the approval or denial details appear to the left of each employee.
[image: ]
Employee Expanded View
Each employee row is collapsed by default. To view detailed information for the employee, select the More Info option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
See Compensation Plan - Employee Expanded View on page 328 for additional information.
Budget Summary Graph
The Budget Summary graph appears below the Plan Details table on Compensation Plan template and summary pages. This graph displays allocations, budgets, and remaining available allocations for each component that is configured to display. The graph is updated dynamically as the compensation plan is edited. See Compensation Plan - Budget Summary Graph Overview on page 317 for additional information.
Additional Comments
On the Summary tab, compensation managers can add additional comments regarding the compensation plan before it is finalized. The additional comments are then viewable within the Plan History pop-up.
When in read-only view, this section displays any existing additional comments, but this field cannot be edited.
Action Buttons
At the bottom of the page, the following buttons may be available:
· Save Draft - Select this button to save the compensation plan without submitting it.
· Previous - Select this button to return to the previous page.
· Submit - Select this button to submit the compensation plan. This button is only available on the Summary tab. This button is only available if the following is true:
· All allocations are within the corresponding guidelines and thresholds.
· If there are Cascaded Budget Type components, all budgets have been distributed.
· If there are Cascaded Budget Type components, all subordinate compensation plans have been submitted.
· Deny - Select this button to deny the compensation plan. This button is only available if the compensation plan is pending the compensation manager's approval. This opens the Approve/Deny Confirmation pop-up. See Compensation Plan - Approve/Deny Confirmation on page 315 for additional information.
· Approve - Select this button to approve the compensation plan. This button is only available if the compensation plan is pending the compensation manager's approval. This opens the Approve/Deny Confirmation pop-up. See Compensation Plan - Approve/Deny Confirmation on page 315 for additional information.
[bookmark: _Ref705169352]Compensation Plan - Options Drop-down Overview
When creating a compensation plan, the following options may be available from the Options drop-down menu:
· Additional Recommendations - Select this option to view the additional recommendations that are associated with the compensation plan tab. This option is only available if the Base, Bonus, or Equity tab is selected, and if the corresponding compensation template is configured to include additional recommendations in a pop-up. See Compensation Plan - Additional Recommendations on page 313 for additional information.
· Contact Administrator - Select this option to send a message to the administrator for the compensation task. This option is only available if an administrator contact is defined for the compensation task. See Compensation Task - Contact Administrator on page 272 for additional information.
· View History - Select this option to view the submission and approval history of the compensation plan. This option is only available if there is any history to display for the user's compensation plan. See Compensation Task - View Plan History on page 277 for additional information.
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[bookmark: _Ref1809708563]Compensation Plan - Additional Recommendations
The Additional Recommendations pop-up provides compensation managers with additional recommendations when completing a Base, Bonus, or Equity tab within a compensation plan. The additional recommendation information is specific to the selected tab. If a different tab is selected, the information may not be available or may change. 
To view the additional recommendations that are associated with the compensation plan tab, select Additional Recommendations from the Options drop-down in the User Dashboard.
This option is only available if the Base, Bonus, or Equity tab is selected, and if the corresponding compensation template is configured to include additional recommendations in a pop-up. 
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Compensation Plan - Components/Pop-ups Overview
[bookmark: _Ref395460976]Compensation Plan - Approve/Deny Confirmation
The Approve and Deny Confirmation pop-ups enable the approver to confirm the approval or denial of the compensation plan.
The Approve Confirmation pop-up opens when an approver clicks the Approve button on a compensation plan that is pending the approver's approval.
The Deny Confirmation pop-up opens when an approver clicks the Deny button on a compensation plan that is pending the approver's approval.
Approve Confirmation Pop-up
[image: ]
The following options are available in the Approve pop-up:
· Approve - Click this button to approve the compensation plan. The compensation plan is approved and moves to the next step in the approval workflow for the compensation task.
· Cancel - Click this button to cancel the approval and return to the compensation plan.
Deny Confirmation Pop-up
[image: ]
The following options are available in the Deny pop-up:
· Deny - Click this button to deny the compensation plan. The compensation plan is denied and is returned to the original compensation manager.
· Cancel - Click this button to cancel the denial and return to the compensation plan.
[bookmark: _Ref-1888737191]Compensation Plan - Budget Summary Graph Overview
The Budget Summary graph appears below the Plan Details table on Compensation Plan template and summary pages. This graph displays allocations, budgets, and remaining available allocations for each component that is configured to display. The graph is updated dynamically as the compensation plan is edited. If all components are hidden from the Budget Summary graph, then the entire Budget Summary graph is hidden.
The Budget Summary graph only appears for compensation planning tasks. 
[image: ]
Currency
From the drop-down, select the currency in which currency amounts should be displayed in the Budget Summary and Comp Analytics graphs. If only one currency is available, then the currency is displayed as text and cannot be modified. Currency conversions are based upon the conversion rate at the time the compensation task was launched. The following currencies may be available:
· Corporate Currency
· Compensation Manager's Currency - This option is selected by default.
· Currency of any eligible employee in the compensation plan
Note: The Currency drop-down is hidden on the Equity tab if all equity components are granted in Shares instead of Awards.
Graph Data
Each component that is visible in the compensation template appears in the graph in the following order:
· Base Tab:
· Merit Increase
· Custom base components that are included in the Base salary in alphabetical order
· Custom base components that are not included in the Base salary in alphabetical order
· Bonus Tab:
· Bonus
· Custom bonus components in alphabetical order
· Custom bonus target components in alphabetical order
· Equity Tab:
· Equity components in alphabetical order
· Equity target components in alphabetical order
· Summary Tab:
· Base components that are included in the Base Salary in alphabetical order
· Base components that are not included in the Base Salary in alphabetical order
· Bonus components in alphabetical order
· Equity components in alphabetical order
The Budget Summary graph displays the following information for each component:
· Component Name
· Average Increase (Base Components Only) - See Compensation Plan - Budget Summary Graph - Average Merit Increase Display on page 321 for additional information.
· Expand/Collapse - If a component has multiple budgets, an Expand icon [image: ] or a Collapse icon [image: ] appears to the right of the component name. Compensation managers can expand a component to view the allocations and budgets for each OU specific component budget. By default, all components are collapsed, displaying only the overall component allocation and budget. See the Component with Multiple Budgets section below for additional information.
· Graph - The bar graph represents the component allocations with relation to the component budget. The allocation percentages are also displayed at the bottom of the graph.
· If the allocations are less than the budget, then the row is green.
· If the allocations exceed the budget, then the row is red.
· Allocation/Budget - To the right of the graph, the exact component allocation and budget values are displayed.
· If the allocations are less than the budget, then the allocation value appears green.
· If the allocations exceed the budget, then the allocation value appears red.
· Amount Over/Under Budget - To the right of the allocations and budget values, the amount by which the allocations are over or under the budget is displayed.
· If the allocations are less than the budget, then the amount remaining for allocation appears gray.
· If the allocations exceed the budget, then the amount by which the budget is exceeded appears red and an Error icon is displayed.
· If a component contains an OU specific component that is over budget, then the overall component and the OU specific component appear as over budget. However, the overage amount only appears for the OU specific component.
Component with Multiple Budgets
If a component has multiple budgets, an Expand icon [image: ] or a Collapse icon [image: ] appears to the right of the component name. Compensation managers can expand a component to view the allocations and budgets for each OU specific component budget. By default, all components are collapsed, displaying only the overall component allocation and budget. 
Component with Multiple Budgets - Collapsed
When a component with multiple budgets is collapsed, the overall budget summary for the component is displayed. This represents the sum of the allocations and budgets from the OU specific component budgets. If an OU specific component does not have a budget, then the allocation amount for the OU specific component is used as the budget.
Component with Multiple Budgets - Expanded
When a component with multiple budgets is expanded, the budget summary is displayed for each OU specific component budget. 
· An OU specific component only appears in the graph if there are eligible employees in the compensation plan who apply to the OU specific component budget.
· If an OU specific component does not have a budget, then the budget for the OU specific component is represented by dash marks (i.e., "---").
Component with Multiple Budgets - Filter
When a component with multiple budgets is expanded, compensation managers can click the name of an OU specific component budget to filter the current tab of the compensation plan by the selected component budget. When a tab is filtered by an OU specific component budget, the following occurs:
· The selected OU specific component budget filter is displayed at the top of the compensation plan tab. To remove the filter, click the X icon to the right of the filter details.
· The Budget Summary graph and the Plan Details table are filtered by the selected OU specific component budget. Only users who apply to the selected budget OU appear in the Plan Details table.
· The Budget Summary graph only displays information for the selected OU specific component and the associated overall component (e.g., Merit Increase - Australia budget and Merit Increase - Overall budget).
· Note: The OU specific component budget filter only applies to the current tab. Other tabs within the compensation plan are unaffected. Also, the compensation manager cannot filter the compensation plan when an employee in the compensation plan has been allocated over the threshold that was set in Adjustment Guidelines. The employee line item appears in red when this occurs.
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[bookmark: _Ref-1554140068]Compensation Plan - Budget Summary Graph - Average Merit Increase Display
Organizations may choose to display the average merit increase in a compensation task. This is only available for base components. This functionality is disabled by default. 
The average merit increase percentage can be viewed per component and per organizational unit (OU). Organizations can choose to display either the Average Allocation percentage or the Average Increase percentage:
· Average Allocation - This displays the average of all allocation percentages for the component or OU. See Compensation Plan - Budget Summary Graph - Use Case - Average Allocation on page 322 for additional information.
· Average Increase - This displays the average of all budget increase percentages for the component or OU. This is calculated using the overall ratio of allocations to current salary. See Compensation Plan - Budget Summary Graph - Use Case - Average Increase on page 323 for additional information.
The values are displayed using the compensation decimals of precision for percentages. 
If automatic lump sum adjustments are enabled for merit increase, then these allocations are included in the Average Allocation and Average Increase calculations. 
Only one value can be displayed. If both values are enabled, then only the Average Increase is displayed.
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[bookmark: _Ref996723374]Compensation Plan - Budget Summary Graph - Use Case - Average Allocation
The following budgets are set for the compensation task:
	Organizational Unit (OU)
	Merit Increase Budget by OU
	Cost of Living Budget by OU

	Division A
	3%
	5%

	Division B
	4%
	4%

	Division C
	3.5%
	3.5


The following users are in the compensation plan:
	User
	OU
	Current Salary/Hourly Rate

	User 1
	Division A
	10,000 USD

	User 2
	Division B
	20,000 GBP (30,000 USD)

	User 3
	Division C
	30,000 USD

	User 4
	Division A
	40 USD/hour; 2080 hours/year (83,200 USD Annualized)


The decimals of precision that are used for percentages in compensation is 2.
The following allocations are given in the compensation plan:
	User
	Merit Increase
	Cost of Living

	User 1
	3% (300 USD)
	4% (400 USD)

	User 2
	4% (800 GBP; 1200 USD)
	5% (1000 USD; 1500 USD)

	User 3
	3.5% (1050 USD)
	3% (900 USD

	User 4
	2.5% (2080 USD)
	2% (1664 USD)

	Total
	4630 USD
	4464 USD


The average allocation is calculated by finding the average of all allocation percentages. The following average allocations result from the compensation plan:
	Division
	Merit Increase
	Cost of Living

	Division A (Users 1 & 4)
	(3% + 2.5%) / 2 = 2.75%
	(4% + 2%) / 2 = 3.00%

	Division B (User 2)
	4% / 1 = 4.00%
	5% / 1 = 5.00%

	Division C (User 3)
	3.5% / 1 = 3.50%
	3% / 1 = 3.00%

	Overall
	(3% + 4% + 3.5% + 2.5%) / 4 = 3.25%
	(4% + 5% + 3% + 2%) / 4 = 3.50%


[bookmark: _Ref-2006933308]Compensation Plan - Budget Summary Graph - Use Case - Average Increase
The following budgets are set for the compensation task:
	Organizational Unit (OU)
	Merit Increase Budget by OU
	Cost of Living Budget by OU

	Division A
	3%
	5%

	Division B
	4%
	4%

	Division C
	3.5%
	3.5


The following users are in the compensation plan:
	User
	OU
	Current Salary/Hourly Rate

	User 1
	Division A
	10,000 USD

	User 2
	Division B
	20,000 GBP (30,000 USD)

	User 3
	Division C
	30,000 USD

	User 4
	Division A
	40 USD/hour; 2080 hours/year (83,200 USD Annualized)


The decimals of precision that are used for percentages in compensation is 2.
The following allocations are given in the compensation plan:
	User
	Merit Increase
	Cost of Living

	User 1
	3% (300 USD)
	4% (400 USD)

	User 2
	4% (800 GBP; 1200 USD)
	5% (1000 USD; 1500 USD)

	User 3
	3.5% (1050 USD)
	3% (900 USD

	User 4
	2.5% (2080 USD)
	2% (1664 USD)

	Total
	4630 USD
	4464 USD


The average budget increase is calculated by dividing the total allocations by the total original salaries. The following average budget increases result from the compensation plan:
	Division
	Merit Increase
	Cost of Living

	Division A (Users 1 & 4)
	(300 + 2,080) / (10,000 + 83,200) = 2.55%
	(400 + 1,664) / (10,000 + 83,200) = 2.21%

	Division B (User 2)
	1,200 / 30,000 = 4.00%
	1,500 / 30,000 = 5.00%

	Division C (User 3)
	1,050 / 30,000 = 3.50%
	900 / 30,000 = 3.00%

	Overall
	(300 + 1,200 + 1,050 + 2,080) / (10,000 + 30,000 + 30,000 + 83,200) = 3.02%
	(400 + 1,500 + 900 + 1,664) / (10,000 + 30,000 + 30,000 + 83,200) = 2.91%


[bookmark: _Ref-2101776732]Compensation Plan - Comments
The Comments pop-up shows a history of all of the comments made for a user for a specific component in the compensation plan. The pop-up also enables the compensation manager to add a new comment.
The Component Tab Comments pop-up can only be accessed from one of the compensation plan component tabs (i.e., Base, Bonus, Equity). To access the pop-up, select the Comments option from the Options drop-down menu that appears to the right of the user photo in the Plan Details table.
The Summary Comments pop-up can only be accessed from the Summary tab or the Read-only/Approval view of the compensation plan. To access the pop-up, select the Comments option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
Component Tab Comments Pop-up
[image: ]
The Component Tab Comments pop-up only displays comments that have been added for the corresponding user on the corresponding component tab. The pop-up title indicates the user whose comments are being viewed.
By default, the last three comments that were added for the user on the component tab are displayed with the most recent comment displayed first. If more than three comments are available, the compensation manager can view all comments by clicking the View # Comments link. The compensation manager can then hide the additional comments by clicking the Show Less link.
The following information is displayed for each comment:
· User Photograph
· Name
· Timestamp - This displays the date and time at which the comment was added.
· Comment Text
To add a comment, enter the comment text in the Add a comment field, up to 2000 characters. This field includes rich text editing options.
· After entering a comment, click Post to post the comment. The pop-up remains open and the new comment appears at the top of the comments list.
· To close the pop-up, click Cancel.
Summary Comments Pop-up
[image: ]
The Summary Comments pop-up enables the compensation manager to view comments from each tab within the compensation plan. Each component tab within the compensation plan appears on a separate tab within the pop-up. Each tab displays comments that have been added for the corresponding user on the corresponding component tab. The pop-up title indicates the user whose comments are being viewed.
By default, the last three comments that were added for the user on the component tab are displayed with the most recent comment displayed first. If more than three comments are available, the compensation manager can view all comments by clicking the View # Comments link. The compensation manager can then hide the additional comments by clicking the Show Less link.
The following information is displayed for each comment:
· User Photograph
· Name
· Timestamp - This displays the date and time at which the comment was added.
· Comment Text
To add a comment for the selected component tab, enter the comment text in the Add a comment field, up to 2000 characters. This field includes rich text editing options. Note: Compensation managers cannot add a comment when viewing the compensation plan in read-only mode.
· After entering a comment, click Post to post the comment. The pop-up remains open and the new comment appears at the top of the comments list.
· To close the pop-up, click Cancel.
[bookmark: _Ref-1859957509]Compensation Plan - Comp Analytics
The Comp Analytics section appears below the Budget Summary graph on Compensation Plan template pages. Each report displays a snapshot of the corresponding information. These reports are updated in real-time. If a component is not included in the compensation plan, then the component does not appear in any compensation analytics graphs. 
The Comp Analytics section only appears on a tab if it is enabled for the corresponding compensation template. The Comp Analytics section may appear on some tabs, but not others.
The following Comp Analytics may be available on each tab:
· Base:
· Salary Distribution - This report displays a pie chart of the distribution of employee salary.
· Total Salary - This report displays a bar graph of each employee's total salary.
· New Compa-Ratio Over Under - This report displays a graph of New Comp-Ratio Over Under for the employees.
· Performance vs. New Compa-Ratio - This report displays a graph of each employee's Performance versus New Compa-Ratio.
· Bonus:
· Bonus Distribution - This report displays a pie chart of the distribution of employee bonuses.
· Total Bonus - This report displays a bar graph of each employee's total bonus.
· Bonus Attained - This report displays a graph of the percentage of each employee's attained bonus.
· Performance vs. Bonus Attainment - This report displays a graph of each employee's Performance versus Bonus Attainment.
· Equity:
· Equity Distribution - This report displays a pie chart of the distribution of employee equity.
· Total Equity - This report displays a bar graph of each employee's total equity.
· Performance vs. Equity Grant - This report displays a graph of each employee's Performance versus Equity Grant.
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[bookmark: _Ref-97016200]Compensation Plan - Employee Expanded View
Each employee row is collapsed by default. To view detailed information for the employee, select the More Info option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
The expanded view displays additional information about the employee. The administrator can configure which information is displayed when the compensation template is configured. 
The following informational graphs are available within the employee expanded view on each tab:
· Base:
· Salary History/Rate History [image: ] - Click this icon to view the employee's salary/rate for the past three years in graph form.
· Performance History [image: ] - Click this icon to view the employee's performance review history.
· Bonus:
· Bonus History [image: ] - Click this icon to view the employee's bonuses for the past three years in graph form.
· Performance History [image: ] - Click this icon to view the employee's performance review history.
· Equity:
· Grant History [image: ] - Click this icon to view the employee's equity awards for the past three years in graph form.
· Performance History [image: ] - Click this icon to view the employee's performance review history.
· Summary, Read-only, Approval - No information graphs are available within the employee expanded view for this tab.
Note: If a component is not included in the compensation plan, then the component does not appear in any compensation plan history graphs.
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[bookmark: _Ref-1543061509]Compensation Plan - Lump Sum Allocation
If lump sum adjustments are enabled for the Base tab, a Lump Sum component appears on the Base tab in the compensation plan. The location and the name of the Lump Sum column is configured by the administrator when the base template is created. A lump sum is a one-time payment that does not affect the employee's salary/rate. However, it does count towards the budget for base adjustments.
Tooltips for Merit Increase and Lump Sum Components
Tooltips for the Merit Increase and Lump Sum components indicate the automatic allocation shift from Merit Increase to Lump Sum. The tooltips are only visible if the compensation template is configured to allow for automatic lump sum allocation for salary range overages.
Merit Increase Tooltip
The Merit Increase tooltip indicates that salary range overage amounts are allocated to the Lump Sum component. Note: The tooltip only displays help text if Recommendations are not available.
When users click into the Merit Increase component field, compensation plans display the original allocated merit increase amount prior to automatic lump sum adjustment and the Lump Sum component reflects "0." When users click out of the Merit Increase component field, automatic lump sum adjustment for salary range overages are calculated and reflected in the Merit Increase and Lump Sum components.
Considerations
The following considerations assume that the automatic lump sum adjustment for salary range overages functionality is enabled:
· Once automatic lump sum adjustment has occurred and the Merit Increase component is not being edited, the Merit Increase and Lump Sum components reflect the amounts calculated by the automatic lump sum adjustment, as currently implemented.
· When editing the allocation amount in the Merit Increase component, the merit increase reflects the original allocated merit increase amount prior to the automatic lump sum adjustment (i.e., <Merit Increase> + <Lump Sum>). Further, the lump sum amount reflects "0."
Use Cases
The following use cases assume that the base template in the task includes Merit Increase and Lump Sum components and that the Automatic Lump Sum allocation for Salary Range overages option is enabled.
	Position
	Wage Type
	Minimum Salary/Rate
	Maximum Salary/Rate

	Sr. Software Engineer
	Annual
	$90,000
	$115,000


 
	Employee
	Wage Type
	Labor Hours
	Position
	Current Salary/Rate

	Jonathan Stanley
	Annual
	N/A
	Sr. Software Engineer
	$115,000


Use Case 1: Merit Increase Component - Read-Only Mode
Default Merit Increase adjustment guideline at 5% of base.
Action
Compensation manager creates a new compensation plan.
Results
1. Jonathan Stanley reflects:
· Merit Increase: $0.00/0.0%
· New Salary: $115,000.00
· Lump Sum: $5,750.00
· Salary Range overage: $5,750.00/5.0%
Use Case 2: Merit Increase Component - Edit Mode
Default Merit Increase adjustment guideline at 5% of base.
Action
1. Compensation manager creates a new compensation plan.
2. Compensation manager opens Jonathan Stanley's Merit Increase component to edit the allocation amount.
Results
1. Jonathan Stanley reflects:
· Merit Increase: $5,750.00/5.0%
· New Salary: $115,000.00
· Lump Sum: $0.00
Use Case 3: Merit Increase Component - Edit and Move
Default Merit Increase adjustment guideline at 5% of base.
Action
1. Compensation manager creates a new compensation plan.
2. Compensation manager opens Jonathan Stanley's Merit Increase component to edit the allocation amount.
3. Compensation manager edits Jonathan Stanley's merit increase from $5,750.00 to $3,450.00.
4. Compensation manager clicks outside Jonathan Stanley's Merit Increase component on the compensation plan.
Results
1. Jonathan Stanley reflects:
· Merit Increase: $0.00/0.0%
· New Salary: $115,000.00
· Lump Sum: $3,450.00
· Salary Range overage: $3,450.00/3.0%
Lump Sum Tooltip
The Lump Sum tooltip indicates the salary range overage amount that has been shifted from the Merit Increase component. In addition to the currency, the following is included in the tooltip depending on if the wage type is annual or hourly:
· Annual Wage Type - The Salary Range overage field displays the amount shifted from the Merit Increase component that caused the employee to exceed the salary range. The Salary Range overage field also shows the percentage of the overage amount against the employee's current salary. The values included in the field display as <Overage Amount> <Currency> / <Overage as Percentage of Base>. Note: The Salary Range overage field displays "0.00 <CURRENCY> / 0.0%" if the employee is still within their salary range or if the employee exceeds the salary range but no Merit Increase amount has been allocated.
· Hourly Wage Type - The Rate Range overage displays the money per-hour rate amount for which the employee is the salary range. The values included in the field display as <Overage Amount> <Currency> / <Overage as Percentage of Base>. Note: If the hourly salary range is only specified by an annualized amount, the rate range overage is calculated using the following formula: <Max Annual Salary>/<Labor Hours>.
New Salary Exceeds Salary Range
If an employee's new salary is over their salary range, the overage amount is deducted from the merit increase allocation and appears in the Lump Sum component allocation. For annual wage type employees, the overage amount is moved from Merit Increase to display in the Lump Sum component. For hourly wage type employees, the overage amount is calculated by taking the overage expressed in money per hour multiplied by the employee's labor hours. This annualized overage amount displays in the Lump Sum component.
Prorated Merit Increase
If Merit Increase is a prorated component, then when editing the merit increase allocation, the Merit Increase Recommendations pop-up displays help text indicating the automatic allocation. See Compensation Plan - Proration - Base on page 347 for additional information.
Considerations
The following considerations assume that the automatic lump sum adjustment for salary range overages functionality is enabled:
· The calculated merit increase proration breakdown is only visible within the compensation statement when using the proration breakdown tag.
· When the user opens the Merit Increase Recommendations pop-up, the total increase amount reflects the total allocated merit increase amount prior to the automatic lump sum adjustment. Each of the prorated line items show the previous allocated line item amount prior to the automatic lump sum adjustment. That is, the system remembers what was allocated to each prorated line item prior to the automatic lump sum adjustment.
· When the user is not viewing the Merit Increase Recommendations pop-up, the compensation plan reflects the actual Merit Increase and Lump Sum components after the automatic lump sum adjustment.
Use Cases
The following use cases assume that the Automatic Lump Sum allocation for Salary Range overages option is enabled.
	Position
	Wage Type
	Minimum Salary/Rate
	Maximum Salary/Rate

	Software Engineer
	Annual
	$75,000
	$90,000

	Sr. Software Engineer
	Annual
	$90,000
	$115,000



	Employee
	Wage Type
	Labor Hours
	Position
	Current Salary/Rate

	Melissa Powers
	Annual
	N/A
	Sr. Software Engineer
	$100,000


Use Case 1: Proration - Simple
Assumptions
1. Melissa Powers' positions from 1/1/2011 - 12/31/2011:
· Software Engineer: 1/1/2011 - 5/20/2011 (140 days, 38.4%)
· Sr. Software Engineer: 5/21/2011 - 12/31/2011 (225 days, 61.6%)
2. Compensation period is set to 1/1/2011 - 12/31/2011.
3. Merit increase is prorated by the length of time in the position.
4. Default Merit Increase adjustment guideline at 20% of base.
Action
1. Compensation manager creates a new compensation plan.
2. Melissa Powers shows $15,000 in the Merit Increase component and $5,000 in the Lump Sum component.
3. Compensation manager edits the Merit Increase component for Melissa Powers.
Results
1. Merit Increase proration pop-up displays the following:
· First prorated period
· Position: Software Engineer
· Proration: 38.4%
· Minimum: $7,671.23
· Maximum $7,671.23
· Increase: $7,671.23/7.7%
· Second prorated period
· Position: Sr. Software Engineer
· Proration: 61.6%
· Minimum: $12,328.77
· Maximum: $12,328.77
· Increase: $12,328.77/12.3%
· Total Increase: $20,000.00
2. The following are compensation tags for Melissa Powers:
· Merit Increase Proration Breakdown:
	Date
	Number of Days
	Amount

	1/1/2011
	140
	$7,671.23

	5/21/2011
	225
	$7,328.77

	 
	Total
	$15,000.00


· Merit Increase: $15,000.00
· Lump Sum: $5,000.00
Use Case 2: Decreasing Component After Salary Range Overage - Proration
Assumptions
1. Melissa Powers' positions from 1/1/2011 - 12/31/2011:
· Software Engineer: 1/1/2011 - 5/20/2011 (140 days, 38.4%)
· Sr. Software Engineer: 5/21/2011 - 12/31/2011 (225 days, 61.6%)
2. Compensation period is set to 1/1/2011 - 12/31/2011.
3. Merit Increase is prorated by the length of time in the position.
4. Cost of Living Adjustment is a base component included in the base salary.
5. Default merit increase adjustment guideline at 20% of base.
6. Default Cost of Living Adjustment adjustment guideline is $1,000.00.
Action
1. Compensation manager creates a new compensation plan.
2. Melissa Powers shows $14,000 in the Merit Increase component and $6,000 in the Lump Sum component.
· Merit Increase proration pop-up displays the following:
· First prorated period
· Position: Software Engineer
· Proration: 38.4%
· Minimum: $7,671.23
· Maximum: $7,671.23
· Increase: $7,671.23 / 7.7%
· Second prorated period
· Position: Sr. Software Engineer
· Proration: 61.6%
· Minimum: $12,328.77
· Maximum: $12,328.77
· Increase: $12,328.77 / 12.3%
· Total Increase: $20,000.00
3. Compensation manager allocates $500.00 to Melissa Powers for Cost of Living Adjustment adjustment guideline.
Results
1. Melissa Powers is $500.00 less over her salary range than previously ($1,000.00 - $500.00).
2. Melissa Powers shows $14,500 in the Merit Increase component and $5,500 in the Lump Sum component.
· Merit Increase proration pop-up displays the following:
· First prorated period
· Position: Software Engineer
· Proration: 38.4%
· Minimum: $7,671.23
· Maximum: $7,671.23
· Increase: $7,671.23/7.7%
· Second prorated period
· Position: Sr. Software Engineer
· Pro-ration: 61.6%
· Minimum: $12,328.77
· Maximum: $12,328.77
· Increase: $12,328.77/12.3%
· Total Increase: $20,000.00
2. The following are compensation tags for Melissa Powers:
· Merit Increase Proration Breakdown:
	Date
	Number of Days
	Amount

	1/1/2011
	140
	$7,671.23

	5/21/2011
	225
	$6,828.77

	 
	Total
	$14,500.00


· Merit Increase: $14,500.00
· Lump Sum: $5,500.00
Automatic Calculation of Salary Range Overages
As adjustments are made to the Merit Increase component on a compensation plan, the system calculates whether or not the amount that is entered causes the new salary to exceed the employee's salary range. If the salary range is exceeded, the overage amount is automatically allocated to the Lump Sum component while Merit Increase retains the amount (if any) that brings the employee to the maximum amount of the salary range.
The following sections provide explanations of possible scenarios that may occur when the compensation template is configured to allow for automatic lump sum allocation for salary range overages.
Recommended Base Allocations Exceed Salary Range
· If an employee's recommended base allocations put them over the salary range, the overage amount is taken from the merit increase allocation and added to the lump sum allocation. This occurs when the plan opens to allow compensation managers to see the lump sum overage amount by default. Note: Only the Merit Increase component is used to reduce the new salary into a range. This means that even if the entire merit increase allocated amount has been shifted to the Lump Sum component, it is possible for the employee to be over the salary range.
· If an employee's current salary is already over the salary range, their entire merit increase allocation is shifted to the Lump Sum component.
Merit Increase Component Exceeds Salary Range
When a compensation manager allocates an employee's Merit Increase component and clicks outside of the component text input box or presses Enter on their keyboard, the system automatically calculates whether or not the amount that is entered causes the employee to exceed the salary range.
· If the employee exceeds the salary range, the overage amount is applied to the Lump Sum component. The Merit Increase component shows any remaining amount that brings the employee to the maximum amount in the salary range.
· If the employee is within the salary range, the Merit Increase component keeps the amount entered by the compensation manager.
Base Component Amount Exceeds Salary Range
When a compensation manager allocates an employee's base component that is selected to be included in the base salary, and then clicks outside of the component text input box or presses Enter on their keyboard, the system automatically calculates whether or not the amount that is entered causes the employee to exceed the salary range.
· If the employee exceeds the salary range and the lump sum has not been calculated (i.e., Lump Sum Amount = 0), the overage amount is removed from the employee's merit increase allocation and shifted to the Lump Sum component.
· If the overage amount is greater than the merit increase allocation, the entire merit increase allocation is shifted to the Lump Sum component. The remaining overage still applies to the employee's new salary. This also applies if there is a zero amount allocated to the Merit Increase.
· If the employee exceeds the salary range and the automatic lump sum allocation has previously occurred (i.e., the lump sum amount is greater than 0), the Lump Sum and Merit Increase components are recalculated from the start. That is, Merit Increase is treated as a new amount, and automatic lump sum allocation is calculated from the amount entered. Note: This may cause the merit increase allocation amount to increase and the lump sum amount to decrease.
· If the employee is within the salary range, then no amount is shifted.
Promotion
If a promotion is included for an employee, the salary range used to calculate automatic lump sum allocation is the new salary range based upon the promotion. Adding or removing a promotion recalculates and adjusts the merit increase and lump sum allocations appropriately upon closing the Promotion pop-up. See the Promote Employee section below for more information about promoting employees.
Prorated Merit Increase Component
If the Merit Increase component has been prorated and the compensation manager must provide allocations for multiple prorated periods in the Prorated Merit Increase Recommendations pop-up, then the total increase applied must also adhere to the automatic lump sum allocation if the increase causes the employee to exceed the salary range.
· The partial overage amount that is deducted from each prorated period is dependent upon the timeline of the prorated periods. The overage amount is first deducted from the last applicable prorated period. That is, the amount is deducted from the last period to the first (latest to earliest).
· For decreases in other base components included in the base salary that cause the overage amount to decrease, the merit increase amount added back to the prorated periods only adds the merit increase amount to the last applicable prorated period.
MERIT.INCREASE Tag
Any conditions or formulas that use the MERIT.INCREASE tag will pull the value of the Merit Increase component once the automatic lump sum allocation has taken place. That is, the MERIT.INCREASE tag reflects the actual merit increase amount after the overage amount is applied to the Lump Sum component.
Adjustment Guideline Considerations
· If an adjustment guideline references Merit Increase, the guideline is set to dynamically update its value in the task, and automatic lump sum allocation is enabled, then the adjustment guideline component resolves upon creating the compensation plan for the first time. However, the adjustment guideline component does not dynamically update in the task.
· Merit increase allocations, regardless of whether or not they are part of the Merit Increase component or shifted to the Lump Sum component, must follow the rules of the adjustment guideline. That is, the original, total merit increase allocation must adhere to that employees' adjustment guideline.
General Considerations
· The compensation manager cannot edit the Lump Sum component if the compensation template is configured to allow for automatic lump sum allocation for salary range overages.
· The Merit Increase component always utilizes the automatic Lump Sum allocation if the feature is enabled, regardless of whether or not the field is discretionary or non-discretionary.
· When adjusting the Merit Increase component, the Lump Sum component is recalculated at that point. That is, the Lump Sum component does not track its previous value; the value is recalculated based on the Merit Increase amount.
· Only the Merit Increase component is used to shift salary range overages to the Lump Sum component, regardless of whether or not there are other components included in the base salary.
[bookmark: _Ref487403428]Compensation Plan - Outside Guidelines
The Outside Guidelines pop-up shows the components within the compensation plan that are outside the component guidelines. The pop-up displays the guideline details and the current allocation amount.
The Outside Guidelines pop-up can be accessed in the following ways:
· On any component tab (i.e., Base, Bonus, Equity) on which there is an error for a component, select the Show Warning option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
· On the Summary/Read-only/Approval screens, click the Warning icon [image: ] next to any adjustment that is outside its guidelines.
This pop-up can only be accessed when there is at least one component that is outside its guidelines.
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The pop-up displays the following information for each of the adjustments that are outside the component guidelines for the corresponding user:
· Adjustment - This displays the name of the component that has an allocation that is outside the guideline for the corresponding user.
· Guideline - This displays the component guideline for the corresponding user.
· Amount - This displays the allocation amount for the component for the corresponding user.
Compensation Plan - Over Budget
The Over Budget pop-up shows the components that are over the budget and threshold that is set for the compensation component. The pop-up also displays the maximum budget amount that is allowed for the offending components, including the threshold.
The Over Budget pop-up can be accessed in the following ways:
· When viewing a component tab (i.e., Base, Bonus, Equity) within a compensation plan in which one or more components are over the budget and threshold for the component, clicking the Next or Back button opens the pop-up.
· When viewing any tab within a compensation plan in which one or more components are over the budget and threshold for the component, clicking the Submit button opens the pop-up.
This pop-up can only be accessed when there is at least one component that is over the budget and threshold for the component.
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The pop-up displays the following information for each budget that is outside the budget guidelines:
· Budget - This displays the name of the component that is outside the budget and threshold.
· Maximum Guideline - This displays the maximum guideline for the corresponding component, including the threshold.
Continue or Cancel
To navigate to the next tab in the compensation plan, click Continue. This button is not available when submitting the compensation plan. This button is only available when navigating to the next compensation plan tab.
To close the pop-up, click Cancel.
[bookmark: _Ref78739254]Compensation Plan - Over Guideline
The Over Guideline pop-up shows the minimum or maximum recommendation for the component for the associated user. The pop-up also enables the compensation manager to adjust the allocation amount to adhere to the guideline rules.
The Over Guideline within Threshold pop-up is accessed by clicking the yellow Error icon [image: ] next to the allocation amount for the user that is over its associated adjustment guideline. Note: This icon only appears when using the Merit Matrix or Editable Merit Matrix.
The Over Guideline Exceeds Threshold pop-up is accessed by clicking the red Error icon [image: ] next to the allocation amount for the user that is over its associated adjustment guideline and threshold.
This pop-up can only be accessed when there is at least one component that is over its guideline.
Over Guideline within Threshold Pop-up
[image: ]
Over Guideline Exceeds Threshold Pop-up
[image: ]
The Over Guideline pop-up displays the current allocation for the corresponding component and user.
· If the current allocation is within the component threshold, then the pop-up displays the minimum or maximum recommendation for the corresponding component and user.
· If the current allocation exceeds the component threshold, then the pop-up displays the maximum allowable allocation for the corresponding component and user.
Adjust or Cancel
To adjust the allocation amount, click Adjust.
· If the allocation was previously within the component threshold, then the allocation is automatically adjusted to the minimum or maximum recommendation (depending on whether the allocation was under or over the recommendation) for the corresponding component and user.
· If the allocation previously exceeded the component threshold, then the allocation is automatically adjusted to be within the threshold for the corresponding component and user. If the allocation is still over the maximum recommendation for the corresponding component and user, then a yellow Error icon [image: ] appears next to the allocation amount in the Plan Details table.
To close the pop-up, click Cancel.
Compensation Plan - Promotion Over/Under Range
The Promotion Over/Under Range pop-up displays the user's new salary or rate based on all allocations to base components included in the salary or rate. The pop-up also displays the new salary or rate range for the user based on the applied promotion.
The Promotion Over/Under Range pop-up opens when the compensation manager clicks the yellow Error icon [image: ] next to the promotion component that has a new salary that is either over or under the salary range indicated by the promotion. The Promotion component appears when a promotion has been given. The new salary is based on all allocations to base components included in the salary.
This pop-up can only be accessed when there is a promotion component that has a new salary that is either over or under the salary range indicated by the promotion.
[image: ]
[bookmark: _Ref-964094473]Compensation Plan - Promotion
The Promotion pop-up enables the compensation manager to promote a user and specify the details of the promotion. The pop-up displays the current salary structure and organizational unit (OU) associations for the user.
To promote a user, on the Base tab of the compensation plan, select the Promote option from the Options drop-down menu [image: ] that appears to the right of the user photo in the Plan Details table. Note: The Options drop-down is not available for ineligible employees. 
The ability to promote a user is only available if a promotion component is available in the compensation plan.
Pre-Configuration Note: A salary range for the Position OU that is selected in the New Position field must already be configured in Salary Structures by the administrator in order to save the promotion. If the new position does not have a salary range configured, then an error message displays when attempting to save the promotion.
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The following information and fields are available within the pop-up:
Currency
This displays the compensation task currency in which monetary values are displayed in the pop-up.
Primary Salary OU
The user's current primary salary OU appears on the left. This is the primary OU from the salary structure, which is configured by the administrator.
In the New (Primary Salary OU) field on the right, click the Select icon [image: ] to select the user's new primary salary OU. This is the user's primary salary OU after the promotion. This is required.
Secondary Salary OU
The user's current secondary salary OU appears on the left. This is the secondary OU from the salary structure, which is configured by the administrator.
In the New (Secondary Salary OU) field on the right, click the Select icon [image: ] to select the user's new secondary salary OU. This is the user's secondary salary OU after the promotion. This is required.
Tertiary Salary OU
If the compensation Base component is configured with a tertiary OU, then the user's current tertiary salary OU appears on the left. This is the tertiary OU from the salary structure, which is configured by the administrator.
In the New (Tertiary Salary OU) field on the right, click the Select icon [image: ] to select the user's new tertiary salary OU. This is the user's tertiary salary OU after the promotion. This is required.
Salary/Rate Range
The user's current salary or rate range appears on the left. This is the salary or rate range that corresponds with the user's current position.
Once the new position and location are selected, the user's new salary or rate range is displayed on the right. This is the salary or rate range that corresponds with the user's position after the promotion.
Salary/Rate
The user's current salary or rate appears on the left. This is the salary or rate that corresponds with the user's current position.
In the Promotion Increase field on the right, enter the fixed amount or percentage of base salary/rate by which the user's base salary or rate is being increased with the promotion. This automatically updates the Total New Salary/Rate value for the user. The promotion increase must not cause the user's total new salary or rate to be above or below the user's new salary or rate range.
Total New Salary/Rate
This displays the user's new salary or rate after the promotion. This value includes all base component allocations included in the user's base salary and the promotion increase. This must be within the user's new salary or rate range.
For hourly employees, if the compensation base component is configured by the administrator to display annual equivalents, then the user's total annualized salary is also displayed.
Comments
In the Comments field, enter any comments that are relevant to the promotion, including the reason for the promotion.
Save, Remove, or Cancel
Click Save to save the promotion details for the user. The user's total new salary or rate must be within the salary or rate range for the user's new position. Once saved, a Promoted link will appear on the Base tab below the user's Position OU title. Click the link to open the Promotion pop-up. Note: If the user is given a promotion, and then the promotion is removed, the Promoted link is removed.
Click Remove to remove the promotion and the promotion details from the user.
Click Cancel to discard any unsaved changes to the promotion details.
[bookmark: _Ref-648858618]Compensation Plan - Proration - Base
Proration enables an organization to adjust a user's compensation based on a prorated time period instead of the compensation period. This may be necessary if the employee has not been with the organization, in the position, or in their current salary for the entire compensation period. This may also be necessary if an employee did not receive a compensation adjustment from the prior compensation period. Proration can be based on the employee's Last Hire Date, Last Salary Change Date, or their time in an OU such as Position of Division. Proration can also be based on an employee's time in a specific group. Compensation components can be set to be prorated by the compensation administrator when configuring the compensation component. 
The Proration pop-up enables the compensation manager to view recommendations and allocate prorated amounts for each of the prorated periods of a component for a user.
The Proration pop-up is accessed by clicking the Edit icon [image: ] for a prorated component for a user in which there are multiple prorated periods.
This pop-up can only be accessed when there is a component with multiple prorated periods.
[image: ]
The pop-up title reflects the component that is being prorated.
Lump Sum Alert
If the Merit Increase component is being prorated and Automatic Lump Sum is enabled for the Base component by the administrator, then a Lump Sum alert is displayed to indicate that any rate or salary range overage will be allocated as a Lump Sum. That is, if the prorated increase causes the user's salary to exceed the salary range, then the amount by which the salary range is exceeded is awarded to the employee as a Lump Sum allocation.
Currency
This displays the compensation task currency in which monetary values are displayed in the pop-up.
Proration Table
Within the proration table, the following information is displayed:
· Proration Criteria - This displays the criterion by which the component is prorated. For example, if the proration is based on the time a user spent in a position, then this column displays the user's positions during the compensation period.
· Proration - This displays the proration percentage that is associated with the proration criterion. This percentage is applied to the increase amount to determine the total increase.
· Min - This displays the prorated minimum adjustment guideline amount.
· Max - This displays the prorated maximum adjustment guideline amount.
· Recommendations - This displays the prorated adjustment guideline amount.
· Increase - In this column, enter the base increase for the proration period as a fixed amount or as a percentage of base. The fixed amount defaults to the amount in the Recommendations column. However, these values can be edited.
· If the Increase value is outside the guidelines but within the threshold, the row is highlighted in yellow, and a yellow Warning icon [image: ] appears to the right of the allocation. When the proration pop-up is saved, the row in the compensation plan is also highlighted in yellow, and a yellow Warning icon appears to the right of the allocation.
· If the Increase value is outside the guidelines and the threshold, the row is highlighted in red, and a red Warning icon [image: ] appears to the right of the allocation. The proration pop-up cannot be saved until the allocations are adjusted to be within the threshold.
Total Increase
This row displays the summation of all of the Increase values.
Annualized
This row is only available for hourly employees if the prorated component is a Base type component that is included in the Base Salary.
This row displays the annualized total increase.
Save or Cancel
Click Save to save the proration allocations. Or, click Cancel to discard the proration allocations.
[bookmark: _Ref27766398]Compensation Plan - Proration - Bonus
Proration enables an organization to adjust a user's compensation based on a prorated time period instead of the compensation period. This may be necessary if the employee has not been with the organization, in the position, or in their current salary for the entire compensation period. This may also be necessary if an employee did not receive a compensation adjustment from the prior compensation period. Proration can be based on the employee's Last Hire Date, Last Salary Change Date, or their time in an OU such as Position of Division. Proration can also be based on an employee's time in a specific group. Compensation components can be set to be prorated by the compensation administrator when configuring the compensation component. 
The Proration pop-up enables the compensation manager to view recommendations and allocate prorated amounts for each of the prorated periods of a component for a user.
The Proration pop-up is accessed by clicking the Edit icon [image: ] for a prorated component for a user in which there are multiple prorated periods.
This pop-up can only be accessed when there is a component with multiple prorated periods.
Bonus Proration by % Attained
[image: ]
If the Bonus compensation template is configured to be set as a percentage of the Bonus Target, then the compensation manager can set an employee's bonus as a percentage of the component target.
The pop-up title reflects the component that is being prorated.
Currency
This displays the compensation task currency in which monetary values are displayed in the pop-up.
Proration Table
Within the proration table, the following information is displayed:
· Proration Criteria - This displays the criterion by which the component is prorated. For example, if the proration is based on the time a user spent in a position, then this column displays the user's positions during the compensation period.
· Proration - This displays the proration percentage that is associated with the proration criterion.
· Target - This displays the prorated component target for the prorated period.
· Min - This displays the prorated minimum adjustment guideline amount as a percentage of the target.
· Max - This displays the prorated maximum adjustment guideline amount as a percentage of the target.
· Recommendations - This displays the original recommendation as a percentage of the prorated target.
· Increase - This column display the allocation amount as a fixed amount and a percentage of base. These values are dynamically updated based on the % Attained allocation.
· % Attained - In this column, enter the allocation amount as a percentage of the target. This value must be greater than or equal to 0% and must be less than 1000%.
· If the % Attained value results in an increase amount that is outside the guidelines but within the threshold, the row is highlighted in yellow. When the proration pop-up is saved, the row in the compensation plan is also highlighted in yellow, and a yellow Warning icon appears to the right of the allocation.
· If the % Attained value results in an increase amount that is outside the guidelines and the threshold, the row is highlighted in red, and a red Warning icon [image: ] appears to the right of the allocation. The proration pop-up cannot be saved until the allocations are adjusted to be within the threshold.
Total
This column displays the summation of all of the following values:
· Target - This is the sum of the targets of each prorated period.
· Recommendations - This is the total recommendation amount as a percentage of the prorated Target Bonus summation.
· Increase - This is the sum of the increase amounts.
· % Attained - This is the sum of the bonus allocations of each prorated period divided by the sum of the targets of each prorated period.
Save or Cancel
Click Save to save the proration allocations. Or, click Cancel to discard the proration allocations.
Bonus Proration by Fixed %
[image: ]
If the Bonus compensation template is configured to be set as a fixed amount or as a percentage of the Base Salary, then the compensation manager can set an employee's bonus as a fixed amount or as a percentage of the Base Salary.
The pop-up title reflects the component that is being prorated.
Currency
This displays the compensation task currency in which monetary values are displayed in the pop-up.
Proration Table
Within the proration table, the following information is displayed:
· Proration Criteria - This displays the criterion by which the component is prorated. For example, if the proration is based on the time a user spent in a position, then this column displays the user's positions during the compensation period.
· Proration - This displays the proration percentage that is associated with the proration criterion.
· Target - This displays the prorated component target for the prorated period.
· Min - This displays the prorated minimum adjustment guideline amount.
· Max - This displays the prorated maximum adjustment guideline amount.
· Recommendations - This displays the original recommendation amount as an amount and as a percentage of the Base Salary.
· Increase - In this column, enter the allocation amount as a fixed amount or as a percentage of base.
· If the Increase amount is outside the guidelines but within the threshold, the row is highlighted in yellow. When the proration pop-up is saved, the row in the compensation plan is also highlighted in yellow, and a yellow Warning icon appears to the right of the allocation.
· If the Increase amount is outside the guidelines and the threshold, the row is highlighted in red, and a red Warning icon [image: ] appears to the right of the allocation. The proration pop-up cannot be saved until the allocations are adjusted to be within the threshold.
· % Attained - This column display the allocation amount as a percentage of the target. This value is dynamically updated based on the Increase allocations.
Total
This column displays the summation of all of the following values:
· Target - This is the sum of the targets of each prorated period.
· Recommendations - This is the sum of the recommendations of each prorated period as a percentage of the Base Salary.
· Increase - This is the sum of the increase amounts.
· % Attained - This is the sum of the bonus allocations of each prorated period divided by the sum of the targets of each prorated period.
Save or Cancel
Click Save to save the proration allocations. Or, click Cancel to discard the proration allocations.
Use Cases
The following use cases use the following data:
Bonus Template 2012 has the following settings and is included in the 2012 Compensation Task.
· The template includes a Bonus component that is set to prorate by the amount of time in the position.
· In the Allocation Rules section, Percentage of Bonus Targets is selected.
	Employee
	Current Salary
	Position
	Proration
	Target Bonus

	Allison Briggs
	$65,000
	Product Specialist
	20.0%
	$2,000

	
	
	Jr. Product Manager
	70.0%
	$7,000

	
	
	Product Manager
	10.0%
	$1,000


Use Case 1: Allocate as Percentage of Bonus Target - Simple
No adjustment guideline is set for the Bonus component.
Action
On the Bonus tab of the 2012 Compensation Task, the compensation manager clicks the Edit icon in the % Attained field for the Bonus component for Allison.
The compensation manager allocates 50.7% in the % Attained field for the Product Specialist prorated period.
Results
The Bonus Proration pop-up shows the following for Allison Briggs:
· Product Specialist:
· Increase (read-only) - 1,014.00 / 1.6% (Calculation: Increase = <% ATTAINED> * <PRORATED TARGET> = 0.507 * 2000)
· % Attained: 50.7%
· Jr. Product Manager
· Increase (read-only) - 0.00 / 0.0%
· % Attained: 0.0%
· Product Manager
· Increase (read-only) - 0.00 / 0.0%
· % Attained: 0.0%
· Total
· Target - 10,000.00 / 15.4%
· Increase (read-only) - 1,014.00 / 1.6%
· % Attained: 10.1%
Use Case 2: Allocate as Percentage of Bonus Target - Fixed Amount Adjustment Guideline
The following Adjustment Guidelines are set for the Bonus component:
· Availability: Position: Product Specialist - $4500.25 USD.
· Availability: Position: Jr. Product Manager - $9000.00 USD.
· Availability: Position: Product Manager - $8750.32 USD.
Action
On the Bonus tab of the 2012 Compensation Task, the compensation manager clicks the Edit icon in the % Attained field for the Bonus component for Allison.
Results
The Bonus Proration pop-up shows the following for Allison Briggs:
· Product Specialist:
· Increase (read-only) - 900.10 / 1.4% (Calculation: Increase = <RECOMMENDATION> * <PRORATION> = 4500.5 * 0.20)
· % Attained: 45.0% (Calculation: % Attained = <PRORATED INCREASE> / <PRORATED TARGET BONUS> = 900.10 / 2000.00)
· Jr. Product Manager
· Increase (read-only) - 6,300.00 / 9.7% (Calculation: 9000.00 * 0.70)
· % Attained: 90.0% (Calculation: 6300.00 / 7000.00)
· Product Manager
· Increase (read-only) - 875.03 / 1.3% (Calculation: 8750.32 * 0.10)
· % Attained: 87.5% (Calculation: 875.03 / 1000.00)
· Total
· Target - 10,000.00 / 15.4%
· Increase (read-only) - 8,075.13 / 1.2%
· % Attained: 80.8%
[bookmark: _Ref-1365542100]Compensation Plan - Proration - Equity
Proration enables an organization to adjust a user's compensation based on a prorated time period instead of the compensation period. This may be necessary if the employee has not been with the organization, in the position, or in their current salary for the entire compensation period. This may also be necessary if an employee did not receive a compensation adjustment from the prior compensation period. Proration can be based on the employee's Last Hire Date, Last Salary Change Date, or their time in an OU such as Position of Division. Proration can also be based on an employee's time in a specific group. Compensation components can be set to be prorated by the compensation administrator when configuring the compensation component. 
The Proration pop-up enables the compensation manager to view recommendations and allocate prorated amounts for each of the prorated periods of a component for a user.
The Proration pop-up is accessed by clicking the Edit icon [image: ] for a prorated component for a user in which there are multiple prorated periods.
This pop-up can only be accessed when there is a component with multiple prorated periods.
Equity Proration with Shares
[image: ]
The pop-up title reflects the component that is being prorated.
Currency
For ISO or NQO equity components, the currency is Options. For RSA equity components, the currency is Shares.
Proration Table
Within the proration table, the following information is displayed:
· Proration Criteria - This displays the criterion by which the component is prorated. For example, if the proration is based on the time a user spent in a position, then this column displays the user's positions during the compensation period.
· Proration - This displays the proration percentage that is associated with the proration criterion.
· Recommendations - This displays the original recommendation amount.
· Increase - In this column, enter the allocation amount as a fixed amount of stock options.
· If the Increase amount is outside the guidelines and the threshold, the row is highlighted in red, and a red Warning icon [image: ] appears to the right of the allocation. The proration pop-up cannot be saved until the allocations are adjusted to be within the threshold.
Total
This column displays the summation of all of the following values:
· Recommendations - This is the sum of the recommendations of each prorated period.
· Increase - This is the sum of the increase amounts.
Save or Cancel
Click Save to save the proration allocations. Or, click Cancel to discard the proration allocations.
Equity Proration with Cash Award
[image: ]
The pop-up title reflects the component that is being prorated.
Currency
This displays the compensation task currency in which monetary values are displayed in the pop-up.
Proration Table
Within the proration table, the following information is displayed:
· Proration Criteria - This displays the criterion by which the component is prorated. For example, if the proration is based on the time a user spent in a position, then this column displays the user's positions during the compensation period.
· Proration - This displays the proration percentage that is associated with the proration criterion.
· Target - This displays the prorated component target for the prorated period.
· Min - This displays the prorated minimum adjustment guideline amount.
· Max - This displays the prorated maximum adjustment guideline amount.
· Recommendations - This displays the original recommendation amount as an amount and as a percentage of the Base Salary.
· Increase - In this column, enter the allocation amount as a fixed amount or as a percentage of base.
· If the Increase amount is outside the guidelines but within the threshold, the row is highlighted in yellow. When the proration pop-up is saved, the row in the compensation plan is also highlighted in yellow, and a yellow Warning icon appears to the right of the allocation.
· If the Increase amount is outside the guidelines and the threshold, the row is highlighted in red, and a red Warning icon [image: ] appears to the right of the allocation. The proration pop-up cannot be saved until the allocations are adjusted to be within the threshold.
Total
This column displays the summation of all of the following values:
· Target - This is the sum of the targets of each prorated period.
· Recommendations - This is the sum of the recommendations of each prorated period.
· Increase - This is the sum of the increase amounts.
Save or Cancel
Click Save to save the proration allocations. Or, click Cancel to discard the proration allocations.
Compensation Plan - Submit Confirmation
The Submit Confirmation pop-up appears when a compensation manager clicks the Submit button on a compensation plan, and it alerts the compensation manager that a compensation plan may be edited during the approval process. The Submit Confirmation pop-up also enables the compensation manager to create a copy of their original submitted compensation plan. The purpose of creating a copy of the submitted plan is to allow the compensation manager to have access to the original submitted version during the approval workflow.
The Submit Confirmation pop-up opens when a compensation manager clicks the Submit button on a compensation plan.
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When a compensation manager submits a compensation plan, they have the option to create a copy of the submitted plan. Once a copy is created, the compensation manager can edit, delete, or copy the copy of the submitted draft.
Close
Select this option to cancel the action and return to the plan.
Copy and Submit
Select this option to submit the plan for approval and create a copy of the submitted plan.
Copying and submitting the plan creates an additional entry on the Compensation Plans tab. The original version has a status of Submitted, and the copied version has a status of Draft. Next to the status of the copied draft, "(Copy of Submitted <Version #>)" is displayed. The version number of the copy is calculated as the next available subsequent version number. For example, if a plan has versions 1.0, 2.0, and 3.0, and version 3.0 is copied, then the subsequent version would be 4.0 and the status would be "Draft (Copy of Submitted 3.0)." Note: When a compensation plan is initially copied and submitted, the submitted version is always 1.0 and the copied version is always 2.0.
· Submitted Version - The compensation manager can view a read-only version of the submitted version from the Compensation Plans tab. 
· Copied Version - The compensation manager can edit and delete the copied version from the Compensation Plans tab.
See Compensation Task - Compensation Plans Tab on page 248 for additional information.
Submit
Select this option to submit the plan for approval without creating a copy.
[bookmark: _Ref-220326770]Compensation Plan - Edit Approved Plan
When an administrator edits an approved compensation plan, the administrator is able to make changes to the plan without routing the plan through the approval workflow. The administrator must adhere to all adjustment guidelines and budget rules. The administrator has the same editing options as the original compensation manager, including editing allocations and adding comments. Only custom fields that are available to the administrator are displayed. If the administrator edits a plan that contains a component that uses the Cascaded Budget type, any changes that are made to the cascaded budget component are automatically locked, regardless of the task configuration. Any available budget is automatically rolled up to the next-level compensation manager.
Note: When an administrator edits an approved compensation plan, eligibility and budgets are not recalculated.  
When the administrator clicks Save when editing an approved compensation plan, a confirmation pop-up appears. This appears regardless of whether any changes are made. This pop-up confirms that the administrator would like to save any changes that have been made to the approved compensation plan.
· Save - Click this button to save the changes and bypass the approval workflow. The changes are not saved until this button is clicked. Once changes are saved, they cannot be undone unless the compensation plan is edited again. If configured in Email Administration, the Compensation Plan Edited email is triggered.
· Cancel - Click this button to discard any changes that have been made.
Note: The system provides a history of the administrator who modifies an approved plan. However, the system does not track the specific changes that are made.  
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Approved Plan - Edit
	Grants ability to edit an approved compensation plan and bypass the approval workflow. This permission does not extend to plans that are in a status of Not Started or In Progress. This permission works in conjunction with the Compensation Task Administration or Compensation Task Administration - Manage permission. This permission can be constrained by OU, User's OU, and User's Subordinates. This is an administrator permission.
	Compensation - Administration



	Compensation Plan - Manage
	Grants Compensation Managers the ability to access to the landing page of their assigned compensation tasks. This permission also grants the ability to create and manage compensation plans within the task. This permission cannot be constrained. This is an end user permission.
	Compensation



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[bookmark: _Ref-150886728]Compensation Plan - Edit as Approver
[bookmark: concept111]Compensation - Award Off-cycle
An off-cycle compensation task can be launched via Universal Profile and My Team.
· To launch an off-cycle compensation task for a subordinate via Universal Profile, click the Award Compensation link from the Options drop-down list. This option is only available to managers if at least one active off-cycle compensation task is available to the manager. See Bio - About Overview for additional information.
· To launch an off-cycle compensation task for a subordinate via My Team, go to My Team, and then select the ID card of the appropriate direct report. Then, go to Activities > Current. From the Actions drop-down menu, select Award Compensation. Then, select the appropriate off-cycle compensation task. The manager is taken to the Award Compensation page if the task is configured with any templates that require the assigner to define the effective date. See Tasks Overview for additional information.
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[bookmark: _Ref-345587371][bookmark: _Toc161996460]Compensation Task Details
The Compensation Task Details page provides the administrator with an overview of the compensation task, including the overall task progress, task period, compensation period, and any compensation templates used. The administrator can also adjust budgets and reset tasks for managers. The administrator can search for tasks by assigned manager and view the details of that particular task.
To view the Compensation Task Details page for a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the View Details icon [image: ] in the Options column next to the appropriate task. This option is only available once the task is In Progress.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


The Compensation Task Details page differs for standard compensation tasks and off-cycle compensation tasks.
· Standard Compensation Tasks
· Off-cycle Compensation Tasks
[image: ]
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Compensation Task Details - Standard Tasks
To view the Compensation Task Details page for a compensation task, go to Admin > Tools > Compensation Management > Tasks. Then, click the View Details icon [image: ] in the Options column next to the appropriate task. This option is only available once the task is In Progress.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration - Manage
	Grants access to the Compensation Task Administration page, and grants ability to view and manage compensation planning and modeling tasks from the Compensation Task Administration page. Administrators can only view a compensation task if they have this permission and are also included in the Visibility settings for the compensation task. Note: Administrators with the Compensation Task Administration permission can view and manage all compensation tasks and do not require this permission. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


[image: ]
The Standard Compensation Task Details page displays the following information for the task:
· Overall Progress - The overall progress of the task. This percentage accounts for all managers assigned the task. The pie chart to the right displays a breakdown of the task progresses by statuses for all assigned managers within the task.
· Tasks Assigned - The number of tasks that are assigned within the task.
· Tasks Completed
· Tasks Pending Approval
· Tasks Incomplete
· Task Period - The duration of the compensation task. Note: This is only displayed for Standard task types.
· Compensation Period - The time period on which the employee is being compensated. Note: This is only displayed for Standard task types.
· Templates - This displays any templates implemented in the task. 
Adjust Budgets for Task
Next to the Budgets heading, click the Adjust Budgets link to open the Adjust Budgets pop-up and modify the budgets for all compensation plans included in the task. Note: This option is not available for compensation modeling tasks. See Compensation Task Details - Adjust Budgets for Task on page 372 for additional information.
Extend Task End Date
If Effective Dating is enabled, administrators can manually extend Task End dates for In-Progress, Completed, and Expired tasks. Administrators can also extend the compensation statement availability date. 
Click the Extend Task End Date link to extend the End Date of all compensation plans in the task.  
The End Date is the date by which managers must complete the compensation task. To extend the End Date, next to the Task End Date value, click the calendar tool to select a new end date. The end date must be after the current end date (i.e., the end date cannot be made sooner; the end date must remain the same or be extended).
The Statement Date is the date on which the compensation statement for the task is available to the employee through the system. To extend the Statement Date, next to the Statement Date value, click the calendar tool to select a new statement date. The Statement Date must always be after the End Date.
Note: When Cornerstone HR or Effective Dating is enabled, then compensation tasks cannot be extended. When viewing the Compensation Task Details for the task, the Extend Task End Date link is not available. See Effective Dating.
[image: ]
· When extending compensation task end dates, the status of the Compensation task does not change for tasks with Not Started, In Progress, or Complete status.
· When extending compensation task end dates for a task in Expired status, the task moves back to In Progress status. 
· Extending compensation task end dates is also supported for inactive compensation tasks for all statuses. 
· For compensation task end dates and compensation statement availability dates, it is not possible to define a new task end date sooner than the existing date. 
Search for Users
In the Search for Users section, a list of managers that are assigned the task is displayed in alphabetical order by last name. Administrators can view a printable version of the list or export the list to Excel by clicking the Print or Export to Excel icon in the upper-right corner of the section.
Using the search filters, you can search for particular managers by Task Status, User Last Name, or User ID. After entering the appropriate search criteria, click the Search button. To include only inactive tasks in the search, select the Display Inactive Tasks Only option and click Search.
The list of users displays the following information for each manager:
· User - The manager's name
· User ID - The manager's user ID
· Status - The status of the manager's compensation task
The following options are available in the Options column:
· Adjust Budgets [image: ] - Click this icon to adjust the budgets for the compensation manager's plan. Only the components included in the manager's plan are available for modification. Budgets that are cascaded cannot be adjusted. This functionality is the same as when adjusting budgets for an entire task. This option is only available for in-progress, standard planning tasks. Note: This option may be available for tasks that are Pending Approval, depending on the Adjust Budgets configuration. See Compensation Task Details - Adjust Budgets for Manager on page 374 for additional information.
· Reset Task [image: ] - Click this icon to reset the task for the assignee. Note: This option is only available for tasks that are in Pending Approval status. 
· Edit [image: ] - Click this icon to edit the approved compensation plan. See the Edit Approved Compensation Plan section below for information on when this option is available. 
· Add Co-Planner [image: ] - Click this icon to add a co-planner to the task for the manager. The co-planner is able to complete the task as though they are the manager that is assigned the task. They can view, edit, and submit compensation plans on behalf of the manager. This overrides the co-planner selected by the manager if one is already selected.
· View Details [image: ] - Click this icon to view the details of the manager's task. This includes the budget status for the manager's compensation plan as well as the plan history of the task. The plan history displays an audit trail of the manager's compensation plan recording when the plan was submitted, approved, denied, and reset, the date of each action, and any comments that are entered. If the components have OU specific budgets, they are not displayed in this pop-up. Note: For modeling tasks, the Total Budget column does not appear.
Edit Approved Compensation Plan
Administrators with the appropriate permissions can edit completed and approved plans.
The Edit icon appears in the Options column for a user if the following is true:
· The administrator is not an employee within the compensation plan.
· The task is active.
· The task period is active (within the compensation task period for standard tasks and before the due date for off-cycle tasks).
· The compensation plan status is Complete.
· The compensation plan user is within the administrator's permission constraints.
See Compensation Plan - Edit Approved Plan on page 359 for additional information.
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Compensation Task Details - Off-cycle Tasks
[image: ]
The Off-Cycle Compensation Task Details page displays the following information for the task:
· Employees Included - The number of employees who have been compensated through the off-cycle task. Note: This is only displayed for off-cycle tasks.
· Tasks Assigned - The number of tasks that have been assigned or initiated via the off-cycle task. Note: The number of tasks assigned can be greater than the number of employees compensated since the same employee can have their compensation adjusted more than once with an off-cycle task.
· Tasks Completed
· Tasks Pending Approval
· Tasks Incomplete
· Templates - This displays any templates implemented in the task. 
Launch Off-Cycle Task
Click the Launch Off Cycle Task link to initiate an off-cycle compensation task for a specific set of users. See Off-Cycle Compensation Task - Award Compensation on page 382 for additional information.
Search
The Search section displays a list of employees that are compensated via the task as well as each user assigned the task. Administrators can view the users by Employee or by Task Assignee by selecting the appropriate radio button at the top of the section.
Administrators can view a printable version of the list or export the list to Excel by clicking the Print or Export to Excel icon in the upper-right corner of the section.
Employee View
The employee view displays all employees who have been included in the off-cycle task. Only employees who have had their compensation adjusted or are in the process of having their compensation adjusted appear. If the employee has had their compensation adjusted more than once through the same off-cycle task, their name appears in the table along with the number of tasks in which the employee was included.
Using the search filters, you can search for particular employees by Last Name or ID. After entering the appropriate search criteria, click the Search button.
The list of employees displays the following information for each employee:
· Employee
· Employee ID
· Manager - The employee's manager
· Task Assigned - The number of times the off-cycle task has been assigned for the employee
· Current Task Assignee
· Current Task Status
The following options are available in the Options column:
· View Details [image: ] - Click this icon to view the details of the employee's tasks. This includes the details for each time the employee was compensated through the off-cycle task.
Task Assignee View
The task assignee view displays all users who initiated the off-cycle task for an employee. The list of assignees displays each instance of the off-cycle task being assigned.
Using the search filters, you can search for particular assignee by Last Name or ID. After entering the appropriate search criteria, click the Search button. To include only inactive tasks in the search, select the Display Inactive Tasks Only option and click Search.
The list of assignees displays the following information for each assignee:
· Task Assignee - The name of the administrator that assigned the task
· Assignee ID
· Employee - The name of the employee that is being compensated
· Employee ID - The employee's user ID
· Current Task Status - The status of the assignee's current compensation task
· Task Due Date - The date on which the task is due
The following options are available in the Options column:
· Adjust Budgets [image: ] - Click this icon to adjust the budgets for the particular task or reset the task back to the manager. Only the components included in the manager's task are available for modification. Budgets that are cascaded cannot be adjusted. This functionality is the same as when adjusting budgets for an entire task. Note: This option is not available if the status is Not Started or if the task is submitted for approval.
· Reset Task [image: ] - Click this icon to reset the task for the assignee. Note: This option is only available for tasks that are in Pending Approval status.  
· Edit [image: ] - Click this icon to edit the approved compensation plan. See the Edit Approved Compensation Plan section below for information on when this option is available.
· Add Co-Planner [image: ] - Click this icon to add a co-planner to the task for the manager. The co-planner is able to complete the task as though they are the manager that is assigned the task. They can view, edit, and submit compensation plans on behalf of the manager. This overrides the co-planner selected by the manager if one is already selected. Note: This option is not available for tasks that are Complete.
· View Details [image: ] - Click this icon to view the details of the manager's task. This includes the budget statuses for the manager's compensation plan as well as the plan history of the task. The plan history displays an audit trail of the manager's compensation plan recording when the plan was submitted, approved, denied, and reset, the date of each action, and any comments that are entered. If the components have OU specific budgets, they are not displayed in this pop-up. Note: For modeling tasks, the Total Budget column does not appear.
· Remove [image: ] - Click this icon to remove the assignment. Note: This option is not available for tasks that are Complete.
Edit Approved Compensation Plan
Administrators with the appropriate permissions can edit completed and approved plans.
The Edit icon appears in the Options column for a user if the following is true:
· The administrator is not an employee within the compensation plan.
· The task is active.
· The task period is active (within the compensation task period for standard tasks and before the due date for off-cycle tasks).
· The compensation plan status is Complete.
· The compensation plan user is within the administrator's permission constraints.
See Compensation Plan - Edit Approved Plan on page 359 for additional information.
[bookmark: _Ref-547651079]Compensation Task Details - Adjust Budgets for Task
From the Compensation Task Details page, administrators can adjust budgets for all compensation plans included in a compensation task. This functionality is only available for in-progress, standard planning tasks.
To adjust budgets for an entire standard planning compensation task, go to Admin > Tools > Compensation Management > Tasks. Click the View Details icon [image: ] in the Options column next to the appropriate task. This option is only available once the task is In Progress. Then, next to the Budgets heading, click the Adjust Budgets link to open the Adjust Budgets pop-up. Note: This option is not available for compensation modeling tasks.
Include "Pending Approval" tasks
Select this option to also adjust budgets for compensation plans that are in Pending Approval status. Note: Pending Approval status is designated for compensation plans that have been submitted but have not yet completed all levels of approval as defined in the approval workflow. When this option is selected, once the Adjust Budgets pop-up settings are saved, the Adjust Budgets icon also appears in the Options column for tasks that are in Pending Approval status.
Component Budgets
In the pop-up, each budget component included in the task is listed in the Component column. To the right of each component, in the Current Budget column, the current budget for that component is displayed. Lastly, in the New Budget, you are able to specify a new budget for that component. If no value is entered for a component in the New Budget column, that component's budget is unchanged. If a value is entered in the New Budgets column, the value must be higher than the value in the Current Budget column. When entering percentage values, one to three decimals may be entered, depending on the decimal precision. The decimal precision for percentages in compensation is controlled by a backend setting.
Save
After entering new budget values for the appropriate components, click Save. The new budgets are automatically implemented. 
[image: ]
[bookmark: _Ref1716609083]Compensation Task Details - Adjust Budgets for Manager
Administrators are able to adjust a compensation manager's budget. This functionality is only available for in-progress, standard planning tasks.
To adjust budgets for a compensation manager's standard planning compensation task, go to Admin > Tools > Compensation Management > Tasks. Click the View Details icon [image: ] in the Options column next to the appropriate task. This option is only available once the task is In Progress. Then, click the Adjust Budgets icon [image: ] in the Options column for the appropriate compensation manager. This opens the Adjust Budgets for Compensation Manager pop-up. Note: The Adjust Budgets option is not available if the compensation manager's compensation plan status is Not Started. This option may be available for tasks that are Pending Approval, depending on the Adjust Budgets configuration.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


The following information is displayed in the pop-up:
· Component - Displays the name of each component in the compensation manager's compensation plan.
· Original Budget - Displays the original budget for the component from the compensation template. This value is read-only and is never updated.
· Difference - Displays the difference between the Current Budget value and the Original Budget value. This value is read-only, but it is dynamically updated when a new value is entered in the Current Budget column. A budget increase is displayed in green, and a budget decrease is displayed in red.
· Current Budget - In this field, enter the new budget for the component. This must be a positive value, but it can be more than or less than the Original Budget value. See Adjust Budgets - Decrease Budgets Use Cases on page 377 for additional information.
When the Adjust Budgets pop-up is saved, the Modification History section is updated to include the new adjustment. Entries in the Modification History section are grouped by budget type. The following information is included for each adjustment:
· Component that was adjusted
· Amount by which the component budget was adjusted
· User who made the adjustment
· Date on which the adjustment was made
[image: ]
When budget adjustments are saved, the system compares the new budgets with the current allocations from the compensation manager's compensation plan.
· If the compensation manager's current allocations do not exceed the new budget allowances, then the lowered component budgets are automatically implemented throughout the compensation manager's compensation task.
· If the compensation manager's current allocations exceed the new budget allowances, then a warning pop-up is displayed, which describes each of the allocations that exceed the new budgets. For example, if a compensation manager previously had a component budget of $900 and had made allocations that totaled $850, and then the component budget is decreased to $800, then this pop-up would appear. The following options are available:
· Yes - Click this button to reset the compensation manager's compensation plan allocations and implement the lowered component budget throughout the compensation task. A message is displayed on the compensation manager's compensation task which indicates that the draft has been reset by the administrator.
· No - Click this button to return to the Adjust Budgets for Compensation Manager pop-up to make additional adjustments to the component budgets.
[image: ]
When an employee is added to or removed from a compensation plan, then the budget is automatically increased or decreased by the employee's default budget allocation. For example, if budget is determined by percentage of base salary and the percentage is set at 10%, then an employee with a salary of $50,000 results in a budget of $5,000 (10% of $50,000). If that employee is removed from the compensation plan, then the budget is automatically decreased by $5,000. Similarly, if that employee is added to the compensation plan, then the budget is automatically increased by $5,000.
[bookmark: _Ref1043444228]Adjust Budgets - Decrease Budgets Use Cases
The following use cases describe the workflow for decreasing compensation budgets:
Use Case 1
A compensation task is configured with the following compensation plan budgets:
· Percentage of Base Budget = 10%
· Overage Allowance = 10%
· Employee 1 Salary (Default) = $60,000
· Employee 2 Salary (Texas) = $50,000
· Employee 3 Salary (Texas) = $50,000
· Employee 4 Salary (Default) = $40,000
· Merit Increase - Default Budget = $10,000
· Merit Increase - Texas Budget = $10,000
The following allocation totals are made within the compensation task:
· Merit Increase - Default = $11,000
· Merit Increase - Texas = $10,000
The administrator adjusts budgets for the compensation task and sees the following information:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
The administrator adjusts the budget to the following:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = -$2,000.00 (red)
· Current Budget = $8,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The administrator saves the adjustments, and a warning pop-up is displayed to indicate that the compensation manager's Merit Increase - Default component allocations exceed the updated budget allowances (new budget plus 10% overage allowance). The administrator clicks the Yes button within the pop-up. The compensation manager's compensation plan allocations are reset and the new budgets are reflected in the compensation plan. 
· Merit Increase - Default = $8,000
· Merit Increase - Texas = $9,500
The Modification History section within the Adjust Budgets pop-up displays the details of the two budget modifications.
Use Case 2
A compensation task is configured with the following compensation plan budgets:
· Percentage of Base Budget = 10%
· Overage Allowance = 10%
· Employee 1 Salary (Default) = $60,000
· Employee 2 Salary (Texas) = $50,000
· Employee 3 Salary (Texas) = $50,000
· Employee 4 Salary (Default) = $40,000
· Merit Increase - Default Budget = $10,000
· Merit Increase - Texas Budget = $10,000
The following allocation totals are made within the compensation task:
· Merit Increase - Default = $11,000
· Merit Increase - Texas = $10,000
The administrator adjusts budgets for the compensation task and sees the following information:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
The administrator adjusts the budget to the following:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = -$5,000.00 (red)
· Current Budget = $5,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The administrator saves the adjustments, and a warning pop-up is displayed to indicate that the compensation manager's Merit Increase - Default component allocations exceed the updated budget allowances (new budget plus 10% overage allowance). The administrator clicks the Yes button within the pop-up. The compensation manager's compensation plan allocations are reset and the new budgets are reflected in the compensation plan.
· Merit Increase - Default = $5,000
· Merit Increase - Texas = $9,500
Employee 1 is moved to a new team and is no longer included in the compensation plan. Because the budgets are determined by percentage of base salary, the original Default budget is decreased by the employee's default budget allocation (10% of $60,000), which makes the original Default budget $4,000 ($10,000 - $6,000). The previous budget reduction of $5,000 still applies to the Default budget. The following new budgets are automatically implemented for the compensation plan:
· Merit Increase - Default:
· Original Budget = $4,000.00
· Difference = -$5,000.00 (red)
· Current Budget = $0.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
A new employee, Employee 5, is moved to the team and is included in the Default budget for the compensation plan. Employee 5's salary is $80,000. Because the budgets are determined by percentage of base salary, the Default budget is increased by the employee's default budget allocation (10% of $80,000), which makes the original Default budget $12,000 ($4,000 + $8,000). The following new budgets are automatically implemented for the compensation plan:
· Merit Increase - Default:
· Original Budget = $12,000.00
· Difference = -$5,000.00 (red)
· Current Budget = $7,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The Modification History section within the Adjust Budgets pop-up displays the details of the two budget modifications.
Use Case 3
A compensation task is configured with the following compensation plan budgets:
· Percentage of Base Budget = 10%
· Overage Allowance = 10%
· Employee 1 Salary (Default) = $60,000
· Employee 2 Salary (Texas) = $50,000
· Employee 3 Salary (Texas) = $50,000
· Employee 4 Salary (Default) = $40,000
· Merit Increase - Default Budget = $10,000
· Merit Increase - Texas Budget = $10,000
The following allocation totals are made within the compensation task:
· Merit Increase - Default = $11,000
· Merit Increase - Texas = $10,000
The administrator adjusts budgets for the compensation task and sees the following information:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = $0.00
· Current Budget = $10,000.00
The administrator adjusts the budget to the following:
· Merit Increase - Default:
· Original Budget = $10,000.00
· Difference = -$5,000.00 (red)
· Current Budget = $5,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The administrator saves the adjustments, and a warning pop-up is displayed to indicate that the compensation manager's Merit Increase - Default component allocations exceed the updated budget allowances (new budget plus 10% overage allowance). The administrator clicks the Yes button within the pop-up. The compensation manager's compensation plan allocations are reset and the new budgets are reflected in the compensation plan.
· Merit Increase - Default = $5,000
· Merit Increase - Texas = $9,500
Employee 1 is moved to a new team and is no longer included in the compensation plan. Because the budgets are determined by percentage of base salary, the original Default budget is decreased by the employee's default budget allocation (10% of $60,000), which makes the original Default budget $4,000 ($10,000 - $6,000). The previous budget reduction of $5,000 still applies to the Default budget. The following new budgets are automatically implemented for the compensation plan:
· Merit Increase - Default:
· Original Budget = $4,000.00
· Difference = -$5,000.00 (red)
· Current Budget = $0.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The administrator adjusts the Merit Increase - Default budget.
· Merit Increase - Default:
· Original Budget = $4,000.00
· Difference = -$2,000.00 (red)
· Current Budget = $2,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
A new employee, Employee 5, is moved to the team and is included in the Default budget for the compensation plan. Employee 5's salary is $80,000. Because the budgets are determined by percentage of base salary, the Default budget is increased by the employee's default budget allocation (10% of $80,000), which makes the original Default budget $12,000 ($4,000 + $8,000). The following new budgets are automatically implemented for the compensation plan:
· Merit Increase - Default:
· Original Budget = $12,000.00
· Difference = -$2,000.00 (red)
· Current Budget = $10,000.00
· Merit Increase - Texas:
· Original Budget = $10,000.00
· Difference = -$500.00 (red)
· Current Budget = $9,500.00
The Modification History section within the Adjust Budgets pop-up displays the details of the three budget modifications.
[bookmark: _Ref417623245]Off-Cycle Compensation Task - Award Compensation
The Award Compensation page enables the administrator to define the compensation manager, the employees included in the task, and template effective dates. The availability of the option to select the effective date for a template is dependent upon the configuration of the compensation task.
To award compensation from the Compensation Task Details page for a compensation task, go to Admin > Configuration Tools > Compensation > Compensation Task Administration, and then click the View Details icon [image: ] in the Options column next to the appropriate task. This option is only available once the task is In Progress. Then, click the Launch Off Cycle Task link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Task Administration
	Grants ability to configure and assign compensation planning and modeling tasks to managers in the organization. This permission cannot be constrained. This is an administrator permission.
	Compensation - Administration


Compensation Task
This displays the name of the off-cycle compensation task that is being launched. This field is read-only.
Who will be the compensation manager?
Select the compensation manager for the off-cycle task. The compensation manager is responsible for completing the compensation task. 
By default, this displays the administrator who is launching the off-cycle compensation task. 
To remove the selected compensation manager, click the Remove icon [image: ]. Then, click the Select icon [image: ] to select a new compensation manager for the task.
Who is included in the compensation plan?
Click the Add Users link to add the users who are included in the off-cycle compensation task. These are the users whose compensation may be affected. The selected users are displayed below the Add Users link.
· If a user who is selected is already included in the off-cycle task and is not yet completed and approved, then that user is not added.
Base/Bonus/Equity effective date
The effective date is only displayed for compensation planning tasks. Also, this field reflects the name that is configured for the template in the off-cycle compensation task.
The functionality that appears is dependent upon the configuration of the compensation template within the compensation task:
· If the administrator enabled the compensation task assigner to define the effective date, then a date selector is available. Click the date selector to select the effective date for the compensation template. This is required.
· If the administrator selected an effective date that is relative to the task completion and approval, then the relative effective date is displayed.
Launch or Cancel
Click Launch to launch the off-cycle task with the defined properties. Or, click Cancel to cancel the off-cycle task and return to the Task Details page.
[image: ]
Compensation: 
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[bookmark: _Toc161996461]Compensation Statement
The Compensation Statement page contains the current compensation statement and previous statements.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Compensation Statement
	Grants ability to view and print a user's own current and previous compensation statements. This is an end user permission.
	Compensation


[image: ]
To view a compensation statement, click the Compensation tab and then click the Compensation Statement link. The following sections are available:
· Organization Information - Includes User ID, Division, Manager, Hire Date etc.
· Base, Bonus, Equity - Separate section for each adjustment made in corresponding task including base, bonus, and equity. If any deferrals are made, the payout schedule is included.
· Summary - Contains a pie chart that displays the dollar break down of base, bonus, and/or equity compensation. The Summary graph only reflects the components that are included in the compensation task. When calculating percentages, the system calculates the total cost based on the allocations that appear on the plan.
· Additional Information - Display custom fields if applicable.
If a custom compensation statement is implemented, the standard statement may also be included as the first or second page of the statement. If this is the case, in the upper-right corner, page numbers are available so that users can switch between pages. Note: Custom Compensation Fields are not supported in Custom Statements.
In the upper-right corner, you can click the Printable Version icon to view a printable version of the statement, or you can click the PDF icon to create a PDF version of the statement.
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by 24.32 USD.

The adjustment amount may not exceed 1,860.81 USD.
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Maria Albert

The New Salary should be within the new salary range of the promotion. The New
Salary is 86,3460.63 USD.

The new salary range s 35,200.00 - 51.200.00 USD.

Close
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Promote Harry Keller

Determine the promotion criteria for this employee. Al fields are required. Enter
the promotion amount. The employee's total new salary must be greater than or
equal to the new salary range. The total new salary includes all salary adjust-
ments made on the compensation plan.

Currency: USD

Current Position New Position *
HR Analyst P 2
Current Location New Location *

Santa Monica R 2
Current Salary Range New Salary Range

24,100,00 - 61.20000 45,0000 - 75,00000

Current Salary Promotion Increase.

5835375

500000 |/ 86 %

Total New Salary
6335375

Comments
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Merit Increase Recommendations
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Bonus Recommendations
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Bonus Recommendations
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1SO Recommendations

Allocate IS0 for each prorated period.

Currency: Options

Position [——
Sales Executive 1% 10 150
Sales Manager Bo% 50 500
Tota 60 &0





image165.png
RSA Recommendations

Allocate RSA for each prorated period.

Currency:USD

P Provation | Target Min Max —
Soles Executive % 18580/29%  NA NA 188750/ 29% w780 |/ 29 %
Sales Manager 30X 279066/43% A NA 275088 /43% zs0ss |1[ 43 %
Tota 467846 /71% 467846 /71% 467846 /71%
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Submit

Once this draft s submitted for approval, it i subject to editing by the next level
manager during the approval process. Only one draft may be submitted for
approval at a time.

Would you like to create a copy of this submitted draft?
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Extend Compensation Task 3

Extend the End Date of all compensation plans in this task Only plans that do not
have a status of ‘Completed” may be extended. The new end date must be greater
than or equal to the current end date

TaskEndDate: [10252012 [

Statement Date: [10252012 [
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Employees Included:

Tasks Assigned:
Tasks Completed:

Tasks Pending Approval

Tasks Incomplete:

Templates: TE-01120

& Launch o Cycle Task
SEARCH %
®empioyee O Task Assionee
Empioyee LostHame: | Employee D & soaren

(4Resuts)

Employee Empojeeld  Manager  Task Assigned CurrontTask Assignee Curront Task Siatus Opions

Abels, ke Uabels Smin,Sam 1 Smin,Sam ot Starteg 22
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Adjust Budgets 3

‘Budget adjustments will apply to compensation tasks that are in “Not Started” or ‘In Progress” status by default. If
the budgetis cascaded, the adjusted budget will applyto the top level manager

J tnclude "pending Approval tasks
Currency: USD.

Current Budget

5.00% of Base [ 525 worbase
Promotion - Default 20,000.00 [
Performance Bonus - Default 85,000.00 [
Team Bonus - Default 10000000 ——
RSA - Default 20,000 Shares [ shares
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Adjust Budgets for Pat Kelly x

‘Budgets adjustment will apply fo compensation tasks that are n “Not Started” o “n Progress” status by defaut.
Ifthe budget i cascaded, the adjusted budget wil apply o the top level manager.

Currency: GaP

Component Original Budget ___Difference Current Budget E

MeritIncrease -Default  7.806.12 19388 5000
Costof Living Adjustment

oo 100000 000 1000.00
Market Adjustment -

ket Cascaded 325000

Promotion - Defauit None. 2
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Adjust Budgets for Jones, Hank x

Thecurent aocated budget for e Increase - Dfaut
A i5 850.00. This excoeds i current Budget Rulss
masimam of 800 60
Thecurent aocated budgetfor ert Increase - Toxas
15100000, Ts exceeds i cuen Budge Rues
masimum of $57 56

By cicking Yes below. you wil decrease the above.
bucgets and reset the Compensation Plan for
Hani Jones. Clicking No wil bring you back to the.
Adiust Budgets Screen.
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ADJUSTMENT

® Discretionary
O Non-Discretionary

* Please define matrix rating and columns before creating matrix
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!
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© Add Metric
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* Please define matri rating and columns before creating matrix

Define Columns:
Total Columns:|
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Search Fields and Metrics
‘Salect user custom felcs and metic rom Performancs or Sucosssion.
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Base Types

Define and lanage diferent Base types for Compensation Planning

@ Add Base Type

Base Type LastUpdated  LastUpdated By Include in Base Salary Actve  Options
MeritIncrease a1t Sam Smith Z &
Market Adjustment Z &
Promotion Z &
coLa Z &
[Foearen ] B %
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 Add Bonus Type
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Currency Types

Manage Currencis for your rganizaton. You can modiy your Corporate Currency, Actvale and Deacivate currencies, Update Conversion

Ratos and Prociion o curtences.

Hido nactvo Currences
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Currency Type.
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0 Create Custom Compensation Statement

Search for Statements
Hames lospiay tnactve stataments
(7 Results)
Statement Name LastUpdated  Last Updated By Active  Options.
Custom Statement 2010 612812011 Mulen, Lori Z@s
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m Compensation Statement

S e CUSTOM COMPENSATION TEUPLATE

‘Canfiure custom Compensation Statements for Compensation Planning.

Name: Custom Statement 2010

Content
© Add Section
v

Welcome to your 2010 Compensation Statement!
Please find below your merit and bonus increase amounts. These amounts are based on your
performance in 2010
2010 Meritincrease  {TOTALINCREASE}
2010 Team Bonus {TEAM BONUS}
2010 Performance Bonus {PERFORMANCE BONUS}
2010 New Salary (SALARY.NEW}
‘Thanks for making 2010 a successful year!
Management

Opions.

¥ include standard statement

Aach before
© Atach ater

[
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Welcome to your 2015 Compensation Statement!

Please find below your merit and bonus increase amounts. These amounts are
based on your performance in 2015.

2015 Meritincrease  {TOTALINCREASE}

2015 Team Bonus {TEAM.BONUS}

2015 Performance Bonus {PERFORMANCE.BONUS}

2015 New Salary {SALARY.NEW}

Thanks for making 2015 a successful year!

Mananamant
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